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¢ OURSE INTRODUCTION

This course presents an overview of the technology relating to the computer systems and exposes you to
operating systems and application packages. The course covers aspects on computer hardware, computer
‘ftware, data communication, computer security, graphical user interface, word processor and presentation
“rware.

The first block discusses about hardware and software of computer system. It includes discussions on data
presentation, memory system of computers, Input/Output devices, parallel organisation, pipelining and
redu .ed instruction set computers. It also covers aspects relating to the computer software such as the

- 'mponents of programming languages and operating system concepts.

- second block presents an introduction to data communication, networking and related technology. The
.--id of data communication has progressed tremendously during the past decade. Therefore, the concepts
relating to it are of utmost importance for a computer user. '

This block also discusses about the computer security and virus. The importance of computer security is of

the ut nost importance when we are discussing concepts like paperless offices, computerised defense systems

where every bit information will be available through the computers. Computer virus is major threat to
~mputer security. We will also discuss about how to deal with it in this block.

~ ¢ third block is a mix of theoretical and practical components. On the theoretical side we have discussed
ac ut the concepts relating to graphical user interface whereas on the practical side, it provides details of a
graphical user interface “Windows 95”

Fonrt™> block mainly emphasises Word processing Application and Presentation software.

~an do Practicals on “Windows 957, “MS-Word” and “MS-PowerPoint” along with the last two biogKs.
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1.0 INRODUCTION

The use of Information Technology is well recognised. It has become must for the survival of business
houses with the growing information needs. Computer is one of the major components of an Information
Technology network. Today, computer technology has permeated every sphere of existence of modern man.
. From railway reservations to medical diagnosis, from TV programmes to satellite launching, from
matchmaking to criminal catching- everywhere, we witness the elegance, sophistication and efficiency
possible only with help of computers.

In this block, we will introduce you to the computer hardware technology, iow does it work and what is it?

In addition we will also discuss some of the terminology closely linked with information Technology and
computers. More details on these terms can be obtained from furth er readings. In this unit, we shall discuss
about basic computer structure, the memory system and characteristics of various memories etc. We will also
define the terms such as the main memory, cache memory, secondary storage and optical memories.

1.1 OBJECTIVES

This unit being the first unit of the block introduces you to the world of computers. At the end of the unit,
you will be able to:

define the term computer

define Von Neumann architecture -

describe key characteristics ‘of memory system.
distinguish various types of memories
differentiate various external memories

define the importance of cache memory.
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1.2 WHATIS A COMPUTER?

Letus first define the term “computer™. In Oxford Dictionary, Computer is defined as "An automatic
clectronic apparatus for making calculations or controlling operations that are expressible in numerical or
logical terms™,

The basic function performed by a computer is the execution of a program. A program is a sequence of
instructions, which operatc on data to perform certain tasks. In modern digital computers data is represented
in binary form by using two symbols 0 and | which are called binary digits or bits. Computers use eight bits
to represent a character internally. This allows up te 2°=256 different items to be represented uniquely. This
collection of cight bits is called a byte. Thus, one byte is used to represent one character internally. One of
the most common codes to represent characters in computers is ASCII (American Standard Code for
Information Interchange). Most computers use two bytes or four bytes to represent numbers (positive and
negative) internally: Another term that is commonly used in computer is a Word. A word may be defined as
a unit of information that a computer can process or transfer at a time. A word-must be equal to the number
of bits transferred between the central processing unit and the main memory in a single step or it may be
defined as the basic unit of storage of integer data in a computer. Normally, a word may be equal to 8, 16,
32, or 64 bits. The terms like 32 bit computer, 64 bit computers etc. basically point to the word size of the
computer.

One of the key aspects in program execution is the ex.ecution of an instruction. The key questions that can be
asked in this respect are (a) how are instructions supplied to the computer? And (b) how are they interpreted
and executed? We will answer these questions alony: with the discussion on the basic structure of the
computer systen. ‘

Most of today's computer designs arc based on con cepts developed by John Von Neumann referred to as the
“Von Neumann architecture™. Von Neumann propposed that there should be a unit performing arithmetic and
logical operations on the data. This unit is termed| as Arithmetic Logic Unit (ALU). A control unit directs the
ALU to perform specific arithmetic and logical functions on the data. Therefore, in such a system, by
changing the control signal, the desired operatiori can be performed on data.

But, how can these control signals be supplied? Let us try to answer this from the definition of a program. A
program consists of a sequence of steps. Each of these steps, require certain arithmetic or logical or
input/output operations to be performed on data. Therefore, each step may require a set of control signals. Is
it possible for us to provide a unique code for each set of control signals? Well, the answer is Yes. But what
do we do with these codes? What about add ing a hardware segment that accepts the code and generates
control signals? The unit that ‘interprets a code to generate respective control signal is termed as Control Unit
(CU). Thus. a program now' consists of a se:quence of codes. This machine is quite flexible, as we only need

‘to provide a new sequence of codes for a ni2w program. Each code is. in effect, an instruction, for the

computer. The hardware interprets each of” these instructions and generates respective control signals.

The Arithmetic Logic Unit (ALU) and thee Control Unit (CU) together are termed as the Central Processing
Unit (CPU). The CPU is the most impor tant component of a computer's hardware. The ALU performs the
arithmetic operations such ais addition. s'ubtraction. multiplication and division, and the logical operations
such as: "Is A = B? (Where A and B are: both numeric or alphanumeric data), "Is a given character equal to M

(for male) of F (for female)?" The con‘irol unit interprets instructions and produces the respective control
signals,

All the arithmetic and logical operaticns are performed in the CPU in special storage areas called registers.
The size of the register is orie of the i mportant considerations in determining the processing capabilities of the
CPU. Register size refers to the amount of information that can be held in a register at a time for processing.
The larger the register size. the fasterr may be the speed of processing. A CPU's processing power is
measured in Million Instructions Per: Secodd'(MIPS).

"How can instructions and data be puat into computers? The instruction and data are to be supplied by external

e_nvil:onment, Therefore, an input m odule is needed. Main responsibility of input module will be to put the
data in the form of signals that :an 'be recognised by the system. Similarly, we reed another component that



will report the results in proper tormat and form. This component is called output fiddule. These Commoig
components are referred together as input/output (1/0O) components. ’ wm
Are these two components sufficient for a working computer? No, because, input devices can bring

instructions or data only sequentially and a program may not be executedsequentially as jump instructions

are normally encountered in programming. In addition, more than one data element may be required ata

time. Therefore, a temporary storage area is needed in a computer to store instructions and data temporarily.

This component is referred to as memory. It was pointed out by. Von Neumann that the same memory can be

used for storing data and instructions. In such case, the data can be treated as data on which processing can

be performed, while instructions can be treafed as data, which can be used for the generation of control

signals.

The memory unit stores all the information in a group of memory cells, also called memory locations, as
binary digits (bits). Each memory location has a unique address and can !~ addressed independently. The
contents of the desired memory locations are provided to the central processing unit by referring to the
address of memory location. The amount of information that can be held in the main memeory is known as
memory capacity. The capacity of the main memory is measured in Kilobytes (KB) or Megabytes (MB).
One kilobyte stands for 2'° bytes, which is 1024 bytes (or approximately 1000 bytes). A megabyte stands for
2'° kilobytes, which is approximately little over one million bytes. -

In addition, to transfer the information, the computer system internally needs interconnections. The most
common interconnection structure is the Bus structure. A bus is a set of wires (Lines) which you can -.
visualise on the motherboard of a computer. It is a shared media; A bus connecting the CPU, memory and
1/0 components is called a system bus. A system bus may cpn@fSt of 50 to 100 separate lines.

Let us summarise the key features of a Von Neumann machine. The hardware of the Von Neumann machine
consists of:

A CPU which includes a ALU and CU

A main memory system

An Input/output system

The Von Neumann machine use stored program concept, i.e., the program and data are stored in the
same memory unit. The computers prior to this idea used to store-programs and data on separate
memories. Entering and modifying these programs is very difficult as they were entered manually by
setting switches and plugging and unplugging. .

Each location of the main memory of Von Neumann machine can be addressed independently.
Execution of instructions in Von Neumann machine is carried out in a sequential fashion (unless
explicitly altered by the program itself) from, one instruction to the next.

Figure 1 shows the basic structure of a conventional Von Neumann machine.
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Figure 1: Structure of a computer



Ceimputer A Yon Neumann machine has only a single path between main memory and control unit (CU). This
Fendmmentals s faateeiconstraint is referred to as Von Neumann bottleneck. Several other architectures have been suggested

fisrcware & )
Sot-rare for modern computers.

Check-Your Progress 1
Staie True or False.

i. A byte is cqual to 8 bits and can represent a character internally.

True l:l False D
True D False l:’

3. Von Neumann architecture specifies separate memory for data and instructions. The memory which
stores data is called data memory and the memory that stores instructions is called instruction

2. A word on PC386 is equal to one byte.

memory.
True D False D
4, In Von Néumann architecture each bit of memory can be accessed independently.
True l:, False l:l
5. A program is a sequence of instructions designed for achieving a task/goal.
True l:] False D
6. One MB is equal to 1024 KB. e D False D

1.2.1 The Computer and Integrated Circuit Technology

But before we discuss about the relation of computers to integrated circuit technology, let us explore more
about the term Integrated Circuit (IC).

In an integrated circuit, the components such as transistors, resistors and concuctors are fabricated on
semiconductor material such as silicon. Thus, a desired circuit can be fabricated in a tiny piece of silicon
rather than assembling several discrete components into the same circuit. Hundreds or even thousands of
transistors could be fabricated on a single wafer of silicon. In addition, these fabricated transistors can be
connected with a process of metalisation to form logic circuits on the same chip they have been produced.

Chip ~ A Chip
0oo "Cl
a 0
ate
o000l
Gate

Vigure 2: Wafer, Chip and Gate



An integrated circuit is constructed on a thin wafer of silicon that is divided into a matrix of small areas (size

Computer

of the order of a few millimetres squares). An identical circuit pattern is fabricated on each of these areas and 2Pd Memory

the wafer is then broken into chips (Refer figure 2). Each of these chips consist of several gates, a useful
logic component, and a number of i input and output connection points. Each of these chips, then, can be
packaged separately in a housing to protect it. In addition, this housing provides a number of pins for
connecting this chip with other devices or circuits. The pins on these packages can be provided in two ways:

. *In two parallel rows with 0.1 inch spacing between two adjacent pins in each row. This package is
called dual m-lme package (DIP) (Refer Figure 3 (a)).

. -, In case, moz: than hundred pms are required, then pin grid array (PGA) is used where pins are
arranged in arrays of rows and columns, with spacing between two adjacent pin of 0. 1 inch (Refer
Figure 3(b)).

Integrated
0.1 inch Circuit Chip

> =

: l

\/\J\T/\J\/\/ Pin | | T
(a) A 24 pin dual in-iine pack’age (DI
(Contains dual rows.which are in-line)

Integrated
0.1 inch . . Circuit Chip

(b) 144-pin Pin Grid Array (PGA) package
Figure 3: Integrate}d Circuit Packages

Different circuits can be constructed on different wafers. All these packaged circuit chips then can be
interconnected on a printed-circuit board to produce several complex electronic circuits such as computers.

Initially, only a few gates were integrated reliably on a chip and then packaged. This initial integration was
referred to as small-scale integration (SSI). Later, with the advances in microelectronics technologies the SSI
~ gave way to Medium Scale Integration where 100s of gates were fabricated on a chip. Then came Large
Scale Integration (1,000 gates) and very large integration (VLSI 10,000,000 components) are expected to be
fabricated on a single chip. According to this, expected projections is that, in near future, almost
10,000,000,000 components will be fabricated on a sifigle chip.

System

9
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What are the advantages of having denscly packed Integrated Circuits? These are:

Low cost: The cost of a chip has remained almost constant while the chip density (number of gates per chip)
is ever increasing. It implics that the cost of computer logic and memory circuitry has been reducing rapidly.

Greater Operating Speed: More is the density, the closer are the logic or memory elements, which implies
shorter electrical paths and hence the higher operating speed.

Smaller computers: Better portability, Reduction in power and cooling requirements.

Reliability: The integrated circuit interconnections are much more reliable than soldered connections. In
addition, densely packed integrated circuits enable fewer inter-chip connections. Thus, the computers are
more reliable.

One of the major milestones in this technology was the very large scale integration (VLSI) where thousands
of transistors can be integrated on a single chip. The main impact of VLSI was that, it was possible to
produce a complete CPU or main memory or other similar devices on a single IC chip. Let us dlSCUSS some
of the important breakthroughs of VLSI technologies.

Semiconductor Memories

Initially, the IC technology was used for constructing processor, but soon it was realised that same technology
can be used for construction of memory. The first memory chip was constructed in 1970 and could hold 256
bits. Although the cost of this chip was high, but gradually the cost of semiconductor memory is coming
down. The memory capacity per chip has increased for e.g. 1k, 4K, 16K, 64K 256K and 1M bits.

Microprocessors

Keeping pace with electronics as more and more component were fabricated on single chip, fewer chips were
néeded to construct a single processor. Intel in 1971 achieved the breakthrough of putting all the components
on a single chip. The single chip processor is known as a microprocessor.- The Intel 4004 was the first
microprocessor. It wasa primitive microprocessor designed for a specific application. Intel 8080 that came
in 1974 was the first' general purpose microprocessor. It was an 8 bits microprocessor. Motorola is another
manufacturer in this area. At present 32 and 64 bit general purpose microprocessors are already in the

~ market. For example, Intel Pentium is a 32 bit processor, similarly Motorola's 68000 is a 32 bit

microprocessor. P6 that is announced by Intel 1995 can process 64 bit data at a time. Figure 4 shows the
Intel family of microprocessors.

INTEL 8 bit 80[80 )
8085
16 bit CPU '
16 bit data path 8086
8186 32 bit CPU
: T 16 bit data path
8088 : 80286 (PC/AT)
— ,
32 bt CPU
16 bit CPU 80386 AT/386 »
8 bit dara paih L
(IBM PC) 0486 32 bit CPU
1
. P e"“‘ﬂ 32 hit CPU
]

<

Figure 4: Intel Microprocessor Families



i
The VLSI technolqu is still evolving and more and more powerfu! microprocessor and more storage space - Computer
now is beine put ina smgle chip. and Memory
System

122 Classnficatlon of Computers

One question which we have still not answered is, , Is there any classification of computers? Well for quite
- sometime computers have been classified under three main classes. These are:

Microcomputers ' ' .
- Minicomputers
Mainframes

Although with development in technology the distinction between these is becoming blurred. Yet it is
important to classnfy these, as it is sometimes useful to differentiate the key elements and architecture among
the classes. :

Microcomputers

A microcompljter's CPU is a microprocessor. The first microcomputers were built around 8-bit
microprocessor chips. What do we mean by an 8-bit chip? It means that the chip can retrieve

instructions/data from storage, manipulate, and process an.8- bit data at a time or we can say that the chip has
a built-in 8-bit data Transfer path. An improvement on 8-bit chip technology was seen in early 1980s, when a
series of 16-bit chips namely 8086 and 8088 were introduced by Intel Corparation, each one with an
advancement over the other. 8088 is a 8/16 bit chip i.e. an 8-bit path is used to move data between chip and
primary storage (external path), at a time, but processing is done within the chip using a 16 bit path (internal
path) at a time. 8086 is a 16/16 bit chip i.e. the interal and external paths both are 16 bit wide. Both these
chips can support a primary storage capacity of upto 1-megabyte (MB).

Most of the popular microcomputers are developed around Intel's chips, while most of the minis and,
superminis are built around Motorola's 68000 series chips. With the advancement of display and VLSI
technology now a microcomputer is available in very small size. Some of these are laptops, notebook
computers etc. Most of these are of the size of a small notebook but equivalent capacity of an oiderw
mainframe.

Minicomputer

The term minicomputer originated in 1960s when it was realised that many computing tasks do not require ap
expensive contemporary mainframe computers but can be solved by a small, inexpensive computer. Initial
minicomputers were 8 bit and 12 bit machines but by 1970s almost all minicomputers were 16 bit machines.
The 16 bit minicomputers have the advantage of large instruction set and address field; and efﬁcxgn_t sforage
and handling of text, in comparison to lower bit machines. Thus, 16 bit minicomputer was more powekful
machine which could be used in variety of applications and could support business applications alongwith the
scientific applications. '

With the advancement in technology the speed, memory size and other characteristics developed and the -
minicomputer was then used for various stand alone or dedicated applications. The minicomputer was then
used as a multi-user system, which can be used by various users at the same time. Gradually the architectural
requirement of minicomputers grew and a 32-bit minicomputer, which was called supermini, was introduced.
“he supermini had more peripheral devices, laree-memor; and could support more users working
simuitaneously on the computer in comparison to previous minicompute:s.

Mainframes

Mainframe computers are generally 32-bit machines or on the higher side. These are suited to big

organigations. to manage high volume applications. Few of the popular mainframe series are IBM HP, etc.
Mainframes are also Used as central host computers in distributed systems. Librarics of applications
programs developed for mainframe computers are much large than those of the micro or minicomputers
because of their evolution over several decade as families of computing. All these factors and many more
make the mainframe computers indispensable even with the popularity of mluoc,(‘mpulus

11
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Supercomputer

The upper ends of the state of the art mamframe machine are the supercomputer. These are amongst the
fastest machines in terms of processing speed and use multiprocessing techniques, were a number of
processors are used to solve a problem. Lately ranges of parallel computing products, which are
multiprocessors sharing common buses, have been in use in combination with the mainframe supercomputers.
The supercomputers are reaching upto speeds as well over 25000 million arithmetic operations per second.
india also has its indigenous supercomputer.

Supercomputers are mainly being used for weather forecasting, computational fluid dynamics, remote
sensing, image processing, biomedical applications, etc. In India, we have one such mainframe
supercomputer system- CRAY XMP-14, which is at present, being used by Meteorological Department

Check Your Progress 2

1. What is a general-purpose machine?

...............................................................................................................................................................

Define the following terms brietly:
(i) Microprocessors
(i) Laptop

(i)Y Supercomputer

........................................................................................................................

13 MEMORY SYSTEM

Memory in a computer system is required for storage and subsequent retrieval of the instructions and data. A
computer system uses variety of devices for storing the instructions and data, which are required for its
operations. Normally we classify the information to be stored on computer in two basic categories: Data and
the Instructions.

"The storage device along with the algorithm or information on how to control and manage these storage
devices constitute the memory system of a computer." A memory system is a very simple system yet it
exhibits a wide range of technology and types. But unfortunately, faster memory technology is more
expensive. In addition, fast memories require power supply till the information need to be stored. Both these
things are not very convenient, but on the other hand the memories with less cost have very high access time,
that is the time taken by CPU to access a location in the memory in high, which will result in slower ‘operation
of the CPU. Thus, the cost versus access time anomaly has lead to a hierarchy of memory where we
supplement fast memories with larger, cheaper slower memories. These memory units may have very
different physwal and operational characteristics, therefore, making the memory system very diverse in type,
cost, organisation, technology and performance. This memory hierarchy will be fruitful if the frequencies of
access to slower memories are significantly less than the faster memories.
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'Figure 5: The Memory Hierarchy -

Thus, a memory system can be considered to consist of three groups of memories. ‘These are:

(a)

(b)

©

Internal Processor Memories: These consist of the small set of high speed registers which are
internal to a processor and are used as temporary locations where actual processing is done.

Primary Memory or Main Memory: It is a large memory, which is fast but not as fast as internal
processor memory. This memory is accessed directly by the processor. It is mainly based on
integrated circuits. :

Secondary Memory/Auxiliary Memory/Backing Store: Auxiliary memory in fact is much larger
in size than main memory but is slower than main memory. It normally stores system programs
(programs which are used by system to perform various operational functions), other instructions,
programs and data files. Secondary memory can also be used as an overflow memory in case the

" main memory capacity has been exceeded. (How? The answer is niot supplied in the block. You

need to refer to furfher readings to get this answer). Secondary memories cannot be accessed
directly by a processor. First the information of these memories is transferred to the main memory
and then the information can be accessed as the information of mair memory.

" There is another kind of memory, which is increasingly being used in modern computers and this is called

Cache meimory. It is logically positioned between the internal memory (registers) and main memory. It
stores. or catches some of the content of the main memory, which is currently in use of the processor.

Before discussing more about these memories let us first discuss the technological terms commonly used in
defining and accessing the memory.

1.4 CHARACTERISTICS TERMS FOR VARIOUS

MEMORY DEVICES .

The following terms are most commonly used for identifying comparative behaviour of various memory
deyices and technologies.

‘Storage Capacity: It is a representative of the size of the memory. The capacity of internal mémory and

main memory can be expressed in terms of number of words or bytes. The storage capacity of external
memory is normally measured in terms of bytes.

Computer
and Memory
System
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Access Modes: A memory is considered to consist of yarious memory locations. The information from these
memory locations can be accessed in the following ways.

H Random Access Memory (RAM): It is the mode in which and memory location can be accessed in
any order in the same amount of time. Ferrite and Semiconductor memories, which generalty
constitute main memory, are of this nature. The storage locations can be accessed independently and
there exist separate access mechanism for each location.

° Sequential Access: On the other hand we have memories which can be accessed in a pre-defined
sequence for example, the songs stored on a cassette can be accessed only one by one. The example
of sequential access memory is Magnetic Tape. Here the access mechanism need to be shared
among different locations. Thus, either the location or the read/write head or both should be moved
to access the desired location.

o Direct Access: In certain cascs the information is neither accessed randomly nor in sequence but
something in between. In direct access, a scparate read/write head exist for a track and on a track the
information can be accessed serially. This semi-random mode of operations exists in. magnetic disks.

Access Time: The access time is the time required between the request made for a read or write operation till
the time the data is made available or written at the requested location. Normally it is measured for read
operation. The access time depends on the physical characteristics and access mode used for that device.

Permanence of Storage: Some memories loose information over a period of time. For example, there can be
some memories where the stored data bit value 1 looses its strength to becofe 0 over a period of time. These
kinds of memories require refreshing. The memories, which require refreshing, are termed as dynamic
memories. In contrast, the memories, which do not require refreshing, are called static memories. Another
factor, which can destroy the contents, is the presence and absence of electricity. The memories, which
looses their content on failure of power are termed as volatile memories. those. which do not are called non-
volatile. Magnetic memories are non-volatile and semi-conductor main memories are volatile in nature.

Physical Characteristics: In this respect the memory devices can be categorised into four main categories
viz., electronic, magnetic. mechanical and optical. One of the requirements for a storage device is that it
should exhibit two well-defined physical states, such that 0 and 1 can be represented in those two states. The
Data transfer rate of the memory depends on the how quickly the state can be recognised and altered. The
following table lists some of the memory technologies along with their physical and other important
characteristics.

Technology Access time Access Mode | Performance Physical nature | Average
(in seconds) of Storage of storage. cost
medium (Rs/bit)
(Approx.)
Semiconductor 10° Random Volatile Electronic -1 10?
memories '
Magnetic disk 107 Direct Non-volatile Magnetic 107
Magnetic tape 10" Seqﬁemial Non-volatile Magnetic 107
Compact disk Approx. 10°! Direct Non-volatile Optical 107
ROM !

Figure 6: Characteristics of some memory technologies

The physical size of memories should be small and it must consume less power. Higher power consumption
may result in more costly equipment for internal cooling of computer. The storage duevices. which require
mechanical motion e.g. hard disks are more prone to failure rather than the semiconductor memories which’



are totally elecﬁrpmc in nature. Very high speed semiconductor memories are also prone to fallure as Computer

technology is movmg towards its limits. and Memory
System

Check Your Progress 3

. State True or False.

(@) Memory hierarchy is built in computer system, a. the main memory can not store very large
data.
True D False D
(b) The secondary memory is slower than that of main memory but has a larger capacity.
True D False D
(c) In Random access Memory any memory location can he accessed indcpcndeml);.

Trué D | False D

2. What are the differences in:
(a) Volatile versus Nou-volatile memory
(b) Static versus dynamic memories

................................................................................................................................................................

...............................................................................................................................................................

1.5 MAIN MEMORY OR PRIMARY STORAGE

Primary memory consists of semiconductor memory chips and is used to store the data and programs
currently in use. Each storage element of memory is directly (randomly) accessible and can be examined and
modified without affecting other cells and hence primary memory is also called Random Access Memory
(RAM). Main memory stores a variety of critical information required for processing by the CPU.. How does
it store the information? Please answer it yourself.

The memory unit stores all the information in memory cells also called memory locations, in binary digits.
Each memory location has a unique address. The contents of the desired memory locations are provided to
the central processing unit by referring to the address of the memory location. The amount of information
that can be held in the main memory is known as memory capacity. The capacity of the main memory is
measured in kilobytes (KB) or Megabytes (MB).

All modern computers use semiconductor memory as its main memory. Semiconductor meinory is known as
Random Access Memory (RAM) since any part of the memory can be accessed for reading and writing.
Another part of main memory is Read Only Memory (ROM). ROMs (Read Only Memories) are the
memories on which it is not possible to write the data when they are on-line to the computer.. They can
only be rcad. The ROMs can be uscd in storing programs provided by the manufacturér of computer for
basic operations. ROMs are non-volatile in nature and need not be loaded in a secondary storage device.
ROM s are fabricated in large number in a way where there is no room for even a single error:

ROMs can be written only at the time of manufacture. Another similar memory is PROM. PROMs are also
non-volatile and can be programmed only once by a special write device hence the name Programmable
ROM (PROM). The writing proggss in PROM can be performed electrically by the supplier or the customer.



Compute;: Special equipment is neéded to perform this writing operation. Therefore, PROMs are more flexible and
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The ROMs/PROMs can be written just once (in ROMs at the time manufacture and PROMs at any time later

also), but in both the cases once whatever is written on, cannot be changed. But what about a case where you
read mostly but write only very few times. This lead to the concept of Read mostly memories and the best
examples of these are EPROMs (Erasable PROMS) and EEPROMs (Electrically erasable PROMS). The
EPROM s can be written electrically. But, the write operation is not simple. It requires erasure of whole
storage cells by exposing the chip to ultra violet light, thus bring them to same initial state. This erasure is a
time consuming process. Once all the cells have been brought to same initial state, then the EPROM can be
written electrically. EEPROMs are becoming increasingly popular as they do not require prior erasure of
previous contents. However, in EEPROMs the writing time is considerably higher than reading time. The
biggest advantage of EEPROM is that it is non-volatile memory and can be nndated easily, while the
disadvantages are the high cost and at present they are not completely non-volatile and the write operation
takes considerable time. Figure 7 summarise the features of these read only and read mostly memories.

Memory Type © Write Time Order of Read Time  Number of
Cycles allowed

ROM QOnce at the time of ' Nano seconds ONE
manufacture

PROM Hours Nano seconds ONE

EPROM Minutes (including time ~ Nano Seconds HUNDREDS
of ensure)

EEPROM Milliseconds Nano seconds THOUSANDS

Common features
* Non-destructive
* Long data life

* Non-volatile

Figure 7: Features of Read Only and Read Mostly Memories

1.6 EXTERNAL/AUXILIARY MEMORY

As discussed earlier the cost of RAM is very'high and the semiconductor RAMs are mostly volatile, therefore,
it is highly likely that a secondary cheap media should be used which should show some sort of permanence

of storage and should be relatively inexpensive. The magnetic material was found to be inexpensive and

quite long lasting material. Therefore, became an ideal choice to do so. -Magnetic tape and magnetic disks are
commonly used as storage media. With the advancements in the optical technology now the optical disks are
trying to make inroads as one of the major external ‘memory. We will discuss about the characteristics of

these memories in this section. ' :

1.6.1 Magnetic Disk

A magnetic disk is a circular platter of plastic, which is coated with magnetised material. One of the key
components of a magnetic disk is a conducting coil named as Head which performs the job of reading and
writing on the magnetic surface. The head remains stationary while the disk rotates below it for reading or
writing operation.
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Data Organisation and Format - Computer -
and Memory
The head of disk is a small coil and reads or writes on the position of the disk rotating below it, therefore, the System
data is stored in concentric set of rmgs (refer figure 4).. These are called tracks. The width of a track is equal
to the width of the head. To minimise the interference of magnetic fields and to minimise the errors of :
" misalignment of head, the adjacent tracks are separated by inter track gaps. ‘As we go towards the outer tracks
the size of a track increase but to simplify electronics same number of bits are stored on each track.

Disk

Inter Sector gap
-Platter

- or Intra qack
gap

Track . Inter track gap

Figure 8:-Logical layout of Magnetic Disk

The data is transferred from and to the disks in blocks. Block is a section of disk data and is normally equal
to asector. A track is divided into 10-100 sectors and these sectors should be either fixed or variabie length
sectors. Two adjacent sectors are separated by intra-track gaps. This helps in reducing the precision :
‘requirements of sectors. To identify the sector posmon normally there may be a starting pomt on atrack or a
starting and end pomt of each sector.

Floppy dlsks

- A floppy dlsk is made of a flexible thin sheet of plastlc material with a magnetic coating and grooves

. arranged in concentric circles with tracks. Floppy disk becomes a convenient recording medium to transport
information from one location to another. Disk is removable from the reading device attached to the
computer and therefore provides unlimited storage capacity. The floppy disks of today are. available in two °
sizes 5.25 inches and 3.5 mches and their capacity ranges from 360 KB to I .44 MB per disk.

" 1.6.2 Winchester Disk

This is a sealed rxgld magnetic oxide medium disk, which typically holds 10 MB to 10 GB of data
Winchester disks are not removable from the drive and since they are sealed dust and other contaminations,
which are likely in a floppy disk, are minimised. These provide substantially faster data access compdied to
floppy disk and provide very large data storage for on-line retrieval.

Sides: The magnetic coating if applied to both the sides of the platter is called as double sided disks. The
data can be recorded on either side of these disks. Some inexpensive disks were initially single sided.

Platters: Some disks have single platter e.g. floppy disks while some disks have multiple platters which are
_stacked vertically, normally at a distance of an inch. This is known as disk pack. In disk pack one additional
-term cylinder is defined which is the ring of all co-centric tracks (Figure 9) A disk pack can contam multlpie

heads mounted with the same arm.

Access time on Disk
Disk operates in sémi-random mode of operation and normally is referenced block wxse The data access
time on dlSk consists of two main components.

17
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' more ruggcd and have error-correction facility. This ¢ ensures proper data transfer from CD-ROM to the main

. Seek time: Time to position the head on a specific track. On a fixed head disks it is the time taken by

electronic circuit to select the require head while in movable head disk it is the time required to move the
head to a particular track.

Latency time: The time required by a sector to reach below the read/write head. On an average it is half of
the time taken for a rotation by the disk.

/Rcad write head
<4+—>

\
Access arm can

move in both
directions

Surface 0 -

‘Surface 1

Figure 9: The Disk Pack

In addition to these two times the time taken to read block of word can be considered but normally it is too

" small in comparison to latency and seek time and in general the disk access time is considered to be sum of

seek time and latency time. Since, access time to disks is large, therefore, it is advisable to read a snzable
portlon of data in a single go and that is why the disks are referenced block wise.

1.6.3 Magnetic Tape

‘Magnetic tapes are mounted on reels or a cartridge or a cassette of tape to store large volumes or backup data.

These are cheaper and since these are removable from the drive, they provide unlimited storage capacity.
Information retrieval from tapes is sequential and not random. These are not suitable for on-line retrieval of
data, since sequentlal searching will take long time. These are convement for archival storage, or for backup.
The tapes are one of the earliest storage devices. They are low cost, low speed portable and are still widely .
used because of their low cost.

1.6.4 Optical Memories

Optical memories are alternate mass storage devices with huge capacity. The adv‘ent ot compact disk digital
audio system, a non-erasable optical disk, paved the way for the development of a new low cost storage
technology In optical storage devices the information is written using laser beam. These devices which are
memories can store large amount of data. We will discuss here three optical memory devices, which are now
becoming increasingly popular in various computer applications. ~ :

CD-ROM

The CD-ROM (Compact disk read-only memory) is a direct extension of audio CD. CD-ROM players are
s

(A7) T TN



‘memory of the computer. CD-ROM is written into during the process of manufacture bya hi’g’h power laser ~ Compute:
beam. Information is retrieved from a CD-ROM using a low power laser, which ingenerate in an optical disk ~ard Mewory
drive unit. In CD-ROMs the information is stored evenly across the disk in segments of the same size. System
Therefore, in CD-ROMs data stored on a track increases as we go towards outer surface of disk. Thus, the

CD-ROMs are rotated at variable speeds for the reading process. '

Identification of first address is 0 minute
' 0 second
0 sector

Figure 10 : A CD-ROM's disk layout

Figure 10 indicates the layout used for CD-ROMS. As discussed earlier, the data is stored sequentially along
a spiral track. , In this disk random access becomes more difficult because locating a desired address involves
first moving the head to the specific area then adjusting the rotation speed and then reading the address, and
then to find and access the specific sector.

CD-ROMs are very good for distributing large amount iof information or data to large number of users. The
three main advantages of CD-ROMs are:

. Large data/information storage capacity
J Mass replication is inexpensive and fast
. Thec= are removable disks, thus, are suitable for archival storage

The disadvantages of CD-ROM s are:

. It is read-only, therefore, cannot be updated
. Access time is longer than that of a magnetic disk
WORM

In certain applications only few copies of compact disks are to be made which makes the CD-ROMs
production economically unviable. For such cases write-once, read-many CD has been developed. WORM
disks are prepared in such a way that they can be written only once subsequently by a laser beam of modest
intensity. The disk controller of WORM is more expensive than that of CD-ROM. WORM uses sector
structuressame as that of magnetic disks. High power laser first prepares the WORM disk. A CD writer can
write them into once. )
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E'rasal’ile Optical Disk .

" The most recent development in optical disks is the erasable optical disk. The data in these disks can be

changed repeatedly as the case with any magnetic disk. A feasible technology that has proved commercially
feasible for erasable optical disk is the magneto-optical system. In such systems, a laser beam is used along
with a magnetic field to read or write the information on a disk, which is coated with a magnetic material.

. The erasable optical disk is a true secondary storage device (unlike CD-ROMs and WORM). The main

advantages of erasable optical disk over magnetic disk are:

o The capacity of an erasable disk is very high in comparison to magnetic disk. For example,a 5.1/4 inch
* optical disk can store around 650 Mbytes of data while the Winchester disks normally can store a
maximum capacity of 512 MB.
o The erasable optical disks are portable while a Winchester disk is not.
The erasable optical disks are highly reliable and have a longer life.
o Erasable optical disk also uses format that makes semi-random access feasible.

The only disadvantage of this disk is the high cost. This disadvantage will disappear in near future.

Check Your Progress 4

1. Conipare and contrast RAM and ROM.

2 What is the importance of'read mostly- memories?

3 What is the head of a disk?

4, Match the following pairs
@) Variable rotation speed (a) Magnetic tape
(i) Low cost, low speed devices (b) Floppy disks
(iii) Double sided double density (c) CD-ROM

7 HIGH SPEED MEMORIES

The Need: Why the high speeds memories? Is the main memory nota hlgh-speed memory? The answer to
second question is definitely "No", but why so, well for this we have to go to the fundamentals of
semiconductor technology that is beyond the scope of the unit then if the memories are slower then how slow
are they? It has been found that the access of main memories is slower than the speed of the processor. Since
each instruction require several memory accesses therefore, faster memories will be of tremendous help in
increasing the overall throughput of a computer.



There are four possible ways to increase the memory speed.

a) Decrease the memory 4ccess time, use a faster but expensive technology for main Iﬁemqu probably it
" will be feasible after few years. . ‘ : '

b) Access more words in a single memory access cycle. That is instead of accessing one word from the
- memory in a memory access cycle, access more words. This is termed as memory interleaving.

¢) Insert ahigh-speed memory termed as Cache between the main memory and prgc‘essdr.
d) Use associative addressing in placé of random access. |

' In this section we will only discuss about one of the most popular technology the cache memory. You can
refer to further reading for most-details on other terms mentioned in this section. s '

Cache Memory

These are small fast memories placed between the processor and the main memory. Caches although are fast
yet are very extensive memories and are used in only small sizes. For example caches of sizes 64 K, 128K,
256 KB, etc. are normally used in typical PC-486 and Pentium based PCs while they can have 1 to 64 MB
RAMs or even more. Thus, small cache memories are intended to provide fast speed of memory retrieval
- without sacrificing the size of memory (because of main memory size). If we have such a small size of fast
memory how could it be advantageous in increasing the overall speed of memory reference? The answer lies
in the principles of locality, which says that if a particular memory location is accessed at a time then it is

highly likely that its near by locations will be accessed in the near future. Cache contains a copy of certain* .

portions of main memory. The memory read or writes operation is first checked with cache and if the desired
location data is available in cache then used by the CPU directly. Otherwise, a block ol words is read from
main memory to cache and CPU uses the word from cache. Since cache has limited space, so for this
_incoming block a portion called a slot need to be vacated in Cache. The contents of this vacating block is
written back to the main memory at the position it belongs to. The reason of bringing a block of words to
“cache is once again locality of reference. We expect that next few addresses will be close to this address and,
therefore, the block of word is transferred from main memory to cache. Thus, for the word, which is not in -
cache, access time is slightly more than the access time for main memory without cache. But, because of
locality of references, cache performs better. For example, if memory read cycle takes 100 nos and a cache
read cycle takes 20 nos, then for four continuous references (first one brings the main memory content to
cache and next three from cache). ‘ A

The time taken with cache C (100+20) +20x3
* For the first - for last three
read operation read operation -
: 120+60 - 180 nos
Time taken without cache 100x4 400 nos

Thes, the closer are the reference, better is the performance of cache and that is why structured code is
considered to be a good programming p'racﬁce, since it provides maximum possible locality-

Check Your Progress 5

l. State True or False.

(a)  High specd memories are needed to bridge the gap of speed between 1/O device and memory

Tme D False ‘:]
True r_:‘ False E:'

(c) The prinéiple of locality says that all the references td data have to be to the same memory

location. .
True D - False E:I

(b)  Cache memory increases load on main memory.

Computer
and Memory
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1.8 SUMMARY

This completes our discussion on the introductory concepts of computers. Some very elementary terms have

. not been defined here, you have to study these of your own. The Von Neumarin architecture discussed in the

unit is not the only architecture-but many new architectures have come up which you will find in later
courses. '

In addition, we have taken a complete view of the memory system of computer system along with the various
technologies. The unit has outline the importance of memory system, the memory hierarchy, the main
memory, the secondary memories and its technologies and the high speed memories. We have also discussed
the key characteristics of these memories and the technologies which are used for constructing these
memories. here are several other concepts such as virtual memory and for more details on the memory system
a student can go through the further readings.

A coursé in an area of computer must be supplemented by further readings to keep your knowledge, upto -
date, as the computer world is changing with leaps and bounds. In addition to further readings the students
are advised to study several Indian Journals of computers to enhance his knowledge.

1.9 MODEL ANSWERS

Check Your Progress 1

1.True 2.False 3.False 4.False 5.True 6. True
Check Your Progress 2 -

Ans.1. =~ A machine, which can be used for variety of applications and is not modelled only for -
~ specific applications. Von Neumann machines are general purpose machines since they can
be programmed for any general application, while a microprocessor based control systems are
not general purpose machines as they are specifically modelled as control systems.

Ans. 2. (i) Microprocessér is a complete processor constructed on a single chip using VLSI technology. -
Intel and Motorola are two popular Microprocessors. ' :

(i) A very small, battery operated microcomputer, which uses liquid crystal display technology
* and very handy to carry.

(iii). The upper end of the state-of-art mainframe machines. Very powerful computational
" capabilities, which are mainly suitable for very large processing requirements such as weather

forecasting.
Check Your Progress 3
1. (a) False (b) True (c) True
2. (a)l " Volatile memory Non-volatile memory

(i) Poweris i'equired all the time (i) Power not required once data is stored



(ii) Temporary storage

(iii) Normaily faster than non-volatile types

(b) Staﬁc memory
(i) Looses its signal
(ii) Periodic refreshing of
memory is needed
(iii) Expensive

(iv) Used as Cache

Check Your Progress 4
1. RAM
¢ Read-write memory
¢ Semi-Conductor memories

e Volatile

(ii) Permanent storage Computer
: . .and Memory
(iii) Slower than volatile memories System

Dynamic memory

@) Does not loose
signal strength

(ii) No refreshing

(ii) Cheap

(iv) Used as main memory

ROM
Only can be read
Semi-Conductor memories

Non-Volatile

e Can be used by user programs and system programs - Cannot be used for user programs

2. They are better than ROMs and PROMs for rewriting purposes, however, can be used in similar
ways. :
3. Head is conducting coil in a dlisk which performs the job of reading or writing data on a disk using

magnetic effects of electricity.

4. (@ - (), (i) - (@), (iii) - (b)
Check Your Progress S

1. (a)False (b)False (c)False

1.10 FURTHER READINGS

1. Stallings, William, Computer Organisation and Architecture, Third edition, Maxwell Macmillan

International Editions.

2. Mano, M. Mdrris, Computer System Architecture and Organisation, Second Edition, McGraw-Hill -

International Editions, 1988.
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UNIT 2 INPUT /OUTPUT ORGANISATION & NEW
TECHNOLOGIES

Structure

2.0 Introduction

2.1 Objectives

2.2 Input/Output Devices (Peripherals)
22,1  Input Device
222 Output Devices

2.3 Input/Output Module Interface

24 External Interfaces

2.5 What is Parallel Processing?

2.6 Pipelining

2.7 Vector Processing

2.8 Introduction to RISC
2.8.1  Reasons for Increased Complexity
2.8.2 . Principles of RISC ‘

2.9 Summary ’

2.10  Model Answers

2.11  Further Readings

2.0 INTRODUCTION

Til! now we have discussed about various components and memory system for a computer.. We have also
introduced one interconnection structure called the Bus. In this unit we will discuss more about the
input/output organisation and newer technologies in computer hardware. We will discuss briefly about

input/outpy:t devices, two popular device. interfaces and the concepts of parallel organisation. We will also
_ discuss abcut the concepts of pipelining, vector processing and the concepts relating to Reduced Instruction

Set Computers (RISC) architecture.

2.1 OBJECTIVES

At the end of this unit you should be able to:

identify some of the Input/output devices
identify the serial and parallel interfaces

define the Flynn's classification of computers
list the characteristics of multiprocessor systems
define pipelining and vector processing °

define the concepts relating to RISC.

® 6 5 o o o

2.2 INPUT/OUTPUT DEVICES (PERIPHERALS)

The computer will be of no use if it is not communicating with the external world, Thus, a computer must
have a system to receive information from outside world and must be able to communicate results to external

- world. Thus, a computer consists of an I/0 system. This system includes twg basic components, one is the

IO devices and another called I/0 module, which not only connects an 1/0 device with the system bus, but
plays a very crucial role in between. A device, which is connected to an I/O module of computer, is called a



) A ' .
peripheral. Let us discuss few Input/Output devices in this section and we will define the /O medule in the " Input/Output

subsequent sections. Organisation &
) - New Technologie:

2.2.1 Input Devices

Input technologies are rapidly developing. These, as the name suggests, are used for transferrmg user
command or choice or data to the computer.

Keyboard

The keyboard is one of the most common input devices for computers. The layout of the keyboard is like that
of the traditional QWERTY typewriter, although there are some extra commands and function keys provided
for. Substantial development has taken place in the ergonomics of keyboard design to ensure that operator
strain is minimal. ’ '

Pointing Devices

The keyboard provides facility to input data and commands to computer in text form. We find that, while
working with a display based packages, we are mostly pointing to some area in the display to-select an option
and move across on the screen to select subsequent options. For such cases pomtmg devices are veTy\useful
There are several pointing devices, some of them are:

(@ Mouse: Mouse is a handy device which, can be moved on a smooth surface to simulate the
movement of cursor that is desired on the display screen. Mouse could be optical; offering quite and
reliable operation, or mechanical, which is cheaper but noisier. User can move the mouse, stop it at
a point where the pointer is to be located and, with the help of buttons, make selection of choices.

(b) Light Pen: This is a pen shaped device allowing natural movement on the screen. The pen contains
the light receptor and is activated by pressing the pen against the display screen. Receptor is the
scanning beam which, helps in locating the pen's position. Suitable system software is provided to
initiate necessary action when we locate an area on the dlsplay surface with the help of the light pen.

There are a few other pointing devices known as track balls and joysticks, which-are used more on
entertainment usage, like games. We will not dlscuss them in this section.

Voice/Speech Input

One of the most exciting areas of research is in recognising human voices/speech so that this could from
input to computer directly. This approach will eliminate the need for keying in data and will facilitate casual
users to use the computer very easily. There are several problem areas for research since speech recognition
system should be able to identify who is speaking and what the message is. Voice recognition techniques
along with several other techniques to convert the voice signals to appropriate words and derive the correct
meaning of words are required for a commercially viable comprehensive speech recognition system. We
have found limited success in this area and today devices are available commercially to recognise and
interpret human voices within limited scope of operation.

Scanners .

Scanners facilitate éapturing of the information and storing them in graphic format for displaying back on the
graphical screen. Scanner consists of two components, the first one to illuminate the page so that the optical
image can be captured and the other to convert the optical image into digital format for storage by computer.
The graphic image scanned can now be seen and processed directly By the computer. Substantial research

work is going on to establish methods by which the scanned image can be automatically converted into
equivalent text for further processing.
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Source Data Automation

Most recent trends for data input are towards source data automation. ‘The equjpment used for source data
automation capture data as a by-product of a, business activity thereby tompletely eliminating manual input

of data. Some examples are: /

I Magnetic Ink Character Recognition (MICR) devices are generally used by the banking industry to
read the account numbers on cheques directly and does the necessary processing. ‘

2. Optical Mark Recognition (OMR) devices can sense marks on computer readable papers. This kind
of device is used by academic-and testing institutions to grade aptitude tests where candidates mark
the correct alternatives on a special sheet of paper. The optical mark recognition devices then
directly read these answer sheets and the information sent to a computer for processing.

(U5)

Optical Bar Code Reader (OBR) scans a set of vertical bars of diftcrent yvidths for specific data and
are used to read tags and merchandise in stores, medical records, library books, etc. These are
" available as hand held devices.

2.2.2 Output Devices

The output normally can be produced in two ways,; either on a display unit/device or on a paper. Other kinds
of output such as speech output, mechanical eutput is also being used in certain applications. In this section,
we will discuss only the display and printing output devices.

Display Devices

One of the most important peripherals in computer is the graphic dispiay device. Conventional computer
display terminals knows as alphanumeric terminals, display characters (images) from a multi-dot array
(normally 5 x 7 or 7 x 9). These are used to read text information displayed on the screen. However, there
are increasing demand for display of graphics, diagrams and pictures to make the visual presentation of
information more eftective for user interaction and decision making.

Graphic display is made up of a series of dots called 'pixels’ (picture elements) whose pattern produces the
image. Each dot on the screen is défined as a separate unit, which can be directly addressed. Since each dot
can be controlled individually there is much greater flexibility in drawing pictures. There are three categories
of display screcn technology:

I. Cathode Ray Tube (CRT)

9

Liquid Crystal Display (LCD)

Projection Displays .

(9%)

CRT Displays

The main components of a CRT terminals are the electrsa gun. the electron beam controlled by an
electromagnetic field and a phosphor coated displav screen.

[he electromagnetic field i order to create an image (Reter figure 3). There are two types of CRT displays
]

(a) vector CRT displays in which the electron beam is directed only to the places where the image is 10
be created. '
(b) Raster displays in which the image is projected on to the screen by directing the electron beam

across each row of picture elements from the top to the bottom of the screen. This type of display
provides a high dynamic capability since image is continuously refreshed and it allows for continual
user input and output. It offers full colour display at a relatively low cost and is becoming very
popular.



Liquid Crystal Displays (LCD) " Input/Output -

' Organisation &
First introduced in watches and clocks in 1970s, LCD is now applied to display terminals. The major New Technoiogies
advantage of LCD is the low energy consumption. The CRT (Cathode Ray Tube) is replaced by liquid

crystal to produce the image. This also have colour capability but the image quality is relatively poor. These

are commonly used in portable devices because of compactness and low energy requirements.
Projection Displays

The personal size screen of the previous displays is replaced by a large screen upon, which images are
normally used for large group presentation. These systems can be connected to computer and whatever
appears on the computer terminal gets enlarged and projected on a large screen. Another popular method is
to connect computer to a LCD flat screen. and to project the LCD image using Overhead Projector. Thesz are
popularly used for seminars, classrooms, marketing presentations, etc.

Printers

Printers are used for producing output on paper. There are a large variety of printing devices, which can be
classified according to the print quality and the printing speeds. Current estimates indicate that about 1500
types of printers are commercially available conforming to about 15 different printing technologies. The
following categories of printers are identified. '

(a) Printing Technology - impact printers vs. non-impact printers

Impact printers use variations of standards typewriter printi.ng'mechanism where a hammer strikes Paper
impact printers use variations of standards typewriter printing mechanism through inked ribbon. Non-impact

printer uses chemical, heat or electrical signals to etch or induce symbols on paper. Many of these require
special coated or treated paper. '

(b) ,Characterforms-fully formed characters vs. dot matrix

Fully formed characters are constructed from solid lines and curves like the characters of typewriter whereas:
a dot-matrix character is made up from a carefully arranged sequence of dots packed very close to each other.
Obviously print quality of a dot matrix printer will be poorer compared to that from fully formed charactcrs.

(c) Printing sequence - serial vs. line vs. page .

This indicates the amount of information of printer can output within a single cycle of operation. Se’r'ial
printing is done character by character whereas line printing forms an entire line and prints a line at a time
whegeas a page printer outputs a whole page of character and images simultaneously during one cycle.
Clearly the speed.of output will depend upon the printing sequence incorporated in the printing device. We
will now look at three of the most popular printers: '

Dot Matrix Printers

This is one of the most popular printers-used for personal computing systems. These printers are rclatively
cheaper compared to other technologies. This uses impact technology and a print head containing banks ‘ef
wires movihg at high 'speeds against inked ribbon and paper. Characters ire produced in matrix format. The
speeds range from' 40 characters pér second (CPS) to about 1,000 cps. A disadvantage of this technology is
that the print quality is low. ;

i

|
I

Side View Front view

Figure 1: Dot Matrix Printer
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Ink Jet rrinters

These print by spraying a controlled stream of tiny ink droplets- accurately on the paper forming either dot
matrix or solid characters. These are non-impact and hence relatively silent and high quality printers. The
typical speeds range from 50 cps to above 300 cps and this technology has been used well for production of
colour printing and elaborate graphics. ”

Paper

ik Ink droplets ; e
o000

Recycled ink

Figure 2: Inkjet Printing
Laser Printers

This is a high quality, high speed, and high volume technology, which works in non-impact fashion on plain
paper or pre-printed forms. Printing is achieved by deflecting laser beam on to the photosensitive surface of
a-drum and the latent image attracts the toner to the image areas. The toner is then electrostatically
transferred to the paper and fixed into a permanent image. Speeds can range from 10 pages a minute to about
200 pages per minute. This technology is relatively expensive but is becoming very popular because of the
quality, speed and noiseless operations.

These three printers are compared in figure 3.
Plotters
To prodﬁce graphical output on paper the plotters are used.

After discussing so much about the 1/O devices, let us come back to one of the basic question: How does 1/0 -
devices are connected to computers? We will try to answer the question in the next section.

Style of Pripting Print quality

Dot matrix - Low quality but .L)teadily improving. Very useful for high-volume work (low
quality) because of great speeds and low printing cost. Lack of descenders on
letters (many .models rectify inability to reproduce well on a photocopier are
major this) and the problems. Dot Matrix Printers have the ability to produce
multiple copies of documents 1 a single print

Ink-jet High-quality print character sets; choice of type set is controlled by program;
print quality quite good than dot matrix; cheap; useful for low volume
applications; high printing cost; ’

Laser Very high quality, prints at speeds unapproachable by other technologies. Price
is affordable. Excellent for high volume high quality works.

Figure 3: Some Printer Technologies
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1. State True or False.

() In case where graphical user interfaces are common mouse should not be used.

"True l:] " False

(b) Keyboard is one of the most common mput device.

True [:I ‘ False
(c) Scanners are devices used for outputting pictures.

[]
L]
e [ Fase [
L]
[]

(d) Projection displays can be used for classroom teaching.

True D * False

(e) Keyboard, VDU and printers are essential for computers.

" True D False

2, Differentiate between the CRT display and LCD display.
3 Compare and contrast the Laser and Dot Matrix Printers.
4 Define the term "Source Data Automation”. Give two examples.

...................................................................................................................................

....................................................................................................................................

2.3 INPUT/OUTPUT MODULE INTERFACE

The input/output fodule interfaces (10 module) is normaHy connected to the computer system on one end
“and one or more Input/Output devices on the other. Normally, an I/0 module can control one or more
peripheral devices. An I/O module is needed because of:

(a) Diversity and variety of I/O devices makes it difficult to incorporate all the peripheral device logic-
(i.e. its control commands, data format etc.) into CPU. This in turn will also reduce flexibility of

using any new development

(b)  The I/O devices are normally slower than that of memory and CPU, thereforc, it is suggested not to
use them on high-speed bus directly for communication purpose.

2
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() The data format and wogd length used by the peripheral may be quite different than that of a CPU.
An /O module is a mediator between the processor and an 1/0 device/devices, It controls the data
exchange between the external devices and main memiory; or external devices and CPU registers.
Therefore, an /O module provide an interface internal to the computer which connect it to CPU and
main memory and an interface external to the computer connecting it to external device or peripheral.

‘The /O module should not only communicate the information from CPU to /O device, but it should
also co-ordinate these two. In addition since there are speed differences between CPU and I/O
devices, the 1/O module should have facilities like buffer (storage area) and error detection
mechanism.

If an /O. module takes more processing burden then it is termed as I/O channel or processor. The primitive
/O modules, which require detailed control by processor, are called I/O controller or device controller.
These O controllers are normally used in micro-computers, while 1/O processors are mainly used for
Mainframe, because the 1/O work for microcomputer is normally limited t~ <ingle user's job. Therefore, we
do not expect a very huge amount of 1/O to justify the investment in 1/O processor, which are expensive.

2.4 EXTERNAL INTERFACES

/Our discussion on /O system will not be complete if we do not discuss about external interfaces. External

"interface is the interface between the /O module and the-peripheral devices. This interface can be characterised

into two main categories: (a) parallel interface (b) serial interface. Figure 4 givesa block diagram from these
two interfaces. '

Connections

Connection
to system to
Bus peripheral
Connection To
to system ° Peripheral
Bus Data Buffer -

~ (b) Serial interface

Figure 4: Parallel and Serial Interface

In parallel interface muliipl_e bits can be transferred simultaneously. The parallel interfaces are normally used for
high-speed peripherals such as tapes and disks. The dialogue that takes place across the interface includes the

- exchange of ¢control information and data. A common parallel interface is centronics.

In serial interface only one line is used to transmit data, therefore, only one bit is transferred at a time. Serial
interface is used for serial printers and terminals. The most common serial interface is RS-232-C.
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Check Your Progress 2
1. - State True or False.

(a) Devices are normally cc.anected direciiy to system bns.

True D , Falsc D

(b) Input/output Module is needed only for slower 1/0 devices. \
True [::I False l::l

(c) Data buffering is helpful for smoothing out the speed difference between CPU and input/ output
devices. -
True I | Falsc I:J

(d) Parallel interfaces are commonly used for connecting printers to a computer.

True D False D

2. What is a device controller?

2.5 WHAT IS PARALLEL PROCESSINé? |

In the previous section, we have defined the Input/Output interfaces of a computer. Let us now, explore
about the newer technologies and trends in computers.

The computers can be made faster by increasing their clock speed or by using improved VLSI technology.
But there is a practical limitation.to both of them. The only way, that seems possible, theoretically, that can
increase the speed in an unlimited fashion is to have multiple modules, that is break the original problems
into independent modules and execute them simultancously. More the number of processors doing the job
simultaneously more the speed up will be. Parallel processing is a term used to denote a large class of
techniques that are used to provide simultaneous data processing tasks for the purpose of increasing the
computational speed of a computer.

One of the most popular classifications of parallel computer is by M.J. Flynn, called Flynns Classification,
and is based on the multiplicity of instruction stteams and data streams in a computer system. The sequence
of instruction read from the memory constitute the instruction steam, and the data they operate of in the
processor constitute the data stream. Flynn's classification divides the computers into four categories:

. .single instruction single data (SISD)
] _single instruction multiple data (SIMD)
J multiple instruction single data (MISD)

° mul*’ “etion maltiple data (MIMD)

-
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SISD or gamaauon is available in most serial computers today. Instructions are executed sequentially,
through may be ovcrldppcd in their exceution stage (pipelining). Al the functional units are under the
supervision of onc control unit. The von Neumann architecture falls under this category.

SIMD organisation consists of multiple processing clements supervised by the same control unit. All
processing units receive the same instruction broadcast but works or different data streams. ‘One of the very
common example is the exccution of a 'for' loop, in which the same set of instructions are executed for, may
be a different set of data. .

MISD organisation consists of N processor units, cach working on a different sct of instruction working on
the same set of data. The output of one unit bccomes the input to the other unit. There is no commercial
computer of this kind.

MIMD organisation implies interactions between N processors because all memory streams are derived from
the same data stream shared by all processors. If the interaction betweenthe processors is high, it is called a
tightly coupled system, or else it is called a lcosely coupled system. Most multiprocessors fit into this
category. '

~ Parallel processors can be categorised into several categories. These include:

. Array Processors

. Distributed Architecture
. Multiprocessors

. Data flow Architectures

Array processors are parallel architectures, which deal with repetitive operations. These are an example of
SIMD architecture, with applications varying from mathematical array operations and in structures in which
data objects are known well in advance.

Diswributed Architecture are composed of relatively autonomous subsystems which are capable of handling
complete system and execution functions, and which cooperate together to runa large application.,

Multiprocessors are architectures composed of multiple computing units, which operate in a synchronous
mode. Generally, both shared and local memory can be available for these processors. The communication
between the processors takes place either through the shared memory area or through the interprocessor
messages.

Dataflow Architectures are functionally distributed architectures, in which the operations are triggered with
the arrival of data at these processors. They may be viewed as very general MIMD parallel architectures.

Most of these parallel processor computers follow an important concept called pipelining. In the subsequent
sections, we will discuss some of the newer technological concepts.

2.6 PIPELINING

\

The basic idea behind pipeline design is quite natural; it is not specific to computer technology. In fact the
name pipeline stems from the analogy with petroleum pipelines in which a sequence of hydrocarbon products
is pumped through a pipeline. The last product might well be entering the pipeline before the first product
has been removed from the terminus. The key contribution of pipelining is that it provides a way to start a
new task before an old one has been completed. The concept can be better understood by taking an example
of an industrial plant. To achieve pipelining, one must subdivide the input task into a sequence of subtasks,
cach of which can be executed by a specialised hardware stage that operates concurrently with other stages in
the hardware. Successive tasks are streamed into the pipe and get executed in an overlappcd fashion at the
subtask level. Hence the completion rate is not a function of total processing time, but rather of how soon a
new process can be introduced.



The subdivision of labour in assembly lines has contributed to the success of mass production in modern Input/Cutput

industry. By the same token, pipeline processing has led to the tremendous improvement of system Organisation &
throughput in modern digital computers. New Technologies

Now consider for execution of dn instruction a computers performs N processing steps. A server unit as
represented in figure 5(a) can perform any one of the N steps in one unit time. If we process M instructions
by this server, then the rate of completion is one instruction of every N steps, and the time behaviour of the
job stream is as described in Figure 5(a). Compare Figure 5(a) with Figure 5(b) which shows N servers
concatenated in a sequence each performing only a single step, the job flows through the collection of servers
by visiting server 1, then server 2, and so on, and finally emerging from server N after N steps. The time
behaviour of this system is described by figure 5(b).

Figure 5(b) is an ideal model of a constant speed assembly line, such as an automobile assembly plant.

leteps >le Nsteps{ )
Job stream .

. S ) )
——._> (Nt):r:r?irts » One completion JOB1
N units/job every N steps

JOB2

time

(a) Sequential execution with N-unit server

J‘Bb stream-

Server Server . Server
| Guit [ | Qunit [P| (Yunit [P One completion

N unitsjob oty 12 s Te ]
| 15 T ]
5T ]
EEERENEEL

) tlme

(b) Pipelined execution thh 1-unit servers

Figure 5: Two ways.of exeéuting N-unit jobs in a stream,

Thus, any arithmetic task is divided into steps. Thus, a sort of concurrent operation can be obtained in the
pipeline. This will help ir} increasing the throughput of the system.- :

Though, superficially it seems that it should be possible to execute any application in various pipeline stages,
it is not actually so. Only those applications, which can be broken into independent subtasks, can take the
advantage of pipelining. It is most efficient for those applications that need to repeat the same task many
times with different sets of data.

2.7 VECTOR PROCESSING

Some of the applications such as
e weather forecasting

e  petroleum explorations
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e seismic data analysis

e ﬂyight simulations

¢ artificial intelligence and expgp systems
»  image processing and its applications

are so complex that wighout the use of sophisticated computers it would not be possible to complete these in
reasonable amount ot ume.

These computational problems are beyond the capabilities of a conventional computer, as these problems
require a vast number of computations that may take a conventional computer days or even weeks to be
completed. The vector computers have emerged as the most important high performance architecture for
numerical problems. It has two key qualities of efficiency and wide applicability.

These scientific problems may involve manipulations of large arrays, where the same computational are
carried out with different sets of data. These numbers can be easily formulated as vectors and matrices of
floating point number (real numbers). A vector can be defined as an ordered set of a one-dimensional array
of data items. Each element in a vector is a scalar quantity, which. may be floating point number, an integer,
a logical value, or a character (byte).

Supercomputers

A commercial computer with vector instructions and pipelined floating-point arithmetic operations is referred
to as a supercomputer. Supercomputers are very powerful, high-performance machines used mostly for
scientific computations. ‘To speed-up the operation, the components are packed tightly together to minimise
the distance that the electronic signals have to travel.

A supercomputer is a computer best known for its high computational speed, fast and larger memory systems
and the extensive used of parallel processing. It is equipped with multiple functional units and each unit has
its own pipeline configuration. Although the supercomputer is capable of general purpose applications found
in all other computers, it is specifically optimised for the type of numerical calculations involving vectors and
matrices of floating point numbers.

>

A measure used to evaluate computers in their ability to perform a given number of floating point operations
per second is referred to as flops. The term megaflop is used to denote million flops and gigaflops to denote
billion flops. A typical supercomputer has a basic cycle time of 4 to 20 nsecs. If the processor can calculate
a floating-point operation through a pipeline each cycle time, it will have the ability to perform 50 to 250
mflops. This would be sustained from the time the first answer is produced and does not include the initial
setup time of the pipeline.

2.8 INTRODUCTION TO RISC :

Aim of the computer architect -is to design computers, whlch are more cost effective than their predecessors.
Cost effectiveness includes:

I. Cost of hardware to manufacture the machine
2. Cost of programming
3. Cost incurred in correcting both the initial hardware and subsequent programs on account of the

new/old/compatible architecture.



2.8.1 Reasons for Increased Complexity Input/Output
. Organisation &
Let us see what are the reasons for increased complexity that leads to complex instruction set computers New Technologies

(CISC) and what exactly we mean by this.
1. Speed of memory Vs. the speed of CPU

The CPU, in general, was about 10 times as fast as main memory. Thus, mére and more instructions were
put into hardware. Since then many higher level instructions have been added to machines in an attempt to
improve performance. This trend began towards the imbalance in speed.

The advances in semiconductor memory have made several changes to the assumptions about the relative
difference in speed between CPU and the main memory. Semiconductor memories are both fast and
relatively inexpensive. Cache memories have further reduced the difference between the CPU and the
memory Speed.

2. Code density

With early computers memory was very expensive. It was therefore cost effective to have very compact
programs. It was assumed that more instructions would result in small programs. While code compaction is
important, however, the cost of 10 percent more memory is often far cheaper than the cost of squeezing code
by 10 percent out of the CPU architecture innovations.

3. Support for high level language

With the increasing use of more and more high level languages, manufacturers have become eager to, provide
more powerful instructions to support them. It is argued that richer instruction set would alleviate the
software crisis and would simplify the compilers. However, RISC designers did not agree to it. They
conducted research to find out what constructs are most frequently used in average programs.

Their research shows that integer constants appeared almost as frequently as arrays or structures; more than
80 percent of the scalars were local variables to subroutines; and more than 90 percent of the arrays or
structure were global variables.

In addition it was found that procedure calls and returns are an important aspect of High-level language
programs. These are also the most time consuming operations in complied high-level language programs.
Thus, it will be profitable to consider ways of implementing these operations efficiently. Two aspects are
significant in this respect: the number of parameters and variables that procedure dealt with; and the depth of
nesting.

Further, it has becn statistically found that 98% of dynamically called procedures pass lower than six
arguments, and 92% of them use fewer than six scalar variables.
i

i
Thus, in the 1980s, a new philosophy evolved called RISC. These machines would have fewer instructions -
(reduced set) and the instructions would be simple and would generally execute in one cycle, hence, the
reduced instruction set computers (RISCs). Optimising compilers are used in these machines to compile the
programs into simple machine instructions.

2.8.2 Principles of RISC
The following are the characteristics of RISC architecture:
1. Hardware Instructions should be kept simple unless there is a very good reason to do otherwise.

2. Microcode, a programming way of implementing control unit, is not magic. Moving software into
microcode does not make it better, it just makes it hard to change.

Simple decoding and pipelined execution are more important than program size. At the peak rate a
new instruction is started every cycle. Pipelined execution gives a peak perforinance, of one
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4.

instruction every step, so the longest piece determines the peﬁbrmanéa"far&gf the pipelined
machine. So ideally each piece should take the same amount of time. -

The large number of registers should be utilised obtimailij

Check Your Progress 3

State True or False.

1.

t

(93]

Vector processors are most suited for high performance computations.
True i | False
Tiue r _‘x False
Applications, which can be broken into subtask, can be implemented as pipelined system.

True D False

. - ]
True [‘ ] False

Pipelined processing improves the system throughput.

80486-is a RISC processor.

2.9

SUMMARY

In this uhit, we have discussed about the Input/Output devices, input/Output module and interfaces. The

discussion is only at the introdugtory level, however, you can refer to further readings for more deiails. The

input/output technologies are developing all the time with the advancement of technology. Some newer
technologies such as data gloves, virtual reality are already available and more and more sophisticated

technologies will be available in near future, however all the new things-can be categorised under one of the
techniques we have discussed in the unit.

In addition in this block, we have introduced the concepts of pipelining; vector processing and Reduced

Instruction Set Computers.

2.10 MODEL ANSWERS

Check Your Progress 1

1.

(a) False
(b) True
(c) False
(d) True
(e) True

CRT 1 LCD

0]

CRT is bulky LCD is.compact

Q)

High energy requirement - Low energy requirement

(i)

Normally high resolution graphics Low resolution
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New .
Laser printer Dot Matrix Printer (DMP) |
(i) High Cost Low Cost
(ii) Form Characters using laser beam Use Dot Matrix to print characters
(iii) Non-impact printer , Impact printer
(iv) High quality output - Output is of low quality
W) Noiseless operation Noisy
) Produces multiple copies in a single print
4. In source data automation data is entered essentially where it is being produced through automatic devices.
Examples are OMR & OBR.
Check Your Progress 2
1. (a) False (b) False (c) True (d) True
2. A device controller is an [/O module, which interacts with the [/O devices as per the instructions
provided to it by the CPU.
Check Your Progress 3

1. True 2. True 3.True _ 4. False

2.11 FURTHER READINGS

1. Stallings, William, Computer Organisation and Architecture, Third edition, Maxwell Macmillan
International Editions. a

2. Mano, M. Morris, Computer System Architecture and Organisation, Second Edition, McGraw-Hill
International Editions, 1988.
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UNIT 3 SOFTWARE CONCEPTS AND
TERMINOLOGY

Structure

3.0 Introduction
3.1 Objectives
3.2 Computer Software
3.2.1  System Software:
322 Application Software
33 Categories of Languages
3.3.1  Machine
332  Assembly
333  High Level
3.3.4  Fourth Generation Language -
3.4 Elements of Programming Language
3.4.1  Variables, Constants, Data Type, Array and Expressions
3.42  Input and Output Statement
343  Conditional and Looping Statement
3.44  Subroutine and Functions
3.5  Summary
3.6 Madel Answers
3.7 " Further Readings

3.0 INTRODUCTION

A computer contains two basic parts: (i) Hardware and (ii) Software. In the first two units we touched upon
hardware issues in quite detail. In this unit and also in the rest of the units of this block we will discuss topics

related to software. Without software a computer will remain just a met: I; With software, a computer can
store, retrieve, solve different type. of problems, create friendly environment for software development cic.

The process of software development is called programming. To do programming one should have

knowledge of (i) a particular programming language. (ii) set of procedures (algorithm) to solve a problem or

develop software.

The development of an algorithm is basic to computer programming and is an important part of computer
science studies. Developing a computer program is a detailed process, which requires serious thought,

careful planning and.accuracy. Itisa challenging and exacting task, drawing on the creativity of the
programmer.

intellectual achievements in Computer Science . It has been said "to understand a computer, it is necessary
to understand a programming language. Uniderstanding them does not really mean only being able to
use them. A lot of people can use them without really fully understanding them". ‘

An (')pt.aratinggiSystem is system software, whic:h may be viewed as an organised collection of software
consisting of procedures for operating a comp uter and providing an environment for execution of programs.
It acts as an interface between users and the hardware of a computer system.

Tbere are many important reasons for studying operating systems. Some of them are;



(1) ~ User interacts with the computer through operating systemi in order to accomplish his task since it is Softas

his primary interface with a computer. gom
er:

(2) It helps users to understand the inner functions 6f a computer very closely.
(3) Many concepts and techniques found in operating system have general applicability in other
' apphcanons

In this unit, we will discuss about the concepts relating to a programming language and in the next unit we
will deal with the operating system concepts.

3.1. OBJECTIVES

After COmpletion of this unit, you should be able to

define the terms system and application software

define various categories of language

define the terms such as computers, interpreters, fourth generation languages

define the elements of programming languages such as arrays, expressions, variables, input-output
- statements A

define conditional and looping structures, and

define subroutines and functions.

3.2 COMPUTER SOFTWARE

Computer software consists of sets of instructions that mould the raw arithmetic and logical capabxhtles of the
hardware units to perform.

In order to communicate with each other, we use natural languages like indi, English, Bengali, Tamil,
Marathi, Gujarati etc. In the same way programming languages of one type or another are used in order to
communicate instructions and commands to-a computer for solving problems. Learning a programming
language requires learning the symbols, words and rules of.the language.

Program and Programming: A computer can neither.thihk nor make any judgement on its own. Also it is
impossible for any computer to independently analyse a given data and follow its own method of solution. It
needs a program to tell it what to do. A program is a set of instructions that are arranged in a sequence that
guides the computer to solve a problem.

The process of writing a program is called Programming. Programming is a critical step in data processing. -
If the system is not correctly programmed, it delivers information results that cannot be used. There are two
ways in which we can acquire a program.. One is to purchase an existing program, which is normally referred
to as packaged software and the other is to prepare a new program from scraich in which case it is called
customised software.

A computer software can be broadly classified into two categories-System Software and Application
Software.

Today, there are many languages available for developing programs software. These languages are designed
keeping in mind some specific areas of applications. Thus, some of the languages may be good for writing
system programs/software while some other for application software. Since a computer can be used for
writing various types of dpplication/system software, there are different programming languages.

i) System Programming Languages: System programs are designed to nrake the computer casicr
to use: An example of system software is an operating system, which consists of many other
programs for controlling input/output devices, memory, prccessor etc. To write an operating
system, theprogrammer needs instruction to control the computer's circuitry (hardware part). For
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example, instructions that move data from one location of storage to a register of the processor. C
and C++ languages are widely used to develop system software.

i) Application Programming Language: Application programs are designed for specific applications,
such as payroll processing, inventory control etc. To write programs for payroll processing or other
applications, the programmer does not need to control the basic circuitry of a computer. Instead the
programmer needs instructions that make it casy to input data, produce output, do calculations and
store and retrieve data. Programming languages that are suitable for such application programs

support these instructions but net necessarily the types of instructions needed for development of
system programs.

There are two main categories of application programs: business programs and scientific application
programs. Most programming languages are designed to be good for one category of applications but not
necessarily for the other, although there are some general purpose languages that supports both types.
Business applications are characterised by processing of large inputs and largz outputs, high volume data
storage and retrieval but call for simple calculations. Languages, which are suitable for business program,
development, must support high volume input, output and storage but do not need to support complex
calculations. On the other hand, programming languages that are designed for writing scientific programs
contain very powerful instructions for calculations but rather poor instructions for input, output etc. Amongst
traditionally used programring languages, COBOL (Commercial Business Oriented Programming
Language) is more suitable for business applications whereas FORTRAN (Formula Translation - Language)
is more suitable for scientific applications. Before we discuss more about languages let us briefly look at the
categories of software viz. system and application software.

3.2.1 System Software

Language Translator: A language translator is a system software which translates a computer program
written by a user into a machine understandable form, We will discuss more about them in the next section.

Operatiﬁg System

An operating system (OS) is the most important system software and is a must to operate a computer system.
An operating system manages a computer's resources very effectively, takes care of scheduling multiple jobs
for execution and manages the “ow of data and instructions between the input/output units and the main
memory. Advances in the field of computer hardware have also helped in the development of more efficient
operating systems. More deta..s on operating systems are given in unit 4 of this block.

Utilities

_Utility programs are those which are very often requested by many application progfams. A few examples

are:

SORT/MERGE utilities, which are used for sorting large volumes of data and merging them into a
single sorted list, formatting etc. '

3.2.2 Application Software

Application software is written to enable the computer to solve a specific data processing task. A number of
powerful application software packdges, which does not require significant programming kniowledge, have
been developed. These are easy to learn and use as compared to the programming languages. Although thes:
packages can perform many general and special functions, there are applications where thes e packages are
not found adequate. In such cases, application program is written to meet the exact requirernents. A user
application program may “= written using one of these packages or a programming languagc. The most
important categories of software packages available are: )

* Data Base Management Software

e Spreadsheet Software
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*  Word Processing Desktop Publishing (DTP) and presentation Software Graphics Software Software

Concepts and
e Data Communication Software Terminology

e Statistical and Operational Research Software.

‘Data Base Management Software

Databases are very useful in creation maintaining query, the databases and generation of reports. Many of
today’s Database Management System are Relational Database Management System’s. Many RDBMS
packages provide smart assistants for creation of simple databases for invoices, orders and contact lists.
Many database management systems are available in the market these days. You can select any one based on
your needs, for example, if you have only few databases then package like dBase, FoxPro etc. may be good.
If you require some additional features and moderate work load then Lotus Approach, Microsoft Access are
all-right. However, if you are having high end database requirements which requires multi-user environment
and data security, access right, very good user interface etc. then you must go for professional RDBMS
package like Ingress, Oracle, Integra etc.

Accqunting Package

The accounting packages are one of the most important packages for an office. Some of the features, which
you may be looking on an accounting, may be:

. tax planner facility

. facility for producing charts and graphs
. finding accounts payable

J simple inventory control facility

o -payroll functions

. on-linc connection to stock quotes

o " creation of invoices easily

One of the good packages in this connection is Quicken for windows.

Communication Package

The communication software includes software for fax. The fax-software market is growing up. Important

fax software is Delrina’s WinFax PRO 4.0. Some of the features such as Remote Retrieval and Fax Mailbox
should be looked into fax software. These features ensure that irrespective of your location you will receive
the fax message. Another important feature is fax Broadcast. This allows you to send out huge numbers of

faxes without tying up your fax machine all day.

If'you have to transfer files from your notebook computer to a desktop computer constantly then you need a
software program that coordinates and updates documents. On such software is Laplink for Windows. This
software offers very convenient to use features. For example, by simply dragging and dropping a file enables
file transfer. This software can work if a serial cable or a Novell network or a modem connects you.

Desktop Publishing Packages

Desktop Publishing Packages are very popular in Indian context. Newer publishing packages also provide
certain in built formats such as brochures, newsletters, flyers etc., which can be used directly. Already
created text can be very easily put in these packages. so are the graphics placements. Many DTP packages
for English and languages other than English arc available. Microsoft Publisher, PageMaker, Corel Ventura
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Information Providers

One of the very interesting information provider which will become popular in India also is Automap road
atlas by Microsoft. This package may provide city-to-city driving instructions and maps. You may also get
the best route, calculate the time it will take.

Many information providers are the Internet access programs. T oday, the Internet access packages comes as
a part of operating system however, many other packages can be used for accessing information on the World
Wide Web." One very simple to use popular tool of browsing Internet is Netscape Navigator.

Organisers, Contact Managers, PIMs
Some of the tasks of an office manager can be able to:

track contacts
balance schedules
manage projects, and
prioritize 1asks.

These things can be easily done using organisers programs, which have a phone book model for maintaining
lists of contacts. They also have a calendar for entering appointments and to-dos. Some of these packages
are Okna’s DeskTop Set for Windows, Lotus organiser, Microsoft Outlook, etc.

If you are interested in knowing more, then only names and addresses about your contacts such as details'like
the industry they are working with, thé products they are manufacturing, their business with you last year,
when did you last spoke to them etc., then you must look to a contact management software. One such -

- software is "Symantec Act! for Windows™.

If you wynt 1o-go even turther then you can look for a personal information manager (PIM). PIM is a tool ’
that stores virtually any information such as reference materials, project details etc. The PIM document
contains eutlines, folders and links. Most of the data in the PiMs is presented as an outline, for example, the
clients may represent the top level, the date of an appointinent with him at the next level, and the details of

the meeting indeuited further below. This item can be linked to any other, allowing-data to be entered only
once and linked up to all other appropriate places. : :

Suites

Suites are a set of packages sold as a group package mainly for the business user. The suite package includes
programs for Word-processing. Electronic Spreadsheet, Databases, and Presentation Graphics software and
may be a mail software. For example. Microsoft Office Professional for Windows includes programs as
Microsoft Word. Microsoft Excel and Microsoft Access. and-a license for Microsoft Mail etc. The word--
processing. spreadsheet. and presentation-graphics software interfaces in a suite are well-integrated allowing
¢asy data transfer among these applications. Today there is a growing family of Office-compatible products,
which will be included in suites. ’

In the fast developing software era the list discussed above cannot be complete. Please refer to latest PC
-journals for most recent software trends.

Check Youi Progress 1
1. What is computer software?
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2. Explain the following terms in one or two sentences each.

Software
Concepts and
Terminology
(a) Operating Systems
(b) Database Management Software

3.3 CATEGORIES OF LANGUAGES

We can choose any language for writing a program according to the need. But a computer executes programs
only after they are represented internally in binary form (sequences of 1s and 0s). Programs written in any
other language must be translated to the binary representation of the instructions before the computer can
execute those. Programs written for a computer may be in one of the following categories of languages.

3.3.1 Machine Language
This is a sequence of instructions written in the form of binary numbers consisting of | s, Os to which the

computer responds directly. The machine language was initially referred to as code, although now the term
code is used more broadly to refer to any program text. ‘

Just as kardware is classified into generations based on technology, computer languages also have a
generation classification based on the level of interaction with the machine. Machine language is considered
to be the first generation language.

Advantage of Machine Language

It is faster in execution since the computer directly starts executing it.

Disadvantage of Machine Language

Itis difficult to understand and develop a program using machine language. Anybody going thrbugh this
program for checking will have a difficult task understanding what will be achieved.when this program is

executed. Nevertheless, the computer hardware recognises only this type of instruction code.

The following program is an example of a machine language program for adding two numbers.

0011 1110 Luad A register with
0000 0111 value 7

0000 0110 Load B register with 10
0000 1010 A=A+B

1000 0000 Store the result _
0011 1010 into the memory location
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0110 0110
0000 0000 whose address is 100 (decimal)
0111 0110. Halt processing

3.3.2 Assembly Language

When we employ symbols (letter, digits or special characters) for the operation part, the atddress part and
other parts of the instruction code, this representation is called an assembly language program. This is
considered to be the second-generation language.

Machine and Assembly languages are referred to as low level languages since the coding for a problem is at
the individual instruction level.

Each machine has got its own assembly language, which is dependent upon the internal architecture of the
processor. '

An assembler is a translator, which takes its input in the form of an assembly language program and produces
machine language code as its output.

The following program is an example of an assembly language program for adding two numbers X and Y -
and storing the result in some memory location.

LDA, 7 Load register A with 7

LDB, 10 Load register B with 10
ADDA,B A« A+B

LD (100), A Save the result in the location 100
HALT Halt process

From this progiam, it is clear that usage of mnemonics in our example (LD, ADD, HALT are the mnemonics)
has improved the readability of our program significantly.

5
A machine canhot execute an assembly language program directly, as it is not in a binary form. An
assembler is needed in order to translate an assembly language program into the object code executable by
the machine. This is illustrated in the figure 1.

Assembly '
' \ge Object Code in mach
Language—»  Assembler [ jec 1 a(; Z ; t;nac ine
Program » guag

Figure 1: Assembler
Advantage of Assembly Language

Writing a program in assembly language is more convenient than in machine language. Instead of binary
sequence, as in machine language, it is written in the form of symbolic instructions. Therefore, it gives a
little more readability.

Disadvantages of Asserhbly Language

°
“ -

Assembly language (program) is specific to particular machine architecture. Assembly languages are
designed for specific make and model of a microprocessor. It means that assembly language programs
written for one processor will not work on a different processor if it is architecturally different. That is why
the assembiy language program is not portable. .

Assembly language program is not as fast as machine language. It has to be first translated into machine
{binaryy language code.



3.3.3 High-level Language Sottware
: Concems ane
Terminology

We have talked about programming languages as COBOL, FORTRAN and BASIC. They are called high
level programming languages. The program shown below is written in BASIC to obtain the sum of two
numbers.

10 LET X . = 7
20 LET y = 10
30 LET sum = X+Y
40 PRINT SUM

50 END

The time and cost of creating machine and assembly languagcs was quite high. And this was the prime
motivation for the development of high level languages.

Since a high level source program must be translated first into the form the machine can understand, this is
done by a software called Compiler which takes the source code as input and produces as output the machine
language ce-'= of the machine on which it is to be executed. This is illustrated in figure 2.

Source program

in High Level ——pf + Compiler ——>  Object Code
Language ;

Figure 2: Compiler

During the process of translation, the Compiler reads the source programs statement-wise and checks the
syntax (grammatical) errors. If there is any error, the computer generates a printout of the errors it has
detected. This action is known as diagnostics. -

There is another type of software, which also does the translation. This is called an Interpreter. The
Compiler and Interpreter have different approaches to translation. The following table lists the differences
between a Compiler and an lnterpreter ’

Compiler Interpreter

1) Scans the entire program first and then Translates the program line by line.
translates it into machine code

2) Converts the entire program to machine Each time the program is executed, every line is
code; when all the syntax errors are removed | checked for syntax error and then converted to
execution takes place. equivalent machine code. _J

3) - Slow for debugging (removal of mistakes Good for fast debugging
- from a program)

4) Execution time, is less Execution time is more.
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Advantages of High-level Programming Language
There are four main advantages of high-level programming languages. These are:

i) .Readability: Programs written in these languages are more readable than assembly and machine
language. '

i) Portability: Programs could be run on different machines with little or no change. We can, therefore,

exchange software leading to creation of program libraries.
iii)  Easy debugging: Errors could easily be removed (debugged).

iv)  Easy Software development: Software could easily be developed. Commands of programming
language are similar to natural languages (ENGLISH).

High level languages are also called Third generation languages.

3.3.4 Fourth Generation Language

The fourth generation of programming languages is not as clearly defined as are the other earlier generations.
Most people feel that a fourth generation language, commonly refersed to as 4GL is a high level language
that. requires significantly fewer instructions to accomplish a particular task than a third generation language
does. Thus, a programmer should be able to write a program faster in 4GL than in third generation language.

-Most third generation languages are procedural languages. This means that the programmer must specify the

steps, that is the procedure, the computer has to follow in a program. By contrast, most fourth generation
languages are non-procedural languages. The programmer does not have to give the details of procedure in
the program, but instead, specifies what is wanted. For example, assume that a programmer needs to display
some data on a screen, such as the address of a particular employee (SANTOSH) from the personal file. In a
procedural language, the programmer wouid have to write a series of instructions in the following steps:

Step | Get a record from the personal file

Step2  Ifthis is the record for SANTOSH, display the address

Step 3  If this is not the.record for SANTOSH, go to Step 1.

In a non-procedural language (4GL), however, the programmer would write a single instruction that says:
Get the address of Santosh, from personal file. |

Major fourth generation languages are used to get information from files and data bases, as in the previous
example and to display or print the information. These fourth generation languages contain a query language

which, is used to' answer queries or questions with data from a database. For example the following figure
shows a query in a common query language SQL,

- SELECT ADDRESS FROM PERSONNEL
WHERE NAME = "SANTOSH"

Some fourth generation languages are used to produce complex printed reports. These languages contain
certain types of program called generators. With a report generator available, the programmer specifics the
headings, detailed data and totals needed in a report. Thus, the report generator produces the required report
using data from a file. Other fourth generation languages are used to design screens to be used for data input
and output and for menus. These languages contain certain types of programs called screen painters. The
programmer designs hew the screen is to look and, therefore, we can say that the programmer paints the
screen, using the screen painter program. Fourth generation languages are mostly machine independent.

Usually they can be used on more than one type of computer. They are m: stly used for office automation or



business applications, but not for scientific programs. Some fourth generation languages are designed to be Software

casily learnt and used by end users. : Concepts and
. " Terminology

Check Your Pregress 2

1. What are the differences between a compiler and an interpreter?

..................................................................................................................................................................

2. State True of False.
(a) Assembly Janguage programs are machine independent,
True False l:l
() Machine language programs are machine independent. y
True - D FalSe‘_ D
© High level languages are machine independent. ‘ o
True D False l:'
‘ (d) All programs arc machine independent.
True D False D
'(e_) ~ Ath generation languages are dependent or databases they are using.
True [:I FalSe l:’

34 ELEMENTS OF A PROGRAMMING LANGUAGE

Leamning a programming language requires understanding of concepts such as representation of different
types of data in the computer, various methods of expressing mathematical and logical relationship among
data elements and the mechanics for controlling the sequence in which operations can be executed for
inputting, processing and outputting of data.

3.4.1 Variables, Constants, Data type, Array and Expressions
These are the smallest components of a programming language.
Variable: The first thing we must learn is how to use the internal memory of a computer in writing a

program. Memory may be pictured as a series of separate memory cells as shown in figure 3. Computer
memory is divided into several locations. Each location has got its own address.

Figure 3: Memory Organisation
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Each storage location holds a piece of information. In order to store or retrieve information from a memory
location, we must give that particular location a name. Now study the following definition.

Variable: It is a character or group of characters assigned by the programmer to a single memory location
and used in the program as the name of that memory location in order to access the value stored in it.

For example in expression A =5, A is a name of memory location i.e. a variable where 5 is stored.

Constant: It has fixed value in the sense that two cannot be equal to four. String constant is simply a

sequence of characters such as."computer" which is a string of 8 characters. The numeric constant can be
integer representing whole quantities or a number with a decimal point to represent numbers with fractional
part. Constant would be probably the most familiar concept to us since we have used it in doing everything
that has to do with numbers. Numeric constants can be added, subtracted, multiplied, divided, and also
compared to say whether two of them are equal, less than or greater than each other. .

A's string constants are a sequence of characters, a related string constant may be obtained from a given one,
by chopping off some characters from beginning or end or both or by appending another string constant at the
beginning or end. For example, from 'Gone with the wind', we can get 'one with ', 'Gone with wind', and so
on. String constants can also be compared in a lexicographic (dictionary) sense to say whether two of them
are equal, not equal, less than or greater than each other.

Data type: In computer, programming, the term data refers to anything and everything processed by the -
computer. There are different types of data processed by the compujer, numbers are one type ofdataand
words are of another type. In addition, the operations that are performed on data differ from one type of data
to another type. For example multiplication applies to numbers and not words or sentences.

Data type defines a set of related values/integers, number with fraction, characters and a set of specific
operations that can be performed on those values. ' :

In BASIC a statement LET A = 15 denotes that A is a numeric data type because it contains numbers but in a
statement LET A$ = "BOMBAY", A$ is a variable of character data type. Data type also defines in terms of
contiguous cells should be allocated for a particular variable.

‘Array: In programming we deal with large amount of related data. To represent each data element we have
to consider them as separate variables. For example if we have to analyse for the sales performance of a
particular company for the last 10 years, we can take ten different variables (names) each one representing
sales of a particular year. If we analyse sales information for more than 10 years, then accordingly number of
variables will further increase. It is very difficult to manage with large number of variables in a program. To
deal with such situation an array is used. '

An array is a collection of same type of data (either string or numeric), all of that are referenced by the
same name. '

For example, list of 5 years sales information of a company can be referred to by same array name A.

A1) ' A(2$ AQ3) ' A(4) A(5)

[ 50,000 | 100000 [ 500000 | 800000 | 900000 |

A1) speciﬁes.§ales information of a first year

_A(2) specifies Sales information of a second year

A(3) specifies Sales information of a fifth year

Expression: We know that we can express intended arithmetic operations using expressions such as X +Y+
Z and so on. Several simple expressions can even be nested together using parentheses to form complex
expressions. Every computer language specifies an order by in which various arithmetic operators are
evaluated in a given expression. An expression may contain operators such as

(V€) T'I-VOu
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Exponentiation ~

Negation -

Multiplication, division * !

Addition, subtraction +, -

The operators are evaluated in the order given above. For'example, the expression
2+8*(4 - 613)

can be considered to be evaluated as follows:

2+8%(4 - 6/3) Sub expression (4 — 6/3) taken up irst

2+8*(4 - 2) division 6/3 within (4 - 6/3) has higher priority than 4 - 6

2+8%2 Subtracﬁon (4 - 2) is performed next (4 — 6/3) is now complete.

2+8*2 . 8*2 will be executed first then its result will be added with 2 that is 16 +
2=18 :

It is useful to remember the order of priority of various operators. But it is safer tc simplify expressions and
enclose them in parentheses to avoid unpleasant surprises. So far we have focused on arithmetic expressions.
But expression is a very general concept. We mentioned earlier that apart from arithmetic operations we
could compare numbers or strings. We do it by using relational operators in expressions.

The following is a list of relational operators:

= ' equalto

<> not equal to

< less than.

> greater than

<= less than or equal to
>= greater than or equal to

These operations have the same level of Priority among themselves but a lower priority than arithmetic
operators mentioned earlier. The relational expressions result in one of the truth-values, either TRUE or
FALSE. When a relational expression such as (3 > 5) is evaluated to be FALSE by such languages, a value
0, that is false, is assigned, whereas (5, < 7) will be evaluated to be TRUE, and value 1 will be assigned.

Note that relational expressions are capable of comparing only two  values separated by appropriate relational
operator. If we want to an express idea such as whether number 7 happens to be within two other numbers 4
and 10, we may be tempted to write relational expression 4 <= 7 <= 10. Such reasonable expectation from us
may be a bit too complex for a computer language. In such cases, we need to explain our idea in terms of -
simple relational expressions such as (4 <= 7) AND (7 <= 10) which means that 7 is between 4 and 10. To
combine several relation expressions for expressing complex conditions, we use logical operators such as
AND or OR operators. Among other logical operators NOT simply negates a truth value in the sense that ‘
NOT TRUE is FALSE, and NOT FALSE is TRUE. The logical operators have lower priority than relational
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operators. Among tiiemselves they have the following order of priority during evaluation of logical
expressions.

Operator Meaning
NOT ~ Simply negates a truth-value. NOT (2>5) is TRUE
AND TRUE is both adjoining expressions are TRUE otherwise it is FALSE. For example

(4 < 7) and (7 < 10) is TRUE whereas (4 > 7) and (7 < 10) is FALSE

OR FALSE is both adjoining expressions are FALSE otherwise it is TRUE For exémpl‘e
(4 <2) OR (7 >2) is FALSE whereas (4 >2) OR (7 > 2) is TRUE

XOR TRUE only if one of the adjoining expressions is TRUE and other is FALSE.
~The XOR has same priority as OR. (4 <7) XOR (7 < 10) is FALSE.

Of the four logical operators NOT, AND and OR are sufficient to express any logical condition.

Expressions would be our basic programming unit. Our Programs would be full of them, and while
executing the program, computer would be preoccupied most of the -time evaluating them. But the computer
would also be doing other things such as taking some values as input from an input device, assigning a value
or result of an expressioit to a variable, send a value for display to a display unit, pondering to be or not to be
on some conditional expression, Repeating some tasks until we are satisfied, and calling some slave-programs
to perform specific tasks. In the following discussion we shall elaborate on these actions.

3.4.2 Input and Output Statement
Syntax: input list of variables
Input statements are normally used for supplying values to a list of variables through an input device such as
a keyboard. On execution, a question mark? (in BASIC) would be displayed on the screen, in response to
which we are expected to supply a sequence of desired values matching appropriately the type (i.e. integer,
floating-point or string type) and the number of variables in the list. For example in BASIC, INPUT A, B, C
is an input statement with list of 3 variables A,B,C.
Assignment Statement
Syntax: variable=expression
This is the most obvious statemerit used, for assigning value to an identifier (i.e. variable). In BASIC
languages this is also known as LET ' statement though the key word ‘LET is optional in most of them. Note
the use of = as assignment operator. -You would recall that it was also used as relational operator. Some
purists justifiably object to ambiguous use of =. In Pascal, : = is used for assignment instead of just = which is
used as relational operator. In language C '=' is used for assignment but for relational operator == is used.
Few examples of assignment statement in BASIC are given below. ’

LET SUM = X+Y

LET X =5
SUM and X are called variables whereas A + B is called an expression.
Print Statement

Syntax: print list of variables

This is again an obvious way to display values of specified list of variables on display screen. We shall make
use of print to represent generic output statement independent of any particular output device such as display



screen, printer and so on. Computer languages nbrmally provide very rich facilities for making the display as  Software
attractive as possible. An Example of print statement in BASIC is PRINT A,B,C, which will display values  Concepts and

- of A,B,C on display screen. - Terminology
3.4.3 Conditional and Looping Statement

Conditional Statement

If then_else structure

Syntax: if (condition)
- Then
statement(s) for Task A
else
statement(s) for Task A
endif

This is one of the most important program-structures that enable a modern programmer to develop well-
structured programs. Note that we are calling it as structure rather than statement. As structure it
accommodates statements corresponding to alternate tasks to be performed depending upon truth-value of
the condition. The structure has three components: a conditional expression the truth-value of which
determines the action, a then-clause denoting task to be performed if the condition is TRUE (Task A), and
an optional else clause with task to be performed if the condition is FALSE.

Looping Statement

Obviously, the purpose of a loop structure is to repeat certain tasks until no more repetition is desired. We
shall be presenting several variations of loop structure appropriate to handle different situations.

While-end While:

Syntax: WHILE (While Condition)

statement(s) for task being
repeated

end while

A loop structure is characterised by the body of statements to be repeated, and the condition for termination
of loop. In while-end-while version the condition is tested before every. execution of the body. The body is
executed if the condition is found to be TRUE. The loop is active as long a condition evaluates to be TRUE
and terminates when the condition is evaluated to be FALSE. In case the condition is found to be FALSE for
the first time, the body will be skipped. ‘ ‘

for-endfor structure

Syntax: for var = Start to Finish step incr do

Body of Statements

endfor
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This loop structure is distinctly different from the while condition - end while we have discussed so far.
Unlike it, the for-end-for structure counts the number of times the body is to be executed on the basis of the
number of times a control variable is incremented from start to finish in specified steps. Managing the
control variable is the responsibility of the for-end-for structure. So we need not and should not woiry about
assigning any value to it in the body of statements. Any attempt to do so may land us in trouble.

This loop structure is so famous that it is available in all languages, structured or not. As usual; key words
provided may be different. The Microsoft BASIC calls it for-next, and optionally provides for specification
of control variable after next. Many other languages insist-on mention of the control variable after next.

We have discussed program structures quite elaborately. Let us turn our attention to data structures that hold
our values. So far we have been dealing with simple variables that hold only one value of a desired type. So
we have integer variable, floating-point variable, and string variable holding only one value on the -
corresponding type at any moment. Can we have data structures that are capable of holding more than one
value? Programming languages do offer complex data structures required for advanced programming. Array
and record are two of them. A detailed discussion of these topics is beyond this unit, however you can refer
to further readings for more details.

3.4.4 Subroutine and Functions

When writing a program sometimes, it is necessary to repeat a statement or group of statements at several -
points. For example, it may be necessary to perform the same computation several times. Repeating the
same, stajement in a program each time makes a program lengthy and also gives poor readability. These
problems could be sorted out if the necessary statements could be written (coded) once and then referred to
cach time they are necded. )

This is the purpose of subroutine and function. Subroutine and function consist of one or more basic
statements that can be referred to at different points in a program. Each time a subroutine and function is

referenced, we say it is called.

A subroutine is a group statcment that can be executed from different points in a program. Syntax for
defining subroutine varies from one language to another language.

Functions: The word function in programming means essentially what it does in mathematics. Function is a
rule or series of rules that assign one and only one value Y to a given value X. Thus, X and Y is called
variables. Value of Y is dependent upon value of X. Variable X is also called the argument of the function. -
The notation used for function should already be quite familiar to you.
Y=F(X)

In this notation "F" is the name of the function. Consider a specific example

Y=FX)=3X+3
If we let X equal 3, then this rule or function directs us to compute 12 for Y If we assign the value of X = - 3,
then Y is - 6. Using function notation, F(3) = 12 and F(-3) =-6. Each language has different rules to define a
function.
Library functions: These are functions supplied with your language compiler interpreter. The code for a

library function does not appear in the program. The computer inserts it when the program is translated into
machine language. Some built-in functions in C programming language are Printf, Scanf etc.

Check Your Progress 3
Question 1. What is the purpose of a looping statement in a programming language?
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Question 3 What is the difference between subroutine and function ?

3.5 SUMMARY

In this unit, we have introduced you many aspects relating to computer software and programming 'anguages.
We have defined the terms system and application software giving details on specific application software.
We have also discussed about various categories of programming languages starting from machine language
to fourth generation language. The concepts of compilers and interpreters have also been introduced along
with this discussion. Finally we have discussed about basic elements of any programming language. The
concepts introduced are variables, constants, arrays, expressions, input output statements, assignment
statements, conditional and looping structures and subroutine functions. These concepts are essential to
acquire a proper know-how about any programming language. You can refer to further readings for more
details. .

3.6 MODEL ANSWERS

Check Your Progress 1
1. It consists of sets of instructions, which enablg-hardware unit to pgrfdrm.

2. (a) Operating System is a system software for effective management of computer resources. Itisa
must to operate a computer system.

(b) A software that maintains and iintegrates large volume of data and provide simpler user
interaction. ST '
Check Your Progress 2
1. ) Compiler : Inerpreter
Scans the entire program in a sing;le go Scans line by line »
Displays all syntax errors Stops on the first syntax error
Slow for debugging Fast in debugging

Execution time is less Execution time is high

2. (a) False (b) False (c) 'fme (d) False (e) False

Check Your Progress 3

1. Looping statements are used to exccute a set of instructions repeatedly.
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3. Mainly the number of values which are returned. Functions return only a single value.

3.7 FURTHER READINGS

1. R.J. Dromey, How to solve it by computers, Prentice Hall of India

2. Pratt, Programming Languages, Prentice Hall of India
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4.0 INTRODUCTION

An Operating System is a system software which may be viewed as an organised collection of software
consisting of procedures for operating a computer and providing an environment for execution of programs.
It acts as an interface between users and the hardware of a computer system.

There are many important reasons for studying operating systems. Some of them are:

(1) User interacts with the computer through operating system_ in order to accomplish hié task since it is
his primary interface with a computer. '

(2) It helps users to understand the inner functions of a computer very closely.

(3)  Many concepts and techniques found in operating system have general applicability in other
~ appli¢ations.

In the previous unit, we mainly introduced different types of software: and categories of programming -
languages. All these software have been developed under a particular operating system environment. The
introductory concepts and principles of an operating system will be the main issues for the discussion in this
unit. Evolution and types of operating systems will also he broadly covered here.

4.1 OBJECTIVES

After going through this, unit, you should be able to:

list and interpret the basic functions of operating systems

to make comparison among different types of operating systems
list future trends in opcrating system

trace the history of operating systems.
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4.2 WHAT IS AN OPERATING SYSTEM?

An operating system 1s an essential component of a computer system. The primary objective of an operating
system is to make computer system convenient to use and utilise computer hardware in an efficient manner.

. An operating system is a large collection ot software, which manages resour ses of ihe computer system, such

as inemory, processor, file system and input/output devices. It keeps track of the status of each resource
and decides who will have a control over computer resources, for how long and when. The positioning of
operating system in overall computer system is shown in figure 1.

Figure 1: Component of computer system

From the figure, it is clear that operating system directly controls.computer hardware resources. Other
programs rely on facilities provided by the operating system to gain access to computer system resources.
here are two ways one can interact with operating system

M By means of Operating System Call in a program

(i)  Directly by means of Opefating System Commands.
System Call: System calls provide the interface to a running program and the operating system. User
program receives operating system services through the set of system calls. Earlier these calls were available
ini assembly language instructions but now a days these features are supported through high-level languages
like C, Pascal etc., which replaces assembly language for system programming. The use of system calls in C
or Pascal programs very much resemble pre-defined function or subroutine calls. ‘

As an example of how system calls are used, let us consider a simple program to copy data from one file to

‘another.” In an interactive system, the foHowing system calls will be generated by the operating system:-

° Prompt messages for inputting two file names and reading it from terminal.
° Open source and destination file.
° Prompt error messages in case the source file cannot be open because it is protec{ed against access or

destination file cannot be created because there is already a file with this name.
° Read the source file. -

. Write into the destination file.



o DlSplay status information regarding various Read/Write error conditions. For example, the Operating Sysiem
program may find that the end of the file has been reached or that there was a hardware failure, The CoPeePts
write operation may encounter various errors, depending upon the output device (no more disk
space, physxcal end of tape, printer out of paper and so on).

. Close both files after the entire file is copied.

As we can observe a user program takes heavy use of the operating system. ‘All interaction between the
program and its environment must occur as the result of requests from the program to the operatmg system

Operating System Commands: Apart from system calls, users may interact with operanng system airectly
- by means of operating system commands.

For example, if you want to list files or sub-directories in MS-DOS, you invoke dir command. In either case,
the operating system acts as an interface between users and the hardware of a computer system. The
fundamental goal of computer systems is to solve user problems. Towards this goal computer hardware is
designed. Since the bare hardware alone is not very easy to use, programs, (software) are dev.'~ped. These
programs require certain common operations, such as controlling peripheral devices. The comm:nd function
of controlling and allocatmg resources are then brought together into one piece of software; the operating

. system.

To see what operating systems are and what operating systems do, let us consider how they have evolved
over the years. By tracing that evolution, we can identify the common elements of operating systems and
examine how and why they have developed as they have.

4.3 EVOLUTION OF OPERATING SYSTEMS

An operating system may process its task seridlly (sequentially) or concurrently (several tasks
simultaneously). It means that the resources of the computer system may be dedicated to a single program
until its completion or they may be allocated among several programs in different stages of execution. The
feature of operating system to execute multiple programs in an interleaved fashion or in different time cycles,
is called as multxprogrammmg systems. In this section, we will try to trace the evolution of operating
system. In particular, we will describe serial processing, batch processing and multiprogramming.

4.3.1 Serial Processing

Programming in is and Os (machine language) was quite common for early computer systems. Instruction
and data used to be fed into the computer by means of console switches or perhaps through a hexadecimal
keyboard. Programs used to be started by loading the program counter register (a register which keeps track
of which instruction of a program is being executed) with the address of the first instruction of a program and .
its result (program) used to be examined by the contents of various registers and mcmory locations of the
machine. Therefore, programming in this style caused a low utilisation of both users and machine.

Advent of input/output devices, such as punched cards paper tapes and language translators
(Compiler/Assemblers) brought a significant step in computer system utilisation. Program, being coded into
programming language, is first changed into object code (binary code) by translator and then automatically
gets loaded into memory by a program called loader. After transferring a control to the loaded program, the
execution of a program begins and its result gets displayed or printed. Once in memory, the program may be
re-run with a different set of input data.

The Process of development and preparation of a program in such environment is slow and cumbersome due
to serial processing and numerous manual processing. In a typical sequence first the editor is called to create
a source code of user program written in programming language, translator is called to convert a source code
into binary code and then finally loader js called to load exccutable program into main memory for execution.
If syntax errors are detected, the whole process must be restarted from the begmnmg
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The next development was the replacement of card-decks with standard input/output and some useful library
programs, which were further linked with user program through a system software called linker. While there
was a definite improvement over machine !anguage approach, the serial mode of operation is obvnously not
very efficient. This results in low utilisation of resources.

4.3.2 Batch Processing
Utilisation of computer resources and improvement in programmer's productivity was still a major
prohibition. During the time that tapes were being mounted or programmer was operatmg the console, the

CPU was sitting idle.

The next logical step in the evolution of operating system was to automate the sequencing of operations
involved in program execution and in the mechanical aspects of program development. Jobs with similar

~ requirements— were batched together and run through the computer as a group. For example, suppose the

operator received one FORTRAN program; one COBOL program and another FORTRAN program. If he
runs them in that order, he would have to set up for FORTRAN program environment (loadmg the
FORTRAN compiler tapes) then set up COBOL program and finally FORTRAN program again. If he runs
the two FORTRAN programs as a - batch, however he could set up only once for FORTRAN, thus, saving
operator's time.

Batching similar jobs brought utlllsatlon of system resources quite a bit. But there were still problems. For
example, when a job is stopped, the operator would have to notice that fact by observing the console,
determine why the program stopped and then load the card reader or paper tape reader with the next job and
restart the computer. During this transition from one job to the next, the CPU sat idle. '

To overcome this idle time, a small program called a resident monitor was created which is always resident
in the memory. It automatically sequenced one job to another job. Resident monitor acts according to the
directives given by a programmer through control cards which contain information like marking of job's
beginnings and endings. commands for !oading and executing programs. etc. These commands belong to job
control language. These job control language commands are included with user program and data. Here is
an example of job control language commands.

$COB - Execute the COBOL compiler
$JOB - First card of a job
SEND - Last card of a job
SLOAD - Load program into memory
SRUN - Execute the user program
$ END
Dats FROM PROGRAM
l $ RUN
i SLOAD
USER'’S
H coB _ BE
$JOB

Figure 2: Card deck for Cobol Program for a simple batch system,




\..th sequencmg of program execution mostly automated by batch operating system, the speed discrepancy
_ between fast CPU and comparatively slow input/output devices such as card readers, printers emerged as a
" major performance bottleneck. Even a slow CPU works in the microsecond range, with millions of
instructions per-second. But, fast card reader, on the other hand, might read 1200 cards per minute. Thus,
the difference in speed between the CPU and its input/output devices may be three orders of magnitude or
more.

The relative slowness of input/output devices can mean that CPU is often waiting for input/output. As an
:xample, an Assembler or Compiler may be able to process 300 or more cards per second. A fast card
.eader, on the other hand, may be abie to read only 1200 cards per minute. This means that assembling or
compiling a 1200 card program would require only 4 seconds of CPU time but 60 seconds to read. Thus, the
CPU is idle for 56 out of 60 seconds or 93.3 per cent of the time.. The resulting CPU utilisation is only 6.7

. per cent. The process is similar for output operations. The problem is that while an input/output is occurring,
the CPU is idle, waiting for the input/output to complete; while the CPU-is executing. input/output devices
are idle. .

Over the years, of course, improvements in technology resulted in faster input/output devices. But CPU
speed increased even faster. Therefore, the need was to increase the throughput and resource utilisation by
overlapping input/output and processing operations. Channels, penpheral controllers and later dedicated
input/output processors brought a major improvement in this direction. DMA (Direct Memory Access) chip
which directly transfers the entire block of data from its own buffer to main memory without interve-.iion by
CPU was a major development. While CPU is executing, DMA can transfer data between high-speed
input/output devices and main memory. CPU requires to be interrupted per block only by DMA. Apart from

DMA, there are two other approaches to improving system performance by overlapping input, output and
processing. These are buffermg and spooling.

Buffering is a method of overlapping input, output and processing of a single job. The idea is quite simple.
After data has been read and the CPU is about to start operating on it, the input device is instructed to begin
the next input immediately. The CPU and input device are then both busy. With luck, by the time that the
CPU is ready for the next data item, the input device will have finished reading it. The CPU can then begin
processing the newly read data, while the input device starts to read the following data. Similarly, this can be
done for output. In this case, the CPU creates data that is put into a buffer until an output device can accept
it.

If the CPU is, on the average much faster than an input device, buffering will be of little use. If the CPU is
always faster, then it always finds an empty buffer and have to wait for the input device. For output, the CPU
can proceed at full speed until, eventually all system buffers are full then the CPU must wait for the output
device. This situation occurs with input/output bound jobs where — the amount of input/output relation to
computation is very high. Since the CPU is faster than the input/output device, the input/output device
controls the speed of execution, not by the speed of the CPU.

More sophisticated form of input/output buffering called SPOOLING, (simultaneous peripheral operation on
line) essentially use the disk as a very large buffer (figure 3) for reading and for storing output files.

CPU

Figure 3: Spaohing
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Buftering overlaps input, output and processing of asingle job whereas Spooling»allpws.CPU' to 6;2rln'p the
input of onc job with the computation and output of other jobs. Therefore this approach is better than

‘buffering. Even in a simple system, the spooler may be reading the input of one job while pfi'n‘ting‘.ihe output

of a different job.

4.3.3 Multiprograniming

Buffering and spooling improve system performance by overlapping the input, output and computation of a
single job, but both of them have their limitations. A single user cannot always keep CPU or I/O devices :
busy at all times. Multiprogramming offers a more efficient approach to increase system performance. In
order to increase the resource utilisation, systems supporting multiprogramming approach allow more than .
one job (program) to utilise CPU time at any moment. More number of programs competing for system
resources, better will be resource utilisation. : ‘ '

The idea is implemented as follows. The main memory of a system contains more than one program (Figure

4).

PRIMARY MEMORY

MONITOR -

Figure 4: Memory layout in multiprogramming environment

-The operating system picks-one of the programs and start executing. During execution prbcess (program) 1

may need some /O operation to complete. In a sequential execution environment (Figure 5a), the CPU would
sitidle. In a multiprogramming system, (Figure 5b) operating system will simply switch over-to the next
process (program 2). o :

PROGRAM 1 PROGRAM 2

(a) Execution in sequential programming environment



% | Opering sy

PROGRAM 1

P1 P1 P1

4 Jpnocmz

(b) Execution in multiprogramming environment
Figure 5: Muitiprogramming

When that program needs to wait for some /O operation, it switches over to Program 3 and so on. if there is no other new
program left in the main memory, the CPU will pass its control back to the previous.programs.

Multiprogramming has traditionally been employed to increase the resource utilisation of a computer system and to
support multiple simultaneously interactive users (terminals).

Compared to operating system which supports only sequential execution, multiprogramming system requires some form
of CPU and memory management strategies which is beyond the scope of this block.

Check Your Progress 1

1. What is a system call?
2. Define the essential difference between
(a) Spooling
(b) Buffering
3 What are the main advantages of multiprogramming ?

........................................................................................................................
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4.4 TYPES OF OPERATING SYSTEM

In this section, we will discuss general properties, types of applications advantages, disadvantages and basic
requirements of different types of operating systems.

4.4.1 Batch Operating System

As discussed earlier during batch processing envnronment it requires grouping of similar jubs which consist
of programs, data and system commands.

The suitability of this type of processing is in programs with large computation time with no need of user
interaction or involvement. Some examples of such programs include payroll, forecasting, statistical
analysis, and large scientific number crunching programs. Users are not required to wait while the job is
being processed. They can submit their programs to operators and return later to collect them.

But it has two major disadvantages:
(i) Non-interactive environment
(it) Off-line debugging.

Non-interactive environment: There are some difficulties with a batch system from the point of view of user.
Batch operating systems allow little or no interaction between users and executing programs. The time taken
between job submission and job completion in batch operating system is very high. Users have no control
over intermediate results of a program. This type of arrangement does not create flexibility in software
development.

The second disadvantage wnh this approach is that programs must be debugged which means a programmer
cannot correct bugs the moment it occurs.

4.4.2 Multiprogramming Operating System

Multiprogramming operating syste...s compared to batch operating systems are fairly sophisticated. As
illustrated in figure 5, multiprogramming has a significant potential for improving system throughput and
resource utilisation with very minor differences. Different forms of multiprogramming operating system are
multitasking, multiprocessor and multi-user operating systems. In this section, we will triefly discuss the
main features and functions of these systems.

Multitasking Operating Systems: A running state of a program is called a process or a task. A multitasking
operating system supports two or more active processes simultaneously. Multiprogramming operating
system is operating system which in addition to supporting multiple concurrent process (several processes in
execution states simultaneously) allows the instruction and data from two or more separate processes to
reside in primary memory simultaneously. Note that multiprogramming implies multiprocessing or

- multitasking Operation, but multiprocessing operation (or multitasking) does not imply multiprogramming.

Therefore, multitasking operation is one of the mechanism that multiprogramming operating system employs
in managing the totality of computer related resources like CPU, memory and 1/0 devices.

Multi-user operating system allows simultaneous access to a computer system through two or more
terminals. Although frequently associated with multiprogramming. multi-user operating system does not
imply multiprogramming or multitasking. A dedicated transaction processing system such as railway
reservation system that supports hundreds of terminals under control of a single program is an example of
multi-user operating system. On the other hand, general-purpose time sharing systems (discussed later in this
section) incorporate features of both multi-user and multiprogramming operating system. Multiprocessor
operation without multi-user support can be found in the operating system of some advanced personnel
computers and in real systems (discussed later).



Time Sharing System: It is a form of multiprogrammed operating system, which operates. in an interactive 'Operating System
mode with a quick response time. The user types a request to the computer through a keyboard. The Concepts
computer processes it and a response (if any) is displayed on the user's terminal. A time sharing system

allows the many users to simultaneously share the computer resources. Since each action or command in &

time-shared system take a very small fraction of time, only a little CPU time is needed for each user. As the

CPU switches rapidly from one user to another user, each user is given impression that he has his own

computer, while it is actually one computer sharéd among many users.

The term multitasking is described any system that runs or appears to run more than one application program
one time. An effective multitasking environment must provide many services both to the user and to the
application program it runs. The most important-of these are resource management which divides the
computers time, memory and peripheral devices among competing tasks and interprocess communication,
which lets tasking co-ordinate their activities by exchanging information.

Real-time Systems: It is another form of operating system which are used in environments where a large
number of events mostly external to computer systems, must be accepted and processed in a short time or
within certain deadlines. Examples of such applications are flight control, real time simulations etc. Real.
time systems are also frequently used in military application.

A primary objective of real-time system is to provide quick response times. User convenience and resource
utilisation are of secondary concern to real-time system. In the real-time system each process is assigned a
certain level of priority according to the relative importance of the event processes. The processor is
normally allocated to the highest priority process among those, which are ready to exXecute. Higher priority
process usually pre-empt execution of lower priority processes. This form of scheduling called, priority
based pre-emptive scheduling, is used by a majority of real-time systems.

4.4.3 Network Operating System

A network operating system is a collection of software and associated protocols that allows a set of
autonomous computers which are interconnected by a computer network to be used together in a'convenient
and cost-effective manner. In a network operating system, the users are aware of existence of multiple
computers and can log into remote machines and copy files from one machine to another machine.

Some of typical characteristics of network operating systems which may be different from distributed
operating system (discussed in the next section) are the followings: :

o Each computer has its own private operating system instead of running part of a global system wide
operating system. ‘ ’

0 Each user normally works on his/her own system; using a different system requires some kind of
remote login, instead of having the operating system dynamically allocate processes to CPUs.

. Users are typically aware of where each of their files are kept and must move file from one system
to another with explicit file transfer commands instead of having file placement managed by the
operating system. ' ’

The system has little or no fault tolerance; if 5% of the persomiel computers crash, only 5% of the users are .
out of business. '

Network operating system offers many capabilities including:

° Allowing users to access the various resources of the network hosts

] Controlling access so that only users in the proper authorisation are allowed to access particular
resources.

o Mal;ing the use of remote resources appear to be identical to the use of local resources

U Providing up-to-the minute network documentation on-line.
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4.4.4 Distributed Operating System

A distributed operating system is onc that looks fo its &5 like an ordinary centralised operating system ‘\but
runs on multiple independent CPUs. The key concep: kore is transparency. In other words, the use of
multiple processors should be invisible to the user. Another way of expressing the same idea is to say that
user views the system as virtual uniprocessor but not as a collection of distinct machines. In a true distributed
system, uscrs are not aware ol where their programs are being run or where their files are residing; they
should all be handled automatically and cfficiently by the operating system.

Distributed operating systems have many aspects in common with cenralised ones but they also differ in
certain ways. Distributed operating system, for example, often allow programs to run on several processors
at the same time, thus requiring more complex processor schedulmg (scheduling refers to a set of policies and
mechanisms built into the operating systems that controls the order in which the work to be done is
completed) algorithms in order to achieve maximum utilisation of CPU's time.

Fault-tolerance is another area in which distributed operating systems are ditferent. Distributed systems are
considered to be more reliable than uniprocessor based system. They perform even if certain part of the
hardware is malfunctioning. This additional feature supported by distributed operating system has enormous
implications for the operating system. '

Advantages of Distributed Operating Systems
There are three important advantages in the design of distributed operating system.

1. Major breakthrough in microprocessor technology: Micro-processors have become very much
powerful and cheap, compared with mainframes and minicomputers, so it has become attractive to
think about designing large systems consisting of small processors. These distributed systems -
clearly have a price/performance advantages over more traditional systems.

2. Incremental Growth: The second advantage is that if there is a need of 10 per cent more computing
power, one should just add 10 per cent more processors. System architecture is crucial to the type of
system growth, however since it is hard to give each user of a personal computer another 10 per
cent.

3. Reliability: Reliability and availability can also be a big advantage; a few parts of the system can be
down without disturbing people using the other parts; 'On the minus side, unless one is very careful,
it is easy for the ccrapunication protocol overhead to become a major source of inefficiency.

Check Your Progress 2
1. Define the essential differences between the time-sharing and real time operating systems.
2. List the main differences between network operating systems and distributed operating systems

..........................................................................................................................
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4.5 SUMMARY Concepts

Operating system is an essential component of system software, wl #:h consists of procedures for managing
computer resources. Initially computers were operated from the #roat console. System software such ag
Assemblers, Loaders and Compilers greatly improved in softwarc®zvelopment but also required substantia]
set-up time. To reduce the set-up time an operator was hired and similar Jjobs were batched together.

Batch systems allowed automatic Jjob sequencing by a resident monitor and improved the overall utilisation of
systems greatly. The computer no lon ger had to wait for human operations - but CPU utilisation was still low
because of slow speed of 1/O devices compared to the CPU. A new concept buffering was developed to
improve system performance by overlapping the inps*, output and computation of a single job. Spooling was
another new concept in improving the, CPU utilisaf’ .q vy overlapping input of one job with the computation
and output of other jobs.

Operating systems are now almost always written in higher level languages (C, PASCAL etc.). UNIX was the
first operating system developed in C language. This feature improves their implementation, maintenance
and portability.

Operating system provides a number of services. At the lowest level, there are system calls, which allow &
running program to make a request from operating -system directly. Ata higher level, there is a command
interpreter, which supports a mechanism for a user to issue a request without writing a program., '

In this unit, we began with tracing the evolution of operating system through serial processing, batch
processing and multiprogramming. On the basis of these characteristics different types of operating systems
were defined and characterised.

At the end we presented a list of clear trends which will dominate the future operating system design.

4.6 MODEL ANSWERS

Check Your Progress 1
1. System call is a way of acting with the operating system of a computer
2. Buffering and spooling both tries to smooth out speed difference between the CPU and I/O devices,
however, buffciizg docs it only for a single job ongoing which SPOOLING allows input of one job
with the computation and output of other job. :
3. The main advantages of multiprogramming are:
* better CPU throughput

® better resource utilisation
¢ can supports multiple users at a time.

Check Your Progress 2
1. The essential difference between time sharing and real, line systems are the way CPU time is

utilised. In time sharing system jobs are given cqual time slot, whereas in real time system a priority
scheme exist and the jobs with high priority are given time first. )
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Network Operating System

Distributed Operating System

° A singie machine has its own O.8S.

All the machines are controlled by single ¢

. The files of a user are kept on
known machine.

Files of a user can be on any machine. but
will get it as and when desired.

J Less efficient processing

More efficient processing.

4.7 FURTHER READINGS

1. Milan Milenkovic, Operating Systems Concepts and Design, Second Edition, Tata McGraw-Hill.
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BLOCK INTRODUCTION

‘rom the computers bemb used usually in an nolatcd manner, the trend is now of a greater communication
~etween computers. It is'expected that with better communication infrastructure becoming available in this
ountry, network based computers will be present everywhere. A computer could be connected to other
‘omputers in the samée room in the same building inithe same campus in the same town in the same country or

ven globally. As an or"amsatlon becomes more dependent on computer systems, it must plan for
_Hntingencies.

his block provides a briet' glimpse of the Fundamentals of Data Communication, which arc covered in
“nit 1. The various networking technologics and some of the emerging trends are covered in Unit 2

I'he third unit covers some methods of cryptography and various W'ays in which loss or corrupti(m of data can
ozcur and the means by which this can be avoided. Amongst other topics, it specifi cally deals with DES and

RSA-129. Both terms have recently received lot of attention. While the unit directs itself towards PCs, the
easures discussed are useful for larger systems even more.

The fourth and last unit of this block touches upon the area of computer virus. While the list of new virus(es)
ever increasing, the unit tries to give a flavour of the widespread variety.

» most of the units of this block instead of check your progress, we have given some open ended questions,
s this block-is just an introduction to the concept and terminology in the arcas of data communication,
Atworking and computer security. This is fundamentally the fastest growing area, therefore, for keeping

surself upto date on various concepts, you must refer to compuiter journals. You will also undergo a detailed
- aurse on data communication:and networks later in your programme.






UNIT 1 FUNDAMENTALS OF DATA
COMMUNICATION
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1.0 Introduction

1.1 Obicctives

1.2 Definitions

'3 Concept f Data Communication

1.3.1 Data Communication Codes (Data encoding)
1.3.2  Communication Speed or Rate

1.3.3  Private vs. Switched Chanuels

134  Analog and Digital Transmission

1.3.5  Parallel and Scrial Transmission

1.3.6  Tariff

1.3.7  Communication Protocols/Standard
1.4 Data Communication Modes

1.4.1  Synchronous and Asynckronous Transmission
142 Simplex, Half Duplex and full Duplex Communication

1.5 Communication Hardware
1.51 Sender/Receiver Hardware
1.52  Communication Devices
1.52  Communication Channcls

1.6 Summary

1.7 Maodel Answers

1.8 lrurther Readings

1.0 INTRODUCTION

A standalone computer in today’s context is not very useful, but coupled with communication technology, it
opens up an enormous repository of information to its users. Information is carried in data communication
systems as signals between two or more points, which could be at.a distance of a few inches or several
thousand kilometers. -

These signals are subjcct to various eftects while they are in transit which alter their characteristics to some
degree. The duta communication technology ensures that information between two communicating entities is
transterred in a reliable and orderly manner.

1o understand transmission one needs to study electrical form that messsages take while they are in transit
and of media and communication technologies that ensure error-free transmission. In our subsequent units
we wonld be discussing the basic concepts of electronic communications.

Data Communication is also well known as DATACOMM.

1.1 OBJECTIVES

Atthe end of thic unit. you would be able to:
1}
+ Define the basic concepts of Data Communication
o Define various terminology of Data Communication
« Siate the fuctions of the following Data Cornmunication Hardwarc
= Nodes and Workstations
o Modem and Codes, Multiplexers and Communication Channels
¢ Doscribe the implecation of Data Communication.



1.2 DEFINITIONS

in data communications, four basic tzrms ~ Data, Signal, Signalling and Transmission are frequently used.
Data are entitics that convey meaning. Information is obtained by processing data using desired functions.

Signals are eleciric or electromagnetic encoding of data, and signalling i, propagation of signal along suitable
communication medium.

Yransmission is communication of data achieved by the propagation and processing of signals.

1.3 CONCEPT OF DATA COMMUNICATION

The concept of Data communication evolved from sharing the computation power of a computer-alongwith
various resources available in a computer environment such as printers, Hard-disk etc. With increasing
demand for exchange of information across the globe, the need for data communication has increased in
many folds. Due to physical constraints involved in connecting two remote points physically data
communication has emerged as an instant solution. .

1.3.1 Data Communication Codes (Data encoding)

The first step towards understanding communications is td look at computer data at its bage level. As all of ~
us know computer and computer device manage store and exchange data using electronic pulses or digital
signals, that come in two varieties, the binary digit '0' indicates the absence ("OFF") and '1" indicates ("ON")
the presence of electric current. A series of ONs.and OFFs in various combirations can be sent on the
communication channels to represent any character.

Every character (letter, numeral, symbol, or punctuation mark) is composed of a group of bits called codes.
To avoid incompatibility between systems, the computer industry has created a number of standards that
establish relationships between bit combinations and their corresponding characters.

The most widely used codes are the American Standards Code for Information Interchange (ASCII) and the
IBM standard, Extended Binary Coded Decimal Interchange Code (EBCDIC). Some of the characteristics of
these codes are tabled below:

Data Codes
: . ASCII EBCDIC
Controlling authority ANSI IBM
Number of bits ’ 7 8
Number of Character 128 - 256

To ensure successful transmission of data between two points, the sender and receivers should use the same
code, or they can use translators to ajd in communication. Translaticn is data communication software,
which translates the sender's data into the codes receiver understands,

1.3.2  Communication Speed or Rate

The speed at which two computers exchange or transmit data is called communication rate on transmission
speed. The unit of measurement of the speed is measured using bps.(bits per second) or baud (both are not
same, for more details refer to further readings). Normal PC based communication station transferred, using
300 to 9600 by.s, whe reas a main frame computer uses 19,200 baud or more.



1.3.3 " Private vs. Switched Channels ' Fundamentals of Data
(3qmmunicalion

Private leased lines are permanently connected circuits between two or more points. These lines are available -
for private use by the leasing party. ‘

Whereas, switched lines or dial up lines are available to any subscriber. For example, telephone connection
in our home or office is a dial up lines as we dial up a number to use a particular circuit. '

1.3.4 Analog and Digital Transmission

One of the fundamental concepts in data transmission is to understand the difference between Analog and
digital signals.

An analog signal is one that is continuous with respect tc time, and may take on any value within a given
ranre of values. Human voice, video and music when converted to electrical signal using suitable devices
produce analog signals. '

A digital signal may take on only a discrete set of values within a given range. Most computers and
computer-related equipment are digital.

Irrespective of original form of the message, the actual transmission of signal could be either in analog or
digital form. Figure 1 shows the two possible transmission methods: '

Originating ' Data Data 'kcceiving
Communication ! Communication . Communication Communication
Device i Device ' Device System

: Communication
Channel
Digital Signal Analog Signal Digital Signal
< > . ¢ > . ¢ R

(a) Analog ’fransmission

' Originating ‘ Line | ‘ Line’ " Receiving
Communication * Interface- . ‘ : Interface Communication
Device . ' » System

Digital Signal

(b) Digital transmission

Figure 1: Analog and Digital Transmission

1.3.5 Parallé} and Serial Transmission

In parallel data transmission, there are muitiple parallel lines connecting the transmitting and receiving units.
Each wire carries a bit of information. Normally, one character is transferred in one go.

In serial datrtvti'anﬁsmission, each bit is sent sequentially onc after another and it requires only one pair of wire
conductors for coftnecting the receiving and transmitting units.

Serial transmission is slower than parallel transmission, which is used primarily for transferring data between
devices at the same site; most common example is Personal Computer to Printer. Communication between
computers is almost always scrial.
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1.3.6  Tanff

As most of the data communication is being done using public channels such as telephone lines, a user has to
pay for the use of channels. The tarifTis gencrally calculated taking various data communication parameters
into consideration such as volume of data tronsferred. communication rate or transmission rate and time
utilised on the communication channel.

1.3.7 Communication Protecols/Standard

There are several manufacturers of computer hardware and software across the globe. For successful data
communication these products should be compatibles with cach other or they should conform to certain set of
rules so that any one carf use them. These sets ol rules are known as communication protocols or
communication standards.

In other words. protocols arc technical customs or guide lines that govern the exchange of signal transmission
and reception between equipments.

Communication protocols are usually defined and approved by some international body such as 1SO, CCITT
or IEEE. At times protocols defined by certain manufacturer of computers or networking products become
so widely accepted. that they become "defactor’ standard even though these protocols may not have approval
of any standardisation body. Some of the Functions that communication protocol regulates are:

° Control of information transfer
. Structure and formats of data
. Ervor recoverics

. Re-transmission control

. Interface management.

Only communication devices using same protocols can communicate with each ather.
To make sure that the bits (or characters) are transmitted through the channel or line, we need a link level

protocol between two computers. Some of the main functions to be performed by such a link level protocol
are:

e  Assuring the data to be transmitted is split into data blocks with beginning and ending markers. This is
called framing and the transmission block is called a frame.

e Achicving data transparency. This allows a link to treat a bit pattern, including normally restricted
control characters. just as pure data.

o Controlling the flow of data across the Link. 1t is essential not to transmit bits faster than they can be
received at the other end. Otherwise. the receiver overflows and the data is overrun, or all buffering
capacity is used up. Lrading to loss of data.

e Controlling errors. This involves detection ot vitors ustng some kind of redundancy check. Italso
involves acknow ledgement of correctly received messages and requests for retransmission of faulty
Messages.

There are basically two classes of link protocols. They are. Blnary SYNchronous protocols (BISNYC) and.
High Level Data Link Control (HDLC) protocols. BISYNC is based on charecter control. where as HPLC is
a bit oriented protocol. In fact. HDLC is widely used in most link protocols of computers. You can refer to
further readings for more details. :
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1.4 DATA COMMUNICATION MODES ' Communication

Sc far, we have discussed « method of transferring information electronically and various aspects involved in
it such as, data characters in a computer system are represented using codes such as ASCII or EBCDIC. The
exchanbc of information can .ake place only if a facility exists to send information from one end, character
by character and also to-reccive it at the other cnd in the same manner or sequence. Hence wc must
understand now the characters arc transmitted over the transmission medium.

1.4.1 Synchronous and Asynchronous Transmission

The mode of transmission is the way in which coded characters arc assembled for the process »f .ransmission
and permits the receiving devices to ldentify where the coding for each character begins and ends within the
torrent of bits. When two computers communicate, they must have a way to synchronise the *low of data so
that the receiving computer can read at the same speed at vhich the sending computer transmits. The
principai inodes are asynchronous and synchronous.

In synchronous transmission characters are ‘ransmitted as zroups, with contro! characters in ‘he Seginning
and ar the end o1 the bt train. The transmission and receiving intervals between ach bit are precisely timed
permitting the grouping of bits intc identifiable characters. In synchronous mode, -ntervals hetween
characters are uniform wiik no space between consecutive bytes.

lu asyncironous ‘ransmission, ach character is transmitted separately, that is, one sharacter at a time. Zach
character hegins with a start bit. which tells the receiving device where the character coding begins and ends
with a step bit, which tells the receiving device where the character coding ends. Then, the next character is
sent, with start and stops bits. The start and stop hits and he interval of time between consecutive characters
ailow the receiving and sending computers to synchronise the transmission. The parity bit is used for error
checking while transmission of daa.

Asynchronous communication is slower than synchronous communicaticn, it is typically used at
communication rates lower than 2400 bits per second. Asynchronous communication does not require
complex and costly hardware as -equiied hy synchronous communication and is the mode most widely used
with microcomputers.

Transmission of a caractor

o~
N

Idle State :

of the line ;
. 2 STOP
bits
——  BbitofData —> I l
...... 2 X . I .
START bit 1 0 0 1 1 o Parity bit (odd or even)

Figure 2(a): Asynchronous Serial Transmission \
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_SYN character ___ - e _Data character >

Figure 2(b) Synchronous data character format

1.4.2 Simplex, Half-duplex and Full duplex Communication

The direction in which information can tlow over a transmission path is determined by the properties of both
the transmitting and the receiving devices. There are three basic options:

In Simplex mode, the communication channel is used in one direction. The receiver receives the signals
from the teansmitting device. A typical use is to gather data from a monitoring device at a regular interval.
The simplex mode is rarely used for data communication.

In Half-duplex mode, tn> communication chaiael is used in both directions, but only in one dircction at.a
time. This requires the receiving and transmitting devices to switch between send and receive modes after
each transmission. The an:lognus example of this mode is the old wircless system (walkie-talkie), which is
used in either transmit modc or receive mode.

In Full-duplex mode, the cc.amunication channel is used in both directions at the same time. Typical

example of this mode of *. sazmission is the telephone in which both parties talk to each other at the same
time.

>
(a) Simplex A to B only
—»
(b) Halt Duplex A to B or B to A one at a time
< |

(¢) Full-Duplex A to B & B to A simultaneously

Figure 3: Modes of Transmission
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1.5 COMMUNICATION HARDWARE . " Commonenion

We have already discussed about communication codes: units of measurement; data transmission methods
such as analog and digital, parallel and serial; data transmission modes such as synchronous and
asynchronous simplex, half duplex and full duplex; the transmission crror control and prot-cols. All this was
intended to lay the foundation for all that is going to fullow.

For any basic data communication process, the hardware required arc.

e Sender and Receiver Hardware
o  Communication-Device$
e Communication Channels

1.5.1 Sender and Recciver Hardware

Sender and Receiver Hardware are used for handling Communication messages, data transfer etc.
z

Nodes and Workstations

Data Communication is dene using various communication devices and software inter-connected for
information exchange. The devices used to communicate in a data communication network are called
‘workstations. These workstations may include computer, terminal, printer, and any other communication
devices. Each workstation is connected to something called a data communication network node.

-~

COMMUNICATION
NODES

WORKSTATION

Figure 4: Communication nodes and workstations

Multiplexer

As the name suggests, multiplexing is a form of data transfer in which communication channels are used for
scveral transmissions. For example, the telephone lines that we use for daily conversation can carry
hundreds or even thousands of conversation using multiplexing. In other words. mulnplu(mg 1s a type of
network machanism, which allows a number of simple, low cost terminals to share cach communiggpen-im,
intriduces almost no delay and requres no special computer software.



Computcr
Fundamentals:
Communication,
Ne’working, Security

12

(a) By dividing a communication channel into various smaller scgments of diffcrent frequencics.

Multiplexing is used in two ways:

Figure 5: Multiplexing

() By.taking groups of bytes from each sender and send or transmit them over the channel one after
ahother. Each group of data bytes are tagged at the beginning and end with start and end control
bytes. These by data bytes are then separaced at the receiving end and sciii to their respective places.
This type of multiplexing occurs so fast that the transmission seems continuous.

1.5.2° Communication Devices

There are several types of communication devices or interface used in data communication. These interfaces
are connection between receiver and sender hardware involved in data communication and the
communication network. Some of these interface or communication devices are discussed below.

(a) Modems or modulator - demodulators are devices which convert digital signals into analog for
transimssion over analog transmission facilities such as telephone lines. At the receiving end, a
modem performs the reverse function and converts analog signal into digital form.

> Time
Analog Signals



> Time
Digital Signals
. < %
A B
- Communication
/™ Network : (S—
) [ sesses | !......——b P eecses | —
Computer Modem Mcedem Computer

Figare 6: Data Communication using Modem

Ling drivers are simple devices used to transmit digital signals over short distances. These devices do not
modalate or demodulate signals, but use filters to recuce thz high frequency compenent and the moditied
signal is transmitted directly over the media. These devices are used Jor distances of upto 1 Km and can
achieve data transfer rates of upto 19200 bps. 1t is mainly used for connecting VDU terminals with a
computer at a distance of more than 100 feet or so.

(b) Codec performs thz opposite function of a modem.

A communication Port/adopter is a connector on the computer which is used as an entry to departure point for
data involved in Data communication. A common type of communication port is RS 232C. This adapter is
used for transfer of data between the computer and the telephone line. During transmission process it adds
start and stop bits and controls the communication raie or it strips the start and stop bits where it receives
data.

1.5.3 Communication Chaanels

The most basic hardware required for communication is the media through which data is transferred. There
are several types of media, and the choice of the right media depends on many factors such as cost of
transmission media. efliciency of data transmission and the transfer raie. We will describe some of these
transmission media.

Fundamentals of Data

Communication
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i ‘Two wires open line

This is the simplest of all the transmission media. It consists of a simple pair of metallic wires made of

copper or sometimes aluminium of between 0.4 and | mm diameter, and each wire is insulated from the
other. There are variations to this simplest form with several pairs of wire enclosed in a single protected
sable called a multicore cable or moulded in the form of a Nat ribbon. '

This type of media is used for communication within a short distance, upto about 50 meters, and can achieve
a transfer rate of upto 19200 bits per second.

2. Twisted Pair Cable

A twisted pair consists of a pair of insulated conductors that are twisted together. The advantage of a twisted
pair cable over the two wire open lines is, it provides better immunity from spurious noise signals. As the
two wires are close to €ach other, both pick cqual interferences caused by extraneous signal sources and this
reduces the differential signal added by the noise.

Twisted pair cable is used for communications upto a distance of | Km. and can achieve ransfer rates of 1-2
Megabytes per second. But, as the speed increased the maximum transmission distance is reduced, and may
require repeaters. '

Twisted pair cable is widely used in telephone networks and is increasingly being used for data. The hub
based ethernets normally use UTP (Unshiclded Twisted Pair) cable.

3. Coaxial Cable

A coaxial cable consists of a solid conductor running coaxially inside a solid or braided outer annular
conductor. The space between the two conductors is filled with a dielectric insulating material.- Larger the
cable diameter, lower is the transmission loss. and higher transfer speeds can be achieved. A coaxial cable
can be used over a distance of about | Km. and can achieve a transfer rate of upto 100 megabytes per sccond.

A coaxial cable is of two'types - a 75-ohm cable. which is used by the cable TV operators and the 50-ohm
cable which is used in high-speed broadband networks and are low loss cables.

4. Fibre Optic Cables

A fibre optic cable carries signals in the form of fluctuating light in a glass or plastic tibre. An optical fibre
cuble consists of a glass or plastic core surrounded by a cladding made of a similar material but with a lower
refractive index. The core transmits the light while the change in refractive index between the core and the
cladding causes total internal reflection. thus minimising the lpss of Light from fibre.

As light waves gave a much wider bandwidth than the electrical signal and are immune from eletromagnetic
interferences. this leads to high data transfer rates of about 1000 megabytes per second and can be used for
long and medium distance transmission links.

S. Radio, Microwave and Satellite Channels

Radio. microwave and satellite channels use clecttomagnetic propagation in open space. The advantage of
these channels lics i, their capability to cover large geographical arcas and being inexpensive than the wired
installation.

The demarcation between radio. microwave and satellite channels lie in the frequencies in which they
operate. Frequencies below 1000 MI1Z are radio frequencies and higher are the microwave frequencies.

Radio frequency transmission may be below 30 MHZ or above 30 MHZ and shus the techniques of
transmission are different. Owing to the characteristics of the ionosphere. frequencies below 30 MHz are
reflected back towards the surface of the earth. Above 30 MHz propagation is on line-of-sight paths.
Antennas are placed in between the line-of:sight paths to increase the.distance. Radio frequencies are prone

- to attenuation and. thus. they require repeaters along the path to enhance the signal. Radio frequencies can

achieve data transfer rates of 100 Kbps to 400 Kbps.



Microwave links would invariably use line-of-sight transmission with repeaters placed every 100-200 kms.
Microwave links can achieve data transfer rates of about 1000 Mbps. ‘

Satellite links use microwave frequencies is the order of 4-12 Ghz with the satellite as a repeater. They can
achieve data trans‘er rates of about 1000 Mbps.

Check Your Progress
1. Match the followings:
(i) Modem (a) baud
(i)  Multiplexer (b) formalised set of rules
(iii)  Protocols (c) translate data into same type of code
(iv)  Translators (d) volume of data transferred
(v)  Communication Rate (e) data link
(vi) Communication tariff ()  Multiple Communication in one
channel at the same time.
Fill in the blanks
2. . allows one single communication channel to send many transmission at the same
time.
3 Any-subscriber cCan Use .......c.oeeeeriinrrnennrnnnnn. lines
A e is a unit of measurement for communication rate.

1.6 SUMMARY

In this Unit we discussed the concept of data communication and defined the process involved in data-
communicaiior:. Various Hardware and Software concepts were also discussed alongwith the digital and
analog signals. It also introduced you to various types of communication devices and also explained what is
transmission protocols.

1.7 MODEL ANSWERS

L)) G)d (i) ), (@(v)(), (v)(a), (vi)(d)

2. Multiplexer 3. Switched line/ dial up 4. Baud/bps

1.8 FURTHER READINGS

I William Stalling, Data and Computer Communication, Prentice-Hall of India.

Fundamentais of Data
Communication
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2.0 INTRODUCTION

Today, Computer networks form the backbone of most enterprises big or small around the world. Computer
networks allow people remote to the computer to access the information available to that computer.
Computer networks are being used to provide resource sharing between systems separated from a few feet to
thousands of kilometres. This technology is leading many corpor_tions to take advantage of the reduced price
and increased performance in the workplace. In the first unit of this block, we have discussed about the data
communication, in this unit we will discuss networking and how it plays an important role in information
exchange Impact of networking be it LAN or WAN and data communication has been felt across the globe,
in various sectors such as education, medicine, transport, etc. This trend of information sharing in most
sophisticated manner has completely revolutionised the concept of communication. It brings with it increased
access to people in different fields.

2.1 OBJECTIVES

At the end of the unit, you would be able to:

define LAN and WAN

define topology and its characteristics

define a Network Interface Unit (N1U) and communication architecture

list and distinguish devices used in WAN

understand and define the trends and impact of data communication and networking in various fields
describe E-Mail, EDI, present scenario of networking in India and explain the term Internet.

¢ @ ©® © . & @



2.2 NETWORK CONCEPT AND CLASSIFICATION  Computer Networis

& Emerging Trends

Communication using computer has brought a revolution in the world of Information Technology,
particularly in the field of personal computer, We have always heard of networking or the term network. A
network is a way or means of transmitting or receiving (exchange) information from one or more sources.

As an example, car salesmen, after years in the business, have developed a network of associates. When the
car salesman needs to locate a car to make a sale, the car salesman calls out to his network to retrieve
information on the location of the car. Employment agents also develop a network. Their customers become
their networks. Employment agents will frequently keep in touch with their clientele for possible openings or
to locate a candidate for an opening. Without the capability of networking, these two people would have a
difficult time. It is the same in computing. Networks provide the means for locating and transporting
information. ’

In computing networks, the origin of the information request utilises the services of a network to locate and
return the information. This is done with addresses. In the two previous examples of the car salesman and
the employment agent, a telephone number can be considered the address of their associate or client.
Addresses in computer networking are used in the same manner. These addresses identify the network
resource. Theru are two popular architectures for networking - hierarchical and peer.

Peer networking does not need pre-defined network addressing. Instead, each resource on the network is seen
as a peer. Each network resource is a peer to the other network resources. When a new network resource

Joins the network it introduces itself and notifies its peer of any other network resources that it knows about -
peer networks are open and share network information.

The entire computer network can be classified into two broad categories (However, elaborate categorisation
exists). They are:

(a) LAN (Local Area Network)

()  WAN (Wide Area Network)

2.3 LOCAL AREA NETWORK (LAN)

As number of sysie.s grows within an organisation, a need is felt for sharing expensive resource and
exchanging data and information between systems. This need of information exchange and resource sharing
within an organisation has resulted in devélopment of Local Area Network or LAN.

A LAN is a data communication network, which connects many computers or workstations (computers
terminal, printer etc.) and permits exchange of data and information among them, within a localised area,
typically confined to a building, or a cluster of buildings. The distance between two communication points
connected on the same LAN channels, is usually upto 02-05 kmis.

LANSs are not rigidly defined but tend to share most of all of the following characteristics:

(a) All the connected devices in the nétyvork sharegthe transmission media.
- (b). Each device connected-in the netwprk can efther operate standalone or in the network.
(c) Area covered is small.’

»

(dY¥ Data transfer rates are high, usuaily 1Mbps?100Mbps. (Million of bits per second)
(e) Each device cnqnéptcd in the nctwork can esguaungcate with any other device in network.

) Cost of setting'up the network is ustally low.
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2.3.1 LAN Topology

A network topology refers to the physical layout of the network in which all the devices are connected. This
includes all the hardware that makes up the network._The points of connection to the network by the stations
are called Nodes or link stations. There are several types of topographical design and strategies used to
implement LAN. The majority of these are based on three types of topologies:

(a) Star
(b) Bus
(c) Ring

Each topology has its advantages and disadvantages.
Star Topology

A star topology is shown in Figure 1. In this topology, a number of stations are connected directly to a central
station or controller. Communications on the connecting links between the stations and the central station of
a star topography can be bi-directional and are point-to-point. A station on this type of network passes an
information frame to the central controller, which then forwards the information to the destination station.
The central controller manages and controls all communications between stations on the network.

NODE

Figure 1: Star Network

Failure of a station on a star network is easy to detect and can be removed from the network. However,

failure of the central controller will disable communication throughout the whole network.

Bus Topology

A bus topology is shown in Figure 2. All stations are connected to a single communication line. This single
communication line is referred to as a bus. Information frames originating at a station are propagated away
from the station in both directions on the bus. Each station on the bus interrogates the information frame
destination address field for its own address. If the destination field does not match the station’s address, the
station discards the information frame back on to the bus. If the destination address matches the station
address, it accepts the information frame and processes the frame.

An extension to the bus topology is tree topology and is depicted in Figure 2. Tree topology extends the
branches of the bus topology allowing more stations to access the bus.

3 e o s

Figure 2 ()
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(b)
Figure 2: (a) Bus Network (b) Tree Network
On'a bus or tree network, there is no central point for management and control. These functions are

distributed to each station on the bus. A break in the bus can be difficult to locate but limits the range of
communications between stations that traverse the broken point.

Ring Topology

Figur'é 3: Ring Network

A ring topology is shown in figure 3. L.ocal area networks that have dach station attached to an adjacent
station using point-to-point links form: a physical ring. Each station attached and active to the ring
regenerates the information frame, theu re-transmits the informati~n frame on the ring. The ring itself is
logically circular and the information travels in one direction.

Failure of a station in a ring topology disrupts the ring because the information frame is not regenerated.
Additions or deletions of stations to the ring can be disruptive, if the changes are not managed properly.

2.3.2 LAN Access Method

A discipline must be imposed on devices connected to the network to ensure a contrilled access to the midia,
Access method are the means or ways by which stations actually gain the use of the common channel o

transmit messages. The right to transmit is an issue inly in brodcast where workstations share a signal
channel. .

8
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Many techniques have been proposed, but two of these are commonly used

(i) Carricr-Sense Multiple Access with Collision Detection (CSMA/CD)

(ii) Token passing

CSMA/CD

CSMA/CD access method is used with bus networks. The bus operates in a Multiple Access (MA) mode. A
node is allowed to transmit on the bus, if it senses that the medium is free (carrier sense). Occasionally two or
more nodes may simultancously sensc that the medium is free and begin to transmit. This creates a collision,
as the contents of transmitted information frames will collide resulting in corruption of the information frame.
This collision is detected (collision detect) by the transmitting node. The two (or more) nodes involved then
wait for a further short random time interval before trying to retransmit a frame once again.

Token Passing

Another way of controlling access to a shared medium is by the use of a control (permission) token. The
control token is passed from one node to another according to a defined set of rules understood and adhertd to
by all nodes. A node may transmit a frame when it is in possession of the token and after it had transmitted
the frame, it passes the token to the next device in a predetermined sequence. :

Figure 4: Token bus

In token passing, a logical ring of all nodes connected to the physical medium is first established and a single
token is generated: the control token passes from one node to another traversing the logical ring. The token.
keeps on circulating the logical ring until it is received by a node wziting to send a information frame. After
receipt of the token, waiting station transmits the waiting frames on the physical medium after which it passes
the control token to the niext node in the logical ring.

For token passing, the physical medium need not be a ring topology, it can be used to control access to a bus -
network also.
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Figure 5:-Ring Token

2.3.3 Communication Architecture for Networks

The task of achieving data communication is a Herculean one. Instead of using entire data communication as
a single module, the task is broken intc various subtasks. And each subtask operates separately by different
layers of the communication architecture.

Systems that follow the OSI (Open System Interconnecting) staridard are said to be open to one another at
different layers and thus called open systems. The communication architecture specifies independent layers
that contain modules for performing defined functions. The architecture defines the functions of the module
and relationship between them. Each layer in an open system, which communicates with its equal in another
open system by using protocols defined in OSI standard.

OSI Reference Model

APPLICATION
PRESENTATION
SESSION
TRANSPORT
NETWORK
DATA LINK

PHYSICAL

Figure 6: Seven layers of the OS] reference model

)

The OSI reference model was accepted by 1SO as an internatiional standard in 1983. The details on these
layers will be dealt with in Jater courses. However, a brief int roduction of these layers is presented here.

Application Layer: This layer supports semantic exchanges Ibetween applications existing in open systems.
This layer also provides access to the lower OSI functions andi services.

Presentation Layer: This layer concerns itself with the represientation of the data to the end user or
application. This includes data conversions and code translation (e.g. ASCil 1o EBCDIC).

Introduction i 3&‘5
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Session Layer: This layer provides the mechanism for organising and structuring imeraction between
applications and/or devices.

Transport Layer: This layer is responsible for transparent and reliable transfer of data. The lower layers
handle the attributes of the transfer medium.

Network Layer: This layer is the agent for establishing connections between networks. The standard also
includes operational control procedures for inter-network communications as well as routing information
through multiple networks.

Datalink Layer: This layer provides the functions and protocols to transfer data between network resources
and to detect errors that may occur in the physical layer.

Physical Layer: This layer defines the mechanical, electrical, functional and procedural standards for the
physical transmission of data over the communications medium. '

As we have seen communication architecture is a common set of rules that define the rules on which all
connected nodes in a network should communicate with each-other. The communication architecture defines
two kinds of relationship between functional modules, interfaces and protocols.

. . . C . o
Interfaces are rules for communicating or exchanging information between dissimilar modules are process,
whereas protocols are rules for communication between similar types of ;odules or process.’ :

The following figure explains the difference between interface and protocols.

Protocol

Interface

Figure 7: Interfaces and Protocols
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2.3.4 LAN Hardware and Software Introduction to
. Computer Networks

As we have seen so far, to realise a LAN process, several functions are to be performed. These are so & Emerging Trends

specialised in nature that they require hardware specially built for such purpose. Here we will discuss briefly
the basic hardware components of LAN, these are:

(a) Transmission channel

(b) Network Interface Unit (NIU)

(c) Servers

(d) Workstations

(a). Transmission Channel

Geivrally following four types of channels are used for data communication in a LAN. These are already .
discussed in section 1.5.3.

(b) Network Interface Units (NIU)

Network interface units connect each device in the LAN network to shared transmission device. It contains
the rules or logic to access the LAN. NIU is also used to implement LAN protocols and for device
attachments. Its function depends on the type of topology used in LAN.- In microcomputers, NIU may be
installed as an-add-on card.

(c) Servers

One of the major benefits of implementation of LAN is sharing expensive resources such as storage devices,
printer etc. This is achieved through providing servers on the LAN. It is a dedicated computer, which
controls one or more resources. ThlS contains both hardware and software interface for LAN. Three major
categories of servers used in LANSs are:

(1) File Server

(i) Printer Server

(iti) Modem Server

In a networking file server is uscd to share storage space for files. Besides providing storage space for files in
a LAN environment, it is used for taking periodical backup, and also to provide gateway to other servers
within and between LANs. :

Similarly printer server is used to handle printing works of all workstation connected in the network.

In LAN environment also modem is required to get connected to other network or simply to use a telephone.
A modem server is used to share few telephone lines and modems by all connected workstations in a network.

2.3.5 LAN Software/Operating System

As the name suggests, LAN Operating System is required to operate on the LAN system, manage the
tremendous work load with a number of various types of server attached to it. It has basncall¥ two aspects
(i) Server software (ii) workstation software. As in case of other multi-user operating systems, LAN
operating system also facilitates the sharing of expensive resources such as printer, storage space etc. among

all LAN users, provides sccurity for data and permits connection to other networks.

There are various types of LAN operating system for example Novel Netware, WINDOWS NT, etc.

23
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2.4 WIDE AREA NETWORK

As the name suggests, WAN spread across countrics and continents, satellites being one of the transmission
media.

A Wide Area Network or WAN, is a network that links separate geographical locations. A WAN can be a
public system such as the Public Switched Telephone Network (the PSTN) or one of the various packet
switched services provided by the public telecommunication authoritics. WANs can also use most other
types of circuit including satellite networks, lSl)N. Value Added Networks (VANsS/VADS).

‘The network can be a prlvate system made up from a network of circuits leased from the local Telephone

Company or set up using public systerrs as virtual private networks. A Virtual Private Network is one which
operates in the same way as 2 private network but which uses public switched services for the transmission of
information.

The main distinguishing feature between a WAN and LAN is that, the LAN is under the complete control of

~ the owner, whereas the WAN needs the involvement of another authority like the Telephone Company.

LAN:s are also able to handle very high data transfer rates at low cost because of the limited area covered.
LANs have a lower error rate than WANS,

2.4.1 Communication Switching Techniques

In a WAN, two computing devices are not connected directly. A network of switching nodes provides a
transfer path between the two devices. The process of transferring data blocks from one node to another is
called data switching.

There are three switching techniques commonly employed, and these are: -

1. Circuit Switching

In circuit switching there is a dedicated communication path between the sending and receiving devices. The

dedicated path is a connected sequence of links between switching nodes. A conventional telephone network,
where a dedicated path is set between the caller and the called party for the duration of a telephone call is an

‘example of circuit switching.

Communication viz. circuit switching involves three steps:
Circuit establishment; data transfer; and circuit termination

Circuit switching is mainly used for voice telephone network, but is not all that effective for data
communication networks, as channel capacmes are not fully utilised, as data communication equipments do
not generate data contmuously

2. Message Switching

Message swntchtng is an alternative swatchmg technique, where it is not necessary to establish a dedicated
path between the sending and recciving devices. In Message Switching, the sendmg device appends the
destination address to thc message and passes it to the network; the message is then passed through the
network from one node to another till it reaches the intended destination. Each switching node receives a
message, stores it brleﬂy and then transmits it to the next node. Examples of a message are electronic mails,
computer files, telegrams and transaction queries and responses. A complete exchange-may consist of several
messages.

The basic disadvantage of message switchinﬁ is the variable delay at intermediate switching nodes.
3. Packet Switching

~ Packet Switching » combines the advantages of message and circuit switching. Packet Switching is
Iunumn(m.\lly similar to mussage switching, in which data is transmitted in block, stored by the first switching



node it meets in the network and is forwarded to the next and subsequent downstream nodes until it reaches Introduction to
the destination. The length of data block is limited in a packet switching network. Typical maximum length ~ Computer Networks

of packets is bexween 128 bytes to 4096 bytes. There are two approaches to packet switching & Emerging Trends
Datagram
o Virtual circuit

In datagram approach, each packet is treated independently and may follow a different path through the
network. Packets may be re-ordered, dropped or delivered in wrong sequence. The communication protocols
provide the error recovery and sequencing of packets at the recciving device.

In virtual circuit approach, a fixed logical path through the network from the sender to the receiver is
established before any packets are sent. Thisgpath remains unchanged for the duration of the session. This is
quite like circuit switching, but no resources are reserve nlnng the path. Packets are buffered at intermediate
nodes awaiting transmission. '

2.4.2 WAN Decvices/HHardware

The switching techniques utilise the routing technology for data transfer. Routing is responsible for searching
a path between two computing devices that wish to communicate and for forwarding the data packets on this
path. Devices such as bridges, router and gateways provide this routing function.

1. Bridges

Bridges are used to connect two LANS that use identical LAN protocols over a wide area. The bridge acts as
an address filter which picks uﬁ packets from one LAN that are intended for a destination on another LAN
and passes these packets on the network. Bridges operate at the data link layer ( layer 2) of the OSI model.
As all devices use tlie same protocols, the amount of processing required at the bridge is minimal. If the
distance between the two LANS is large, the user would require two identical bridges at either end of the
communication link.

Besides a point-to-point link, the intervening communication facility can be a network such as a wide area
packet switching network in such cases the bridges need to add X.25 link layer header and trailer.

2, Routers

Routers can be used to connect networns that may not be similar. Routers provide connectivity between two
LANs or two WANs over large geographical distances. Routers operates at the network layer (layer 3).0f the
OSI'model. All routers participate in a routing protocol to access the network topology, and based on this
information routers compute the best route from a sender to the receiver.

For large Wide Area Networks spanning thousands of kilometers, the normal pra.uec i, o pul neinw otk
routers at suitable locations to minimise link costs for leased lines and provide adequate reliability from link
failures. Networks and other systein are then connected 10 the nearest router.

3. Gateways

Gateways are used to connect two dissimiiar LANs. The term gateways and routers are used interciiangeably.
though there is a subtle difference between the two. A router operates at the network layer (layer 3} of the
OSI model, whereas a gateway operates on, the application layer (layer 7) of the OSI model. A gateway is
required to convert daia packets from one protocol format to another bejore forwarding it. as it connests two
dissimilar networks.

While discussing the WAN devices we referred to X.25; what is it? X.25 is a set of recommendation by
International Telegraph and-Telephone Consultative Committee for packet switched network. You can reier
to further readings for more details. '
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2.4.3  Types of Wide Area Networks

The essential purpose of Wide Area Networks, regardless of the size or technology used, is to link scparate
locations in order to move data around. A WAN allows these locations to access shared computer resources
and provides the essential infrastructure for developing widespread distributed computing systems,

We will now discuss the different types of WAN, which are cammonly used.

1. Public thworks

Public Networks are those networks, which are installed and run by the telecommunication authorities and are
made available to any organisation or individual who subscribe it. Examples include Public Switched
Telephone Networks (PSTN), Public Switched Data Networks (PSDN), Value Added Services
(VANSs/VADs) and the Integrated Services Digital Networks (ISDN). We would be discussing the main
features of these services. .

Public Switched Tclcph(me'Nc(work (PSTN)

The features of the PSTN are its low speed, the analog nature of transmission, a restricted bandwidth and its
widespread availability. As PSTN is designed for telephones, modems are required when it is used for data
communication,

The PSTN is most useful in wide area data communication systems as an adjunct to other mechanisms. It is

seldom advisable to use PSTN as the soic communications medium for building a network system. Costs are
high, as data connections last for a considerable time. Also, the links set up are unreliable and can terminate

without warning.

PSTN connections are usually easy to obtain at short notice, and are widely available and cover almost every
location where people live and work. PSTN is most useful for occrsional user or as backup to private
circuits. It is also used for facsimile (FAX) machines.

Public Switched Data Networks (PSDN)

The term PSDN covers a number of technologics. although currently it is limited to Public Packet Switched
Networks available to the public. The main features of all PSDNs are their high level of reliability and the
high quality of the connections provided. They can support both low aud high speeds at appropriate costs.

Like the PSTN. a PSDN is very useful and adjunct to a private network for backup and occasional access
purposcs. lt can also be used to link computer systems and networks of one organisation to several other
organisations. PSDN is very popular for connecting public and private mail systems to implement electronic
mail services with other companics.

Value Added Services (VANs/VADs)

In Value Added Services. the provider of such services must process. store and manipulate the data thdt is
carried on the network. that is. add value to it. The technique can be used in specific types of business in
which it is advantageous to be able to share information with other companies in the same line,

Electronic Data Interchange (EDI) is one ..rea for Value Added Services in which two trading partners
exchange trading documents such as purchase orders. invoices, transportation etc. using electronic means. In
India, Videsh Sanchar Nigam Ltd. is a service provider.

Integrated Services Digital Network (ISDN)

The ISDN is a networking concept providing for the integration of voice. video and data services using digital
transmission media and combining both circuit and packet switching techniques. The motivating force
behind ISDN is that telephone networks around the world have been making a transition towards utilising
digital transmission facilitics for many years. ’

Users in shops or small oftices can use their digital conne__tion to Telephone Coh)pan)' for transmitting both
voice and data over the same twisted pair cable which ccnnects their telephone. As infarmation frem the
telephone /PC/Stereo/TV/PABX are all seen as bit streaims by the networks switch, they can be switched and
transported by the same network.
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The basic technique used in all forms of private WAN is to use private (or more usually leased) circuits to

Private Networks Introduction to

Computer Network
& Emerging Trend

link the locations to be served by the network. Between these fixed points the owner of the network has
complete freedom to use the circuits in any way they want. They can use the circuits to carry large quantities
of data or for high-speed transmissions. :

Check Your Progress

I

6.

Wiich of the followirig networking solution is suitable for networking within a building?

(a) WAN

(b LAN

(¢) MAN

(d) None of the above

Data transfer rate for LAN is normally:

(a) 1-100 Mbps

(b) I-2 Mbps
(c) 1-10 Mbps
) None of the above

Which of the following topology share a single channel on which all stations can receive and
transmit data? ‘

(a) LAN

thy BUS
(¢) TREL
(d) None of the above

In which topology data packet is removed by the source destination

() RING

(h) BUS
() STAR
(d) None of the above

Which of the following LAN access method uses the right to transmission by a special bit pattern?

(a) CSMA/CDH

(™ RING topology
() Token Passing
(d) None of the above

Which of the following topology is least aftected by removal/addition of workstations?

a RING
(by STAR
(c) BUS

(d) Nonc of the Adove

Protocol is used to communicate between

(a) similar module
(b) dissimilar module
(c) both (a) and (b)
(d) None of the above
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‘tworking, Security (a) 1 bytes
(h) 128-4096 bytes
(¢) 10 MB
(d) None of the above
9. Which of the following takes a fixed logical path through network in packet switching methog®

(a) Datagram

(b) Virtual circuit
(¢) L.AN topology
@) None of the above
10. Which of the following is used to connect two LLANs using same LAN protocols over a wide wrea?
(a) Router
(b) Bridses
{c) Gateways

(d) None of the above

2.5 FEW APPLICATIONS

Networking revolution has swept the country and slowly but steadily more and morc enterprises are
beginning to rely more on various form of electronic data exchange.

2.5.1 E-Mail (Electronic Mail)y

E-Mail system is basically used for sending message electronically to individuals or group of individuals in
an inter and intra office environment. It requires networks to connect them. In the world of information

technology E-Mail is consider to be first experience and exposure to the field of data communication and
networking.

But an E-Mail system can do more than just send message back and forth. Applications that will be build on
the messaging infrastructure include multimedia mail, database access, document sharing, fax routing,
scheduling etc. The most promising areas are workflow, deviation support, task automation information
routing etc.

Every day E-Mail vendors coming up with their new version of E-Mail system. Let us discuss few important
aspect of a good E-Mail systems.

The E-Mail should contain the feature to compose and send messages easily. Message editing and the ability
to easily send attachments that can be quickly opened and read by the recipient are important to improve
productivity and use of an E-Mail system.

(a) Automatic differentiation of text created when typing, from initial message.

An e-mail system should provide support for OLE object linking and embedding, which allows user to
incorporate graphics, sound and text into in message.

Attaching a file or object to an E-Mail message is the faster way to route information to a workgroup.

One of the advantages of E-;viail is that it gives users the ability to review, respond to a file, and discard
incoming message quickly. E-Mail is fast becoming more than just a way to route electronics notes. It is
becoming an important communication medium and infrastructure for workgroup applications that make it
easier for people to work together.
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Electronic Data Interchange is ‘the inter-organisational exchange of business documentation in structured, & Emerging Trend:
machine-processable form. '

EDI is often viewed as simply a way of replacing paper documents with electronic documents, and replacing
traditional methods.of transmission such as mail, phone, or in-person delivery with electronic transmlssmn
However, EDI is actually a way of replacing manual data entry with electronic data entry.

The purpose of EDI is not to eliininate paper, but rather to eliminzic processing delays and data re-entry.

Electronic data interchange can be used to elecironically transmit documents such as -urchase orders,
invoices, shipping notices, receiving advices, and other standard business correspond nce between trading
partners.. EDI can also be used to transmit financial intormation and payments in electronic form. When used
in this application, EDI is usually referred to as EFT, Elcctronic Funds Transfer.

What is Application-To-Application EDI?

Figure shows the use of EDI in place of traditional methods for the transmission of a purchase order between
a buyer and seller and demonstrates the key concept.bchind EDI. Once data are entered into the buyer's
computer system, the same data are electronically entered into the seller's, ;c&)mplitér. without the need for
rekeying or re-entry. This is normally referred to as application-to- application EDI. When EDI is fully
integrated with application programs, not only do data tlow electronically between trading partners without
the need for rekeying, data also flow electronically betwcen intemal applications of each of the trading
partners.

The repeated rekeying of identical information in the traditional paper-based method business comiuunication
creates a number of problems that can be eliminated or swmtlcantly reduced through the usage of I:DI. These
problems include—

e [ncreased time

e Low accuracy

e High labour charges

e Increased uncertainty

EDI has become a major means of business communications among large companies in the U.S. EDI can do,
for communications between unrelated companies, what Electronic Funds Transter (EFT) has done for
transactions between large financial organisations-substitute electronic transactions for paper ones.

Pufehulno

EOI Flow

Figure 8: EDI vs. traditional metrods
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EDI consists of standardised electronic message formats (called transacuon sets) for common business
documents such as Request for Quotation, Purchase order, Purchase Change Order, Bill of Lading, Receiving
Advice, Invoice, and similar documents. These electronic transaction sets enable the computer in one -
company/organisation to communicate with the computer in another company/organisation without actuall
producmg paper documents. The human effort required to read, sort and physically transport such documents
is eliminated. The documents just mentioned, for.which standard EDI formats are either in existence or under
development, constitute about 85% of the ofﬁclal communicatiens associated with commercial transactions
between business, government educational institutions, and non-profit establishments in U.S. and most of the
industrialised world. .

To take full advantage of EDI's benefits, a company must computerise its basic accounting records. Trading
partners are individual organisations that agree to exchange EDI transactions. EDI cannot be undertaken
unilaterally but requires the co-operation and active participation of trading partners. Trading partners -
normally consist of an organisation’s principal supplicrs and wholesale cusiomers. Large retail stores,
because they transact business with a large number of supplicrs, were among the early supporters of, and
participants in EDI.

Benefits of EDI

The use of EDI climinates many of the problems associated with traditional information flow.

* The delay associated with order making are eliminated, time required to re-enter data is also eliminated.
e Since data is not repeatedly keyed, the chances of error are reduced.

* Asdata is not re-cntered at each step in the process, labour costs can be reduced.

*  Because time delays are reduced, there is more certainty in information flow.

The other advantage in the use of EDI is that it generates the functional acknowledgement whenever an EDI

message is received, and it is clectronically transmitted to the sender. This acknowledgement states that the
message is received.

Therefore, the core concept of EDI is that data are transferred electronically in machine processable form, i.c
the EDI message can be immediately processed by receiving computer without, any human intervention, or
interpretation or rekeying.

Therefore, EDI is most suited in the areas where any of the following characteristics exist:

Handles a large volume ..i repetitive standard action.

Operates on very tight margin.

Faces strong competition requiring significant productivity improvements.

Operates under time constraints. *

EDI eliminates the paper documents associated with common business transactions. Consequently, the
handling, filing, and transportation necessitated by the existence of the paper documents are also eliminated.
Elcctronic documents (messages) can be duplicated and routed (transmitted) instantly to anyene in the
organisation with a need to see them. Where a hard copy of a document is desired or r;quirud by law, a paper
copy can be produced. Space that normally would be occupicd by files of multiple paper copies can be
devoted to more productive use and the manual filing operatiuns eliminated entirely.

All of the above benefits result in a more efficient operation and usually provide identifiable cost savings to
the company that implements EDI. In addition. eliminating the time required for the preparation and physical
movement of paper documents speeds up the entire process of information transfer between companies.

These benefits are so compelling that companies must soon adhere to EDI < andards if they expect to sell to
large U.S. organisations such as Fortune 1000 companies, where the volume of these documents is alwavs
burdensome. The alternative will be to send paper documents to a third party (service bureau) where the
document is converted to an EDI message acceptable to the addiessed company. Such service bureats are
already in operation in U.S.A. It is this kind of computerisation which s forcing mdxa as country to adopt
EDI technelogy for mtemational transactions.
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We have seen what electronic data communication is and how its plays a crucial role in the success of
organisations. Its impact has been felt across in globe, let us take a look at some of the networks.

2.6.1 Internet

Internet is the world’s largest networks, originated out of a US department of defence funded project. Itisa
unique collection of networks with vast proportions of its own kind. It has evolved into one of the
technologies greatest democracies, permitting the passage of all kinds of information exchange with full
freedom. The first result of the project funded by US defence department for a fault tolerant networking
system, is Arparet, which in terms become the largest, the most potent aid definitely most uncontrollable
force in the world. '

The networks or computers operating in different platform are.connected to Internet by a common protocol
-known as TCP/IP Transmission control protocol/Internet protocol. Internet provides the following services.

(a) Global Electronic Mail

As we have already discussed e-mail permits user to send and receive messages electronically to an
individuals or a group. Internet mail makes delivery of area of message more wide and reliable.

(b) USENET-Views and News

Views and News or USENET is the BBS (Bulletin Board Service) of Internet. The messages in this BBS are
organised into thousands of News groups, which cover specific areas of interest.

(c) TELNET-Remote Login

Telnet allows an Internet user to access a remote host. After properly connecting and logging into the. remote
host, the use can enter data, run programs or do any other operation. -

(d) FTP-File Transfer Protocol

It permits an Internet user to move or transfer a file from one computer to another even if they are running or.
different piatform (or operating system). The files may have data, graphics, text etc.

(c) Navigators-Information Servers

More than 1000 new users are joining Internet each month making it a global information ocean. This also
makes difficult to find any thing specific on Internet. There are several powerful tools used on Internet for
scarching information. These information-tracking utilities are means to develop easy method of discovering,
locating, and retrieving information on various objects freely available on Internet. Some of the well-known
utilities are Gopher, Archie, Hytelnet, WAIS, and WWW. The WWW out of. these is the most popular and,
have resulted in the massive growth of Internet resources. You can obtain more information on Internet in
further readings.

2.6.2 BITNET (Because-Its Yime Network)

City University of New York and University of Yale established BITNET basically to exchange information
between universities. The basic series provided by BITNET are: ' '

(a Excharige of electronic messages (datafile)
(b) Electronic student admission
(©) Remote job entry and storing research information

A counterpart of BITNET in India is ER Net, which is established for educational and research purposes.
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2.6.3 CompuServe

CompuServe is a commercial network based in US. 1t uses (clephone lines and microwave for
communication. CompuServe user can casily communicate with cach other, around the world. Following are
the services offered by CompuServe:

(a) Electronic Mail box for message transfer

(b) Bulletin Board Services

(c) News report alongwith report on sports and weather

(d) Information on computer hardware and software.

2.6.4 ISDN (Integrated Services Digital Network)

ISDN is basically used for Communication of both data and voice. ISDN was first launched in Singapore in
1990. It has the following features:

(a) Transmission and processing of digital data

(b) Processing of various types of information data, voice, video etc.
(c) Electronic mail box

(d) Tele-conferencing

(e) Telefax, videofax,. etc.

2.6.5 NICNET

NICNET is a satellite-based nationwide network of NIC (National Information Centres). The basic idea of
interviewing NICNET is to extract data from each village, district and city of India. It consists of earth of
stations in almost all districts, state capitals, regions and NIC headquarter in Delhi. The basic objectives of
NICNET are:

(a) To help governmicent in better planning administration

(b) To help government maintain communication in times of national emergencies and natural disasters.

In India, many other Government owned network exist.

2.7 OPEN INDENT QUESTIONS AND ACTIVITIES

1. Explore whether there is any E-Mail service provider in your town and if so obtain the rates for
various services. Make a comparison with charges for similar work if it had been done through
Ordinary mail, Speed post, Internationhal Air mail or through Fax.

Z. Explore with some business organisations to which you have access, whether they are aware of EDI.
if so, are they contemplating moving towards it?
3. If you find that not many businesses are aware of the potential of EDI, what would vou attribute this
to? ) '
o
4. Try to visit an organisation within your reach and find whether they are connected to a National or

International network?
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In this unit you leamed about networking concept and its utilisation. It also explained various kind of
networking such as L:AN'and WAN. It defines what is LAN, its topology, hardware and software for LAN,
and also talked about WAN in details. You have also been aconveyed the functions of E-Mail and Electronic
Data Intér-change. The difference between the two has to be appretiated. Some description of tﬁé,various
standards that exist as well as their need in case of EDI was presentéd. A brief description ofisdme of the
well knovinetworks, both in India and abroad, were presemed.. '

2.9 MODEL ANSWERS

CheckYour Pregress

JL®) 2@ 3.0) 4@ 50 6@ 7@ 8@ 9.® 10.(b)

2.10- FURTHER READINGS

\ ’
\ ’

i. Andrew S. Tancnkaum, Computer Networks, Third Edition, Prentice-Hall of India.
2. William‘SlaHing, L ata and Computer Communication, P’rentic_c;l'!all of India.
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3.0 INTRODUCTION

In this unit we will describe the-various ways in which loss or corruption of data can occur and the means by
which this can be avoided. Our main thrust would be directed towards PCs, but we would also look at the
measures available on larger machines. We will also discuss about cryptography.

Once more and more information is kept in digital form, the protection of data in computer systems begins to
pose challenges to designers, researchers-and system managers. It is clear that when such data involves
financial transaction, there has to be complete reliability. Even in University examination systems, the
security of the data is very important. In an information society, even for businesses the competition would
be on the basis of the information available. Therefore, pilfering of information or eavesdropping when data
is being communicated from one part of the organisation to another, can be a serious threat.

One of the methods adopted from time immemorial -relates to jumbling up- the message so that-it cannot be

easily understood. Of course, persons wanting to get the information, would want to break through the
jumbled message, and will try to find a meaningful content.

The field of cryptography (from the Greek kryptos, "hidden" and Graphein, "to 'write"), deals with the.
methodologies involved in creating cryptograms i.c. messages which should appear to be meaningless, excep!
for those who have been provided the means to extract the original text from the jumbled up text.
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At the end of this session, you should be able to:

define the computer security

give various security measures to be undertaken
explain physical security and sofiware security -
appreciate the possible approaches to cryptography /
define the concepts of cryptanalysis.

32 DEFINITIONS

Generally the terms privacy, integrity and confidentiality are loosely construed to be synonymous with
security. These however have different connotations with respect to data or information. They also address
different areas of information systems. To better understand the measures and to ensure protection in each
area, let us see their definitions. ' '

SECURITY: "Data or information security is the protection of data against accidental or intentional,
destruction, disclosure or modification". Computer data security refers to the technological safeguards and
managerial procedure, which can be applied to computer hardware, software and data to ensure that
organisational assets and individual privacy are protected.

PRIVACY: "Is a concept applied to an individual”. It is the right of an individual to decide what
information he/she wishes to share with others or is willing to accept from others.

3.3 SECURITY STATUS ON PC

Before studying the ways in which security can be compromised, let us see what some of the leading
magazines have to say about PC security.

The "New Scientist" in its issue of 7 July 83 warned: "New PC users beware ! PCs are the higgest threat to
Computer Security. Micros are lefl: in unguarded offices or at home, where data snoopers may steal
- confidential files or data, if not the machine itself”.

A few years later "PC Week" in its issue of 7 May 85, Cautioned: * The PC has NO inherent security”. Fora -
user with confidential data, the data stored in the PC is vulnerable because anyone can walk up and tum the
switch ON and access information.

The same article had this to say for networked PCs: "Put your PC on-line and you are open to a New World

of terrors. A LAN is an open opportunity for mischievous or disloyal co-workers to get confidential

information. A telephone connection can invite everyone from the 10-year-old down the street to the

KGB -to intercept your communiques and romp through your memory banks, borrowing a file here, erasing
-~ others there, until the only memory you have of your data is an ulcer".

The article Digital defence in the February 7-21, 95 issues of Business Today has the following to say "If you
marvel at the speed, efficiency, and ease-of-usc with which your computer system crunches, sorts and spews
p out data, remember this: it's just as simple for a digital desperado on the prowl to coax out the same data from
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3.4 BREACHES OF SECURITY

The above warnings paint a fairly bleak picture for PC users. Some of the ways in which data loss or
manipulation can occur have been hinted at in these articles. Let us look at the details of the manner in which
fosses can occur. '

Theft of PC and Media: May sound preposterous but it is a distinct possibility. A smart person with a false
calling card can take away the PC for repairs aid of course never show his face again ! However, electronic
media like floppies and CD-ROMs are slightly safe as it is far easier to lock up floppies in a safer place.

Damage due to Breakage: Floppics are easily breakable. 1t is hard to visualise dropping PCs but it can
happen if they are shifted from tne place to another. More likely is that something may get dropped on the-
PC resulting in damage. Damage can also occur due to natural causes such as storms or floods, or due to
clectrical or other fires.

Environmental Damage: The manufacturer recommends some environmental conditions like temperature
and humidity ranges. voltage limits, dust micron limits etc. If the conditions in your oftice remain outside -
these limits the PC and media are likely to get damaged.

Inadvertent Corruption/Loss: This can occur due to:

LI Usage of inferior media : If sub-standard media is used, as it would be generally cheaper, after using
it for some time it may develop faults and data held on it may become unusable. One hears about
frequent corruption of data on inferior floppies.

) Erasure of Files : Files may get crased from the media due to incorrect actions by the operator.
Corruption may occur duc to the PC being subjected to frequent power failures, wrong programming
techniques or defective software. ’

Environmental losses: Excessive dust or humidity can result in corruption of disc surfaces or read/write
heads resulting in loss of data.

Malicious damage/Leakage: We now turn to the real problem of computer installations, be they stand alone
PCs or large main frames with hundred of terminals. It is not necessary that outsiders would do this; it is
equally possible that some unhappy or impish insiders may wreck havoc.

Unauthorised Access: As the saying goes "Curiosity Killed that Cat", but it does not stop the human from
trying to look at things they should not or need not. Information on personnel, finance, products or assets can
be accessed and copied for malafide use.

Modifications Erasures etc.:' The person accessing data files may be authorised to read the data only, but he
would like to alter, modify or erase the data by writing into that file.

Computer Viruses: This is the latest threat to computer users. These can be introduced deliberately or
unknowingly by anyone at anytime and the consequences to the user would be equally disastrous. The
problems created by viruses include:

Desttuction of file Allocation Table (FAT) - user loses everything on his media;
Erasing of specific programs and/or data on discs H

Alter contents of fields in the file:

Suppress execution of RAM resident programs;

Destroy parts of programs/data held on disc by creating bad sectors;

P.zduction of free space on disc:

formatting of discs or tracks on discs in a different way;

Overwriting of entire disc directories:

"Hang" the system at periodic intervals so that keyboards become inoperative;
Automatic copying of results obtained by other programs into some designated areas..



Data Tapping: In large computer systems or when systems are networked, data has to travel between the The Management of
processing unit and terminals, or different processors, over communication lines. Any person trying to get ~ Computer Security &
access to data can intercept the traffic on the circuit by tapping into the cable at convenient points. This may Principles of Crypto;
even enable him to send spurious channel over the network and access the computer itself by emulating

terminal responses. Very sophisticated means have been developed which allow a person to 'listen’ to the

traffic on a line even without physically connecting into it. Thus the data following over communication

lines is ever susceptible to "eavesdropping”.

3.5 SECURITY MEASURES

The measures for-data protection taken by an organisation reflect its awareness and attitude towards
information and Information Technology. 1f top management treats computers as a dechumanised, intangible,
but necessary evil, the measures taken to protect data, individual privacy and data integrity would, at best, be
lackadaisical. On the other hand, if the management considers information as an important resource and
computers as an aid in decision making one would find a positive approach and involvement by the .
management towards security of information. This attitude naturally percolates down to the lower levels and
the workers consider the computer correspondingly as an enemy or an ally.

One of the best and first steps in ensuring data security is to create an awareness and develop a culture within
the organisation towards the ways in which information can be lost/altered and what would be the -
consequences, of such an occurrence, to the organisation and individuals. The other steps that can be taken
are:

e IT Planning: the organisation must decide on a policy for introduction of IT. This mustbe done at the
highest level and should address issues such as level of protecnon for various aspects of information
relating to the organisation;

e Selection of technology: keeping in mind obsolescence due to new innovations and necessity for keeping
in step; :

¢ Identification of points of exposure of weak links to device means to plug them;

e Physical protection of machine and media.

Control and Monitoring the access to data, its usage by persons and its integrity must be clearly defined and
responsibility for ensuring these must rest on persons designated for these tasks; an audit procedure would go
a long way in ensuring adherence to laid down guidelines. 'While the above are relevant for any computer
based MIS implementation, in case of PCs, the rules for acquisition and use must be unambiguously stated.
Additional points to be looked into are:

o Information classification;

¢ Responsibilities for Security;

e  User training to increase security awareness and propagation of "do's and don'ts"

¢ Guidelines for creation and changes to passwords etc.

There are four time-honoured principles for ensuring security and recovery in case of breaches of security:

Prevent: The best method is of course stopping all breaches of ‘security before they occur. 'Need-to know'
policy is an offshoot of the principle of prevention.

Detect: Howsoever, one may try to ensure it, total security is almost impossible. The next principle,
therefore, is that you must be able to detect breaches to security, whenever they occur, within the shortest

possible time. This helps in damage assesssient anid alea  davising furter preventive measures.
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Minimisc Damage: The aim here is to contain the damage, when tesses occur, to reduce the adverse effects
of such damage.

Recovery: There must be cnough resilience in the system to recoup the losses/damage and become
functional, by reinstating the status, at the carlicst.

We would now look at the various measures available to the PC user, to ensure security of machine and data,
relating to the principles enumerated above.

3.5.1 Physical Security

These measures are for PCs being used in offices. The PC may be in use by an individual or being shared
between two or more users. The measures available are: -

»  Physically bolt down the PC to a table so that it cannot be casually lifted and taken away;

*  Locate the PC in such a way that it is conveniently accessible to the uscr, but hidden from casual passers-
by;

e Have likeable cupboards for floppies and keep them locked at all times, except when used;

* Kceyboard and PC locking devices can be fitted so that the PC cannot be operated unless these locks are
opened;

®  Keeparecord of all floppies in use: do not permit alicen floppies into the organisation:

® Use lockable rooms for I'Cs, specially those handling sensitive data. Make it a practice to lock the room
when leaving it for even a short time.

e The above apply to server, gateways and the like.

Environmental Conditions: The PCs are fairly rugged and can tolerate wide ranges of temperatures,
humidity and voltages. However. {0 ensurc trouble free and prelonged life, consider the following measures:

* Have temperature and humidity gauges placed in the close proximity of PC: and keep a casual watch to
ensure that conditions are within limits. Switch off if’ the limuts are exceeded:

* Ifyour normal electrical supply is subject to large variations of voliage and frequency or spikes, it is
prudent to have voltage and frequency stabilizers for the PC:

*  Ensure that excessive dust or paper scrap does not accumulate near the PC;

*  The plug sockets should fit snugly and cables leading to terminals and printers should be secured
properly and not left hanging;

*  You may consider putting a thin transparent plastic cover on the key board if it does not hamper your
_ handling the kevboard;

The most important is the use of a vacuum cleaner at regular intervals.

3.5.2  Software Security

As is apparent from the views on security’ of various leading mazazines. provided on PCs. there is hardly any
sccurity provided on the PC. There are some measures you can take to ensure that data is not corrupred or

modified by unauthorised users and to re initiate the database to its known status in case ihis happens and
these are:

'

® Use original software far Operating ‘Svstem, compilers or sofiware packages. You may have to pay for
it, but.you can then be sure that it would be bug-free, known also as "licensed” software:

®  Use correct procedures for shutting down the PC sc that all files ete. would be properly closed:
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¢ Keep back-ups of all your files. Whenever you operate on any file, (especially in update/append/alte,
mode}, if yom have your own programs - they should include a "copy" procedure; this ensures that a back
up of your data files would always be automatically taken. ’

3.5.3 Network Security

The protection required for nctworked systems is much more extensive as physical security measures are
totally inadequate. It is also extremely difficult to know- who, when and how someone is accessing your
data. in LANS, generally there would be one server which holds the shareable data on network and services
the requests of vafious nodes. The normal method used is password identity for permitting access;. the
measures that can be adopted for additional security are: .

e Keep the servers away and limit physical access to them.

® Run servers in the background mode; thus the server can be bboked, on, for use in the network, but, for
direct nse of the server, a separatc password would be necessary;

*  Some networks provide auditing facilitics, which can be used to advantage;

¢ Bc aware that the network cables can be'tapped, so try and shield or conceal them to prevent easy access;
if possible use optical fibre; ‘

*  Use codes and ciphers in data communication; remember, however, that this would impose considerable
overheads on your resources; -

*  Use fibre-optic cables. for highly sensitive networks as they are difficult to tap; however, here too it may
be possible to steal data through sensing the perturbations of the fibre itself;

¢ Prohibit the use of passwords embedded in communication access scripts; if this is unavoidable, use
encryption for passwords;

*  Cunsider the use of see-through devices for any system accessed through networks or through dial up.

Pratection against virus: A number of measures are available for reducing the risk of being attacked by
B ©virus:

.

¢ Build employee awareness of the risk;

* Do not allow the use of outside programs for company PCs.or networks;

* Do not interface company networks to outside "Bulletir: Boards”;

¢ Make system/server files "Read only";

e Try and obtain source code for important software in use and compile it in-house;
* If'source code is difficult to follow,’it should ring a'waming bell in your head;

*  Check executable code using "debug" or separate utilitics to study code structure and check spaces for
viruses.

3.5.4 Password Security

In'most organisations or computer systems, the only authorisation for data aceess is giving the correct
password; rightly speaking, this is only one step; the whole process would be:

10
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 Cuitputns Identification: An identification user code only indicates an object with a unique identity assigned to it. Thus

Fundamentals: it should not become authorisation to access data without further checks, if some measure of security is
Communication, desired: :
Networking, Security *

Authentication: This process verifies that a person or object is who he, she or it claims to be. This could be
achieved by asking some standard questions (from a large selection) and getting answers to them. If the
answers match with those held on the systems, the person or object is authenticated. Biometric and other
physical authentication processes are also popular in systems where security is a primary concern.

1
Authorisation: This is the last step in the process. Through this you can ensure that only a given user,
terminal or other resource can access data to which permission has been granted to read, write or alter. Thus
a matrix can be created to indicate which users have access to which file, records or ficlds. If the user request
passes the matrix he is allowed access, otherwise he is denied access to some parts of the database.

Other Aspecté

We have had a fairly close look at the measures for data protection available on stand alone as well as
networked PCs. Some of the measures that we studied can be implemented only on mini and mainframe
systems easily, while trying to introduce them on PCs may incur too much of resource overheads. We would
now take a quick look at the protection, detection and recovery mechanisms available on large systems. This
is in order to give you pointers for discerning when to go in for a larger system rather than a PC LAN and
what facilities to look for.

" Database Access: Larger systems provide various mechanisins to prevent access to data. User classes can be
defined automatically prohibiting access to data by userclass. User can be given only "query view" of the
data so that he can have only "read" access to a limited amount of data. In some systems, certain terminal
numbers can display or access only some parts of database, thus, even a user, with higher access permissions
cannot access some data on those terminals.

Access to Operating Systems: In some systems the operating system is written in a lower level language and
users are not given the use of that language. Thus, the user cannot alter any part of the operating system.
Some operating systems follow the concept of access control levels. In this any program which has equal or
higher access control level cannot access any routines which are below that level. The operating system
routines are placed at much lower level and paths are predefined for access to these,'which incidentally, are
via other system routines placed at 4 high level.. From this point of view 'UNIX' is not a secure Operating
System as, ‘C', which is the language in which 'UNIX' is written, is also available to the user as a
programming language, however, it have many good security features.

Access Control Cards: This is the latest method and is also available on PCs. Here an additional card is
inserted on the PC. This card has its own memory and software. The user can program upto ten complex
account codes. Anyone wanting access to a PC has first to pass through authentication routines through this
card. Only when he passes, he is allowed to access the PC itself. These codes can be reprogrammed
whenever required. Thus the basic problem of preventing access to the operating system of the PC can be
solved 1o a large extent.

3.6 CRYPTOGRAPHY: A BRIEF HISTORY

In the current scenario of computer usage that predict is that networks are likely to be present everywhere,
security has become much talked about issue. Especially, with the relatively easy access to the [nternet, the
confidence in the sanctity of the data is a major concern.

However, the science of Cryptology is at least 4,000 years old. Cryptology is defined as "the design and
analysis of codes and ciphers." In its first 3,000 years, Cryptology was deveioped independently in several
ancient cultures, including Egypt, India and Mesopotamia. Perhaps the oldest evidence of Cryptology is an
ancient inscription, carved about 1900 BC, in the main chamber of an Egyptian torab. 1t used some unusual
hieroglyphic symbols in place of more ordinary symbols. Although the inscription utilised one of the
important methods of cryptography transformation of the text-it was not secret writing. The intenition appears

30 to have been to impart authority and dignity to the writing.



However, rather better known technique is attributed to Julius Caesar, who used a simple cipher system more.
than 2,000 years ago to conceal military information. The method consisted of replacing the letters of
alphabets in the original text by letters that arc a fixed number of places away. For example, ‘A’ could be
replaced by ‘D’, ‘B’ by ‘E’ and so on. Thus, the key for the cipher would be as follows:

Plain: ABCDEFGHIJKLMNOPQRSTUVWXYZ
Cipher: DEFGHIJKLMNOPQRSTUVWXYZABC

Using this system, the secret message "ZHOFRPH WR WKH FRPSXWHU FRXUVH" would actually mean
"Welcome to the Computer course”. Thcre were of course other systems developed around the similar time
in history which included approaches such as:

Writing secret messages backwards.

Writing messages vertically rather than horizontally.

Substituting dots for vowels.

Using alphabets of other languages such as Greek or Hebrew.
Substituting special symbols tor the normal letters of the alphabets.

e e o o o

A Caesar type encryption mechanism can be easily is detected by trying all possible djsplacements till the
message becomes meaningful.

3.7 CRYPTOGRAPHY

- Cryptography is the process of transforming plain text or original information intq an unintelligible form
(cipher text) so that it may be sent over unsafe channels of communication. A data string (key) controls the
transformation process. Anyone getting hold of the cipher text while it is on the unsafe channel would need
to have the appropriate key, to be, able to get to the original information. The authorised receiver is assumed
to have that key. This is illustrated in the following figure:

Encfyption Process

" ENCRYPTION DECRYPTION
Plain Text Cipher Text
“HELLO” “XRVIF”
‘Algorithmi  (g¢———] KEY -1 Algorithm
Cipher Text ' Plain Text
“XRVIJE” “HELLO”

The stage of conversion of the plain text into a cryptogram is called Encrypting or enciphering or encoding.
Reconverting the cryptogram back into the original form, when done by the authorised person is called
decrypting or deciphering or decoding. :

3.7.1 Cipher Systems

Although there may appear to be many variations, there are mainly two basic classes of cipher systems. These
two classes are called transpesition and substitution. ‘

The Managementor | -
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A transposition involves rearrangement or change in the sequence of the letters of the plain text message
without any change in their identity. However, the substitution involves a replacement of the plain text letters
by other letters (or other symbols) without any change in their sequence. Transposition and substitution may
be combined in a single cryptosystem.

The Caesar Cipher mechanism was described carlier and is a specific case of what may be called a
“transposition type cipher". :

Code System

A code system is a specialiscd form of substitution in which entire words, long phrases or even sentences of
the plain text are replaced by arbitrarily selected equivalents. These may be other words, groups of letters,
groups of figures or some combination of these. It is only in rare cases that the substitution process is applied
to elements smaller than whole words.

A code system, therefore, makes use of a codebook in which the words, phrases and sentences of the
vocabulary are listed in an organised manner and accompanied by their equivalent code groups. Many large
commercial firms have their own private cudes, constructed especially for their use.

In modern times, communication does not take place only through the passage of text. The same general
ideas of substitution and transposition, which were used for literal cryptosystems. are also used for
encryption, for speech (ciphony), facsimile (ciphax) and television (civision). In literal cryptosystems, the
unit of encryption is usually a single character. But in ciphony, cifax, or civision, the relevant unit is a timed
portion of the continuously varying audio or image-scanning signal. Ciphony, cifax, civision system are
categorised as privacy system or security systems. Privacy system mainly offers the protection against direct
listening or direct viewing. The security systems, on the other hand, offer greater protection which actually in
some cases will attempt protection against analysis as well.

3.7.2 Data Encryption Standard (DES)

IBM developed the Data Encryption Standards (DES) algorithm in the carly 1570s. DES specifies a method
for encrypting 64-bit blocks of clear data plain text into corresponding 64-bit blocks of cipher text employing
a user-specified 56-bit key. DES may be double-or triple-encrypted for additional security, with the user
employing a different key after each transmission.

Because 2* combinations of the keying variable are possible (and these keying variables can be changed
readily), the algorithm is deemed by some experts to be highly secure. Cryptography experts in industry and
government agencies maintain that DES is still a reliable standard. Operating at one try per microsecond, it
would require approximately 2,284 years to break the code. Another consideration is the effect on security if
the length of time the key is operative is shorter than the time it would take to search for the key.

DES is commonly used in the design, generation, and verification of personal identification numbers (PINs).
These personal passwords are at the heart of the security scheme for validating ownership of automatic teller
machine (ATM) debit cards. Message authentication also uses the DES algorithm.

Some experts believe that the DES is bre- kable. It may be possible for a parallel processor using special
integrated circuits to go through all the permutations of a single DES transmissién in one day. Although DES
offers a high degree of security for commercial threats, the security of DES is lower for national or military
threats. ‘

" The two main components of the DES-based system are an algorithm and a key. The DES algorithm is a

complex interactive pracess comprised of substitutions, permutations, and mathematical operations.
The important feature about the DES approach is that the algorithms is fixed and is public information.
However, the actual key used is shared secret between the originator and the receiver of a transmission
Advances in DES nclude lengthening a key to 128 bits and the multi-pass DES, which involves several
passes usually three of encryption and decryption using different kcys.
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In its continuing search for a truly secret code, another encryption method which is now known as the RSA t

after its three inventors from the Massachusetts Institute of Technology, namely, Ronald Rivest, Adi Shamir
and Leonard Adelman is now considered an important standard. The principle behind the RSA method is
that it is easier to multiply two numbers than to factorise their product. This is even more so if the two
numbers in question are large prime numbers. For example, it is easy to multiply the prime numbers 11,927
and 20,903 and get the number 249, 310,081. But if you are given the number 249, 310, 081 it is rather
difficult to find its prime factors. But if the number is small, such as %5, it is easy to sec that its prime factors
are 5 and 7. The factoring of 29083 into 127 and 229 comes somewhere in beiween in terms of level of
difficulty. There are an infinite number of prime sumbers, and there is no known pattern to them except that
they are prime.

Relying on this difficulty, Rivest and his colleague in the year 1977 had proposed the system, which is now
known as RSA-129. RSA-129 is a 129 digit number given below which was open to challenge by anyone in
the world factorise into its prime factors. This challenge stood unbroken for about 17 years. But in 1993 it
was broken through a cooperative effort of academics and hobbyists using over 1500 computers working for
over 8 months on the Internet. The RSA-129, 114, 381, 625, 757, 888, 867, 669, 235, 779, 976, 146, 612,
010, 218,296, 721, 242, 362, 562, 561, 842, 935, 706, 935, 245, 733, 897, 830, 597, 1239 563, 958, 705,

058, 989, 075, 147, 599, 290, 026, 879, 543, 541, factors into the following two prime numbers, one of which
is the following number of 64 digits, 3, 490, 529, 510, 847, 650, 949, 147, 849, 619, 903, 898, 133, 417, 764,
638, 493, 387, 843, 990, 820, 577 and the other 32, 769, 132, 993, 266, 709, 549, 961, 988, 190, 834, 461,
413, 1717, 642, 967, 992, 942, 539, 798, 288, 533 of 65 digits.

The episode about the RSA is an interesting one to show that what may be considered difficult and '
impenetrable teday may actually be rather easily broken into by more and more powerful computers of
tomorrow.

The pursuit of truly secret code, physicists have been contemplating new approaches based on quantum keys.
These ideas are still at a theoretical stage but with the kind of development seen in the past in other aspects of
the computer industry, it may not be difficult to imagine that this approach of quantum cryptography can
become a reality in the coming decade.

3.8 CRYPTANALYSIS

The interpretation of secret communications without any previous knowledge of the system or the key is
called cryptanalysis. In the case of modern cryptosystem, this requires extensive theoretical study, unusial
power of observation, inductive and deductive reasoning, great concentration and perseverance. Also
necessary are vivid imagination guided by good judgment. This has to be supplemented by a special aptitude
and intuition gained from long and varied practlcal experience. It is possible that isolated, short cryptogram
may resist solution indefinitely, even if it is in a fairly simple system.

However, a large volume of matcnal even in a very complex cryptosystem-may well be solved with time and
effort, and especially with the help of modern powerful computers.

In general, the art of cryptanalysis may be reduced to three basic steps:

(a) arrangement and rearrangement ot data to disclose non-random characteristics or manifestations
(c.g., in frequency counts, repetitions, pattems, and symmetrical phenomena);

(b) recognition of the non-random characteristics or manitestations when disclosed:
(c) an explananon of the non-random characteristics when recognised. The requirements for the first
step are experience or ingenuity and time-which may be appreciably reduced by the use of machine

aids; for the second step, expericnce or stalistics; and for the third step, expericnce or imagination,
Land telligence,
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3.9 OPEN QUESTIONS AND ACTIVITIES

1. Explore about the basic requirements for your account and password from the system administration
of your LAN.
2. Explore the backup policy of your centre.

»

Explore the orervation standards followed if ary.

3.10 SUMMARY

It is becoming increasingly =ssential for all oroamsat;ons to ensure data security. Ensuring data security on
PCs and LANSs is a major probiem as, inherently, very ‘ew mechanism are provided o guard against data
loss, corruption, misuse or eavesdropping. Unless the organisation creates security awareness i s work
force, any measures for data sccurity are not likely to prove successfui.

The organisation must decide on the IT and security policy at the highest level and ¢nsure its strict
1mplementat|on for a reasonably successful outcome. There are a number of imeasures available io the
organisation, especially on larger system, to cnsure data security. Equal attention. howcever, needs (¢ be paid
to PC security, as there is an increasing use of PCs as terminals. That is where, this unit w:ll bring awareness.

In this unit, the major approaches to cryptography have been il!ustrated. From the elementary Caesar Cipher
to the RSA-129, is the range covered. An idea has also been given about the concept of cryptanalysis. This
unit only introduces you to these concepts and we do not expect that you will wi expert in Cryptography.

3.11 FURTHER READINGS

1. Andrew S. Tanenbaum, Computer Networks, Tuird Editix;n, Prentice-Hall of India.
2. William Stalling, Data and Computer Communication, Prentice-Hall of India:-
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4.0 INTRODUCTION

The world of computers and Information Technology is going through an era of electronic terrorism, in the
form of virus. Itis a problem that is potentially so dangerous that it threatens the proper functioning of the
computer system in today's information age.

In this unit, we would discuss about the evolution of virus, the menace caused by them, the process of
infection. classification of viruses, types of viruses, the prevention and the cure against them.

4.1 OBJECTIVES

At the end of this unit you should be able to:

define computer viruses and its evolution

explain the damage a virus can do

definc the process of virus infection

identify different types of viruses depending or their area of operation/infection
describe/apply virus preventive measures.

.

4.2 THE EVOLUTION OF VIRUS
|

The concept of virus dates back to 1949, when John Von Neumann submitted a paper putting forward the
concept of a "Self Replicating” program; the idca seemed impossible and was dropped. Subsequently, the
first virus like program appeared in the form of a recreational game called "CODE-WARS" at the Bell Labs
of American Telephone and Telegraph Company. In "Code-wars" two players were to code a set of programs
that would destroy the other players programs. Realising the potential danger of such programs, the authors
did not reveal the presence of such programs. Concurrently, at Massachusetts Institute of Technology,
students were carrying out experiments with computer, which no body had ever tried. Their relatively
harmless hobby of messing up with other programs gave rise to the idea and concept of computer viruses.

The first commercial application of viruses was in 1985, when two Pakistani brothers, in order o keep track
of software piracy used Brain Virus (also known as Pakistani virus) on their low cost soflware sold from their
outletin Lahore. Hidden in nearly every disk they sold, was an extra program not supplied by the original (N
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manufatturer a snippet of computer code, scif-replicating in nature that would infect an unauthorised user's
computer by disrupting his operations. These self-replicating programs multiplied so fast that, today, they are
a threat to the smooth operation of a computer.

(42 XA

4.3 THE MENACE

The virus, whether biological or electronic is an information disorder. Biological viruses are tiny genetic
codes DNA or RNA that take over the machinery of a living cell and are capable of making thousands of
replicas of the original virus. Like its biological counterpart, a computer virus carries in it an instructional

code that makes copies of itself. ‘ |

Lodged in a host computer, the typical virus takes temporary control of the computer disk operatix{g system,
When the infected system comes in contact with an uninfected computer, the virus passes onto the uninfected .
machine and, thus spreads like a forest fire, infecting machines after machine with which it comes in contact.

Computer viruses are computer programs, which are a collection of coded instructions. The basic difference
between a normal program and a virus is that viruses are self-replicating, they have the capability of
executing themselves without being asked for. Computer virus is a very broad term in itself and includes not
only viruses, but also Worms and Trojans.

Trojans are similar to viruses. They move around as valid programs, sometimes getting executed with flashy
opening screens describing them as— "Word Processor" or a "Database package". Trojans are programs that
claim to do something but do something completely different and in the process damage information stored
on a computer system. Trojans do not i1fect other software.

Worms travel longer distances by storing themselves in critical areas of the disk from where they get loaded
and have with them sufficient code to transfer themselves outward from the system they infect. Worms have
been known to damage and infect entire LANS.

Apart from self-replication, another devastation caused by viruses is data loss. A virus can also take steps to
avoidits detection. That makes viruses even more dangerous, because you may come to know about the
infection when it has struck. Even though all viruses are developed with a specific characteristic, most of

them result in data-loss.

Most viruses are designed to perform simple feats but in order to do so, they:

e Corrupt the-most sensitive area of the disk the File Allocation Table (FAT) or the directory area.

e Modify the interrupt organisation of the system, meaning when a read or write to screen operation takes
place, it is routed through the virus code in the memory resulting in unresolvable interrupt clashes where

a program opens up a file simultaneously for read-write access and the virus interrupts every operation.

Even though the virus may have no instructions built into it to destroy data, it can nevertheless render a disk
full of files absolutely useless.

\‘i

44 THE PROCESS OF INFECTION

To understand how a virus infects a system, we go; back to the elementary working of a computer. On
booting, the system carries out the ROM instructions, the first being the power on Self Test (POST), which is
followed by the bootstrap process of reading the boot record and loading of the disk operating system. In
MS-DOS, it involves the loading of IBMDOS.COM, IBMBIO.COM and COMMAND.COM along with
some optional files like CONFIG.SYS and AUTOEXEC.BAT. The booting process culminates into the
system prompt displayed on the VDU. ' : ‘

The infection may begin as <30n as a computer: systein boots from a contaminated disk or executes .1
infected program. Whatever viruses are present gets activated, which immediately begin to spread throughout
the system.



Another iniportant aspect that needs mention here is the Interrupt mechanism. Al imput/output activitics on a
PC are carried out by interrupts. The interrupt mechanism in itself is very complex. We will try to
understand it with an exampie. Let us say, a. uscr wishes to save his program and presses ine required keys
on the key board. This treated as an interrupt. The main memory has specific routines to handlic these user
requests. One such set of routines exists in the ROM-BIOS and the another is in the DOS program in the
memory, loaded from IBMBIO.COM. The routine that scrvices the interrupt requests are termed as Interrupy
Service Routines (ISR's) and are located in the memory with their addresses. Then interrupt request activates
a number and not the routine address, thus, there exists a table with the interrupt numbers and the
corresponding routine address in DOS. When an interrupt request is made, the CPU looks up the table
performs the required routines and transfers the control back 1o the program. 4

The contents of ISR address table being in the RAM is vulnerable to modification by user programs and that
is what a virus does-modify the ISR's address.

4.5 CLASSIFICATION OF VIRUSES

Viruses are classified on the basis of their mode of existence and there are three categories of viruses:

I. - BOOT Infectors
2. SYSTEM Infectors
3. GENERAL EXECUTABLE PROGRAM Infectors.

4.5.1 BOOT Infectors

As the name suggests, they are characterised by the fact that they physically reside in the boot sector [0
(zero)l sector of the disk. A system infected by such a virus will have the virus residing in a particular area of
the disk rather than in a program file. . These viruses get loaded soon after the Power on Self Test and control
the system and remains in control at all times. They sometimes have the capability to trap soft booting (i.e.
CTRL ALT DEL) and remain in control even if the system is booted from a non-infected floppy, thereby
contaminating the clean floppy.

Boot infectors displaces information originally residing on the location, which they occupy. While writing
onto the boot sector, the virus ensures that the booi record is not deleted. Once the virus is loaded, it
automatically transfers zontrul to the area where the boot record is available. The reason behind doing this is
that the boot record contains instructions to read IBMBIO.COM and IBMDOS.COM and if these files are not
readable, access to the disk is not possible, and so the virus becomes ineffective.

Boot infectors typically create "Bad sectors”. Boot infectors are the types, whicl. once loaded would stay in
the memory until the system is shut off, and until the disk reformats.

4.5.2 SYSTEM Infectors

This second category of viruses® deals with the components of the system itself. All machines without
exception require an operating system in orderto create an environment in which the operator works. in MS-
DOS, COMMAND.COM contains all the internal commands. If no such command file exists, commands
such as COPY, DIR etc. are not loaded onto the memory when the machine is booted. The System Infectors
attach themselves to a file such as COMMAND.COM or other memory resident files and manipulate these
files.

System infectors differ from Boot infectors in the sense that system infectors gain control after the computen
is booted: and infects the hard disk or bootable floppies, which contain the appropriate system files only.
They have another peculiarity that they may activate after a given period of time or may instantly begin subtle
modifications in system processing such as, increasing the time to perform system functions, scrambling of
data, or modification of systems error messages or information messages.



‘smpuicr
‘wndamentals:
‘ommunication,
detworking. Sccurity

From the infection point of view, these viruses are most dangerous and devastating of the three classcs of
viruses. They attach themselves to program files and can spread to almost any executable program in any
system. These viruses change the original program instructions into a "jump" to its own code and follows that
code with a return to the original program. As a result, wheneyer the program is executed, the virus gets
loaded and executed first and then allows the original program to proceed. It remains memory resident and
infects each and every program that is loaded for exccution.

By attaching themselves to EXE or COM files, they alter the file size and sometimes multiple infections
renders program files too large to be accommodated in the memory.

4.6 SOME VIRUS

. - ’
The virus list has become a non-ending entity with new viruses joining the list every other day. We would be
discussing some of the most commonly prevalent viruses in the computer industry. However, this list is
incomplete.

1. Scores Virus

These viruses are prevalent in Macintosh machines. Scores virus has a built in time trigger that activates at
two, four and seven days after the disk kas became infected. The consequences are varied ranging form
printing problems, system crashes and malfunctioning of disk operations. This virus does not directly affect
data files, but erasure of this virus requires deletion of all files.

2. Brain Virus

This is one of the first viruses that came into being. Also known as the Pakistani virus, it was. dcvclopcil by
the Pakistani brothers to keep track of low cost software, those were sold out of their outlet in Lakore. The
virus pops up a screcn saying “Welcome to the Dungeon™. This virus is known to destroy data and are highly
contagious.

3. _Lehigh Virus

This virus originated at the Lehigh University Computer Centre. This virus stays in the stack space of
COMMAND.COM. With the booting of a PC fro:1 an infected disk, the virus is spread through commands
such as COPY, TYPE, DIR etc. On any other disk with COMMAND.COM the virus code gets copied to the
other disk and a counter is incremented on the parent. When the counter reaches a value of 4. all files of the
disk gets erased. The boot sector gets ruined and also the FAT.

4. ‘ Friday the 13th

This virus attacks not only the COMMAND.COM but also other executable files. When'a .COM or .EXE file
is executed for the first time after booting. the virus captures a specific interrupt and inserts its own code;
after which, whenever any .EXE file is exccuted, the virus code is written to the end of the file resulting in
increase in size of the file by 1808 bytes. In COM files the virus code is written to the beginning of the file.

The increase in size of the EXE and COM files causes the program to become too large to be loaded into the
memory. Also after a certain interval of time, delays arc inserted resulting in considerable slowing down of
the programs. The worst disaster occurs, if the infected .EXE or .COM is executed when the system date is

Friday the 13th, all files get deleted.

5. Sunnyvale Slug

This does a variety of things like displaying a message "Greetings form Sunnyvale. Can you find me?" and’
also sometimes modifies the COPY Commund resulting in deletion of files instead of cor: ring.



0. Raindrops

This virus infects COM files. It intercepts the load and exeeute function of MS-DOS. 1t checks whether the

file is EXE or not, if the file is not an EXE file. the first thiee bytes of the file are replaced by a jump

instruction at the end of the file, where it gets attached aticr encryption. This results in dropping or showering

of characters on the screen like raindrops and is also accompanied by appropriate sound effects.

7. Happy Birthday 30th

This virus gets activated on January Sth, if any of the infected program get executed, and will ask the user to
type "Happy Birthday 30th". It might destroy all the data stored on a disk. Tlic symptoms of this virus arc

that the computer memory is reported 6KB less thar actual ¢.g. 634 KB instead of 640 KB.

Following is a list of prominent viruses that have created havoc on may machines across the globe. A
comprehensive list cannot be built as every other day a new virus gets included into it.

Name Also known as Name Also known as
‘Marijuana (Stoned) l'equila
Joshi (Happy Birthday Joshi) Slow
Flip BFD .
Eddie (Dark Avenger) World peace
Jerusalem (Jerusalem Ver Ato E,) Kanishka
(Friday the 13th)
‘ Disk-washer
Serum (Yankee Doodle, Version A, B) Alfa
Kinky (Fellowship) Trikal
V2000 Mummy
Zealot (Keypress) Mubamk
Changu-Mangu Charas
March-6th (Michael Angelo) Feist ]
Frodo (4096, 100 Years) Boabob
Desi (Made in India) Monkey
Datalock ExeBug 7
‘Gravity (Raindrops, 1701,17XX)
: (1701/1704 Version A, B)
Feist ~
Hong_Kong NewBug =
Liberty 1403\ T
[ Form ‘
Pronto (15XX) G3 T
Taiwan : ~ Cansu
“Invader (And-CAD) Dong 2.
Generic (Keydrop) Long- 1
Possessed (Poss) Khobar -
Black Monday ' PFO
Plastique ' Dic-Hard-2
Bosh Bloomington
Dir-2 N Fat-avenger
Gumnam 1 Green-Catapillar

oo

Angelina

47 PREVENTION

-Even though the computer industry has found
ol vaccines, 1t is always advisable to follow the dictum "P
vituses are made-faster than the vaccines. It is

which can reduce the

a somewhat plausible solution to the virus problem in the form.
revention is better than cure”. Moreover, the

the vaccin agood practice to follow some simple precautionary measures,
poassibility of a viras attack. The precautionary measures are:
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The CHEDSK comniand can be incorporated to the AUTOEXTEC.B AT to cheek the disk. If the nui
of hidden files increase, the matter should be looked into

e Do not copy pirated software on your system.
e Write proteet tags should be used on the original seftware disketies.
o Proper backup of all data and program files should be kept.

e Copving of files should be done carctullyCa better practice is to write the COPY command in a batch file
with CHKDSK command.

o Uscd floppics should be reformatted.

-

e Avoid letting the system to be used by unauthorised users.

o Restrict the use of outsigeloppics

e Do not download suspicitas shareware programs.

4.8 THE CURE

The viruses are not omnipotent. Viruses can be cured with anti-viral programs. The anti-viral programs
perform one’or more of the following functions:

prevention

detection
vaccination
inoculation
identification. and‘or
damage control.

A good anti-viral utility is one which checks whether the system has been infected or not. These programs
stop the virus from infecting the system. They do not allow the modification of executable files, so that a file
virus cannot get a foothold.

Some of them refuse to let any program make itself resident in RAM unless allowed by the user. Others do
not allow the user to run a program unless it is on a list of approved and tested applications. The detectors
warn the user of the presence of a virus after it is loaded into the machine or disk. These programs maintain a
file with a list of checksum values of the executable files. The identifiers rely on the fact that when the virus
replicates, it makes a copy of itself. -

The vaccinators inject son:e code into the executable files. When the vaccinated file is run, the injected code
performs an integrity check on the program being executed and wams if any changes have been made.

The innoculators insert the virus signature into infected areas or files at appropriate locations. When the virus
performs their self-detection, they find their signature and believe that the memory. disk file is already
infected and so do not infect.

The better equipped anti-viral programs control damages. They may be preventive or restorative. Preventive

-techniques include stopping attempts at direct access such as formatting and deleting, or even write protecting

the hard disk while testing unfamiliar software. The restorative process is achieved by maintaining a copy of
the CMOS information. boot sector information. the file allocation table etc. in a safe area like a floppy.

As a virus can hide itselt in many different ways. it is difficult to detect.all viruses with just one anti-viral
program. Moreover. the virus writers keep altering the viral code, so that any existing anti-viral programs

cannot detect it. The point to remember is that there. is no cent pgr cent foolproof anti-virus program
available ar. . in principle there never will be.



4.9 OPEN INDENT QUESTI ¢ 'S AND ACTIVITIES

I. Make a iist of at least 10 viruses with their characteristics.

2. Make a list of anti-virus packages yb'u are using at your centre.

4.10 SUMMARY

This nnit discussed about the threat faced by computer virus.. It explains the evolution characteristics of the
virus and the damage they can do to a computer. We studied different types of viruses and their
<characteristics. It also discussed about different preventive measures, that should be taken to get rid 6f
computer viruses. With the development of computer field, new viruses/vaccine software may come.

Therefore, one has to keep track of latest development in this field and know how to counter these problen «

Computer Viru,
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BLOCK INTRODUCTION

" ~dvent of Graphical User Interfaces has made computer popular among masses, as computers have
- more users friendly. This block provides an introduction to the theoretical and practical aspects of
" .cal user interface. :

rst unit of this block is devoted towards the theoretical aspects of graphical user mterfaces while
ning units mainly focus a popular GUI Windows 95.

“ first unit, the definition, evolution of GUlSs, the terminology associated with GUIs and termmology
-ated with Windows, has been discussed.

:cond unit presents the system setting and disk utilities of Windows 95,a popul‘ar GUI. Please note that
:rpose of this unit is to provide you information about various system management utilities of Windows
that you can use thesec whenever the need be.

“1irc unit deals with the use of file systems in Windows. It presents the utilities available in Windows 95 for
diing varlous ﬁles and folders. This is also a practical unit.

t, fifth and sixth units are also practical oriented and covcr aspects relating to, how to run various
- grams, accessories, configuring computer on a network, working in nctworked environment, and
ritimedia tools available with Windows 95.






UNIT 1 INTRODUCTION TO GRAPHICAL USER
INTERFACE (GUI)

LY

Structure

1.0 Introduction
1.1 Objectives
1.2 What is Graphical User Interface?
1.3 Evolution of the Human and Machine Interaction
1.4 Common Graphical User Interface Terms
1.5 Microsoft Windows (MS-Windows)
1.5.1  Structure of a Window
1.5.2  Basic Techniques for Working in Windows
1.5.3  Using Menus
1.6 Working with a Dialog Box
1.7 Starting Windows 95
1.7.1  Task Bar
1.72  Start Menu
1.7.3  Shortcut Menus
1.7.4  Setup Screen Saver
1.7.5  How to get Help?
1.7.6  Shut Down Windows 95
1.8 Summary
1.9 Model Answere¢

1.0  INTRODUCTION

The Gmphical User Interface (GUI) is one of the most revolutionary changes to occur in the evolution of
modern computing system. In less than 10 years, the expectation of what the interaction between human and
computer would be like was changed from a terse, character-oriented system to the now more graphics-

oriented system. This revolution has increased the accessibility and usability of computer systems to the
general public. ' ' ' '

In this unit, we will look at another type of software, which helps users to interact with the system easily and
to perform a complex task with little knowledge of operating system or memorised commands. The software
providing such features-supports Modern User Interface concept such as desktop metaphor, which makes
computer available to the majority of people who are either novice or non-programmers. The personal
computer was invented for these users.

In this unit. we will look at several aspects of GUI, starting from common GUI terms, major corponents of
GUL, its history and finally a popular package supporting GUI - MS- Windows.

1.1 OBJECTIVES

After going through this unit, you will be able to:

e definc what is GUI and how it is different from character oriented system,
e define all the terms related with GUI

e identify important features of GUIs

o identify resources available in MS-Windows, and

¢ identify vatious dialog-box options.
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- Inlerface 1.2 WHAT IS GRAPHICAL USER INTERFACE?

The terms “user interface” originated in the engineering environment in the late 1970s. Virtually every one
who interacted directly with computers had been engineers and programmers, but a new kind of users was-
-emerging: the non-programming user. These users often reacted more negatively to difficulties in dealing
with a machine. New forms of interaction was needed, new interfaces were required and attention flowed to
“the user interface™.

With the introduction of the Macintosh in 1984, Apple Computer popularised the user interface as it is known
today. Apple’s use interface is now commonly referred to as a Graphical User Interface or GUIL. The GUI
has become associated with a common feature set available in a number of product offerings. Common
features include: '

. secondary user-input devices. Usually a pointing device and typically a mouse,

° point and shoot functionality with screen menus that appear or disappear under pointing-device-
control, '

° windows that graphically diﬂplay what the computer is doing, -

o iconsv that represent files, directories and other application and system entities,

. dialog boxes, button, sliders, check boxes and many other graphical metaphors that let the

programmer and user tell the computer what to do and how to do it. -

Today’s GUIs have expanded basic functionality to support not only graphics but also dimensions, colour,
height, video and highly dynamic interaction. Mpdern user interfaces can simulate a very realistic view of a
real, three-dimensional world.

1.3 EVOLUTION OF THE HUMAN AND MACHINE
INTERACTION

The primary means of communication with computer until recently has been through command-based,
interfaces. In command interfaces, users have to learn a large set of commands to get their job(s) done. In
early computer systems paper tapes, cards and batch jobs were the primary means of communicating these
commands to the computers. Later, time-sharing systems allowed the use of CRT terminals to
interact/communicate with the computer. Users trying to share precious computer resources such as CPU and
peripherals heavily burdened these early systems. ‘

The batch system and time sharing led to command-driven user interfaces. Users had to memorise commands
and options or consult a large set of user manuals. The early mainframe and minicomputer systems required a
large set of instruction manuals on how to.use the system. In some systems, meaningful tcerms were used for
command names to help the end-user. But in other systems the end-user had to memorise several sequences
of keystrokes to accomplish certain tasks. ‘

Early users of computers were engineers and what we now call expert users; users that had a lot of interest in
knowing more about the computer systems and the technology. Command line interfaces were acceptable by
the majority of these users. In the 1970s, computers were introduced to a new class of users: secretaries,
managers and non-technical people. These new users were less interested in learning computer technology
and more interested in getting their jobs done through the machine. The command based interfaces caused
many of these new users to develop computer phobia. Imagine the thought of memorising commands made
up of “Control-Alt-Del” to boot the system.

To make life easier for the end-user, a large collection of devices have been invented to control, monitor and
display information. The early (and still widely used) peripherals are the keyboard and the video terminal.
But. it was not until the late 70s, research projects at ;ome universities led to the invention of pointing devices



and windowing systems. The mouse and joystick were among some of the few pointing devices that were
invented in this period. Also, research pioneers invented the notion of splitting the screen to allow multiple
windows and direct manipulation of objects.

In the 70s, researchers designed powerful new workstations armed with graphical user-interfaces. The basic
assumption of these ~ew workstations was that one user could have a powerful desktop computer totally
dedicated to that user’s task. Thus, the computer is not only used to perform the task, but can also provide a
much more intuitive and easy-to-use environment.

Instead of memorising commands to each stage, the user selects a command from a menu bar displaying a list
of available commands. For example, Figure 1 displays the menu bar. This menu bar displays a list of
commands available such as File, Edit and view. When the mouse is clicked on any one of these menu
commands the appropriate action is taken.

W Microsoft Word
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Figure 1: Menu Bar

Pull-down and pop-up menus display option commands available for each selection. F igure 2 shows the
pull-down menu displayed when the file menu item is selected. The user can then select from different file
related activities.
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Figure 2: Pull-down Menu

Dialog boxes allow more complex interaction between the user and the computer. Dialog boxes employ a
large collection of control otjects such as dials buttons, scroll bars and editable boxes. For example, in figure

Introduction to GUI
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o 3, a aralog box is used to open a file. This dialog b x is composed of two buttons called Open and Close and
nterfa

edit box that allows a file name to be entered and a stroll region that allows navigation through the list of files
and directories available on the {. Clicking on the'open button causes the file to be viewcd.

In graphical user-interfaces, textual data is not the only form of interaction. fcons represent concepts such as
file folders, waste baskets, and printers etc. Icons symbolize words and concepts commonly applied in
dlfferent situations. Figure 4 shows the paint utility with its palette composed of icons. Each one of these

ns represents a certain type of painting behaviour. Once the pencil icon is clicked, for example, the cursor
can behave as a pencil to draw lines.
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Figure 4: Paint Paletie

The idea of metaphors has brought the computer closer to the natural environment of the end-user. The
concept of physical metaphor paadwm developed by Alan Kay, initiated most of the research for maphlc



user interfaces based on new programming approach called object oriented programmmg Discussion on
this subject is beyond this unit. This will be covered in detail in C++ and object oriented programming

course. The physical metaphor is a way of saying that the. visual display of a computer system should present
the images of real physical objects.

For example, the wastepaper basket icon can be used to discard objects from the system by simply dragging
the unwanted objects into the wastepaper basket, as in real life. The desktop metaphor probably has been the -
most Yamous paradigm. Because of the large set of potential office users, this metaphor can have the most
dramatic effect. In this paradlgm, the computer presents informatiop and objects as they would appcar and
behave in ‘an office, using icons for folders, in-baskets, out-baskets and calendars.

14 COMMON GRAPHICAL USER INTERFACE TERMS

.This section presents a list-of terms and commonly with the graphical user interface (GUI).

1. Pointing devices

Pointing devices allow users to point at different parts of the screen. Pointing devices can be used to invoke a
command from a list of commands presented in a menu. They can also be used to manipulate objects on the
screen by:

o Selecting objects on the screen
e Moving objects around the screen, or:

e Merging several objects into another object.

Since 1960s, a diverse set of tools have been used as pointing devices include the light pen, Joystlck touch

sensitive screen and the popularity of the mouse is due to optimal coordination of hand and easier trackmg of
the cursor on the screen. .

2. Bit-mapped displays

As memory chips get denser and cheaper, bit displays are replacing character-based display screens. Bit-
mapped displays made up of tiny dots (pixels) that are independently addressable and provide much finer
resolution than character displays. Bit-mapped displays have advantages over character displays. One of the
major advantages includes graphic manipulation capabilities, which present mfonnatlon in thefinal form on
paper (also called WYSIWYG: What You See Is What You Get).

3. Windows

When a screen is split into several independent regions, each onc is called a window. Several applications
can display results simultancously in different windows. Figure 5 presents a screen with two windows.

Introduction to GUI
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The end-user can switch from one application to another or shamdata buwe&ﬁ apphcatxons Windowing
systems have capablhtles to display windows either tiled or ove¥'lappe (F igtire 6 and Figure 7). Users can
organise the screen by resnzmg the window or moving related windows sloser.
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Figure 5: Screen with two windows

Figure 6 : Tiled Windows



Figure 7: Overlapped Windows

4. Menus

A menu displays a list of commands available within an application (Figure 1). From the menu, the end-user
can select operations such as File, Edit, view. Instead of remembering commands at each stage, a menu can
be used to provide a list of items. Each menu item can be eithcr a word or an icon representing a command or
a function. Menu item can be invoked by moving the cursor on the menu item and selecting the item by
clicking the mouse.

When a menu icon is invoked it could cause other menus, called pull-down menus, to'appear. Pull-down
menus (Figure 2) are used to present a group of related commands or options for a menu item. Figure 2
presents the File pull-down menu. '

5. Dialog boxes

Dialog boxes are used to collect information from the user or to present information to the.user. For example,
when printing a file, (Figure 8) a dialog box is displayed to get additional information.
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Figure 8: Dialog box

[

Introduction to G1E



A Graphical User
Interface

Some of the information obtained is the number of copies and page numbgrs to be printed. Dialog boxes are
also used to indicate error messages in the form of alert boxes. Dialog boxes use a wide range of screen
control-clements to communicate with the user.

6.

Icons

lcons are used to provide a symbolic representa.ion of any system/user-defined object such as file, folder,
address, book, applicaiions and so on. A specific type of icon represents different types of objects. In some

GUls, documents representing folders are represented by a folder icon (Figure 9). A folder icon contains a

group of files or other folder icons. Double clicking on the folder icon causes a window to be opened
displaying a list of icons and folder icons representing the folder’s contents.

7.
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Figure 9: Icons

Desktop metaphor

In the desktop metaphor, users are not aware of applications. Users deal with files, folder, drawer, a
clipboard and an out-box. Instead of starting the word processor and loading file, users merely open the

report document, which implicitly invokes the word processor. Clicking the mouse on an icon representing

icon’
-

the report cause word processor to get started and to load the report file implicitly. Today, .several computing
environments provide this capability.

8.

Graphic User Interfaces

GUISs are systems that allow creaticn and manipulation of user interfaces employing windows, menus, icons,
dialog boxes, mouse and keyboard. Macintosh toolbox, Microsoft windows and X-windows are some
examples of GUISs.

Cheek Your Progress 1

I

What 1s GUI and what are its features?
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Define the featur s of the followings:
(a) Windows

(b) Pull-down menu

(c) Dialog Box

(d) Pointing devices

.....................................................................................................................

....................................................................................................................

....................................................................................................................

1.5. MICROSOFT WINDOWS (MS-WINDOWS)

MS-Windows is the most popular GUI for personal computers. Windows provides an environment that
enhances DOS in many ways. The major benefits of Windows are:

1. Common Look and Feel : All Windows applications have the same basic look and feel. Once you
know-one or two Windows applications, it is easy to learn another one.

2. Device Independence : Windows presents a device-independent interface to applications. Unlike
- most of today's DOS applications, a Windows application is not bound to the underlying hardware
such as mouse, keyboard or display. Windows shields the applications from this responsibility. The
application deals with the Windows API to manipulate any underlying devices.

3. Multitasking: Windows provides non-pre-emptive multitasking support, Users can have several
applications in progress at the same time. Each application can be active in a separate window.

4 Memory Management: Windows also provides memory management to break the 640K limitation of

MS-DOS. An application has the ability to use the extended memory, share data segments with other
applications and swap unwanted segments to disk.

5. Support for existing DOS applications : Windows allow most standard DOS applications to run
under it directly. Any application that does not control the PC's hardware, use the PC BIOS or MS-
DOS software interrupts, can run in its own window.

6. Data Sharing : Windows allows data transfer between application Clipboard. Any type of data can be

transferred from one window with the Clipboard. The Dynamic Data Excliange (DDE) protocol



ffc" aphical User defines how two applications can share information. Information such as bitmzp, metafile, character
interface strings and other data formats can be shared.

7. Support for Object Orientation : In order to create screen objects such as windows, the application
developer defines a class (similar to record) specifying the necessary properties. Instances of class can
then be created. Several applications can share the same windows simnltaneously. To communicate
with instances of a window class, messages are sent and received by a special function called the
window function. The windows handles all messages such as re-drawing the screen, displaying icons
or pop-up menus and changing the contents of the client area (refer to Figure 10). This facilitates the
process of Application development.‘An application can choose to display the window, resize the
window, display additional information in the client area, and so on.

1.5.1 Structure of a Window

For the sake of simplicity certain parts, such as title bar and menu bar, arc common for most of the windows.
Since the window parts of many of the window based application software are common, this makes a person
to understand and memorise faster. You will see that the button to maximise or to minimise always appear on
the right top corner in all the windows. Similarly the menu bar, the tittle bar, the control menu bar also appear
at the same place for all the windows. This way if you get familiar to one window, you will get familiar with
the other windows too as the meaning for each of the similar buttons remain the same. Depending upon the
type of application all windows, however, may not have every element.

Minimise Maximise

Control Menu Box Mouse Pointer Title Bar Button  Button
Menu Bar

Insertion Point Client Area

\yindow Border Horizontal Scroll Bar Vertical S&oll Bar

Figure 10: Parts of a Window



Control-menu box

Title Bar
Menu Bar

Scroll Bars
Maximise Button
Minimise Button

Restore Button

Window Border
Insertion Point
Mouse Pointer

Client Area

B

It is in the upper-left corner of each wmdow Clicking on the Control-menu Introductlon to G-

box opens the Control menu. The Control menu can be used to move, size,
and close a window while working with the keyboard.

- It shows the name of the application, document, or a folder name.

It lists the available menus. A menu contains a list of actions or commands.

They are used to move through a document or a list when the entire document
or list does not fit in the window.

Clicking this button using the mouse dnlarges the active window so that it fills
the entire desktop.

Clicking this button reduces the window to an icon and arranges it on the
desktop. Minimising the application window does not quit the application.

The Maximise button is replaced by the Restore button after the window is
enlarged. Clicking this button returns the window to its previous size.

It is the outside edge of the window. The window can be resized by
lengthening or shortening the border.

Itisa ﬂashihg vertical bar that marks the: glace where text or graphics are to
appear on typing or drawing. o

An arrow useu for pointing items. It appears if the mouse is installed on the
system.

~Area inside the window which is under tHe application control.

Pop-up and Child Windows

Pap-Up and child windows are special types of windows, and are used to communicate information between
the application and the end-user. They remain on the screen for a short period of time. Dialog boxes
discussed in the next section, are more sophisticated form of pop-up windows. MS-Windows Drowdes a
collection of pre-defined child windows.

Resources

Resources are used to manage windows and user-defined objects. MS-Windows provides nine kinds of
resources to application developers. These resources are : icons, cursors, menus dialog boxes; fonts, bitmaps,
char strings, user-defined resources, and keyboard accelerators.

1. -Icons and cursors: Windows defines a few types of icons and cursors. An icon or a cursor is
essentially a bit-mapped region that is used to represent and symlbolise a window or cursor. A
developer can also define an original icon or cursor using the ICONEDIT utility.

2. Menus : Each window can have its own menu bar. A menu item: can be a character string or a
bitmap. Elach item of a menu bar in turn can have a pop-un'menu presenting a list of options.
Currently, Windows does not support nesting of pop-up menus within other pop-up menus.
(Windows 3.0 provides this functionality). But a pop-up menu can invoke a dialog box.

3. Dialog boxes : These provide another mechanism besides pop-up. menu and menu bars to obtain
informat ion from the end-user. Dialog boxes are much more flexible than menu bars or pop-up
menus. Dialog boxes usually contain a group of child windows such as buttons, scroll bars, and"
editable fields. Just like windows, dialog boxes have a function that is used to process messages
receivecl from the user upon selection of options.
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Fonts : Windows provides a few familics of fonts with different sizes and shapes : modem, roman,
- Swiss, Helvatica, and script. Application processors and desktop publishing can define additional
fonts as needed.

L

Bitmaps : They are used to represent icgns, cursors, or draw picture on the screen. Both mono and
colour bitmaps can be defined.

6. Character Strings : Character strings are handled as resources mainly to provide a manageable
solution to internationalisation of a window application.

7. User-Defined Resources : These can be used for any purpose and support any user—deﬂned data
type. Any arbitrary data can be managed as a user-defined resource.

1.5.2 Basic Techniques for Working in Windows

Windows offers an on-line Tutorial in which one can practice working with a mouse and performing basic
Windows tasks. To run the Tutorial, choose the Windows Tutorial command from the Help menu.

Jsing a mouse is usuaily easier and faster than using the keyboard but one needs to know both mouse and.
keyboard techniques to work in Windows. Almost all the functions in Windows can be performed using either
the keyboard or a mouse.

Basic Mouse Techniques

Generally the mouse has two buttons where one is the primary mouse button and the other is secondary. In
Windows, the left mouse button is set as the primary button by default. The primary budtton is used to perforrn
the majority of the tasks whereas the secondary button is used to display shortcut menu for the current
window-application.

Term Meaning
Click To quickly press and release the primary mouse button to select a single item.
Double-click To click the primary mouse button twice in rapid succession to carry out an

action afier the item is selected.

Point * | To move the mouse until the mouse pointer on the screen points to the item of
choice. :

Drag To press and hold down the primary mouse buttan while moving the mouse.

Drag-and-Drop Pointing to the item of choice, press and hold down the primary mouse button

while moving the mouse. Release the mouse button on reaching the desired
location to place the itern.

The similar operations can be performed using keyboard also. For equivalent keyboard commands refer to
your windows manual.

1.5.3 Using Menus

Each application window, and other windows as well, have menu names located on the meru bar.

Commands, the actions that can be carried out in Windows, are listed on menus. Along with the menus on the
menu bar, each window also has a control menu.



Menus on the Menu Bar Introduction to €

The menu on the menu bar can be selected and opened by pointing it and then clicking the primary mouse
button. After opening the men 1, a command or a menu item can be selected by dragging the selection cursor
down or up the menu until the menu ;tem is highlighted and release the mouse button to execute the
command. .

Clicking the menu name or anywhere outside the menu can close the menu. Pressing the ESC key on the
keyboard can perform the same, but the control remains on the ménu bar,

There are a number of menu conventions used in Windows, which are as follows:

Dxmmcd (or not visible) ' The command cannot be used with the application at the current time.

qommand ' ‘

An ellipsis (...) following a A dialog box appears on chocsing the command. The dialog box

command ' contains options need to be selected before carrymg out the comman.!

A check mark () to the left ofa The command is in effect. By choosing the command again the check

command mark is removed and the command is no longer in effect.

A key combination to the right of The key combma ion is a shortcut for choosmg the command. Pressing
| acommand 3 the keys carry out the command without opening the menu.

A triangle () to the right of a On choosing this corhmand, a cascading menu appears, listing

command additional commands.

Control Menu '

Application windows, document windows and their icons; and some dialog boxes have a Control menu. The
commands on the Control menu allow one to work with a window. A window can be moved to a different
location, or enlarged and even reduced s ea icon using these commands. The commands that are on the
Control menu and ths way this menu is opened vary. The Control menu for windows and dialog boxes can be
opened by selecting the Control-menu box in the upper-left corper of the window or dialog box..The Control
menu for an icon is opened on selecting the icon. Some commonly found Control menu commands are as
follows:

Use : To " Co e

Restore ! .Restore the window to its former size after it is reduced to an icon or enlarged.
Move | Move the window to another position by using the keyboard.

Size Change the sze of the window by using the keyboard.‘

Minimise Reduce the window to and icon

Maximise | Enlarge the window to its maximum size.

Close Close the window or the dialog box and even quit the application.
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1.6 WORKING WITH A DIALOG BOX

A dialog box supplies additional information o a command, required for the completion of a task. An
cilipsis(...) after a menu command indicates that a dialog box will appear on choosing this commarid.

Most dialog boxes contain options that can be selected. After specifying the options, one can choose a
command button to carry out the command. Some other dialog boxes may display information, warnings, or
error messages. Moving a dialog box is just like moving a window - by dragging the title bar or using the
Move command on the Control menu.

Types of Options

One mz need to select one or more options within a dialog box and for this one need to move from one
option o another. To move within a dialog box :

O can either click that option or press TAB to move to the next option and SHIFT+TAB tb the previous
ortion. ' ‘

The curréntly selected option is marked by the selection cursor, which appears as a dotted rectangle, a
ki ghlightgr both. The types of dialog box options are as follows :

Text Box Command Buttons

Associate

Files with Extension:

Associate With:
(N&ne

-ard File [caidfile.exe)

Fax (FaxView.exe)

Fax Key Viewer (keyview._exe)

Fax Signature Viewer (sigview.exe)

List Box
Figure 11: Dialog box options
;Command Button »

A Command Button,initiates an immediate action, such as carrying out or canceling a command. The OK,
Cancel and Help buttens are cammon confmand buttons. They are often located along the bottom or on the
right side of the-dialog box. Some command buttons are marked With greater-than signs (>>) which expands
the active dialog'box.AA command button containiag an ellipsis (...) opens another dialog box.

“Text Box .

+ A text box is used to type information. On moving to an empty text box, an insertion point appears to its far

left side.
List Box

A list box displays a list of choices. If there are more choices than can fit in the box, scroll bars are brovided
to move quickly through the list, :
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Usually only one item can be selected in a list box; and in some cases, more than one item can also be Introduction to GUI
selected. )

[~ Patter
Name:| (None)

S0X Gray
— " Boxes
Applicd Critters
X Fas{Diamonds
. Paisle

Drop-Down
List Box

~ Screen Saver ™
Name:|Blank Screen :
Delay: &l Minutes > This command
- - button will open
w allpaper lcons
Fite: [(None) ] [ Spacing: [75  [&] Pixels | another dialog box
Q_Center @ Iile X Wrap.Title ) '
~ Sizing m —Cursor Blink RBate Check Box
Granularity: ) Slow Fast | Option Button
Dorder Width: 3 , | [ naopitee v [ ] [renen] 2] '
Figure 12: More Dialog box options
Drop-Down List Box

A drop-down list box appears initially as a rectangular box cdntaining the current selection. On selecting the
down arrow in the square box at the right, a list of available choices appears. If there are more choices than
can fit in the box, scroll bars are provided. '

Option Buttons

Option buttons represent a group of mutually exclusive options. Only one option can be selected at atime.
The selected option button contains a black dot. If one option is already selected, then the current option
replaces it.

Check Box

A check box presents non-exclusive options, that is, more than one option can be selected at a time. Selcgted
check boxes contain an X. . v ‘

Check Your Progress 2
1. What are the four major components of GUI? Explain the functioning of any one component.
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1.7 STARTING WINDOWS 95

-

hY

This section and onwards, we will be mainly discussing about the Windows 95 vision by Microsoft. For
starting Windows 95, simply switch-on the computer and you will come directly to Windows 95 screen ( as
shown in the figure given below). This screen is called the desktop (metaphor), the settings of which can be
changed as the user likes.
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Figure 13: Start Window 95

To adjust settings such as desktop colour and background, use the right mouse button to click anywhere on
the desktop, and then click Properties.

The icons on the left side represent some of the accessories and tools. They provide the short and easicr

access to the features that we will discuss in the later sessions. The bar that is at the bottom of the screen is
called the taskbar.

1.7.1° Task Bar

The taskbar contains the Start button, which is used to quickly start a program or to find a file. It is also the

fastest way to get Help. By default, the taskbar and the Start menu are always visible when Windows is
running.

Also when you open a program, a document, or window, a button appears on the taskbar. You can use this
button to quickly switch between the wigdcws vou have opened.

To customize the taskbar, right-click on it, and click on Properties.



1.7.2 Start Menu

Click on the Start button. The ménu options (as shown in Figure) are popped-up above the taskbar. From
here you can start your adventure with Windows 95.

Figure 14: Start Menu

When you click on the option that has a right pointed anow, a i:ascading menu appears. Depending on your

computer and the options-you have chosen,
overview of each command is shown below :

you may see additional items in these cascading menus..An

'COMMAND | DOES THIS

Programs - Displays a list of programs you can start.

Documents Displays‘a list of documents that you have opened previously.

Settings ) Displays a list of system combonems for whith-you can change settings.
Find Enébles you to f;nd folder, file, shared computer, or ma:il méssage.

Help Starts Help.

Run Starts a program or opens a folder when );ou type an MS-DOS command.
Shut Down Shuts down or restarts yov..xr computer, or logs you off.,

The Start menu can be customised (add/remove programs) in the following way:

1. Click the Start button, and then point to Settings.

2. Click Taskbar, and then click the Start Menu Programs tab.

3. Click Add, and then click Browse.

4. Locate the program you want to add, and then double-click it.

n

Click Next, and then double-click the menu on which you want the program to appear..

Type the name that you want to see on the menu, and then click Finish.

H
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7. If Windows prompts you to choosc an icon, click one and then click Finish.

1.7.3 Shortcut Menus

Use the right mouse button to click any item and see a shortcut menu. This menu contains common
commands that you can use on the item you clicked. For exampie, by clicking on the blank area on the
taskbar with your right mouse button, you can choose to arrange windows and customize taskbar.

To work with files and folders, instead of using the standard menus to find the command you need, use the
right mouse button to click a file or folder. The menu that appears shows the most frequently used commands
for that file or folder.

1.7.4 Setup Screen Saver

The screen saver is set to save the wear and tear of the screen. The screen saver starts if your computer is idle
for the number of minutes specified in the Wait box. To clear the screen saver after it has started, move your
mouse or press any key.

By default, only a limited set of screen savers is installed during Windows Setup If you assign a password to
a screen saver, people who do not know the password cannot clear the screen saver, and therefore cannot

easily gain access to your computer.

Yo sét-up the screen saver, follow the steps given below

1. Right-click on the desktop and select Properties OR Choose Settings option from the Start menu, then
select Control Panel and choose Display from the displayed items.

2. Click on the Screen Saver tab.

3. Click on the down-arrow under Screen Saver field and browse through the different screen savers.

4. Choose the one that you like.

5. Click on Settings... button to customize the way it works.

- 6. You can set the password by choosing the option Password Protected.

7. Set Password... button is activated. Click on it and specify the password.

8. Preview the screen saver and set the timings, so that after the specified time, the screen saver will be
activated.

9. Press OK.

1.7.5 How To Get ﬁelp?

If you do not know how to do something, you can look it up in Help Just click the Start button, and then click
Help.

You can get Help on each item in a dialog box by chckmg the questlon-mark button in'the title bar and then
clicking the item.



To learn what any-toolbar button is for, you can rest your mousce pointer on the button for a few seconds. Introduction to GUI
Windows'displays the button name.

To find a topic in Help, follow the tips given below:

1. Click the Contents tab to browse through topics by category. If your Help file does not have a Contents
tab, click the Contents button to see a list of topics.

2. Click the Index tab to see a list of index entries: either type the word you are looking for or scroll through
the list. ' ‘

\ )

Click the Find tab to search for words or phrases that may be contained in a Help topic. -

To search for words in a Help file, follow the steps given below:

1. In Help, click the Find tab. If this is the first time you have clicked the Find tab, follow the instructions
on your screen to compile a word list.
[

2. In the first text box, type the word(s) you want to find. Matching words appear in the list bejow it
3. Inthe list of matching words, click the word(s) you want to look for.

4. In the bottom list box, doublé-click atitle to display the topic.

4
If you want to look for more than one word, separate them with spaces in the first text box. When you look
for hyphenated words, be sure to type the hyphen. To set specific search criteria, click Options.

To get Help in a dialog box, follow the steps given below
1. Click at the top of a dialog box, and then click the igén‘_i you want information about, If the dialog
’ box does not have the button, look for a Help button, or try pressing F]. '
2. The pop-up window displays the related information. To close the pop-up Window, click inside it.

3. Ifyou want to print or copy the information in a pop-up window,. use the right mouse button to click
inside it, and then click Print Topic.

OR

Another way to get Help on an item on the screen is to use your right mouse button to click the area you
want Help on, and then click the What's This? command.

1.7.6 Shut-Down Wihdows 95

To shut down your computer, click the Start button, click Shut Down, and then click Shut Down The
Computer. Do not turn off yaur compater until the "You can now safely turn off your computer” message
appears.
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1.8 . SUMMARY

In this unit, you lcarned:

—

What is a GUI?
. What are the basic-components of it?
What are the parts of Windows?
What are the basic techniques for working with Windows?
Icons arc termed as objects in Windows 95 because of their propertics.
Windows 95 propcnies can be easily customised according to the needs of the user.
Switch easily between windows through taskbar. | |

Use Screen savers to save your screen and work.

© ® N o s W N

Always remember to shutdown the computer properly.

1.9 MODEL ANSWERS

Check Your Progress |

1. GUlis a system l?at allows creation and manipulation of user interfaces employing windows, menus,
icons, dialog boxs, ctc. The basic features of GUL are :

e Pointing device such as mouse, which controls cursor.

Point and shoot functionality under control of device which cause screen menus appear or dlsappcar
Support of windows which graphically disriay the status of a computer program.
¢ Icons that represent files. directories and other application and system cntities.

+  Support of graphical metaphors such as pull-down menus. dialog boxes. buttons, slides that let

the programmer and usr tell the computer what to do and how to dojt.

o

When a screen is splint into several mdx.pundv.nl regions cach one is called a window. Several
applications can display results simultancously in different windows. The user can switch from one
window to another window. Windowing systems have capabilities to display windows either tiled or

overlapped. Users can organise the screen by resizing the window or moving related windows closer.

3. Bit-mapped gisplay is made up of tiny dots (pixels) that is an independently addressable and hs much
finer resolution than character displays.-Bit-mapped displays have the advantages over character

displays. One of the major advantages is of graphic capability.

Check Your Progress 2
1. There are four major components of GUL
(1. A windowing system
(11) An emerging model
(11) An application program interface .
(iv) A set of tools and frameworks for creating interfaces and developing integrated application.
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The API (Application Program Interface) is a set of programming language functions that allow the Introduction to GU!
programmer to specify how the actual application will control the menus scroll bars and icons tht appear on
the screen. Liking windowing models, APIs align with particular GUIs. Its features vary from package to
package.

2. There are several ways MS-Window enhances DOS environment,
"-(i) Device independence. It presents a‘device independent interface to applications. Unlike most of
today's DOS applications, a window application is not b=und to the underlying hardware such as

mouse, keyboard or display windows. "

ii)  Multitasking. Users can have several applications in progress at the same time. Each application
can be active in-a separate window.

(iii) Memory management. Windows also prbvidc memory management the 640K limitation of MS-
DOS. An application has the ability to extend memory and share data segments with other
applications.

(iv) Data sharing, Clipboard allow data transfer between application clipboard. Any type of data can
be transferred from one window to another through the clipboard.

25
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2.0 INTRODUCTION

In the previous unit, we have discussed about the features and components of GUIs. We have also introduced
you to starting up of a powerful GUI based operating system Windows 95. In this and subsequent units, we
will be focussing mainly on the practical aspects of Windows 95 package. Since these units are more¢
practical in nature, we will expect you to use these units during yeur practical sessions also.

Windows 95 provide a lot of utilities for managing your system. These utilities like Disk utilities help to
maintain disks and access the maximum available space on the disk. If multiple users are using tie same
system, they have the advantage of setting the system as they like. Different persons can specify thei [ogins
on the same system and switch over to their settings. In this unit our focus will be on system settings, baciup
and disk management utilities.

2.1 OBJECTIVES

This unit is a practical workbook for:

* personalising your system settings

e adding and removing'hardware/soﬂware
e setting up printers

e taking data backup

e managing your disk

* setting up windows it multiple users are sharing a computer.

/"‘\\\
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2.2 MY COMPUTER Windows 9%

In Windows 95, the things you have on computer, like programs, documents, and data files, are all accessinie
from one place called My Computer. You can find its icon on the desktop.

To see what is on your computer, follow the steps given below :

Double-click the My Computer icon. It opens the window that looks like the figure shown below

Floppy Drives Hard Disk Drive

A
CD-ROM Drive

A

£ My Computer

=5 ,
et ) 34 Floppy (B) Praveen (C)

1. Double-click the icon for the drive you want to look at.

2. Windows displays the files and folders on the drive. Folders can contain files, programs, and even other
folders.

3. To open £file or folder, or start a program. double-click it.

The information can also be displayed abour the different drives, Control Panel, and Printer(s) that are "
installed on your system. When an object (any of the above mentioned things) is selected, the related
commands are highlighted in the File menu. Select any drive and click on File menu. The difterent options
that are displayed are : '

Open Opens the selected object in u window.

Eplore Opens the explorer to sece the file structure of the drive.
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Find Helps you search for files on the selected drive or anywhere on the filing system.
Sharing Lets you share the selected drive with other users in your organization that are connected
on your computer. :

Format Erases or formats the selected floppy drive.

Create - Places a shortcut for the object on Windows 95 Desktop for quick access.
Shortcut e ,

Properties D'isplays information about the selected object.

Close Closes the open window.

2.3 SYSTEM SETTINGS

The System can be personalized by making interesting and useful changes to Windows 95 settings. For
example, you can :

e Adjust the double-click speed for your mouse.

e Change number, currency, time, and date settings.
e Change printer settings.

e Change settings for network service.

e Change bﬁckground of your desktop.

e  Change the capacity of ﬁxe R;:cycle Bin.

e Change the number of colors )'/our.monitor displays. -
e Have your monitor automatically turn off.

e Change the screen resolution.

e Change displa); fonts.

® . Protect your screen by setting-up a screen saver.

®  Configure multimedia devices.

*_ Enable multiple users to personalize settings.

®  View or change resource settings for a hardware device.



ges you can make to make your workplace more interésting. Some of Mansge System in
things are left to be tried out on your own (as per your requirement), Windows 95

Above mentioned are some of the chan
them are explained below, while other

You can start with clicking on the Start menu and then ch

oose Settings option. A cascading menu is
displayed as shown below : : ’

2.3.1 lControl'Panel

When you ciick ~1'he option Control Panel from the cascading menu of Settings, a window is opened that -
contains the icon of the utilities for changing hardware configurations or customising the Windows.95 °
graphical interface as shown below :

g Cng,l Panel

CElS g

oy

Accessibiity ~ AddNew  Add/Remove
Options Hardware Programs

Joystick Keyboard

@ 3\

0DBC Paszwcids Printers .Regional
Sgttings

P o o e enm e e ks e am e eeen

{19 objectfs)

You can also access the utilities of Conirol Panel, if you click on My Computer and then on Control Panel
icon.

29
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Date & Time

To update date and time settings of the system, follow the steps given below :

i, Select Date/Time icon from the displayed icons that will open-up the window displaying the current date
znd time. '

OR
Double-click on the clock on the right-most ;:omer of the taskbar. 7
9. Click the down-arrow in the month field to choose the correct month.
3. Click the up or down-arrow in thé year field to choose the current year.
4. Click the currenf day in the calendar.
5. Set the new time-field by clicking the up or down-arrow

OR
Click anywhere ih the text-box and type a new number.

6. To set the correct time zone, click the Time Zone tab and then click your current location on the map of
the world that is displayed.

Looks of Windows

The looks of Windows include wallpaper and pattern in the background of the desktop, cursor blink rate or
item size, color and fonts.

To change the background of your desktop

¢ In the Pattern or Wallpaper list, click the nattern or wallpaper you want to use.
o To cover your entirc screen with a small wallpaper image, click Tile.

e To center a wallpaper image, click Center.
To change the way the items on your desktop look

»  If you want to change the appearance of only one screen element, click that element in the Item list. Then
change the settings in the Item Size and Color and Font Size and Color areas.

e If you want to change the appearance of all screen elements simultaneously, click an appearance scheme
in the Scheme list.

To use larger or smaller display fonts

o In the Font Size box. click the size you want your displayed fonts to be.

»  To customise the size of displayed fonts, click Custom.

s Ifthe Font Size area is unavailable, make sure your Desktop Area setting is higher than 640 by 480
pixels. If 640 by 480 pixels is the only setting available to you, you cannot change your display font.



To adjust the rate at which your cursor blinks Manage Syifcfn
Windows 95
e Drag the slider in the Cursor Blink Rate area.

Add Neiv Hardware

To set up new hardware

Click on the Add New Hardware icon (as shown ) to start the Add New Hardware wizard.

Add New
Hardware

Simply, follow the instructions on your screen.

It is recommended that you let Windows detect your new hardware. Make sure you have connected your
hardware or installed its components in your computer before running the wizard.

Fonts

{nere is a collection of fonts with \yindows 95. You can use these to format text in documents. The fonts can
“be viewed, added, or removed from the available font list.

To view fonts on your computer
1. Double-click the Fonts icon to open the Fonts folder.

2. To look at a sample of a font, double-click the icon for the font.

“When you install a printer, it may include several printer fonts. These do not appear in the Fonts folder, but
they do appear in the Font list of Windows-based programs such as WordPad.

To add a new font fo your computer

1. Open the Fonts folder.

2. On the File menu, click Install New Font.

3. Click the drive and folder that contain the fonts you want to add.

4... Double-click the icon for the font you want to add.

To select more than one font to add, press and hold down the CTRL key, and then click the fonts you wan:.

Te select a range of fonts in the list, press and hold down the SHIFT key while dragging the cursor over the
fonts. .

"To delete a font from your computer

1. Open the Fonts folder.

2. Click the icon for the font you want to delete.

k3
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A (§r§rilliéul User 3. " On the File menu, click Delete.
fnterface .

To select more than one font to delete, press and hold down the CTRL kev, and then click the fonts you
want. '

Keyboard

Keyboard layouts vary to accommodate the special characters and Symbols used in different languages. This

affects which characters appear when you press the keys on your keyboard. After you change your keyboard
layout, the characters that appear on your screen may no longer correspond to the characters that are printed
on your keyboard’s keys. : ' '

To change the keyboard layout

L. In the list, click the language whose keytoard layout you want to change, and then cli'ck_A Propérties.

N

2. Selecta differe}lt keyboard layout.
To change the way your keyboard responds

I If you want to adjust how much time clapses before a held-dowsi key beguis icpeating, drag the Repeat
Delay slider. '

2. If you want to adjust how quickly characters repeat when you hold do_Wn a kéy, drag the Repgaf Rate' :
slider. - ‘ - :

You can test the repeat delay and repeat rate by clicking the box below the sliders, and then holding down a
key. ' o ' '

Mouse

The settings for the mouse include the button configuration, double-click speed of the mouse, pointer speed
and pointer trail, mouse pointer shapes, and switching over to different mouse driver.

To change the settings. double-click the Mouse object. The displayed window shows four tabs - Buttons,
Pointers, Motion, and General. These tabs are far different purpose of settings.

To reverse your mouse buttons

1. Select the Buttons tab.

2. In the Button Configuration area, click Right-Handed or Left-Handed.

To adjust the double-click speed for your mouse
1. Select the Buttons tab.
2. In the Double-Click Speed area, drag the slider.

3. Totest the speed, double-click the image in the Test area,

32



To change the appearance of your mcuse pointer Manage System in
Windows 95

1. Click the Pointers tab.

2. To change all your pointers at one time, select a different scheme in the Scheme list.

3. To change only one pointer, click it, click Browse...; and then double-click the filename of the pointcr
you want to use. C )

By default, only a limited set of mouse pointer schemes is installed during Windowé_ Setup.

To adjust the speed of your mouse pointer

1. Select the Motion tab.

2. In the Pointer Speed area, drag the slider.

Changing the speed of your mouse pointer causes the pointer to respond more quickly or slowly to thc
movements of the mouse itself.

To turn on and adjust the mouse pointer trail

1. Click the Motion tab.
2. In the Pointer Trail area, make sure the Show Pointer Trails box is cheoked.

3. To adjust the length of the pointer trail,_ drag the slider.
To switch over to the different model of the installed mouse

1. Click the General tab.

2. Select the type of mouse you have installed from the list box.

Regional Settings

While installing Windows 95, you have to select a country, on which depends the number formats, currcncy,
time and date formats. These formats are used in various windows programs.

To change the settings

I Sclect the object Regional Settings from the Control Panel window.

2. The Regional Settings Properties window is opened in which you can select the formats appropriate for
your country. N

3. Click on the Regional Settings tab.
4. On the map displayed, click the region and Windo xs 95 c:hénges its formats to match that reigion.

5. For special adjustments, click the Number, Currency, Time, or Date tab and change settings.
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Using the System Properties dialog box can modify the System configuration once set. For this, click on the
object System from the Control Panel window. From this dialog box, you can view or modify your
computer’s hardware settings.

Click on the General tab to display the configuration of your computer, the operating system that is being
used, and the name of the person and organization to whom the software is registered.

{lick on the tab Device Manager to view the devices that are connected to your computer either by their
types or by their connections.

if you click on the tab Hardware Profiles, you are provided with a way to crzate hardware configurations
that you can choose from at startup. Though there are very few instances in which there is any need to create
hardware profiles.

To enable or disable hardware in a hardware profile

1, Click the plus sign next to the hardware type, and then double-click the hardware.

2. Inthe Device Usage area, click to place a check mark next to each hardware profile in which you want to
enable the hardware, or clear the check box to disable the hardware for that hardware profile.

3. If you see a message prompting you to restart.your computer, click Yes.
Click on the Performance tab to display the Performance Status of your comput i system. For example :

total memory, percentage of free system resources at that instant, File System, virt..al memory, information
about Disk Compression and PC cards.

2.3.2 Printers

Windows 95 has significant advances in printing features. These ave :

o It supports bi-directional communication with printers so that printers can provide Windows 95 with
information about their current state and attributes.

e The Windows 95 printing system also returns control to users more quickly after a job is sent to the
printer due to a new print spooler.

¢ Mobile and remote users can defer their printing job until later if they are not connected to a printer.

Print jobs are stored in a local queue and automatically sent to the printer when they reconnect with the
printer or recennect to a network that has printers.

2
-

To change printer settings

1. Select the object Printers from the Control Panel winduw.
2. From the Printers window, click the icon for the printer you are using.

3. On the File menu, click Properties.

4. The settings you can change depend on the type of printer you have. Click the different tabs to see all of
- the options you can set.



settings for one document, use the Page Setup or Print Setup command on the File menu in your program. Windows 95
To set up a new printer

1. Select Add Printer icon from the Printers window.
2. Add Printer Wizard is opened, and follow the instructions on the screen.
3. If you want to print a test page, first make sure your printer is on and ready-to print.

If you want to use a shared network printer, you can set it up quickly by browsing for it in Network
Neighbourhood, clicking the printer's icon, and then clicking Install on the File menu. ’

2.4 BACKUP YOUR DATA

You can use Backup to back up files on your hard disk. You can back up files to floppy disks, a tape drive, or
another computer on your network. When you have made a backup file, you can restore it if your original ~
files are damaged or lost.

There are two ways you can backup your files :
e You can backup files on your hard disk to a floppy disk or other media by using simple copy techniques.

e The Microsoft Backup utility can also be used, which compresses files and puts them in an archive.
These compressed files can be copied to a floppy drive, tape drive or other backup device.

To start the Backup utility

1. Click Start and select Programs.
2. Select Accessories from the cascading menu, and then click on System Tools.

3. Now click on Backdp! -

If this utility is not wesépt in the cascading menu of System Tools, then probably this utility was not
installed when you set up the system.

To install the Backup utility. follow the instructions given below :
1. Start the Add/Remove Programs utility from the Control Panel window.
2. Click-the Windows Setup tab and click the Disk Tools option in the window.

3. Then clickv OK to install the Backup utility, and then follow the instructibns on the screen.

While restoring backup files. again the Microsoft Backup utility is used. Restoring the files may pose a
problem if vou need to restore them on a system that does not have this utility or is not running Windows 95.
In that case, other backup method may be used.

35
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Changing the printer properties will change them for all documents you print on this printer. To change these Manage System in

X



A Graphical User
toterface

2.5 DISK DRIVE UTILITIES

Windows 95 includes utilities to format diskettes, Check diskettes and hard drives for errors, defragment
disks. and do other types of maintenance. Some o; these utilities are discussed below.

To access these utilities
1. Open the Start menu and select Programs.

2. Choose Accessories and then System Tools. The cascading menu that appears includes the various Disk
Drive utilities.

2.5.1 Disk Defragmenter
Disk Defragmenter is used to rearrange files and unused space on the hard disk so that programs run faster.
To speed up your hard disk by using Disk Defragmenter, follow the instructions given below :

1.~ From the cascading menu of System Tools, select Disk Defragmenter. Select Drive dialog box is
opened to sclect the drive you want to defragment.

Select Drive

.

_",’;Whicli drive do you want to defragment?

3 Praveen (C)) :_J
5 53 Floppy [&:) ‘
= 3% Floppy [B:)

2. Click the drive you want to defragment. and then click OK.
3. Ifyou want to change the settings that Disk Defragmenter uses, click Advanced....

4. Click Start.

While Windows defragments the selected disk, the computer can safely carry out other tasks. However, the
computer will operate more slowly. To temporarily stop Disk Defragmenter so vou can run other programs
at full speed, click Pause.

2.5.2 Check for Disk Errors

You can use ScanDisk to check your hard disk for logical and physical errors, and then repair the damaged
areas.



To check your disk's surface, files, and folders for errors Manage System in
Windows 95

1. Select the option ScanDisk from the cascading menu of System Tools.

2. Click the drive you want to check.

3. Click Thorough. If you want to change the settings ScanDisk uses when checking the disk’s surface,
click Options. If you want to change the settings ScanDisk uses when checking files and folders, click
Advanced.

4. Click Start.

Select {he dlige[§] you'w
&= 5% Floppy (A:)
{&3 3% Floppy (B:)

. If you want to specify how ScanDisk repairs any crrors it finds, make sure that the Automatically Fix Errors
* box is not checked.

The Standard type of test is only to check errors in files and folders, but does not check the disk surface.

2.5.3 Increase Disk Space
You can use DriveSpace to compress both hard and floppy disks to create more free space If’or files. You can

also usc DriveSpace to configure disk drives that you have already compressed by using DoubleSpace or
DriveSpace.

To determine how much space is available on a disk

1. Double-click the My Computer icon, and then click the disk you want to check.

2. On’the File mén"u, click Properties. A pie chart shows how much free and used space is on the disk. Z .;'



A Graphical User To create more disk space by using DriveSpace
Interface

1. Inthe Drives On This Computer list, click the drive you want to compress.
2. On the Drive meny, click Compress.
3. Click Start.

4. If you have not backed vp your files, click Back Up Files, and then fcilow the instructions on your
screen. When you are done, proceed to step 6. '

(9, ]

Click Compress Now.
6. If Windows prompts you to restart your computer, click Yes.

7. If youwant to free up more disk space after your ccmputer restarts, start the Disk Space Troubleshooter
again.

2.5.4 Format Disks

Formatting a disk means establishing the tracks and sectors on the disk where files will be stored. Be aware
that formatting a disk removes zall infcrination from the disk, you cannot fermat a disk if there are files open
on that disk. If the disk has been comnpressed, use DriveSpace, or ather compression scftware. to format the
disk.

To format a disk

1. If the disk you want to format is a floppy disk, insert it into its drive. Otherwise, go to step 2.

2. Double-click the My Computer icon, and then click the icon for the disk you want to format. Be sune
not to double-click the disk icon, because you cannot format a disk if it is open in My Computer or
Windows Explorer.

3. On the File menu, click Format.

The various options for formatting disks are:

Capacity It could be low-density or high-density.
Format Type : Quick(erase) Formats the disk without checking for error§.
Format Type : Fuli Checks for the disk errors and then reforinats it.
Format Type : Copy System Files Only Copics the system files to the formatted disk to

make it bootable.
Label Type the label name for the disk.

No Label This option is selected if you do not require the
label name for the disk after formatting it.



Display Summary when Finished To get information about the bad sectors (if any) Manage System in
after the disk is formatted. , Windows 95

Copy System Files Copies the system files during the formatting
process.

2.6 ADD/REMOVE APPLICATIONS

The Windows 95 components, accessorics, or other applications can be added or installed, and removed by
using the Add/Remove Programs utility from the Control Panel window. The advantage of usirg this
utility 15 that Windows 95 inaintains control over the installation process by making proper entries into the
registry.

T'o install an application, click on Install... button. While installing the application, the wizard helps you to
complete the process step-by-step.

To add a program, select it from the displayed list of programs and then click on Add/Remove button.

To remove the application, again select it from the displayed list of applications and programs and click on
Add/Remove button.

2.7 SET-UP WINDOWS FOR MULTIPLE USERS

[f more than one person uses the same computer,’cach one can customisc the settings according to his/her
needs. The important fact is that, each user has to create a prefile so that when he/she logs on, their personal
windows settings are used.

To set-up user profiles

1. Click the Password object from the Control Panei.

2. Select the 2nd option under User Profiles. When it is selected. the options under the head User Profile
Settings are highlighted.

3. Choose the options as you require.

4. Click OK.

This enables multiple users to personalise settings.
To log off your computer so someone else can usc it

. Click the Start button, and, then click Shut Down.

2. Then click Close All Programs And Log On As A Diffcrent User.
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At times, you may require to work in MS-DOS environment.
To start an MS-DOS window

I. Click the Start button, zu}d then point to Programs.

2. Click MS-DOS Prompt.

To switch between a full screen and a window, press ALT+ENTER. To quit MS-DOS, click X or type Exit
at the command prompt. '

Check Your Progress

I. What is “My Computer” ?
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4. Name the various disk drive utilities.
5. How can you add Windows 95 components or accessories that were not installed before 2

..............................................................................................................................



2.9 SUMMARY | ' Windows 95

L
iR

"Manage System ir %

In this session you learned :

10.

11

12.

In Windows 95, all the things you have on computer. like prog'rams, documents, and data files, are
accessible from one place called My Computer.

The System can be personalised by making intcresting and useful chaﬁges to Windows 95 settings.

Windows 95 has utilities for changing hardware configurations or customising the Windows 95
graphical interface.

The System configuration once set can be modified.

While installing Windows 95, you have to select a country, on which depends the number formats,
currency, time and date formats that are used in various windows applications.

Changing the printer properties will change them for all documents you print on this printer.

The Microsoft Backup utility compresses files and puts them in an archive. These compressedfiles can
be copied to a floppy drive, tape drive or other backup device.

While restoring backup files, again the Microsoft Backup utility is used.

Windows 95 includes utilities to format diskettes, Check diskettes and hard drives for errors; defragment
disks, and do other types of maintenance.

The Windows 95 components, accessories, or other applicaticns can be easily added or installed, and
removed.

If more than one person uses the same computer, each one can customise the-settings according to
his/her needs by creating a profile for every user so that when he/she logs on, their personal Windows
settings are used.

You can easily switch over to MS-DOS prompt to work with DOS-based applications.

2.10 MODEL ANSWERS

The questions given in the ‘Check Your Progress’ have been designed only at the conceptual level apd the
answers to these questions are directly available in the unit. Therefore, Model Answers have not been
provided. However, as this block is more practical oriented, therefore, students are advised to try the
-commands given, on their terminals.

-y
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UNIT 3 FILES AND FOLDERS

Structure

3.0 Introduction

3.1 Objectives
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33 Working with Files
3.3.1 File Naming Conventions in Windows 95
3.3.2 Finding a File
3.3.3  Creating a File
3.3.4  Copy/Move Files
3.3.5  Associating Files & Programs
3.3.6 Delete Files
3.3.7 Find Information on a file

34 Working with Folders
3.4.1  Creating and Renaming Folders
3.42 Deleting Folders
3.4.3 Viewing Folders
3.4.4 - Organising Files with Folders
3.4.5 Controlling Access to a Folder

35 Recycle Bin

3.6 Summary

3.7 Model Answers

3.0 INTRODUCTION

The Windows 95 file system is based on folders. Folders hold files and other folders, so the system is
inverted tree-structured. In this unit, we will discuss about the management of files and folders in Windows
95. In previous versions of Windows, folders were called directories. The benefit of creating folders and files
under them is better organisation of your information.

3.1 OBJECTIVES

At the end of the unit, you should be able to work with:

' the files and folder of Windows 95
basic file operations -
the windows explorer
* organisational and access related aspects of files.

3.2 WINDOWS EXPLORER

" Windows Explorer is a file-management utility that provides an alternate method of accessing the Windows -
95 tile system. This utility is in the place of File Manager that was in the previous versions of Windows.



Explorer gives you a view of your entire file system, as well as file systems on other computers if you are
connected to a network.

Filen aned Velboie / £

To start Explorer

1. Select Programs from the Start menu.

2. Select Windows Explorer from the cascading menu of Programs.

: eFdder  2B/STTSPM [E
B8 Sk (k) Y Fle Folder 5123057 548 P
B8 P (B) | Fil Folder 2021150 71084

E] 2D PraveenC) ] File Folder 313/97 409 AM
U : “mssetup.t File Folder 2121737 7.04 AM
. E‘; 5 File Folder 2120197 10:54 AM
LA d’f"' File Folder 2/20/97 11:02AM
Dey | F1° Folder 4723137 417 PM

Dos

On the left of the Explorer window, you can view the desktop, and drives and folders under My Computer
When you click a-drive and folder, 1ts contents are displayed on the right part of the wmdow

I
From this window, you can easily copy, move files by simply dragging it tc the folder where you want to
place it. To delete the file, drag it to Recycle Bin heading on the left side of the window.

3.3 WORKING WITH FILES

Files contain information like text, graphics, and numeric data. Initially they are _.cated in the memory of the
system, but then they are saved to a disk storage device. -

There are different types of files that are categorised by the type of information they hold. These categories
are :

FILES TYPE OF INFORMATION - EXAMPLE |
Program Files Contain computer—readab.e code written by ' Calc.exe, Clock.exe,

programmers. -| Dialer.exe, Winword.exe ;

- N ]
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‘;‘m(;::mm Cser Support Files Some programs store information in these Wphelp.hlp, Config.sys
files, but they cannot be exccuted or started. °
° These files have the extension names as .OVL,
.SYS, .DRV, and .DLL.
| Text Files Contain alphanumeric characters that follow Relnotes.rif, Sample.txt
‘ the ASCII format. Autoexec.bat,
Graphics Files Contain visual or graphic information. Rivets.bmp, Thatch.bmp
Multimedia Files Hold sound and video information in digital ‘Passport.mid, Tada.wav
form.
Font Files' Contain information about various fonts, ‘| Coure.fon, Courbd.ttf
Other Data Files Contain numbers, names, addrésses, and other
information created by database and
spreadsheet programs.

3.3.1 File Naming Conventions in Windows 95

There are certain guidelines to be followed while working with files in Windoxys 95. These aré;
i. Files in the same folder cannot have the same name.

2. Windows 95 supports 256-character filenames in botﬁ upper and lower case,

3. | The drive and folder location of the file is important.

4. You can use multiple period-separated extensions, like Budget.Sales.1997. This is also a strategy for
long filenames.

5. Names can include spaces but not the special symbo's as shown
2N e <>

6. Windows 95 does not use uppercase or lowercase formats to distinguish filenames.

7. Wildcard characters can be used to search for filenames.
3.3.2 Finding a File

To find a file or folder, follow the given steps:

1. Click the Start button, and then point to Find.

2. Click Files Or Folders.

3. ln'the Named box, type all or part of the file's name.

If you do not know the nanie of a file or want to refinc the search, click the Date Modified or Advanced
tabs.




5. If you type upper- and lowercase letters in'the Containing Text box on the Advanced tab, and you want
the search to be case-sensitive, click the Options menu and make sure the Case Sensitive box is
checked. - ‘ ‘ '

6. If you want to specify where Windows shquld begin its search, click Browse....
7. Click Find Now.

S8 If you want to save the bres'ults of a search along with the search criteria, click Options, and then click
Save Results. - ' '

9. If you want to save ohly the search criteria, make sure the Save Results box is clear.

10.- Click the File menu, and then click Save Search. An icon representing the search results or search
criteria appears on your desktop.

3.3.3 Creating a File

You can use Notepad to create or edit text files that do not require fénixatting and are smaller than 64K.
Notepad opens and saves text in ASCII (text-only) format only. To create or edit files that requires
formatting or is larger than 64K, use WordPad. ' '

WordPaﬁ is a text editor for short documents. You c¢an. fbrrnat'documents in WordPad with various fonts and
paragraph styles. '

We will learn to use Notepad and WordPad ‘in the next unit.
3.3.4 Copy/Move Files

 The files can be copied or moved from one destin;ition to another. This can be done either through menus
using cut and paste technique or by using drag ‘and» drop technique. :

To copy a file, follow the given steps:

1. 'In My Computer ui Windows Explorer, click the file you want to copy. To select more than one file .
- copy, hold down the CTRL key, and then click the items you want, -

2. On the’Edit',menu, click Copy.

3 Open the folder or disk wheré you want to .;.mt the copy.

4. On the Edit meh_u,' click Pdsig._

To copy a file to a floppy disk, the steps are: -

1. Insert the disk in the'ﬂoppy d'i‘sk dfive. ,

2. In My Co‘mputeAr or Windows Ex.plore'r, click the file you wéﬁt to copy.

-3. On the File meny, point to Send To, and then click the drive you want to cc;py the file to..

1o
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To move a file, the steps are:

1. In My Computer or Windows Explorer, click the file or folder you want to move. To select more than
one file to move, hold down the CTRL key, and then click the items you want.

2. On the Edit menuy, click Cut.

3. Open the folder where you want to put the file.

4. On the Edit menu, c}ick Paste.

In drag and drop technique, you use the mouse to click a file or folder and drag it to.new location. This

technique is used when both the source file and the destination folder, drive or other object to mové the
source to are visible.

3.3.5 Associating Files & Programs

While saving the document file, most of the programs automatically add a filename extension to it. In
Windows 95, certain extensions are associated with programs, so if you double-click a document with a
certain extension, the program in which it was created starts and loads the document in its workspace. For
example, .DOC files are associated with Microsoft Word.

‘You can also create your own associations. If you have all your data files in Excel, you can save these files it

Excel with the extension .DAT, then associate this extension with MS-Excel. After that, whenever you will
double-click the file with the .DAT extension. Excel will start and load the document in its workspace.

To change which program starts when you open a file, follow the instructions given:
. In My Computer or Windows Explorer, click the View menu, and then click Options....
2. Click the File Types tab.

3. Click the New Type... button to display the Add New File Type dialog box.

&) CD audio Track

m) CFG File




4. Type the description in the Description of typ§ bo;c, ) 7 Files and Foider:
5. Then type the new extension in the Associated extension box.
6. Click the New... button. This will open the New Action dialog box.

7. Type Open in the field Action and locate the application associated with the extension name by clicking
on Browse... button.

8. Click OK
9. Inthe Add New File Type dialog box, click the two lower check boxes to enable these features.

10. Click OK.

3.3.6 Delete Files

To delete a file or folder, follow the steps given below :

1. In My Computer or Windows Explorer, locate the file you want to delete.
2. Click the file.

34. On the Filé menu, click Delete.

If ybu want to retrieve a file you have deleted, look in the Recycle Bin. Your deleted file remains in tae
Recycle Bin until you empty it. A

You can also drag file or folder icons onto the Recycle Bin icon. If you press SHIFT while dragging, the
item will be deleted from your computer without being stored in the Recycle Bin.

3.3.7 Find Information vn a File

At some point of time you. .may“.need to get information about certain files, like :
*  What type of file is this ?

e What is its size ?

*  When was it created or last modified ?

¢ What are the attributes of the file "

To get all this information

1. Right-click the file on which: you want the information.

2. Select Properties from thé s hort-cut menu that is displayed.

:
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A dialog box appears that displays the information on the selected file.

3.4 'WORKING WITH FOLDERS

Till now, we have done a lot of work with folders. The concept, being same as of directories, is not difficult -
to understand. Now, we will get to know better by creating, naming, deleting, controlling access to folders.

3.4.I Creating and Renaming Folders

You can create a new folder directly on the desktop, at the root level of a disk drive, or within another folder.
To create a new folder, fol’-+; thg steps given bélo’w :

1. In My Computer or Windows Explorer, open the folder in which you want to create a new folder.,

2. On the File menu, point to New, and then click Folder. The new folder appears with a temporary name.
3. Type a name for the new folder, and then press ENTER. h

To change the name of a file or folder, the steps are:

1. InMy Computer or Windows Explorer, click the file or folder you want to renamé. You do not need tc
open it. '

2. On the File menu, click Rename.
3. Type the new name, and then press ENTER.

The name can contain up to 255 characters. including spaces. But. it cannot ¢ontain any of the following
characters: \/:* 9" <> | .



3.4.2 Deleting Folders Files and Folders

Deleting a folder removes all files and subfolders within it.
To delete a file or folder, follow the given éteps:
1.” In My Computer or Windows Explorer, locate the folder you want to delete.
2. " Click the folder.
3. On thg: File menu, click Delete. ‘
OR
‘Right-click the folder and select Delete from the menu.:

. OR
Right-click and drag the folder to the Recycle Bin.
The deleted folders can be retrieved from the Recycle Bin. But if they are removed from there also, then it is

not possible to récover the deleted folders.

343 Viewing Folders

To see the hierarcﬁy of ‘folde_rs ona ciisk drive, the steps are :

1. 'Clifck;me;sm;-:_b;unqq:

2. Point to Programs, and then click Windows Explorer.

3. Click a folder on the left side of the window to dispiaf} its contents on the right. .
4. Click the plus signs (+) to display more folders.

To change the size of either side of the'winAdow,‘ drag the bar that separates the two sides. To quickly open a
folder and display its subfolders, double-click the folder on the left side of the window.

3.44 Organising Files with Folders

Folders are created within other folders to organise the file system. The advantages of doing this are : -
e 'Most programs, when you instail them, are automatically placed in their own folders.
e Creating separate document folders helps keep document files separate from program files.

e Backing-up files is easy.
3.45 Controlling Access to a Folder

You can control access to your folders by using passwords or by listing names of people you want to have
access to these resources.

AO
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o control access to a folder, the steps are:

. In My Computer, click the shared folder you want to limit access to.

2. On the File meny, click Properties.
3. Click Sharing.

4. I you are using user-level access control, click Add to specify the people you want to be able to use
yOur resources. -

(¥,

If you are using share-level access control, type the password you want to use for the folder.

3.5 RECYCLE BIN

The Windows 95 Recycle Bin protects you from accidentally deleting files. This is located on the desktop.
You can use it to retrieve files you deleted by mistake, orempty it to create more disk space.

If you have opened too many windows, and you cannot see the Recycle Biri, use right mouse button to click a
biank area of the taskbar, and then click Minimize All Windows.

The Recycle Bin holds deleted files in a queue, with the most recently deleted files on the top. The oldest file.
is permanently deleted when the queue becomes full, as Recycle Bin has a limited amount of space.

{#"WRSO0OSTMP: . TMP Fil
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The deleted files can be recovered by dragging them out of the Recycle Bin to an appropriate drive and
folder. ’

The Recycle Bin folder has a menu with many familiar options, for example, the View option is to change the
way files are listed or rearrange the order of files. } ’

You can also click the buttons above each column to sort the file list on that column. If the width of the
column is not enough to accommodate the entries, then point the mouse to the left or right side of a column
bution, and then click and drag to widen the bution.

To clear out the Bin, choose Empty Recycle Bin from the File menu. Individual files can also be deleted by

selecting them and choosing Delete on the File menu. This will permanentiy delete the files without any
chance of recovering them.
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" To change the amount of disk space set aside for storing deleted files: Files and rolders
1. Right-click the Recycle Bin object and choose Properties.
2. Inthe Properties for Recycle Bin dialog box, you can adjust the amount of disk space to hold delete'd
files. The default disk space is 10% of the disk drive’s total size. Decrease this value if you are running
out of disk space, or increase it if you have a lot of disk space and want to make sure you can recover
more files.
Check Your Progress’
1. What was the name given to folders in the earlier versions of Windows? -
2. What is the function of Windows Explorer?
3. WhatisaRecycle Bin?

.....................................................................................................

~
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& SUMMARY

In this session, you have learned.

1.
2.

w

N s

The Windows 95 file system is based on folders.
Folders hold files and other folders, so the system is inverred tree-structured.

Windows Explorer is a file-management utility that provides an alternate method of accessing the
Windows 95 file system.

Files contain information like text, graphics, and numeric data.
Notepad can be used to create or edit text files that do not require formatting and are smaller than 64K.
WordPad can be used to create or edit files that require formatting or are larger than 64K.

The files can be copied or moved from one distination to another either through menus using cut and
past technique or by using drag and drop technique.

In Windows 95, certain extensions are associated with programs, so if you double-click a document with
a certain extension, the program in which it was created starts and loads the document in its workspace.
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10.
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14.
15.

The deleted file remains in the Récyclc Bin until you empty 1.
Folders are created within other folders to organise the file system.

You can create a new folder directly on the desktop, at the root level of a disk drive, or within another
folder. :

Deleting a folder removes all files and subfolders within it,

You can control access to your folders by using passwords or by listing names of people you want to
have access to these resources.

The Windows 95 Recycle Bin is located on the desktop.

The Recycle Bin protects you from accidentally deleting files, as you can use it to retrieve files you
deleted by mistake, or empty it to create more disk space.

3.7 MODEL ANSWERS

The questions given in the *Check Your Progress’ have been designed only at the conceptual level and the
answers to these questions are directly available in the unit. Therefore, Model Answers have not been
provided. However, as this block is more practical oriented, therefore, students are advised to try the
commands given, on their terminals. '
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40 INTRODUCTION

Windows 95 comes with a set of programs called “Accessories”. These accessories are used to write, paint,

calculate, and perform a variety of other tasks. Some of these accessories Were also in the previous version of
Windows. Usually, they have common features, so they are easy to use. This unit will be discussing about
the use of these accessories. '

4.1 OBJECTIVES

A the end of the this unit, you should bg able to deal with:

Paint package

Wordpad and Notepad

Other accessories of Windows
Briefcase utility: of Windows 95

42 RUN YOUR PROGRAMS

To'run the accessory programs, follow the instructions:
1. Click the Start button.
2. Then click on Programs, and then click on Accessories.

3. The cascading menu appears. Click on the program you want to run.

53
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To run other programs, that have been created by the users :

1. Click on Run... option from the Start menu.

2. 'Run dialbg box is opened. In the Open text box, enter the path name of the program you want to run.
3. 0f you do not remehber the name of the file, click on Browse... buttoﬁ.

4. In the Browse window, look in text box lists the available drives, folders, and files. Click on the down-
arrow.

5. To see inside a folder, click it. The box below shows the folders and files in the selected lqcation.

6. Double-click a folder or file to open it.

7. To open the folder one level higher, click " = on the toolbar.

8. Once the file is located, click on Open and then click on OK from the Run window.

43 WINDOWS 95 ACCESSORIES

In the following session, we will discuss the various accessories in more detail.

'43.1 General Use

The usual accessory programs that are used are easy and useful to work with. They are provided for
performing certain day-to-day activities of the users.



Calendar

Windows Calendar is used to view the current .month’s calendar that shows the day and date, and also the
-current day showing the timings to keep track of your appointments. To display either of the mentioned:
views, click on the View option, and select whichever you require.

1] Calendal lUnmIedl

11:00
12:00 PM
1:00
2:00
3:00
4:00
5:00
6:00
7:00
8:00

F

Monday, May 26 1997

May 1997
w
4 5 6 7 8 9 10
1 12 13 14 15 16 17
18 19 20 21 22 23 | .24
25 57 | 28 | 29 30 3

Above given are the samples of two views. The left window displays the day schedule to track your

appointments, whereas, the right window displays the month calendar.

Calculator

You can use Calculator in standard view to do simple calculations, or use it in scientific view to do

advanced scientific and statistical calculations. You have been using this program in earlier versions of
Windows also.

Character Map

Character Map works only with Windows-based programs. Thls is used to insert a special charactet into a

document.

To insert a special ciaracter in the document, follow the given steps :

1.

2.

Select Character Map from the cascading menu of Accessories.

Click the Font box, and then click a font.

To magnify a character in Character‘Map, click it and hold down the mouse button. Double-click each

character you want. The character(s) will appear in the Characters To Copy box.

Click Copy.

In your document, clxck where you want the charactcr(s) to appear, click the Edit menu, and then click

Paste. \

Select the character(s), and then change them to the same font you used in Character Map.

Programs and
Accessories
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Clipboard Viewer

As we know from our earlier experiences, that clipboard is the invisible holding area for copy and cut
operations, but you can save the information for later use. If the current information on the clipboard is not
saved, itis lost the next time you copy new information to it.

Clipboard is mainly used to transfer information between applications.
Cardfile

You can use Windows Cardfile to organise and manage information, such as names, addresses, and phone
numbers.

Card view displays your file as a series of cards. List view displays the index line of every card.in the file in
alp* :betic order.

Index Line

Information Area

Index Line is the bar at the top of each card that contains the title of the card. Entering text in the index line is
optional. In List View, the index line of every card in the file is displayed in alphabetic order.

The area of the text below the index line, into which you type information is the Information Area.

The options from the menu enable you to the usual tasks like, add or delete cards. Pictures and drawings can
also be embedded or linked in cards.

MS Exposition

Microsoft Exposition is used to learn about Microsoft products, in categories such as Entertainment,
Business, and Kids.



Games

If you do not see any games on your Accessories menu, then you did not install any games when you
installed Windows. Usually the games that come with Windows 95 software are Solitaire, FreeCell,
Minesweeper, and Hearts.

4.3.2 Writing & »D‘raw‘iing

Whereas, drawing brings out fun in the work, writing part is essential for all types of communications. The
different tools that are provided with Windows 95 are WordPad in addition to Paint (Paint Brush in earlier
versions'of Windows), and Notepad that was there in earlier also. Let us look into these tools in detail.

Paint

Paint is a bitmap-painting program with a full set of painting tools and a wide range of colours. You can use
it to create, edit, and view pictures. The pictures created by Paint can be pasted into another document you
have created, or use it as your desktop background. You can even use Paint to view and edit scanned photos.

To start Paint, select Paint frori the cascading menu of Accessories.

ait‘ . ———

The Paint window conists of a workspace, or canvas, where you paint pictures. To the left of the canvas is
the Toolbox, which contains a set of painting tools. The colour palette is at the bottom of the canvas. The
selection box is on the left side, where you select the width of lines or pen tips to use for the Brush, Line,
Eraser, and other tools. To paint, select a tool, a colour, and a line width, and then start painting on the
canvas.

Programs and
Accessories
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WordPad

WordPad is a text editor for short documents. Though, this accessory does not have the advanced features of
full-blown word processors like MS-Word. You can format documents in WordPad with various fonts and
paragraph styles.

To start WordPad, click on Start menu, then on Accessories, and then on WordPad.

Once WordPad is mnnihg,‘ you can do the following:

1.

‘Specify the initial page layout for a document, such as paper size and margin settings.

2. Type, edit, and delete text, as well as copy or move text from one place to another You can also copy or
move text between two different applications.

3. Change the font, style, and size of characters, and change the alignment and indents of paragraphs. You
can also set special tabs and create bulleted or numbered lists.

4. Search for previously typed text or replace fext with new text.

5. Create compound documents that contain pictures, spreadsheet data, charts, sound, and vidc
other applications.

Notepad

You can use Notepad to create or edit text files that do not require formatting and are swaller than 64K.
Notepad opens and saves text in ASCII (text-only) format only. To create or edit files those require
formatting or are larger than 64K, use WordPad. Notepad loads very quickly and is easy to learn and use:

To start Notepad, click on Notepad from the cascading menu of Accessories.




Now you can typé text in the workspace and use standard editing techniques to insert, delete, and copy or Programs and
move text. Ascessovies

4.4 BRIEFCASE

Briefcase is designed for mobile users who carry portable computers with them while'travelling. These users
work on files at home and while travelling on the road, therefore they can use Briefcase to help keep the
various copies of the files updated. : '

The principle behind Briefcase is that, the user has multiple copies of files on different systems. The

Briefcase keeps track of which files are the most recent and update the files that do not have the most recent

data. ’

To use Briefcase, follow the steps given below:

1. Drag files from shared folders on your main computer to the Briefcase icon on your portable computer,

2. After you finish working on the files on the portable computer, reconnect to your main computer.

- 3. Click Update All in Briefcase to automatically replace the unmodified files on your main computer with

the modified files in you Briefcase. The files on your main computer are automatically revised; you do

not need to move the files you worked on out of Briefcase or delete the existing copies.

When you are copying files from your main computer into Brlefcase, the two computers must be connected,
either over a network or by a cable. '

If you do not see a Briefcase icon on your desktop, follow the steps given below:

1. Ciicfc on Settings from the Start menu, then click on Control Panel, and finally double-click on
Add/Remove programs object to open the Add/Remove Programs dialog box.

2. Click Accessories, and then click Details.

3. Click the checY box for Briefcase to mark it for installation, and then click OK.

Check Your Progress

I. What are the “Acdessories” of Windows?

s.;»‘-...-..-.-.’...‘..a-‘-.¢....--.‘.~-o.-..:..~‘.---.....‘....-..A.........'l .................................................

..............................................................................................................................

...........................................................................................................................

3. What s the function of the “Briefcase” in Windows 952
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4.5 SUMMARY

In this session you have iearned:

1.

12.

13.

Windows 95 comes with a set of programs called “Accessories”.

Windows Calcndar is used to view the current month’s calendar that shows the day and date, and also the
current day showing the timingg to keep track of your appointments.

You can use Calculator in standard view to do simple calculations, or use it in scientific view to do. -
advanced scientific and statistical calculations.

“Character Map works only with Windows-based programs, that is.used to insert a special character into a

document.

Clipboard is the invisible holding area for copy and cut operations, and also to save the information for
later use.

Clipboard is mainly used to transfer information between applications.

Windows Cardfile is used to organise and manage information, such as names, addresses, and phone
numbers.

Microsoft Exposition is used to learn about Microsoft products, in categories such as Entertainment,
Business, and Kids. ,

The pictures created by Paint can be pasted into another document you have created, or use it as your -
desktop background.

. WordPad is a text editor for short documents.

. Notepad is used to create or edit text files that do not require formatting and are smaller than 64K.

Briefcase is designed for mobile users who carry portable computers with them while travelling.

The Briefcase keeps track of which files are the most recent and update the files that do not have the
most recent data

4.6 MODEL ANSWERS

The questions given in the *Check Your Progress’ have been designed only at the conceptual level and the
answers to these questions are directly available in the unit. Therefore, Model Answers have not been
provided. However,-as this block is more practical oriented, therefore, students are advised to try the
commands given, on their terminals.

PP
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5.0. INTRODUCTIGN

In many organisations today, computers are connected together by cable or by phone line in a network. In a
network; a computer can be attached to computers in adjoining offices, adjoining buildings, and to computers
around the globe. If you are connected to a network, you can open and save files on other computers or use
resources attached to those computers, like printers and CD-ROM drive. Of course, you must have access
permission-

Windows 95 has come up with another bonanza, that is, Network Communication with other users, The users
can connect with other users to share data files and peripheral devices, like Printers.

The communication tools of Windows 95 include E-Mail and connection to Intemet.

S.1 OBJECTIVES

At the end of this unit you should be able to:

Set up the network configuration using Windows
Share folder and printers over a network

Browse the network

Set up connection for dial-up connectivity

® & o o

5.2 NETWORK SETUP & CONFIGURATION

Assuming that the network administrator has already installed the network and established your computer as
a workstation, you should be able to identify your computer network settings, like - the network name, the
workgroup it belongs to, and how folders, drives, and other resources are shared on your computer.

[

e



A 4

A Graphical
EJser Interface

To access other computers on your network, open the Network Neighbourhood object on the desktop. If your
network is large, you can view the computers in your immediate workgroup. A workgroup is a collection of

- computers and computer users that share similar resources and belong to the same group. Whereas, domain

that is similar to a workgroup is much larger in scale. Each domain has its own computers and workgroups
and is managed independently of other domain.

To find out the network settings, double-click the “Network™ object from the Control Panel window. In the

Network window that is opened up, you will find three tabs - Configuration, ldentification, and Access
Control.

Configuration will display the network components that are installed, or removed, or properties are viewed.
These are: ’ '

CHamt Software - It enables you to use files and printers shared on other network computers.
An Adapter - 1t is a hardware device that physically connects your computer-to the network.

A Protocol - 1t is the set of rules a computer uses to communicate over a network. All computers connected
1o the same network must use the same protocol to communicate with each other.

In the same window, the Primary Logon is the client that is used to validate your user name and password,
process any login script, and perform other start-up tasks. ‘

Identification tab will open up the dialog box that displays the information to identify your computer on the
network. In this, the Computer name is the name of your computer that other people see when they browse
the network. The Workgroup is the name of the local network that your network belongs to. The Computer
Description text box provides the place to enter the description for your computer. Other users will view this
information when they browse the network.

Access Control tab provides you the option to determine how the files on your computer and the resources
attached to it are shared over the network. The two options are:

Share-level access control is used to specify the passwords that other network users must type to access the

resources you share on your computer.

User-level access control enables you to validate or authenticate users before they can access your computer.
This works only if your netwerk has a special security server.

5.3 LOGGING ONTO THE NETWORK

The Network Administrator assigns the login name and the password to every person who will use the
network.

If you are already working on Windows 95,40 log on to the network, follow the given instructions: -
1. Click the Start button, and then click Shut Down.

2. Click Close All Programs and Log On As A Different User.

3. Click Yes.

»

In the Enter Network Password box, type your user name and password.
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In order to access folders on network drives from some applications, a drive letter must be assigned to these
folders. These drives are not physical drives but the mapping is done for logical drives.

To map a drive letter to a network computer or folder, follow the given steps:

1. In My Computer 6r Network Neighbourhood, locate the folder you want to map.
2. Right-click the folder to open its context menu.

3. 'In the Drive box, the next recommended drive is displayed. You can click on the down-arrow button to
choose a different drive letter. In any case, it should not be the drive letter that is already in use.

4. Type a. path to the computer and folder in the Path field.

5. Click OK.

To disconnect a mapped dri+ e to make it free for other mappings, follow the given steps :
1. Open the My Computer window. |

2. Right-click the mapped object yqu want to disconnect.

3. From its context menu, select Disconnect to remove the mapping.

5.5 NETWORK BROWSING

Open the Network Neighbourhood window to browse the computers and resources on the network. Even it is
easy to copy or move files on another network computer.

To locaté a fodder on another network computzr, follow the given steps:

1. Open the Network Neighboufhood window in which computers in your network neighbourhood is
displayed.

2. Locate and double-click the: icon of the computer you want to access.

3. A window showing all the shared resources on that computer is opened. From here double-click the
folder you want to work writh.

In Windows 95 networks, the rights you have in a folder also apply to all the subfolders within the folder.

5.6 SHARING FOLDERS & PRINTERS

Folders and printers can be shiared amongst different users on the network. Even you can share disk drives by
using the method described tielow.

o
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To share a folder with other people, follow the given steps :
1. In My Computer, click the folder you want to share.
2. On the File menu, click Properties.

3. Click the Sharing tab, and then click Shared As. If the Sharing tab is not visible, you need to enable file
and print sharing services.

.4.  Choose options and fill out the options (described in detail below).

5. Click OK,

Fields in the Shared As area are:
Share Name - the name that will appear to other users when they browse the network.

Comment - to describe the object. Choose List from the View menu of a Network Neighbourhood window to
see the shared resources and their commerits.

Options of the Access Type area are:

Read-enly - Other users can read files from the device but they cannot change them without copying them to
their own computers fifst.

Pull - Other users can read and write ﬁles to and from the device.

Depends on Password - The user has both Read-only and Full access rights for the devxce, but he must type
the cotrect password to gain access.

Options in the Password area are:
Read-only Password - to gain read-only access to the device.

Full-access Password - to gain read and writes access to the device. -

5.7 CONNECTING TO ANOTHER COMPUTER ON YOUR
NETWORK

Connection to another computer on your network enables you to see files and folders on that computer only if

they are shared. The connection can be either a Dial-up connection or through Cables. Both of these are
discussed below.

5.7.1 Dial-up

To set up a network connection by using Dial-Up Neiworkin’g, the steps are:

1. Double-click the My Computer icon, and then double-click Dial-Up Networking. If you do not see a
Dial-Up Networking folder in My Computer, then it is not installed.

2. Foliow the instructions on the screen.



If you have already set up éne or more Dial-Up cdr,inections, you can double-click Make New Connection to
create a new connection. To dial a connection that you have already set up, double-click its icon in the Disl-
Up Networking window.

5.7.2 Using Cables

To set up a direct cable connection, the steps are:
I Click the Start button, and then point to Programs.

2. Point to Accessories, and then click Direct Cable Connection. If you
do not see Direct Cable Connection in your Accessories menu, then it is not installed.

3. Follow thenstructions on the séreen.
If you have already successfully run Direct Cable Connection on this computer, the connection w;zard does

not appear unless you click Change in the Direct Cable Connection dialog box. The wizard then starts, and
you can change your previous séuings. '

3.8 E-MAIL

E-Mail is a sophisticated network communication. You can call it as an electronic postal siystem. The users
can exchange messages within minutes. Even the data files and large documents can be sent through E-Mail.
With Windows 95, this can be done either using Microsoft Exchange or'Microsoft Network.

With Microsoft Exchange, you can send and receive electronic mail. You send messages from and store all
messages in MicrbsoftvExchange, so there is one convenient place to look for all your me:ssages. To open
Microsoft Exchange to send or receive a message, double-click the Inbox icon on your desktop. If the Inbox
icon is not on your desktop, then Microsoft Exchange is not installed.

Also an access to the Microsoft Network, a new on-line service, is a feature of Windows 95. With the
Microsoft Network, you can exchange messages with people around the world; read the.latest news, sports,

weather, and financial information;; find answers to your technical questions; download fi-om thousands of
useful programs; connect to the Internet, and more! '

To start The Microsoft Network, double-click The Microsoft Network icon on your desktop.

3.9 INTERNET

The Internet is a global interconnected “web” of computers and computer networks. Schools, institutions,
businesses, hospitals, research institutes, and other entities are connected to the Internet and make their
systems available to the public. The underlying connections include the dial-up telephone network and
satellite and ground-based microwave links. The new computers and networks are constantly added and the
electronic pathways of information are constantly changing.

E-Mail services are availabie on the Internet. Your access to some cf the information may be free and
unrestricted, may depend on access privileges, or may be quite expensive.

Communication
‘Throvgh Metweary
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Connecting to the Internet

There are many ways you can connect to the Internet using Windows. Two of these are:

1. You can sign up for*The Microsoft Network on-line service.

2. You can create a Dial-Up Networking connection to an Internet access provider.

Following are the steps to follow, if you are creating Dial-Up Networking connection to an Internet access
provider;

i.  Getting an Raternet account

When you call an Internet access provider to sign up for Internet account, make sure you get the following
information:

¢ User name

* Password

Access phone number

L]

Your host name and domain name

¢ . Domain Name Server (DNS) server address

'_I‘he access provider may also provide the following information:

o IPaddress and subnet mask

® * DNS search order (if required)

e Gateway'addres_s

*  Authentication procedure (whether or not they require a terminal window to log on)

Use a PPP account if your provider offers it. If your organisation has a direct connection to the Intemnet, you
can skip this step. : '

2. Setting up your communications hardware

You need a modem (9600 bps or faster is recommended) to connect to the Interniet. If your organisation has 2
direct connection to the Internet, you can use a network adapter card instead of a modem.

3. Make sure you have Dial-Up Networking installed

Double-click the My Computer icon on your desktop. If you do not. see a Dial-Up Networking icon, then
follow the given steps:

1. Display Add/Remove Programs window.
2. Clic}c Communications, and then click Details.

3. Check Dial-Up Networking, and then click OK.



4.  Install the Windows 95 TCP/IP protocol Communication
Throug™ Network

Display Network properties. If you see (in the displayed listy tifat the Windows 95 TCP/IP protocol is not
installed, then follow the given steps: ’

1. Click Add. "
2. Click Pr;)tocol, and then click Add.

3. Click Microsoft, and then click TCP/IP.

4. Click OK.

5. Click Dial-Up Adapter, and then click Properties. If your organisation has a direct Internet
connection, click your network adapter, and then click Properties.

6. Click the Bindings tab, and then make sure the TCP/IP check box is checked.

When you install TCP/IP, it is bound to all of your-adapters by default. If you have a network card and do not
use TCP/IP with it, click the Bindings tab, and then remove TCP/IP.

'S.  Entering TCP/IP information

1. Open up Network propei‘ties.

2. Click TCP/IP (If there is more than one TCP/IP entry, click TCP/IP -> Dial-Up Adapter), and then
click Properties.

3. On the IP Address tab, if your provider gave you an IP address, click Specify an IP Address, and
then type your IP address and subnet mask.

4. If your provider did not give you an IP address, click Obtain an IP Address Autoniatically.
6.  Setting up a connection to your access provider

In DiaioUp Networking, double-click Make New Connection. (If it is your first Dial-Up Networking
connzction, you will be prompted automatically.) And follow the instructions on your screen.

1. Using your right mouse button, cliqk the Connection icon, and then click Properties.

2. If your provider requires a terminal window to log in, click Configure. Click the»Options tab,
make sure Bring Up Terminal Window After Dialling is checked, and then click OK.

3. Inthe Properties for the connection, click Server Type, and then make sure the type of server is
set to PPP. ’

You can decrease the time required to connect by making sure that the following options are not checked:
¢ Log On To Network
¢ NetBEUI

e IPX/SPX Compatible
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7.

Dialing your Internet access provider

Double-click the connection, enter your name and password, and then click Connect. Follow the instructions
provided by your Internet access provider for browsing the Internet, reading e-mail, and accessing
information.

Check Your Progress

1.

to

(93]

What is a Computer Network 7

R

..............................................................................................................................

...............................................................................................................................

3.10 SUMMARY

In this session, you have learned:

2.

The users can connect with other users to share data files and peripheral devices, like Printers.
The communication tools of Windows 95 include E-Mail and connection to Internet.

In a network, a computer can be attached to computers in adjoining offices, adjoining buildings, and to
computers around the globe.

To access other computers on your network, open the Network Neighbourhood object on the desktop.

The Network Administrator assigns the login name and the password to every person who will use the
network. '



6. Inorderto access folders on network drives from some applications, a drive letter must be assigned to. Communication
these folders. , Through Network

7. The Network Neighbourhood window is used to browse the computers and resources on the network,
and to copy or move files on another network computer. :

8. In Windows 95 networks, the rights you have in a folder also apply to all the subfolders within the
folder. o ’ '
-9.  Connection to émothcr computer can be either a Dial-up connection or through Cables on your newwork
that enables you to see files and folders on that computer only if they are shared, -

10. E-Mail is a sophisticated network communication that is also called as an electronic postal system,
through which the users can exchange messages, data files and large documents within minutes. With
Windows 95, this can be done either using Microsoft Exchange or Microsoft Network. - '

11. The Internet is a global interconnected “web” of computers and computer networks.
12. The two ways of connecting to the Internet using Windows are either you can sign up for The Microsoft

Network on-line service, or you can create a Dial-Up Netwarking connection to an Internet access
provider.

5.11 MODEL ANSWERS

The questions given in the ‘Check Your Progress’ have been designed only at te conceptuai ievel and the
answers to these questions are directly available in the unit; Therefore, Model Answers have not been
erovided. However, as this block is more practical oriented, therefore, students are advised to try the
wormands given, on their terminals. ’ ' '

e,
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UNIT 6 MULTIMEDIA IN WINDOWS 95

Structure

6.0 Introduction,
6.1 Objectives
6.2 Multimedia in Windows 95
6.3 Multimedia Add-ons
6.4 Media Types
6.4.1 Audio
6.42 Visual
6.5 Multimedia Tools
6.5.1 CD Player
6.52 Media Player
6.53  Sound Recorder
6.54  Volume Control
6.6 Summary
6.7 Model Answers

6.0 INTRODUCTION

‘Multimedia is the term for different media like graphics, animation, sound, and video all wrapped in one
_ interactive package. The basic idea is to manage and co-ordinate the various devices of communication and
entertainment electronics with the RC as a central controller: Multimecdia brings dazzle to presentations, ,
actions to games, and fun to leaming. It promises to play an important role in the communication systems of
the future. :
Multimedia uses the concept of digita! information that has many advantages:

¢  The information like pictures and sound are stored in digital forms and can be copied without loss of
quality. :

» Digital information can be compressed to take up less space on a storage device.
o Information can be put on a CD-ROM, and CD-ROM’s take up very little shelf space.
o Interactive computer programs that use digital media are excellent learning tools.

In this unit, we will discuss about multimedia tools in Windows.

6.1 . OBJECTIVES

After going through this unit, you should be able to:

o define multimedia in Windows 95
¢ identify multimedia add-ons
* use the multimedia tools
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The previous versions of Windows and DOS were not designed to support multimedié, therefore, the
multimedia presentations were either not running or running very slowly. With Windows 95, things are
improved as it supports multimedia at the base level, as discussed below:

Multimedia presentations require more than one media, and Windows 95 is a 32-bit, multitasking and
muitithreading operating system. This assures piaying more than one media smoothly, and more
responsive to user interaction.

During installation procedure of Windows 95, it automatically detects and configures itself for
multimedia devices

Windows 95 aliows you to create compound documents that include sound, video, graphics, charts,
pictures, and other elements from various applications.

A new CD-ROM file system in Windows 95 improves CD-ROM performance.
An AutoPlay feature makes it easy to set up and play back programs on CD-ROM. .
The video standard in Windows 95 is widely supported in the computer industry.

Windows 95 supports larger video windows and higher frame rates.

‘Windows 95 supports Sony VISCA interface which means that you and your applications can control

VCRs and laser disc players.

New graphic programming interface improves the game performance i Windows 95.

- Windows 95 supports a variety of mdustry-standard sound and video compression codecs (coders /

decoders). Codecs reduce the size of multimedia files.

" All the multimedia controls can be changed or edited from the Multimedia Properties dialog box. To open

this box, open the Control Panel and double-click the Multimedia utility.
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6.3 MULTIMEDIA ADD-ONS

Multimedia add-ons are the hardware devices and software rivers that are required to convert a PC (Personal

Computer) to a MPC (Multimedia PC). The Multimedia Marketing Council defines MPC specifications. The
members of this council are a number of leading hardware and software manufacturers like - Microsoft,  _
Tandy, Fujitsu, AT&T, Olivetti, Media Vision, Creative Labs, CompuAdd, NEC Technologies, and Headland
Technology.

Following are the minimum requirement for running Windows 95 multimedia:

¢ An Inter 80486 CPU, though a Pentium systein is recommended for digital video applications.

e A PCl bus to provide high data throughput for disk controllers and video cards.

® A high capacity HDD (in gigabyte range) _is‘-"‘riecessary while capturing high-quality digital video. -

e A dual-speed, triple-speed. or quad-speed &-ROM drive with front-panel volume control is required.

*  Sound cards that provide 11.25-,22.05-, and 44.1-Khz stereo sampling rates, multivoice ana
multitimbral capabilities. and internal mixing capabilities to combine input from multiple sources.

*  Microsoft rccommends VESA or PCI video cards for best performance. as the requirement is for VGA or
better video hardware that can support 640 X 480 at 16 colors. Although the digital video looks best
when supported by SVGA at 600 X 800, and 256 colors.

* An IBM-stylc analog or digital jovstick port.

e A MIDI (Musical Instrument Digital Interface) port. MIDI is a standard for recording notes and related
information that is played on electronic music devices like digital kevboards.

6.4 MEDIA TYPES

The different media types are either audio or visual. Multimedia information is stored in sound. video. or
MIDI file format.

6.4.1 Audio

Recording and playing back sound were the first multimedia applications for personal computers. With the
Help of installed sound card. you could record a voice, store it in a file on disk, and play back the same sound
on another computer. Music and sound can be recorded for computer-generated presentations.

" There are basically two typés of audio for multimedia:

Wave Audio - Actual sound waves are recorded and converted to digital data.



MIDI Audio - 1t is the recording of keystrbkes or other actions that direct synthesisers and other MIDI- Multimedia ir
compatible electronic music devices to generate sound. Thus, thesi files are smaller in size, Windows 95

6.4.2 Visual _ .
This media includes the following files:

Animation - The first thing that comes in mind are the animation movies like Jungle Book. Animation is the
images that move on the screen. The animation movies include these kinds of images and sound.

Video - The video pictures can be récorded from cameras or laser discs into a computer and store it on the
disk. To capture high-quality video and store it efficiently, these files need to be compressed.

6.5 MULTIMEDIA TOOLS

Windows 95 offers accessorie; for editing and listening to sound, playing movies, and playihg music CDs.
To access these accessories, follow the gi\}en steps:

1. Open the Start menu.

2. Select Programs from the menu.

3. Fr?m the cascading menu, click on Accessories.

4. Then click on Multimedia from the cascading menu of Accessories.

The options of the Multimedia menu are - CD player, Media Player, Sound Recorder, and Volume Control.
Each of these is discussed in the subsections. '

6.5.1 CD Player

You can use CD Player to play audio compact discs from a CD-ROM drive connected to your computer. To
use CD Player, you also need a sound card.

Click to start a CD To stop playing CD

| & Co Player
Rise Misw * Dotions  Help.
; lu?:' @-@@ 1":
 (00] 00:00

- ‘a.*“tvjst‘: |D ata or no disc loaded

e e R

Title: [Ploase insart an audio compact, dise’. .

NIV R

Tiacs: ’

| ¥otal Play: D006 me 7T

To eject CD from drive
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Before playing a CD make sure it is in the CD-ROM drive, and then click the start button as shown in Figure.
Your CD continues to play even if you minimise CD Player.

6.5.2 Mecdia Player

You can use Media Player to play audio, video, or animation files, and to control the settings for multimedia
hardware devices. To use Media Player also, you should hwuve a sound card.

6.5.3 Sound Recorder

The Sound Recorder is a handy but somewhat limited digital recorder. Using Sound Recorder you can
record, play, and edit sound files. To use Sound Recorder, you must have a sound card and speakers installed
on your computer. If you want to record live sound, you also need a microphone. This multimedia utility can
be used to create recorded messages andinclude them in files or include them in electronic mail messages
that you send to other users. :

To record a new sound, follow the steps given:

1.

Attach a microphone to the soundboard or a patch cable from another sound source, such as a CD audio
player or stereo.

To customise recording options, choose Properties from the File menu.
Choose recording format in the Format Conversion field.
Click the Convért now button that opens the Sound Selection dialog box.

In the Name field, specify the quality of sound from the pull-down list - CD Quality, Radio-Quality, or
Telephone Quality. For every option of the Name field that you select, note the contents of the Format
and Attributes fields, which show the recording options and disk space requirements in seconds.



Jlay the pre-recorded sound
‘{a Windows 95

Multimediz in

1. Open the File menu from the Sound Recorder window.
2. Choose the Open command.
J. Open the Media folder that is the subfolder of the Windows folder.

4. Choose the wave file that you want to play.

:5.4 Volume Control

~+ou have a sound card, you can use Volume Control to control the volume and speaker balance when you -
+ay audio files.

- adjust the volume for multimedia devices, open the Multimedia Properties dialog box. In the Playback
© Recording area, drag the Volume slider.

Chek Your Progress

1. . Whatdo you understand by the term Multimedia? N

...........................................................................................................................
..............................................

.............................................................................................................

- SUMMARY

wssion, you have learned:

“ltimedia is the term for different media like graphics, animation, sound, and video all wrapped in one
"“active package. :

edia uses the concept ¢! digital information.

timedia presentations require more than one media, and Windows 95 is a 32-bit, multitasking and
“*hreading operating system.

4. Multimedia add-ons are the hardware devices and software drivers that are required to convert a PC
(Personal Computer) to a MPC (Multimedia PC).
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5. The Multime,diaMarketing Council defines MPC specifications. p

6. Vhe different media types are either audio of visual.

7. Multimedia information is stored in sound, video, OF MIDI file format.

§. Thereare basically two types of audio for multimedia, that is, Wave Audio and MIDI Audio.

g, The visual media includes either the Animation file or Video file.

10. Windows 95 offers accessories for editing and listening to sound, playing movies, and playing musi
s,

i1, Youcanuse Media Player to play audio, video, or animation files, and to control the settings for
multimedia hardware devices.

12. The Sound Recorder is a handy but somewhat limited digital recorder.

13. Using Sound Recorder you can record, play, and edit sound files.

14, ifyouhavea sound card, you can use Volumé Control to control the volume and speaker balance
you play audio files. '

¢- MODEL ANSWERS

"The questions given in the ‘Check Your Progress’ have been designed only at the conceptual Jevel and ©*

answers to these questions are directly available in the unit. Therefore, Model Answers have not been
provided. However, as this block is more practical oriented, therefore, students are advised to try the

comraands given, on their terminals.
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BLO’Clg INTRODUCTION

In the previous block, we have discussed about the Graphical User Interfaces and have stated that onc of the
advantages of GUI is the common look and feel. In this block, we will demonstrate this feature without
specific mention. This block presents two important applications, viz. Word Processing and Presentation

- Graphics, on Windows platform. This block although is practical oriented, yet we expect from you that you
will try to relate the features discussed in this block to any other similar application on Windows platform.

4

This block mainly focuses on Microsoft Word, a full-featured Word Processor that can be used to create:
letters, memos, reports, newsletters and just about any other kind of document, and Microsoft PowerPoint, a
package for creating presentations. The block consists of five units.

Unit 1 covers the fundamental features of Word, and explains the various typing and editing features in
MS-Word. S

init 2 covers the various character formatting and paragraph formatting features.
onit 3 describes the various Page Design and Layout features, Table Creation and handling.v

Unit 4 introduces you to Mail Mgrge and Macros. The various advanced techniques of Mail Merge have alsc
been discussed. It also explains the document management.

The fifth unit covers the introduction to Business Graphics, how to create presentation slides, using tools like
Wizards, creation of graphs and tables, and creating slide shows. ‘

lease note the objective of this block is not to give you the complete functionality of these packages, but to
srovide the basic feel of it. However, you can experiment with the options once you are familiar with the
asic concepts explained in the block. -

5






UNIT1 MS-WORD BASICS

Structure

- Introduction
. Objectives
1.2 Starting WORD
1.3 The WORD Screen
1.4 Getting to Word Document
1.5 Typing and Revising Text
1.5.1  Typing Text
1.5.2 Text Editing
1.5.3  Copying and moving
1.54  Typing Special Characters (Sy 1bols)
15 Some Common Features
1.6.1  Changing the CASE of text
1.6.2  Moving & copying text with drag & drop
1.6.3  Justifying text ,
1.6.4 y Creating Bulleted & Numbered lists
1.6.5  Arranging & moving between documen..
1.7 . Finding and Replacing .
1.8 Editing and Proofing Tools
1.8.1  Using the Spelling Checker
1.8.2. Checking Grammar
1.9 Summary
1.10  Model Answers

1.0 INTRODUCTION

Consider the following typed letter:

C-1/45
Janak Puri
Delhi-110 058

Dear Anu,

We both have holiday next Monday. What do you say to a trip to muree and a ramble in the gulli s?
We could start early, say 6 a.m., in my car, and take some group with us, and make a day of it up in the cocl.
It would be a change from this heat down here. If you agree, I will arrange the picnic, and-be round at ycu:r
house at a quater to six on Monday moring. Bring your carnera with you.

Yours

Rohit

Just notice, in this letter, there are some spelling errors, typing mistakes, missing words, missing lines, &
paragraph to be moved down andsoon.

In order to make the changes, the entire document has to be retyped and if there were many documents of this
sort, the time and effort required to retype each wouid be phenomenal.

Such work, defined above, is called Word Processing.
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A word processor is a software pa~kage, which helps enter and edit a document much faster than the usual
manual ways. Most of the word processors today allow much more than allowing one to enter and edit a
document. :

The following is a list of some of the functions that are possible by using a Word Processor:

L]

Creating the document (typing in)

Saving the document -

Opening an existing document

Moving or copying paragraphs from one place in the document to another
Finding the words and replacing them with another word

Searching for spelling errors

Printing the document etc.

In this block, we will describe the use of a word processor: Microsoft Word (MS Word). MS Word is a
windows based application and is a normally available as an icon in the Application group or the MS Office

group. This unit describes the various features related to

typing and revising text, selecting text as a group,

instead of a letter or word at a time.

Most word-processing efforts, whether a note to yourself or an annual report, are created through an iterative
process of typing & editing. In this unit, we briefly cover some simple ways of revising documents.

With Word, you can sea
* command. :

rch a document for specific characters, formats, or styles using the Find & Replace. .

_ Various editing & proofing tools including spell check have been explained. Word’s spelling feature is used-
- .to check an entire document or a block of selected text against Word’s built-in dictionary or against
" specialized dictionaries that you create. T Toommre e

s e o

11 OBJECTIVES

" After going through this unit, you will be able to

-
L)

. printa document, )

“create bulleted text. T e

start the WORD software package.

create-and edit document,

close and save the document,

copy and'move text.

finding and replacing text

- -correct your typed document .us.'ri:g spett chéc}kar.:
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12 STARTING WORD

As in the case with other window applications, to invoke MS Word, you click on the icon Microsoft Word. In
“application or MS Office group the following icon will be displayed. To invoke MS Word, double click on
this icon.

Startxfng Word and Opening a document

To start word and smmltaneously open a word document, double-click the filename of the document in the
“File Manager

1.3 THE WORD SCREEN

This section provides an overview of the major elements on the Word screen, such as menus, toolbars and
‘status bar,

) When the word is started, a new, blank document appears on the word screen. The followmg illustration -
1dent1ﬁes each part of the word screen.

Standard Taolbar Formatting Toolbar Title Bar i Menu Bar

Mlcms )" Word Documenl‘

- Use these buttons to switch to /
- different views of the document Ruler Scroll Bar

" The (Menu-bar) provides access to the word commands. These commands are grouped together in menus,
with only the group (menu) name dlsplayed on the menu bar..
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The “toolbars” contain buttons that provjde quick access to commonly used commands.

Clicking a button has the same effect as selecting the command from the menus, but can be done in a single

action.

The Ruler

The Ruler allows you to accurately set the layout of the document. It allows you to set tabs, indents, and
change page margins.

1.4 GETTING TO WORD DOCUMENT

This section explains the basic procedures for creating new documents, saving your work, opening existing
documents, and printing.

Creating a Document

To create a new document at any time, click the new button on the Standard toolbar. While creating a
document such as memo, letter, report, or resume, on¢’ can often save time by using one of the wizards or
templates that come with Word.

When you open a document it is placed on the top of any existing once and becomes the active document.

The next step is to enter the text for the document.

Opening a Document
To quickly open one of the last documents you worked on, choose it from the bottom of the file menu. To

open a document, click the Open button on the Standard toolbar. When the dialog box appears, select the
document in the File Name box (Wmdows) and then choose the OK button.

Saving a Document

To save a document on disk, click the Save button on the Standard toolbar. When you save a document for
the first time, Word displays the Save As dialog box so that you can type a name for the document.

- Printing a Document

Before printing a document, Page breaks and choosing print preview from the File menu checks the overall
appearance of the document. To view the document one page at a time, and also edit the text more easily,
choose Page Layout from the View Menu. When ready to print, click the Print button on the Standard
toolbar. Your default printer should be set using Windows program for printing.

Closing a Document and Quitting Word

When finished workin g in Word close the active document and then quit Word by choosing Exit (Windows)
from the file menu. To work on another document in Word, close the active document by choosing Close
from the file menu and then open the other document.

Also, several documents can be open at the same time. To work in a particular document, click anywhere in
its window, or select the document name from the window menu.
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1.5 TYPING AND REVISING _TEXT

When you open a new document in Word, the insertion point is at the top of theddcurhent ready for youto
begin typmg Word inserts a non-printing character called a paragraph mark at the end of a paragraph This
section gives the details about typing text and the various ways of revising text.

1.5.1 Typing Text

Typing text in MS-Word is very easy and straightforward task, because of the useful word processing features
supported by it. When you create a new document in Word you can just start typmg Press the Enter key
only when you have finished a paragraph.

MS-Word automatically moves the text to the next line when it reaches the right edge of the screen. This
feature is known as word-wrap. When you end a paragraph, word inserts a non-printing character called a

paragraph mark (). To display all non-printing characters, click the show/hide button on the standard
toolbar.

1.5.2 Editing text

detmg Text includes selecting, deselecting, deletmg, inserting, replacing text, which are described in thrs
subsections.

- The cursor changes shape to an I-beam when it is over the text work area (document page). However, when

you move the cursor into the left margin it changes to a white arrow. The area of the page is known as the
“selection bar” and allows you to select blocks of text easily. .

1. Selecting text

You can select text by dragging over the text to select it, as well as clicking actions. The actions you perform
- depend on what you want to do. The options are:

Selecting a word; a complete line; an entire sentence; a paragraph; a block of text, the whole document.

i)  The easiest way to select a word is to double-click anywhere on the word. The selected text then
appears reversed (or highlighted).

ii) ~ One way to select a complete line of text is to drag the cursor over it.

A simple way to achieve this is to click in the left margin beside the line (the cursor appears as a white
arrow).

To select several lines drag the mouse in the left margin beside the text you require.

iii) To select an entire sentence hold down the “CTRL” key and click anywhere in the sentence. Note that
the punctuation mark (if any), and the space following the sentence is also selected.

iv)  You can select a paragraph by clicking three times anywhere within the paragraph. Alternatively,
double clicking in the left margin beside the paragraph can do this.

v)  To select the block of text click at the beginning of the first line, then press “Shift” as you click at the
end of the last line you wish to select.
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vi) Toselecr the whole document click three times in the left margin. Alternatively, you can do this by
pressing the "CTRL” key and clicking in the left margin

2. Deleting Text

Text can be deleted by using either the “Delete” or “Backspace” keys. Delete removes single characters to
the right of the cursor, while backspace removes single characters to the left.

Block deletions make it casy to delete sentences. paragraphs and sections of documents. Once you have
selected the text you wish to remove, pressing the “Delete” or “Backspace” key removes it from the
document.

3 Inserting Text

MS-Word offers several ways of inserting text into an existing document. The simplest among all. is to move
the cursor to the required position and .art typing. The existing text will be pushed and adjusted accordingly.

Place the mouse pointer (the 1-beam) where you want to being inserting text.

Next, click the mouse button to move the insertion point to the desired locations.

4. Replacing Text

Word can combine the steps ot deleting unwanted text, positioning the insertion pomt and inserting
replacement text. To replace text:

. Select the text to be removed
. Start typing the new text
. The selected text will be removed and the new text accommodated.

1.5.3 Copying and Moving

Word tor windows supports all of the usual windows techniques for copying and moving information (text,
graphics or an item inserted from other application)

. - “Moving” means to remove (cut) the sclected text or graphic from one location and insert it in
* another location,

. “Copying™ means to make a copy of the selected text or graphic and 'naert it in another location,
- leaving the original unchanged.

Cut, Copy & Paste

‘The procedures used to cut, copy and paste are similar to window s editing procedures. If a portion of the

text is to be moved to a different place, select the text to be moved and then use the cut option in the edit
menu. The selected text will be copied to the clipboard in Windows. Now the Paste option is enabled in the
Edit menu. To paste the text that is in the clipboard at some position in the document. place the cursor at the

starting point of insertion and choose Edit — Paste. The text will be pasted there.

If the text to be pasted elsewhere is only to be copied but not removed trom its original position then

. Select the text to be copied

. Choose the Edit — Copy option.



. Place the cursor at the insertion point. - : MS-Word Basics
. Choose the Edit — Paste option to paste a copy of the selected text.

The pasie option can be repetitively used once the copy operation is made. To try these operations type the
following lines of text: : : , - .

Example:*:

If you choose to do a complete installation, can tell the installer whicb items want to install.

Now, selecfth?é word “you” from the example ahcve. Lnuose Edit — Copy. The text will be copied to the
Clipboard. - Now place the cursor after the compa and choose the Edit — Paste option. Again place the
cursor between the words items and ‘want’ and repeat ihe paste operation. Thie final text should look like
this. LT : : '

If you choose not to do a complete installation, you can tell the installer which items you want to install,

Copying From One Word Document to Another

. ‘ . |
MS-Word provides facility to copy (portions or whole) one document to another. To do this, two documents
should be opened first. To edit two documents at the same time do the following:

. Open any two documents on¢ after the other using the File menu.

. Choose the Window —» Arrange All option. The two documents are displayed in separate windows
on the screen. The highlighted title bar indicates the active window. ’

o ‘To-activate a document window of your choice just click on that document with the mouse pointer.
The individual documents can be.re-sized according to convenience using the size-boxes in the
lower=right corners of the window. »

o Now copy the portion of ihg document desired to be copied to the other document on to the
’ clipboard using Edit — Copy option.

. Change the focus of input to the other document and place the cursor at the point of insertion.

. Use Edit — Paste option to copy the document.

1.5.4  Typing Special Characters (Symbols)

MS-Word supports a set ef special characters and symbols, which ¢annot be entered through the keyboard.
To insert these specials characters choose Insert — Symbol. The dialog box of all available symbols is

displayed for respective fonts. Clicking on the symbol disnlays an enlarged version of the symbol. Double
clicking inserts the characters at the current cursor position in the document.

If you don’t see the symbol you're looking for, vou may nieed to select a different font in the font box, which
shows all of the fonts installed on your system. All fonts based on the ANSI or ASCII character set are listed
as Normal Text.
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The Special Charactes; tab includes additional characters such as em and en spaces, em and en dashes, non-
-breaking hyphens, non-breaking spaces, ©, and ®.

- To display and print a particular symboli, Word needs both the screen font and the printer font that contain
that symbol. If you have installed only the printer font, the symbols may be printed properly but may not be
displayed correctly.

1.6 SOME COMMON FEATURES

In this section, we will discuss some of the common features of the MS-Word.

1.6.1 Changing the Case of text

The “Change Case” command in the “Format™ menu allow you to change the case of the characters in text
without having to retype them.

In brief, to change the capitalization of text
1. _Sei:ct the text yoﬁ want to change.
2. From the Format menu, choose Change Case.

3. Select the option you want, and then choose the OK button.

For-a quicker method of achieving the same results, select th: text vou want to replace and then press
SHIFT+F3 until the text has the effect you want.

1.6.2 Moving and copying text with drag and drop
You can move text within a document by dragging it to a new lecation. This method of moving text is known
as “drag and drop”. When you move text its attributes (size, fonts, etc.) accompany it without changing the
text in the new location. ' : '



To drag and drop, you first select the text you want to move, then drag it to the desired location. When the
cursor is positioned over selected fext it changes to a white left pointing arrow. Drag-and-drop editing is the
easiest way to move or copy a selection a short distance and you can also drag and drop items between
documents. However, to move or copy a selection a longer distance, the Cut, Copy and Paste commands are
often more convenient,

To move text and graphics using drag-and-drop editing.
1. Select the text and graphics you want to move.

2. Point to the selected text and graphics, and thzn hold down the mouse button. When the drag-and-drop
pointer appears, drag the dotted insertion point to the new location.

3. Release the mouse button to drop the text into the selected place.

To copy text and graphics using drag-and drop editing.
1. Select the text and graphics you want to copy.

2. In Windows, hold down the CTRL key, point to the selected text and graphics, and then hold down the
mouse button while you drag the dotted insertion point to the new location.

1.6.3 Justifying text

Justification determines the way text is aligned with respect to the margins. The default for Word is left
Justification, which aligns text to the left margin. You can change the justification of text by using the
Justification buttons on the toolbar from left to right they are:

- Buttons for Numbering

Buttons for Justification and Indenting

Creating anew-documentq]
Saving tha*documenty]
Printing the'documendl]
Copying fee-documenty

MS-Word Basics
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1. Left - Justifies text'on the left margin;

2. Center - Centers all lines of text;

3. Right - Justifies text on the right margin:

4. | Justify - Justifies text on both left and right margins.

When you justify text the current paragraph or selected text is atfected. The selected justification remains in
affect for the document until you change it.

1.6.4 Creating Bulleted and Numbered lists

You can casily create a bulleted or numbered list by selecting a list and then clicking the Bullets button or the
Numbering button on the formatting toolbar. Alternatively, you can click either of these buttons before you
type a list. When you’ve finished typing the list, just press ENTER and click the samc button again. The new
text you type is not formatted with builets or numbers.

1.6.5 Arranging and Moving between open documents

All the open documents can be viewed at the same time via the “Arrange All” command in the “Window”
menu. The title bar of the active document becomes colored.

Jp——

To move to another document, you click inside its window or via the window list in the “*Window™ menu.

Check Your Progress 1
1. Type in document given below (The content of check your progress) and perform the following
operations:
i) Go to the third of the Ist paragraph and copy it at the bottom of the current page and at the
beginning of the next page.
i) Cat the first word of the paragraph and raste it at the end of the first sentence.
iii) Make the paragraph right justiﬁed.
iv) Split the screen to two portions. Set one portion of the document to the page layout view and
the other to Normal view.
v) Type in the last paragraph of one portion to the other portion and watch the changes.
vi) List the steps to remove this split, bring the document to full screen view, then close the

document and quit Word.

2. Click the appropriate answer

L. The toolbar in Word
a) provides a shortcut way of accessing commands
b) allow the current time to be displayed
c) help in displaying the position of the insertion point

d) allow you to move around in a document
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11 Print Preview is used to
a) Save the document
b)  Print the document
¢)  View how the document will appear when printed

d)  Copy the document

111 The ficld for current time is displayed on
a) the toolbar
b) ~ the horizontal ruler
c) the status bar

d) the vertical ruler

3 What are the deticrences between viewing a document in Normal view and Page Layout view 7
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1.7 FINDING AND REPLACING

MS-Word provides some excellent features as Find and'Replace, which may be used for a number of tasks,

with high flexibility. Using these features it is possible to find a specific text in a document, search for a
particular pattern of text etc. : :

Finding and Replacing Text and Formatting

To find a particular text in a document, choose the Edit->Find opticn. A dialog box like the.one in example

below appears. This dialog box can be used to specify the text to be found. The text found by this option can
be chiinged, by clicking the mouse at the position required, in the document. The dialog box can be reusea to
feich the next instance of the text. o

ey,

MS-%ord Qusice
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LExample:

The Find dialog box can be used to specify the direction in which the Find operation is to be done. To
do this use the Search option in the dialog box.

Special search requests like Match Case or Use Pattern Searching can be used. If the Match Case option is
not checked out then MS-WORD finds all the instances of the text specified, irrespective of upper or lower
case characters. For example, if the text to be found is given as “New York” then “NEW YORK”, “n
york”, are also found as matching text.

The Find Whole Words Only option can be used to make searches on complete words only. If not checked

_ out, all matching patterns of texts are shown. For example, if the word “man” is to be searched and

replaced by the word “woman”, then if the above option is not checked, this would lead to a search for
all words containing the word “man” (e.g., words like “human”, “manner”, “Manmohan” are also found
by MS-WORD)

Finding Special Characters

To specify special characters like line break, tab character, white space, etc., in the Find Dialog box, choose
the Special drop'down list. Most of the special characters here are self-explanatory. Suppose it is required to
find the words “Indian Team” with a white space in between (the white space might be a tab, a single space, 2
spaces etc.). Then the correct way to specify this is by typing the word “Indian” in the Find What box. Now
choose Special-> White Space which inserts a (W) in the Text box next to “Indian”. Now type in “Team”.
So the correct search pattern would be “Indian"wTeam”.

In the same manner the Any Letter and Any Digit options can be used.

Use the Find->Replace option to replace the text found, matching the specifications in the Find Dialog box.
This is a very useful feature using which one can make fast editing in the existing document at specific
locations. For example, a business letter can be addressed to a ne' - person by replacing the old person’s name
with the new person’s name but retaining the rest of the format ana style.
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Example:

In the Replace dialog box (example above) one can make a global replacement of text of the next pattern to
verify if roplacement is necessary and commit replacement.

1.8 EDITING AND PROOFING TOOLS

The editing and proofing tools in Word help to improve your writing and the readability of your text. These
tools can:

. Find and correct spelling errors.
. Automatically correct typing and spelling errors that you’ve specified.
. Locate possible grammatical or stylistic errors, suggest improvements and help you evaluate the

readability of your text.

° Look up synonyms, antonyms, and related words.

e Automaticaiiy hypnenate text.

. Check text in other language.

. Display document statistics such as word count or paragraph count.

1.8.1 Using the Spelling Checker

Spell check is one of the powerful features of MS-Word. It also provides to check the spellings of the entire
document including the header, footer and the hidden text. Adding words to the dictionary is possible

The Spelling Checker provides a convenient way of correcting spelling mistakes in your documents. It
compares the words in your document against its own dictionary.

You should always check your documents with the Spelling Checker before you print them:.

MS-Word Basics
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You start the Spelling Checker via the “Spelling” command in the “Tools” menu or by clicking the “Spelling”
button.

The Spelling Checker automatically checks the active document.

*
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" AutoCorrect |:{" Options... } ‘} | " Cancel: .} |- Help

R . : . .

When the Spelling Checker locates a word it cannot find in the dictionary it stops. highlights the offending
word, and display it on the “Not in Dictionary™ line.

You have the option to:

1. lgnore its selection;

t9

Manually type in a correction to the word:
3. Replace the word with a suggested word;
4. Add the word to the dictionary.

The “Suggestions” box lists possible alternatives to the word. 1f it cannot find a close match this box will be
empty.

To retain the word, choose Ignore and to ignore the change at all its occurrences in the document Choose
Ignore All.

To change the word, choose Change and to change the word at all its occurrences in the document chocse
Change All. '

To add the current selected word into the dictionary chooses the Add button.

You have the choice to add the word to the default Word custom dictionary, or a new custom dictionary that
you create. You create new customs dictionaries via the Options pution.

Before you add a word to a dictionary, check that it is spelled correctly, otherwise it will be assumed that the
misspelled word is correct.

{f vou have any doubts, check the word with a paper dictionary before vou add it.

The Speller Checker is not foolproof and will not catch a mistake if vou accidentally type in another word:
The Spelling Checker does not understand the context in which the word is used in the sentence.
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1.8.2 Checking Grammar

During a grammar check; Word identifies sentences that contain possible grammatical or stylistic errors and
suggests improvements. For example, if you wrote “The project were completed by your team,” Word could
question the grammar, first for subject-verb agreement and then for passive voice. Word also question style
errors, such as wordiness and the use of clichés.

You can determine how strictly Word observes grammar and style rules by using rule groups. Word provides

three rule groups-forma’, business, and casual-which you can customize to observe or ignore specific
grammar or style rules. You can also create up to three of your own custom rule groups.

Cheek Your Progress 2

I During spell check, Word uses the English (US) dictionary as its Main dictionary, supporied by
‘ i) us.pIC
i) SCIENCE . DIC
i CUSTOM.DIC
iv)  FRENCILDIC
2. The keyboard shorteut kevs for undoing the modifications made to a document q:e.
1) Alt+Z
iy Shiitnz
i lab+z

vy Cirl- 7

1.9 SUMMARY

This unit, was an attempt to help you in editing text, finding and replacing word or text in the document; and
making spelling and grammatical checks. :

After going through this unit you must have become familiar with the features of Word which make-it
distinguished from the other Word processors. By now, you must know how Word document appears in
different views. The various cornmands can be invoked either through the toolbar, meru or keyboard shortcut
keep. In short, Word Processing job has been made easier and faster.

1.10 MODEL ANSWERS

I'he questions given in the *Check Your Progress’ have been designed only at the conceptual level and the
answers to these questions are directly available in the unit, Therefore, Model Answers have not been
provided. However, as this block is more practical oriented, therefore, students are advised to try the
commands g_iévcn. on their terminals,
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UNIT2 F ORMATT[NG TEXT

Structu: ¢

Introduction
Objectives
Formatting Text Characters
Formatting Paragraph
230 Centering, Right Alignment and Left Alignment
2.3.2  Indenting Text
233 Tab Stops
234  Line Spacing
2.3.5  Paragraph Spacing
236 Borders and Shading
24 Document Templates
24.1  Template Wizards
2.4.2  Starting a New Document from a template
2.5 Summary
2.6 Model Answers

NS ENEN
wiv=—2o

2.0 INTRODUCTION

The format ny feature in Word sets each document apart from others. A well-designed document uses
formatti: 2 10 provide visual cues about its structure. For example, you can work through a document
applying formats to headings and summary paragraphs one by one but Word provides an easier way to store
custom combinations of formatting by defining the combination as a style. You can then apply that
combination to a paragraph simply by sclecting the style from the style list.

In this unit, we explore a few more formatting techniques and then show you how 1o turn combinations of
formats into styles that you can apply with a couple of clicks of the mouse button.

In this unit, you’ll learn how to produce attractive documents even when you’re in a hurry using the

AutoFormat command on the format menu. This unit introduces you to Templates and Wizards, which serve
as models for new documents.

2.1 OBJECTIVES

After going through this unit, vou will be able to
°  format puragraplls, boarders and shading

o align paragraphs in a document

+use teimplates

v create document using the existing templates.
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2.2 FORMATTING TEXT CHARACTERS

Characters include letters, numerals, symi-ols (such as @, *, and &), punctuation marks, and spaces.

This section provides general information about character formatting. To change the appearance of text,
selectthe text and then apply the formats you want. If you choose a command without first selecting text,
Word applies the formats at the insertion point. Text that you type from that point forward has the new
formatting until you change the format again. Text that you type takes on the formatting of the immediately
preceding text.

You can also see which formats are applied to text by selecting the text and looking at the settings on the
formatting toolbar or in the Font dialog box.

Characters formatting tools include:

o Pick fonts

. Pick fonts sizes

o Pick underline styles

o Add effects like superscript, subscript etc.

o Change default cha;acters

o Change characters spacing

. Insert special characters and symbols

. Change case

Characters Formatting with Formatting Toolbar *

This is used for modifying character appearances.

Example:

8 Microsoft Word -_Doumean

i CG Omega

H Desdemona
System

‘i MS LineDraw

‘K Impact
'11' Garamond
|

plyll\nllrvwlnﬂe;'.-..

A

O



™~ 4 f ’
C’) %;-'\Léﬁzwp!c(.)l-i @

agrented
Application:

Pick a Font from tie formatting tooltar and set point size or toggle between bold, italic, underline as
required.

Character Formatting Using Font Dialog Box

®  Choose Format — font command.

&  Choosc I'ont, the style and size, underline and color settings. A sample is displayed at the bottom with
the chosen settings applied. ‘

® Eifects boxes allow to specify Strike Through, Superscript, Hidden, All Caps etc.

S — e ———

Small Fonts
.1 "W Symbol

System

Terminal

ST SR S ot DR

The default button in the Font tab of the dialog box can be used to make the default settings.

Character Spacing
Spacing allows overriding the standard spacing between characters in terms of | point.

® Choose the text of interest.

®  Select the character Spacirig tab in the Font dialog box. Select Expanded/ Condensed from the Spacing
list. '

@ Choose a new setting by typing in the By option box or clicking on the triangles and watch the preview
change. Click OK 10 save changes. ' :

Color Choice ,
|

{

®  Choose text of interest

®  Choose desired color from Color option box in the Font tab of the Font dialog box and click OK..
While printing the document on the printer, enable color setting of the printer.

Changing Case

®  Select text and choose Format-> Change Case.

®  Point to the desired option and click OK.
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2.3 FORMATTING PARAGRAPH

In Word, a paragraph is any amount of text, graphics, object or other items that are followed by a paragraph
mark. A paragraph mark is inserted each time while pressing the ENTER key. In order to change the
formatting of a paragraph, select the paragraph and then apply the formats you apply. Paragraph formats

, affect the entire paragraph and new paragraphs keep the formatting of the preceding paragraph. Paragraph
marks store the format of each paragraph, if the paragraph mark is deleted, the text in that paragraph becomes
part of the next paragraph. The various ways in which the Paragraph formatting can be done is described in
the following subsections: '

23.1 Centering, Right Alignment and Left Aliohment

By default, the text in Word is left aligned. These alignments can be changed as described in the previous
urit. '

2.3.2 Indenting text

Indenting a paragraph enables it to set off from other text..

. To indent paragraphs automaticaily, drag the top half of the triangular indent marker or the ruler to
- the right to the desired position. Alternatively, you can select Format — Paragraph and enter a
setting in the first line Indent box in the Paragraph dialog box.

o To increase or decrease indents by one Tab stop, use the Increase Indent and Decrease Indent button
on the formatting toolbar.

o To create a hanging indent (an indent that sticks out beyond the paragraph), drag the top half of the
triangular indent marker to the left to the desired position. You can also select Format — Paragraph
and enter a setting for the first line indent box in the paragraph dialog box that is farther left than the
indent of the paragraph as a whole.

Notice the different between left and right margin and the paragraph indentations.

The margins establish the overall width of the main text area and the space between the main text area and the
edges of the page.

Left and right indents are measured from the'left and right margins, respectively. The first line indent is
measured relative to the lefiipdent. The negative left-indent measurement for the text appears when the text
runs into the leftthargin.

2.3.3 Tab Stops

By default, the Tab Stops are set at 0.5-inch intervals from the left margin. The insertion point can be moved
to the next tab stop in the current paragraph by pressing the TAB key.

I
Use the ruler to set a tab stop at a particular position or to change the way text lines up at a tab stop.
To set tab stops

1. Select the paragraph in which you want to set or change tab stops.

2. To set or change the tab alignment, click the Tab Alignment button at the far left of the horizontal ruler
until the tab alignment is the way you want it to be.

Ny
ot
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3. On the ruler, click where you want to set a tab stop.

Also you an set precise measurements for tab stops by using the Tabs command on the format menu.

To move a tab stop, point to the tab marker and drag it to a new position. To clear a tab stop, drag thetab
marker off the ruler. , “

The spacing between the default Tab Stops can also be changed but this will affect only the active ddcument.

To do this, type or sclect the distance you want between the tab stops in the Default Tab Stops box and then

click the OK button.

2.3.4 Line Spacing

Line Spacing determines the height of each line of text in the paragraph The default (single lme spacing)
depends on the size of the font characters. Individual line spacing is easy io change.

The indents and spacing tab of the Paragraph dialog box provides a drop-down for simple but effective
control of the space between lines under most circumstances. The preview area demonstrates the relative
effect of single, one-and-a half and double line spacing. Single spacing causes 12-point line spacing, 13z line
spacing is 18 points and double spaced lines will be 24 points apart

Choosmg the appropriate options from the Line spacing menu in the Paragraph dlalog box can make all these
line spacing settings. '
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When you use these choices, Word will compensate for graphics, superscript and large or small type sizes. Formatting Te)

2.3.5 Paragraph Spaéing

Word enables each paragraph to give unique before and after spacing if you wish. The spacing settings can
be in points (pt), inches (in), centimeters (cm) or lines (li). '

One advantage to adding space this way is that the spacing 'befor_e and 'after'paragraphs does not change the
point size of your text. Another advantage is that you can use different spacing combinations for different
purposes. :

Headings often have different spacing requirements for body text. For instance, you may require different
before and after spacing designs for figures and figure captions as well. Also you can have unique spacing
specifications as part of a style, making it easy to keep the look of your documents consistent.

The Paragraph command on the format menu can be used to add space before and/or the paragraph. The
other advantages of us_ing the Paragraph command are: :

.

1. You can make precise adjustments to the spacing between the varicus text elements. For example, you

can use paragraph spacing to clarify the relationship between headings and body text.

(894

If the paragraph is moved or deleted, its spacing goes with it. The paragraph doesn’t leave behind extra
blank lines. , :

3. If you include spacing in the paragraph styles you use to format text, Word adds the space along with the
other formatting. You need not add blank lines manually.

2.3.6 Borders and Shading

You can add bordefs,‘to any side of a paragraph, and you can add background shading. You can also add
borders and shading to ordinary text and to the paragraphs in table cells and frames

24 DOCUMENT TEMPLATES

Document Templates serve as a boilerplate for a new document. It is basically a detailed document with
preset text and formatting on which a new document can be based by amending them according to our
requirement. - ‘

2.4.1 Template Wizards

To avoid the routine repetitive work of creating new documents, it is best to base them on templates designed
for the types of dncuments you ceate most often. '

A template is a blueprint for the text, graphics, and formatting of a document. A template also stores styles,
macros, AutoText entries, and customized Word commands Settings. These items can help you work faster
on a particular type of document. : ' :

Word provides templates for common types of documents, such as memos, reports, business letters, fax
‘orms, invoices etc. Yo' can use any ternplate as it is or tailor it to your specific.requirements.

oS
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The first time you use the Fax wizard, you required to fill in your personal information and select options for
the fax cover sheet. This information is then automatically placed on the fax cover sheet..

It is only necessary to enter your personal details the first time you use the fax wizard.

An exampie of how the fax cover sheet will look is displayed. You need to select whether you want it to be
printed down the page (Portrait), or across the page (Landscape).

In this example, let us select the “Portrait” setting which is common for fax covers sheets and continue. Click
the “Next™ button in the dialog box. You can choose that from three styles for the fax cover sheet. The
current one is the “Contemporary” style.
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Let's create a fax cover sheet using the “Modem” style. Click the “Modem” style in the dialog box.

-

Type your nome.
fiINOU

Type vour gcompany's name. - PR
lcNou e

Type yous mailing address

[ cancel ]| <Back | Mext> -I;_!_:l_nl\f:—‘:

A preview of the “Madern™ style fax sheet is displayed. Let’s continuc by clicking the next buiton in the
dialog box. The name and company name that was entered during installation is automatically inserted into
the "Name™ and “Company Name™ boxes. To change it. just enter the names you want in the relevant boxes.

In this example, let’s leave this unchanged and enter the mailing address. First, let’s click inside the Address
box. Let’s enter the mailing address which is (778 Eagle Rd. Lakeside CA 2049) in this example.

Let’s go to the next step by clicking the “Next” button in the dialog box.



Formattirig Tex

The next step is to enter the fax and telephone number information in the relevant boxes.

In this example, let’s assume that our telephone number is (245) 678-6518 and enter it in the “Phone” box and
enter the fax number, which is (245) 678-2171 in the “fax” box.

You can go back and change any of the information or selections you made in previous steps via the “Back”
button.

‘.I
The “Finish” button creates the fax sheet with the options and personal information you entered. You
tvpically use this to create fax cover sheets after the first time, if none of your personal information has
changed. )

Let’s go 1o the next step by clicking the “Next” button in the dialog box.

7 : A

Those are all the ‘answers the wizard
needs to create your fax cover sheet!

WwWould you itke to display Help. aftel the
fax cover sheet is created?

O Wes display Fielp as i work
o N just display (he fax cover shaelt

esoek [ JU S

You are given the option of dmme 1¢ Help after the fax cover sheet is croated Let's accept the default
setting which is “No™ and create the fax sheet

27
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A new document for the fax cover sheet has been created.

To display this document at full screen, click the “Full Screen” command in the “View” menu. You now save
and name the document as you would any other.

The next time you create a fax sheet with the fax wizard you don’t ne¢d to enter the sender information unless
it has changed.

2.4.2 Starting'a New Document from a Template

You can save time by basing new documents such as memos, letters, and reports on one of the templates that
come with Word. From the File menu, choose New, and then select the template you want. The templates
you can use are displayed alphabetically in the “Template” list. “Normal” Temrlate is the default for Word
and is the one you use when you click the “New Document” button. :

A short description of the current tefnplate is displayed in the “Description” box. You select the template that
matches the type of document you want to create. For example, if you want to creats 1 voices you would use
the “Invoice” template.

When you select a template, Word opens a copy of the template as a new document. All of the information in ‘
the template is copied into the new document.

Check Your Progress
1. To copy character formatting from place to p'ace in a document, choose the
a) AutoFormat button
b) Format Painter button
¢) Style command in Format menu
d) Style Gallery command in Format menu
2. You can use styles to
a) format your documents
b) 'Save_ changes to documents
¢) Delete text in documents
d) Make copies of documents
3. Toremove a tab from the ruler

a) Double-click the tab on the Ruler
b) Select the tab and press the Delete key
¢) Select the tab and press the backspace key

d) Drag the tab from the ruler



4. The default line spacing for text is
D) 05
2) 1.0
3) 15
4) 2.0
5. Document templates allow you to
1) Use pre-designed documents for specific purposes

2) Create documents step by step after asking the questions

3) Create and save the document automaticz!ly

4) Save ‘e changes to-the document.

2.5 SUMMARY

In this unit, we have focuseq our main a&cntion to formatting text, which includes the two kinds of styles:

I. The Paragraph Style

2. The Character Style

By usiﬁg styles to format text, you can quickly produce professional looking documents and maintain
consistent formatting. Various formatting techniques including embellishing individual characters, changing

the indentation of paragraphs, adjusting the white space between lines and paragraphs etc. have been
explained in this unit. The concept of templates has also been explained.

2.6 MODEL ANSWERS

The questions given in the ‘Check Your Progress’ have been designed only at the conceptual level and the
answers to these questions are directly available in the unit. Therefore, Model Answers have not been
provided. However, as this block is more practical oriented, therefore, students are advised to try the
commands given, on their terminals.

Formatting Text”
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3.0 INTRODUCTION

In the last unit, we have described some of the formatting capabilities and how to combine formats to create
professional looking documents in MS-Word. In this unit, we'll show you few more tricks for designing a
document. For instance, the page setup options which included paper size and page orientation etc. are
normally set at the beginning of a document can be easily changed at any time. We’ll also define how to
create tables to present facts and figures. If you've already set up your information in a spreadsheet program
and don’t relish the thought of having to recreate it in Word, you'll be pleasea to know that you can import

" spreadsheet data directly into a word table.

3.1 OBJECTIVES

After going through this unit, you will bé able to

e sctup apage i.e. its layout, margins, paper size and its source
»  page orientation i.e. portrait or landscape

¢ create mirror image of the page

e set up headers and footers

o  create tables and enter text in the tables

e setrows and column width and set gutters.



3.2 PAGE SETUP

Word for Windows gives you on-screen clue about how your document will look on paper. If you give Word
some basic information, such as the paper size and the kind of printer you will be using; it can show you line
endings, page endings, the relative size and placement of text, graphics, margins and so on. In order to do
this, Word needs some information from you, such as the paper size and the kind of printer you will be using.
The Page Setup dialog box allows you to give Word all ti.e information it needs.

The Page Setup command in the file menu enables you to set the paper size, page oriengation (portrait or
landscape), the working of headers and footers, and similar options before you began a documem. But you

can easily change these and other settings at any time. You can also use sections and set different options for
each section.

-

3.2.1 Paper Size and Page Orientation
The paper size wab in the Page Setup dialog box can be used for selecting the paper size. The options that are

available depend on the capabilities of the printer you have selected.

To use a custom paper size, type the aimensions of the paper you want to use and also be sure that the printer
is capable of feeding the custom paper size through its printing mechanism.

Once you specify the size of the paper on which you will print the document, Word calculates margins by
measuring from the edges of the paper.

Page orientation can be vertical (Portrait) or horizontal (Landscape).

To select the paper size and page orientation follows these steps:

1. Select the text you want to have a different paper size or page orientation.
2. From the File menu, choose Page Setup and then select the Paper size tab.
3. Select the paper size on which you want to print and the page orientation.

4. In the Apply To box, select how much of the document you want to print on the selected paper size or in
the selected orientation. Then click the OK button.

Also it is possible to change the default page size and orientation. Like, if you often print on paper other t4:
the standard letter size - 8.5x11 inches or if you use landscape orientation more frequently than portrait
orientation, you can save time by changing the default settings. After specifying the new settings, choose the
default button. When Word asks you that you want to change the default, choose the Yes button. Word save:
the new default settings in the template attached to the document. ’

3.2.2 Page Margins

Margins determine the distance between the text and the page of the paper. In Word, text and graphics at.
normally printed inside the margins while headers, footers, and page numbers are printed in the margins.

‘ocument Margins

s gives you three ways to set margins. The most straightforward method is to use, the Margins porti-.
the Page Setup dialog box, reached with the File — Page Setup commanc,

Layout
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You can also drag margins using the rulers in Print Preview. This lets you see the results of margin chzhxg\es
after a slight repagination delay.

Finally, you can drag new margins with the rulers Page Layout view. The margin brackets are located on
the ruler. Let’s look at all three techniques, starting with the dialog box.

Follow these general steps to change margins from within the Page Setup dialog box:

1. Place the insertion point on the page where you want margin settings to be changed (unless you plan to
see the Whole Document choice)

2. Choose File — Page Setup.

3. Ifneed be, change paper size and orientation by using the Paper Size tab.
4. Switch to the Margins tab if it is not already displayed.

5. Current settings are shown in the various margin dimension boxes.

6. Type the dimensions you desire, or click the little triangles to increase aﬁd decrease settings. The
Preview will change as you work.

7. When satisfied, click OK.

Dimensional settings in most of Word dialog boxes can be expressed in inches (in), points (pt), centimeters
(cm), picas (pi), and, frequently lines (li). For instance, to sct a top margin’s height to 12 points, you would
type 12 pt in the Top margjn box, to set a one-and-one half line top margin, you’d type 1.5 i, etc.

/

While you can type other measurements, Word will convert them to the default measurement when you close

the dialog box. You change the default measurement in the Genera] tab of the Options dialog box (Tools —

Options).
Alternate Facing (Mirror) Margins

Select the Mirror Margins feature in the Margins tab of the Page Setup dialog box (File — Page Setup) when
you want different left and right margin widths and your final output will be two-sided. Word makes inside
margins of odd and even numbered pages the same size; and does the same with the outside margins of odd
and even pages. This is how you get white space on the appropriate side of even and odd, two-sided pages.

When adjusting margins in Print Preview, if you’ve chosen the Mirror Odd/Even feature, display two pages in
Print Preview so that you can see the different margins.



Gutters Facilitate Binding Page Design ssd
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Gutter margins-additional white space in the inside margins-compensate for the paper tucked away in the

binding of a two-sided book that would be unreadable. The gutter width, which you specify in the Margis tab

of the Page Setup dialog box (File — Page Setup), reduces the text area. Instead of using gutters, you might

simply want to increase the size of the inside margins to accommodate binding.

323 Headers and Footers

Headers and Footers are places to put repetitive information in a document’s top and bottom margins-headers
print at-the top, footers at the bottom. You can use headers and footers to print something simple on each
page, such as you name, or something complex, such as graphic. Stylized text, dates and automatic page
nurbering can all be included in headers and footers.

You can use identical headers and footers on all pages in your document, or you can specify different contents
for each section of the document. Odd and even pages can have different designs if you wish. The first page
of each document of each section can be unique.

In Word 6, header and footer editing always takes place in Page Layout view. You work right in the header
and footer area of your document after double clicking to unhide it. ‘

You can apply virtually any paragraph cr character style to your headers and footers using the F ormatting
toolbas 2nd rulers. They will repeat on all pages thereafter.

Once headers and footers have been added to a document, it is possible to see and edit them in Page Layout

view. They are also displayed in Print Preview, but when you attempt to open a header or footer in Normal
view or Print Preview, Word switches you to Page Layout view and displays the Header and Footer toolbar.

Creating Basic Headers and Footers

To enter a header that repeats on all pages in your document:

1. Choose View — Header and Footer or double-click in the header area of the first page to be modified in
Page Layout view or Print Preview.

2.’. Word will switch to Page Layout view if it is not already there and display the Header and Footer toolbar.

_ Sz~ [(el=]u](=M==h

45 5 R M i

v

‘, ‘; mlElx] « K
OgojelhhoiE]

' msuntl ] File Manag

33



© 7 ISample GUI

Oriented
Applications

3. Create and edit header text as you would any other. You can paste graphics, apply styles, and otherwise
format you work nomlally .

4. Use the automatxc page-number, time-stamping, and date-stamping features described later in this .
chapter.

5. Double-click in the main document to return to work there.
Vou enter footers the same way as headers, except that you work in a Footer window.

The Layout tab of the Page Setup dialog box helps in:

Page Setup
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1. Creating Different Headers and Footers for Odd and Even Pages

2. Creating Different Headers and Footers for the First Page

3.2.4 Page Numbering

Word offers a variety of tools to help vou automatically number pages. You can choose from many page
numbering format and style choices and position page numbers nearly anywhere that'pleases you. Let’s
explore these features and discuss the effects of document sections and pagination on page numbering.

If you plan to break a document into multiple section, you may want to insert page numbers before you split
the document into sections. Otherwise, you will have to repeat the page numbering for each section of your
document. '

Page Breaks

Word uses “Soft” and “Hard” page breaks to indicate when one page ¢nds and another begins. Then are two
categories of page breaks:

a) Soft Page Break

Soft Page Break are automatically inserted by Word, when text reaches the bottom of the page and

are represented by a dotted line across the document. The text beneath it will appear on the second
page if we print this document.

The position of Soft Page Breaks in a document automatically changes when text is added or deleted
to reflect the new page boundaries.

b) Hard Page Break
You insert Hard Page Breaks when you want to end one page and begin another. This is done via
the “Break” command in the [nsert menu, or by pressing the “Ctrl+Enter”.

Hard Page Breaks appear with the words “Page Break” on the line. They remain at the exact same
spot in the document regardless of any text changes you make.
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To remove a hard page break you position the cursor just after it and press the backspace key, or Page Design and
position the cursor at the start of the page break and press the “Delete” key. Layout
Repagination

In order to display and print page breaks properly, Word must recalculate page endings after you’ve made
changes. Normally, this is done automatically in the background whenever Word can steal some otherwise
unused computer time. This process is called automatic repagination. Since page endings affect certain other
features word always repagjnates when you

° ask 1t to print
. are in Print Preview or Page Layout view
. complete a Table of Contents or Index.

3.3 TABLES

Word's tables feature, enables you to arrange columns of numbers and text in a document wiithout using tabs.
It helps you to organize complex columnar information.

Tables also provides a convement way to present text in side-by-side paragraphs as in a resurne, or to arrange
text beside graphics. You can use them to create such diverse documents as forms, television scripts,
financial reports, parts catalog, and resumes. You can insert tables anywhere you need them in Word
documents. Word's table feature and the terminology used to describe it, reminds you of a spreadsheet.

Word's tables consist of horizontal rows and vertical columns. You do the typing in arcas ¢alled cells. Cells can
column text, numbers or graphics. The text in cells is edited and embellished as usual with Word's formatting
toolbar and ruler. '

Column

. JAMESa ' 123.ASTREET,NYe o _ \ :
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Rows End-of-cell marker End-of-row marker

Nongprinting table gridlines

A rumber of table specific features let you control the size, shape, and appearance of cells. Border and
Shading features are available. Itis also easy to insert and delete rows and columns.

They can be created from existing text without needless retyping. Also the table feature can be used to
organize information and then convert your table to text. : '

Another feature, Table Wizard. helps you automate table creation. The dotted lines around each cell represent
nonprinting table gridlines.

Format -» Borders and Shading command can be used to add printing borders.



33.1 Table Creation

A simple tablo can be created with the Table button on the Standard toolbar and a complex table by the Insert
Table command of the Table menu.

B

To create a table with the Table button

1. Place the insertion point where you want to insert a table.

2. Click the Table button on the Standard toolbar, then drag while holding down the mouse button to
highlight the number of rows and columns you want in your table.

3. When the displayed grid represents the desired number of rows and columns release the mouse button. -
An empty table will be inserted at the insertion point when the mouse button is released.

: occnl

To create a table using the Table menu

The Table — Insert Table command can be used to create more complex tables by specifying the Number of
Columns and Rows in the Insert Table dialog box. '

Entering and editing text in a Table

You navigate, enter and edit table text just as.you do any other Word text. The mouse or arrow keys are used
to position the insertion point. The cells are thought of as milsiature pages and the cell borders as margins.
Type the text normally within these cells and Word will automatically wrap textwithin the cell as you reach
the right edge Rows will automatically grow taller as necessary to accommodate your typing.



To move from cell to cell within a table, either use the Tab key to go forward and Shift+Tab to go backward.  Page hevign and

Layout

Pressing Tab in the rightmost column will move down the insertion point to the beginning of the next row and
pressing Shift+Tab past the leftmost column will move the insertion point to the end of the previous row.

The familiar character formatting toolbar, ruler and menu features work in the same manner to all or selected
characters in a table.

A cell can contain more than one paragraph. Paragraph creation is done in the usual way and Word’s
paragraph format applies to paragraphs in cells.

Within a cell, you can have several different indent settings, line-spacing specification styles. etc. -
Converting Text to or from a Table

You can convert text separated by paragraph marks, commas, or tab characters into cells in a table and also
convert a table to ordinary text paragraphs.

This is required at times when you’ll start a project using tabs and wish you’d created a table or a co-worker
will give you same tabbed text.

" Converting Text to Tables .

To convert text to a table, highlight the text you want to turn into a table. Choose Table —» Convert Texi to
Table... and click the appropriate option button in the resulting dialog box. Here’s an explanation of the
choices:

Tab 'Lines of text separated by paragraph marks or the breaks will become rows in your table.
Tab-separated strings of text within those lines will become cell entries in the row. Word
will automatically create the necessary number of columns based on the maximum number
of tabs in a line. .

Comma Lines of text separated by paragraph marks or line breaks will become rows in your table.

' Comma-separated strings of text within those lines will become cell entries in the row.
Word will automatically create the nccessary number of columns based on the maximum
number of commas in a line. Beware of commas that might create unintentional cells.

Paragraphs Word will propose a single column and create as many rows as you have paragraphs.
Changing the number of columns will distribute paragraphs among the columns from left to
right. In a two-column layout, the first paragraph would end up in the top-left cell of the
new table, the second paragraph in the top-right cell, th third in the left cell of row two,
and so on.

Converting Tables to Texl

To convert an existing table to text, select the table cells you wish to convert, or Alt+double click to select the
whole table. Choose Table — Convert Table To Text. Word will display a Table to Text dialog box, which
asks if you want the table converted to paragraphs, tab-delimited text, or comma-delimited text. Pick one.

Choosing the paragraph option will convert each old table cell into at least one paragraph If the table’s cells
contain multiple paragraphs, the paragraph marks are retained during the conversion, so some cells will create
more than one new paragraph.

If you pick the comma or tab options. Word will convert each row of your table into the paragraph. Cells
from the tables will be separated within the paragraphs by tabs or commas.
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The Tabie Wizard

The Table Wizard will ask vou some questions and format your table. Here are the basic steps to using the
Wizard: - ' "

Place the insertion point where you want the table. Tap J once or twice if you've Jjust opened a new
document.

2. Choosc Table — Insert Table.

-

Click the Wizard buttor: in the resulting dialog box. You will be presented with a number of screens
asking vou questions.

v Look at cacn choice carctuliy, and seicct one of them,

This wizard creales formatted tables. Which table layout would you like?
8 .
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5. Click the Next button after each choice or the Back button to back up one screen.

6. When the Wizard runs out of questions, click Finish. You’ll be presented with the Table AutoFormat
dialog box. '

Cruise the format samples until you find just the right mode, then click OK.

3.3.2 Table Modification

Medifying a table involves selecting, inserting, deleting, copying and moving rows, columns and cells. It also
describes how to change the spacing and column width and how to split a table.

1 Selecting in Tables

As already seen, you can select characters, words, and other items in table cells using Word’s usual mouse
and keyboard features. In addition, Word also provides table-specific sclection tools enabling you to select:
whole cells, entire rows, columns, or areas. The area between the first character in a cell and the left edge of
the cell is called the cell selection bar. When you point to it, the mouse pointer changes directions (points to
the right).. Clicking on it selects the contents of the entire cell. -

‘To select a-column, move the mouse pointer to the area cailed the column selection bar at the top of a column,
when thepointer changes into a large, down-pointing arrow. Holding down the Alt key while clicking
anywhere in a column will also select the entire column. :



Selecting Rows Page Dexn and
- Layout .
To select the entire row, double-click any cell selection bar. The same can be accomplished by selecting and

dragging the leftmost or rightmost cell in a row.
Selecting Adjacent Groups of Cells

To select groups of adjacent cells, either drag through the cells or click in one cell and Shift+click in the
others.

Selecting the Whole Table

To select an entire table, hold down the Alt key and double-click anywhere in the table. If your document

contains multiple tables and they arc not separated by paragraph marks, this technique will select all adjacent
tables.

2. Inserting Cells, Rows and Columns
A new row can be inserted above the selected row, a new column to the left of the sclected column and s new

cell at the specified location. To insert a new cell, row or a column, first select an existing cell, row or
column. ‘

&) To add cells to a table, select the number-of cells from this table, next to which you want to add new
cells and click the Insert Cells button on the Standard toojbar. The number of cells inserted will be
the same as the number of cclls selected in this table.

b) To insert row in a table, select the same number of rows below which you want new rows to be

added and click the Insert Rows button on the Standard toolbar. The number of rows will be same as
those selected in this table.

To add a row at the end of a table, position the insertion point in the last cell of the last row and then
press the TAB key. The cells in the new row have the formatting of the cells in the preceding row.

C) To insert columns in a table, select a column or group of columns to the right of which you want to
insert a new column or columns and click the Insert Columns. Word inserts a column or columns to
the left of the selected column or calumns.

3. Deleting Cells, Rows and Columns

The Cells, Rows and Columns in a Table can be deleted by the Delete command on the Table menu, which
changes according to what is selected.

4. Changing Column Width

The width of selected cells and enure columns can be changed by dragging the table column markers on the
ruler or by dragging the column boundarics.

To change the column width automatically, use the AutoF it button to adjust the width of columns quickly.
3. Changing Row Heights

Normally, Word sets the height of each row automatically to accommodate the cell containing the tallest
entry. For instance, if one cell in a row needs 2.0" to accommodate the text or graphic it contains, all of the
cells in that row wiil be 2.0" high.

To drag a row to new heights, Click anywhere in the row you wish to resize. 'The Row heights can also be
resized by the Table —» Cell Height and Width. o

39
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6. Splitting a Table

To split a table, position the insertion point in the row where you want the new table to start and then choose
split table from the Table menu.

|

3.3.3 Table Formatting

The readability of a table can be improved by formatting the text within the table, aligning text, creating
column headings, and adding borders and shading. The AutoFormat command from the Table menu can also
be used to automatically format the table for you. '

-Formatting Text in a Table

.
Text formatting within the table can be done in a similar manner as it is done with the rest of the text in the
document i.e. by using the formatting toolbar, format menu commands, or the ruler.

The TAB key in a table cell has a different function. 1t will just move the insertion point between cells. To
insert a tab character in a cell, press CTRL+TAB. o

Centering a Table and Aligning Rows

To center a table or change row alignment

‘1. Select the entire table or rows you wish to align.

2. Choose Table — Cell Height and Width and select the Row tab.
8. The various options are listed below.

2) To center the table, choose the cénter option button under alignment.

b) To set an exact amount of indentation from the left margin, type or select a number in the Indent
from left box.

c¢) To set the alignment in relation to the page margins, select the Left, Center or Right option button
under Alignment.

Creation of Table Headings

Merging cells can create table Headings that span several columns. Use the Merge Cells feature to combine
the contents of multiple cells - for example, to make a heading in one cell span an entire table or a selected
group of columns. You select the cells to merge, then choose Fable — Merge Cell, and the contents of the

designated cells will merge. You may need to reformat text me- _zd this way.

You can repeat table headings when a table is split betwec.. pages. Word automatically repeats table
headings only for tables that are split by “soft” page breaks. If a “hard page” break is inserted within a table
or the split Table command is used then the heading is not automatically repeated. ‘

The Page Layout view, only displays the Repeated Table headings on each page.
Table Borders and Shading

An easy way to dress up a table is to add printing borders and shading. Select the cell or cells you wish to
embellish, then use the line thickness portion of the Borders toolbar. Pick the desired combination of line
thickness and apply the borders just as you would add them to word paragraphs. Add shading to some or all
the cells.
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AutoFormatting Tables

Word’s Table — Table AutoFormat command attempts to pick cell settings that make a presentable table.

The basic steps for using Table AutoFormat are:

I Enter, edit, spell-check, recognize and otherwise finish with your table.

9

Save the document.

3. Select the entire table\.:

4. Choose Table —» Table AdtoFormat to open the Table AutoFormat dialog box.

5. Preview the format choices from the scrolling list by highlighting their names one at a time,

6. Pick a style by highlighting it and click OK.

3.3.4 Shorting and Numbering Cells

Word's Table—> Sort Text command will attempt to sort selected text alphabetically, numerically, or
chronologically at your request. Sort can be up to three levels “deep”.

To sort a tablé"with this command, follow these steps:
l. Save the table,
2. Place the insertion point in the table you wish to sort,

3. Pick Table - Sort Text. Word will highlight (select) the entire table, and you will see the Sort Dialog
box.

4. If you have labels at the top of your table, choose the option My List Has Ileader Row. There will be up
to three drop-down lists containing the column labels or column numbers,

5. Specify the sort order by choosing the desired column for each sort level. -
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6. Choose a sort order for each column.

7. Tell Word, if the data in each column are text, numbers. or dates by choosing from the Type drop-down
lists. '

8. Click OK and Word will sort.

3.3.5 Special Tasks with Tables

The special tasks, which can be performéd with tables, can be perform calculations, import data from
Microsoft Excel, create a graph, or set up a database.

Performing Caleulations in a Table

You can add subtract, multiply and divide numbers in a word table. You can also perform other calculations
like averages. percentages. minimum and maximum values etc. :

To sum a row or column of cells, position the insertion point in the last cell'of a row or column. The'cell does
not have to be empty; however, if it contains a number and you want the result of the calculation to réb)ace
that number, you must sclect the number. Otherwise Word inserts the results without removing the original
number in the cell. Choose. the formula command from the Table menu. Click the expression in the formula
box to make sure it will sum the numbers you want to add. then choose the OK button. e

To perform otaer calculations. vou specify which cells to use in the calculation and use the formula for each
calculation. In the formula box, tvpe between the parentheses, the cell references you want to use in the
calculation. '

Exchanging Data with Microsoft Excel

Word has a feature to pste Microsoft Excel Worksheet into a wora decument. Word then converts the
worksheet to a word table. Word commands can then be applicd to wérk with the data. The reverse is also true.

In addition to copying and pasting worksheets: you can link and embed Microsoft Excel Worksheet.

Using a Table to Create a Graph

Word makes it easy to create a graph. or chart from data in a table. Select all or any part of the table and then
click the Insert Chart’button on the Standard toolbar. Word opens MS-Graph, which uses the selection to
create a graph. You can use any of the commands in MS-Graph to format the graph. The graph appears
immediately below the table vou selected. The inserted graph is an embedded object.

Using a Table as a Database
Word table can be used as a simple database for storing information such as addresses or client records.
To use a table as a database. be sure that the insertion point is within the table. then click the Data Form

button on the Database toolbar. Word displays the Data Form dialog box. Type information in the fields
provided.



Check Your Progress

1.

Layout
To view multiple columns on the screen, switch to
i) Page Layout view
ii) Normal View
iii) Outline View
iv) Master Document View

Which of the following is incorrect?

i) Page Orientation in the Page Setup commz=d can be either Portrait or Landscape

ii) The Gutter feature in the Margins tab of the Page Setup dialog box allows you to set different left
and right margin widths '

iii) Header and Footer editing always takes place in Page Layout View

Choosing which of the following tabs in the option box can change the default units for the document
margins?

i) Viewtab

ii) Edittab

iii) “General tab

iv) " Print tab

The maximum number of columns in a table can be
iy 21

i) 30

iii) 31

iv) 11

To insert a tab character in a cell
i) Press CTRL+TAB

ii) Press SHIFT+TAB

iii) Press ALT+TAB

iv) Press CTRL+ALT+TAB.

3.4 SUMMARY

The various options that aftect the appearance of a document include the following:

Paper size

Page orientation (Portrait or Landscape)
Margins

Headers and Footers

Page Num bers

[.ine Numbers and number of newspaper style columns.

Page Design and
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When you use the Page Setup command on the file menu to specify a paper size, the options that are available
depend upon the capabilities of the printer you selected.

By the end of this unit, we have aiso described the creation and usage of Tables.

3.5 MODEL ANSWERS

The questions given in the ‘Check Your Progress’ have been designed only at the conceptual level and the
answers to these questions are directly available in the unit. Therefore, Model Answers have not been
provided. However, as this block is more practical oriented, therefore, students are advised to try the
commands-given, on their terminals.
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4.0 INTRODUCTION

This unit discusses two important concepts in world: Mailmerge and Macros. Word’s Mail Merge feature is a
quick and easy way for mass-producing form letters, envelopes, mailing labels, phone lists etc. By using Mail
Merge, you can send the same letter to a number of people, without typing the original letter more than once.

A Macro is a sequence of actions that is named and stored. When you run a macro, Word performs ail the
assigned actions in sequence. You can assign a macro to a key, a combination of keys, a tool button, or a
- menu. The Macro feature basically helps in faster editing and formatting.

This unit also explains the details of managing Word documents, which includes creating, opening, saving
and protecting documents,

The end product of a. Word Processing session is usually a printed document. Before printing from Word for
the first time, you must check that your printer setup is correct. And Word’s Print Preview feature used
before printing any documents, helps in checking that all its elements are in place. All these printing options
have been explained in detail in this unit.

4.1 OBJECTIVES

After going through this unit, you will be able to
e create a data source for the document
e merge the addresses for printing on envelops and labels

e create and run macros in Word

»  protect your document -

s print your document.
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42 MAIL MERGE

Word’s Mail Merge feature lets you quickly create personalized correspondence and other documents by
combining information (merging) information from two different files.

For instance, you could merge a fist of names and addresses from one file (your data document) with another
file (your main document) to produce a number of personalized form letters.

You could also create catalogs, forms with variable information fields, or labels. You insert data instructions
(fields) in the main document wherever you want data from the data source to appear in your merged
documents.

Mail Merge feature can also be used to prep: . otner kinds of merged documents such «. catalogs, parts lists,
directory lists forms or invoices, print addresses on envelopes and mailing iavels.

4.2.1 Data Sources and Main Documents

Data Sources are organized collections of information - databases-stored as Word tables. Word can also use
data from other applications such as MS Excel or MS Access. After opening a data source in another
application, make sure that the merge fields in your document match those in the data source. All data .
sources, no matter where they come from, contain iecords and ficlds. For example, an employee data source
wouid contain one record for each employee. This record would contain multiples fields - one for the
employee’s first name, one for the middie initial, one for the last name, one for each part of the address and so
on.

The data source contains the information that can vary in each version of a form letter, such as the names and
addresses.

You can either open an existing data source or create a new one in Word.

Main documents as mentioned earlier coiitain the text of your project (the bodv of a letter), fields, and merge
instructions.

Main Documents can bc . d from earlier versions ~f Word or from other Applications.

While using the Main document from other applications, open that documents in Word 6 and convert its
contents to Word for Windows. However, field names and formatting from some applications may not
translate well into Word for Windows format. Check the fields in your main document and adjust them if

necessary before completing the merge or you can paste the main document into Word for Windows as plain
text, then apply the formatting and centering the field names.

4.2.2 Starting and Editing the Main Document

Creating a merge main document, such as form letter, is a three-step process.

Step 1: To set up the main document, which contains the text, punctuation, and other items that
remain the same in each version of the form letter.

Step 2: To set up a data source, which contains the information that varies in each version This
can be done either by opening an existing data source or creating a new one.



Step 3: To complete the main document by inserting merge fields and by typing or adding . Mail Merge and
information you waat to be the same ir. each form letter, such as the body of the letter, your ;’{"“m‘"‘
address and your logs. anagement

Step 1: To start the main documen;
Step 1:

i) Select the create button to start creating your main document. A list will drop down offering you four
choices-Form Letters, Mailing Labels, Envelopes ard Catalogs..

if) Select the type of main document you want. A dialog box appears offering you the choice of the active
window or a new main document. . ‘

iii) Choose the Active Window button if the active window contain information for your main document or
choose the New Main Document button if the active window doesn’t contain any information for the
mail merge.

Whichever button you choose, Word will return to the Mail Merge Helper dialog box and the space below the
create button now lists the information you’ve entered so far-the type of merge and the main document to use.

Step 2: NCXAt, you need to specify the data source and arrange it in the fields that will be available to
olep £
your main document for the merge.

1)  Click the Get Data button to display a list cf options for your data source.

ii) Ifycu eready have a data source that you want to use, select Open Data Source or if you want to create a
new one, select Create Data Source.

Creating a Data Source

The Create Data Source dialog box that appears when you choose Create Data Source contains a list of
commonly used field names under “Field Names in Header Row” box. The next step is to add field names in
the data source. This can bs done by selecting the field names from the Field Name in Header Row box or by
adding the new ones to it. These field names can be upto 40 characters long and contain letters, numbers, and
underscore (). They cannot contain spaces and must start with a letter. The following operations on the field
names can be done: '

1. To delete a category from the data source, select it and choose Remove Field Name button.

2. To add a category to the data source, type the new field name in the F ield Name box and then choose
Add Fieid Name button.

3. To change the order of ficld names, select a field name in the field names in Header Row box, and then
click the up or down arrow at the right of the list until the field name is in the desired position.

When you finish creating the field names, choose the OK button. Word then displays the Save Data source
dialog box. You save the new data source by giving a new filename to it. .

Word then displays a message asking you whether you want to edit the data source or edit the main
document. Choose the Edit Data Source button to type the information that varies in each version. The Data
form dialog box appears. Type the information you want in each data field box and then press ENTER. To
move to the next or previous data field box, press TAB or SHIFT+TAB.

Continue typing information, choosing the Add New button to start each new record. Choose the OK button
in the last. ’
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Opening a Data Source

To open an existing data source, Select Open Data Source from the Get Data drop-down list. The Open Data
Source dialog box that appears works just like the File Open dialog box. Select the document you want to use
and click OK. Word will open the document and return you to the Mail Merge Helper dialog box.

Step 3: One you’ve completed the second step-Creating a new data source or Opening an existing
data source-you can complete the main document by inserting merge fields and by typing or
adding information you want to be the same in each form letter.

This can be done by:

a) Completing a form letter main document:
Type or add any text and graphics you want to include in each letter. Then insert a merge field
where you want each category of addressee information to be printed. Place the insertion point in
the document where you want to insert information from the data source, click the Insert Merge field
button on the Mail Merge toolbar and then choose the appropriate merge field. Choose save from
the file menu after editing the main document.

b) Merging the data source with the main document:

Before merging the main document with the data source, the following things should have been
done:

1. All the addressee information in the data source should have been typed.
2. All the merge fields should have been inserted at the desired location into the main document.

To merge a data source with the main document

1. Click, the View Merged Data button on the'Mail Merge toolbar while the main document is in the active
window. Word displays information from the first data record in place of the merge fields in the main
document text. To view information from other data records, click one ¢ f the arrow buttens on the Mail
Merge toolbar, or type a record number in the Go To Record box.

4.2.3 Merge Printing Labels and Envelopes

Word’s Mail Merge Helper can also be used to merge labels and envelopes. The procedures for merging
labels-and envelopes are very similar to those for form letters.

Printing Addresses on Envelopes

Word § offers the ability to print addresses on enveiopes. This can be convenient for small number of
envelopes: but as most laser printers require you to feed envelopes in by hand, printing large numbers of
envelopes can be a slow business.

To print envelopes by using the Mail Merge command

[. Select Tools — Mail Merge to fire up the Mail Merge Helper.

2. Click the Create button to drop down a list of options and select Envelopes from this drop-down list.



3. Arrange the data source as usual. Then click the Mail Merge Helper button on the Mail 1ie
and under Main document, choose the Set up button. In the Envelope options dialog box i
make the appropriate choices for your envelopes.

®  On the Envelope options tab, click the font button in the Delivery Address box or i/
the Return Address box to change the fonu iif which the addresses appear. You can also
position of the delivery address or return address hy entering from Top and from Leit mes
in their boxes.

*  On the Printing Options Tab, select the feed method and the tray to feed from.

4. Choose OK to close the dialog box.

5. "Next, the Envelope Address dialcg box appears. Position the insertion point in the Sampie Envelope
Address box. . Then choose the Insert Merge Field button and choose the appropriate merge fields, Type
any spaces and punctuation you want between the merge fields, and press ENTER at the end of cach ling,
Choose the OK button to close the Envelope Address dialog box.

6. In the Mail Merge Helper dialog box choose the Edit button under main document and then choose
Envelope document from the list. Word displays the enveiope main document in Page Layout view. if
the user Info Tab in the Option dialog box (Tools menu) has an address specified in the Mailing Address
box. tl =n that 'address is used as the return address.

7. Theck whether your printer is ready to print envelopes. Then click the Merge To Printer bution on the
Mail Merge toolbar.

Printing Labels on Lascr Printers

The Mail Merge Helper makes merging labels on a faser printer deal simple. You use the Mail Merge Helper
to create a main document containing a table with fixed-size cells and cel] spacing that match the size and -
position of your blank labels, then insert merge nstructions in each table cell.

i. Select Tools — Mail Merge to fire up the Mail Merge Helper.

9

Click the Create button to drop down a list of options.
3. Select Mailing Labels from the drop-down list.

4. Arrange the data source as usual. Word will then invite vou to set up your main document. In the Labei
Options dialog box that appears, make the appropriate choices for your printer and labels:

* Inthe Printer Information box, select Laser or Dot Matrix as appropriate.

5. When you’ve chosen the labels to use, choose OK to close the dialog box.

6. The Create Labels cialog box will appear. Position the insertion point in the Sample Label box. Ch’?}:‘as‘e
the Insert Merge field button and choose the appropriate merge fields. Type any spaces and punctuation
you want between the merge fields and press ENTER a the end of each line. ’

7. Open the Mail Merge Helper dialog be  nd choose the Merge button to merge your data source with e
main document. Choose wiet] «ge to new document or to the printer. (You can also use the -
Merge to New Document and Merge to Printer buttons on the Mail Merge Toolbar here). -

£

8. Save your documents with meaningful names.
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43 MACROS

‘This section introduces you to Macros in Word.

4.3.1 What are Macros? ,

A Macro is a series of Word commands grouped together as a single document to make everyday tasks easier.
It can be assigned to a toolbar, a menu, a shortcut key ‘and run it by simply clicking a buttor, selecting a menu
choice or pressing a key combination. Macros are instructions in Word’s macro language, Word Basic.

Some typical uses of Macros are:

. To speed up routing, editing and formatting.

. To combine more than one command.

° To make an option in a dialog box more accessible.
. To automate a complex series of tasks.

43.2 Recording a Macro

It’s easy to create a Macro: you start the Word macro recorder and record a sequence of actions, then stop the
recorder and edit the macro if needed. You can then run the macro whenever you need to perform that same

- set of actions. For example, if you often need to display as much of a document as possible, you can record a

macro that maximizes the document window and then hides the horizontal ruler, toolbars and scroll bars.

The macro recorder cannot record mouse actions in document text. You must use the keyboard when
recording such actions as moving the insertion point and selecting text. However you can use the mouse to
choose commands and select options when you’re recording a macro. '

There are three ways to start the macro recorder:

. Double-click REC on the status bar.

. Select Tools—Macro, then click the Record button in the Macro dialég box.
o Click the Record button on the Macro toolbar.

To Record A Mt’.crol

1. Start the macro recorder by selécting'any of the three options described earlier. The Record Macro
dialog box appears.

[89)

Enter a name for the Macro in the Record Macro Name box. If vou don’t give your macro a name. Word
will name it Macro1, Macro 2 and so on. No spaces, commas, ¢r period allowed in the name.

3. Enter a description of what the macro does in the Description box. This is-optional and you can use upto
255 characters.

4. To assign a macro to a toolbar, a menu or a keyboard shortcut, click the appropriate button.



5. If the current document is attached to a template other than the Normal template, select either that Mail Merge anu
template or Normal in the Make Macro available to box. If the current document is attached to the a‘:‘:“‘:::m
Normal template the macro is automatically stored in the Normal template. ARement

6. Choose OK, then perform the actions you want to record.

7. To stop}'ecording the macro, do one of following:

e  Double-click REC on the status bar.

¢ Click the stop button on the Macro Recorder toolbar.

1
Running A Macro

Once you have recorded your inacro, you can assign it to a toolbar, a menu or a shortcut key combination.
You can then run it as you would a normal Word command or feature.

If you don’t want to assign a macro to a toolbar, or key combination-perhaps you simply have too many
macros, or use some of them too seldom to merit having them available all the time,-you can also run a macro
by choosing Teols—Macro, selecting the macro name in the Macro dialog box, and clicking the Run button.

If you’ve got everything right, your macro will perform the actions you taught it to do. If something is
wrong, you may have to edit it.

4.3.3 Editing and Organising a Macro

You can edit macros you write or record in a macro-editing window. To edit a macro:

1. Choose Macro from the Tools menu.
2. Select the list of macros you want to choose from, the Macros available inbox.

!

3. Select the macro ydu want to edit and then choose the Edit button.
Word new Organizer dialog box greatly simplifies managing your macros.. You can use it.
1. To Copy Styles, AutoText entries, toolbars, or macros to the attached template from another template.

2. To Rename a macro

3. To delete a macro.
Copying, Renaming or Deleti'ty A Macro

The Organizer dialog box can be used to rianage your macros by copying them into different templates or
renaming them.

You can copy styles, Auto Text entires; toolbars, and macros from one template to another. You can copy styles
between templates and documents, but you can copy macros, Auto Text entries and toolbars only betwen
templates.

St

H a‘? &



y macros from one template to another:

iic-»Templates. The Templates and Add-Ins dialog box will appcar.
2. Click the Organizer button to display the Organizer dialog box.
%, Choose the Macros tab.

4 i nesessary, close the open file, select the Open file button, and open the template or document
containing the macro.

$. Select the macro you want to copy, then choose the Copy button.

&, Click the Close buiton when finished topying macros.
Kenaming A Macro

Vou can use the Organizer dialog box to manage your macro by renaming them.
-

Tae sfeps (o rename 2 macro are:

1. Select Tools—>Macre. The Macro dialog box will appear.

i the Organizer button. The Organizer dialog box will appear with the Macros tab selected.

% i the left list box, choese the macro to rename. If necessary, choose a different template in the Macros
avatiable in listbox.,

4. Click the Rename button. The Rename dialog box will appear:

5 Entering a new name for the macro and click OK. The macro will be named.

4324 Assigning Macros to a Menu, Toolbar and Shortcut Keys

‘This subsection gives the detailed of how a macro can be assigned to a menu, a toolbar and shortcut keys.

3

Assigning a macro (0 menu:

3

From the Tools menu, choose Customize.

¢ the Benus tab.

foad

Casegories bex, select Macros.



9.

In the box to the right of the categories box, select ihe macro name to be assigned to a menu.

In the Change What Menu box. select the name df the menu to which you want to assign the macro
name.

In the Position On Menu box, dc one of the following:

a) Select (Auto) to automatically position similar menus together, or

b) Select (At Top) or (At Bottom) io position the macro at the top or bottom of the mcn;x or

¢) Select the item below which you want to add the new item to position the item within the menu list.

In the Name On Menu box, accept the default name or type the name of the macro you want to appear on
the menu.

Choose the Add button and click the Close button.

Assigning a Macro to a Toolbar Button

You can customize Word toolbars so that they contain buttons for the macros:

1.

Fol]ow the following steps for this:

Choose Customize— Tools.
Select tﬁ‘e\tooibars tab from the Customize dialog box.
In the Categories box, select Macros and choose the macro name to be assigned.

From the box to the right of the categdfies box, drag the maero name to the toolbar you want to add it to.
As Macros don’t have built-in button, a blank button appears on the toolbar and the custom button dialog
box appears.

N

In the button box, select an ixﬁ‘a_ge to place an image on the blank button.

Choose the Assign button and then the Close button.

Assigning Macro to a Shortcut Key’

The steps followed to assign to a shortcut key are:

Choose Customize—Tools.

Select the keyboard tab.

In the Categories box, select Macros.

In the box to theAright of the Categories box, select the macro name to be assigned.

In the Press New Shortcut key box, type the shortcut key you want to assign to the macro.

Choose the Assign button and Close button.
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I While nsing the data from other applications in the data source file,

1) the records nisst contain maltple fields
i) the meree Sebds inhe documents must mateh (Il(m; in the data soaree
H vou mest (st click the Create an Soure» button
iv) mone of the above
2. The Date and Time command
t) inserts the date and time you can specity
i) automatically adds the current date and time
iii} shows the date a file was created

iv) shows the date a file was last revised

“d

The View Merged Data button

Hallows you to view all the records in the data source file
) allows you to insert records into the main document
i) allows you to view how the form letter will appear

iv) allows you to select the records to be merged
4. The Macros can be assigned to a toolbar. a menu or shorteut keys by using

1) the Options command in Tools menu
i) the Macro command in the Tools nmienu

1) the Customize command in the Tools menu

4.4 PROTECTING DOCUMENTS

The major file management operations include creating. opening, saving. restoring and protecting documents.
This detail about creating, opening and saving the documents have been explained earlier in unit 1. This
section mainly deals with protecting documents.

Protecting a document

Protecting a document implies saving it from being changed either accidentally by some other user. A
document can be protected in two ways:
*®

1. Opening a document as read only.

When a document is opened as read-only, the user cannot make any changes to the document. This can
be achieved by selecting the read-only check box in the Open dialog box. This read-only option will not
allow any changes in the document to be saved.

Protecting a document with a password.

3-,.;

The other way to protect a document is to use the Protection Password, which is typed in the Protection
Password box. In this way, the users who know the password can only open the document. These
passwords can be changed and deleted too.
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4.5 PRINTING A DOCUMENT A Document

Mianagement

While printing a document, you can:

1. Print the entire document or only specific pages.

2. Print summary information, annotations or list of styles, AutoText entries or key assigﬁments.

3. .Print a draft copy, which omits graphics to allow faster printing.

4. Set printing options, such as number of copies.

You can also automatically create and print an envelope, using an address from a document or one that you
type. You can either print directly on an envelope or store the informaticn so that you can print the envelope

later.

The printers you can use affect the way Word prints and displays text on the screen. Before you print a
document, you must install and select the printer you intend to use to print the document.

Word displays a document, as it will look when you print it. If you want to preview a document before you
print it, use page layout view or print preview. In each of these views, you can make last minute changes to
text formatting, page breaks and margins.

Line breaks and page breaks should be the same on the screen and in the printed document. Howeéver, the
fonts and view options you choose can affect the match betweer: what you see on the screen and what appear:
on the printed page.

Three kinds of fonts affect your work in Word: Scaleable fonts, Printer fonts and Screen fonts.

Use scaleable fonts, such as True Type fonts to ensure that what you see on the screcn is what appears on the
printed page.

For using printer fonts, you must have a corresponding screen font and font size to display each font on the
screen. If each screen font you use has a matching printer font, the screen display of the document will
closely match the printed document.

The three basic steps for printing a document are:

1. Connecting the Printer:

Cornect the printer either directly to your computer or to a network.

2. Selecting the Printer:

Choose Print from the file menu then choose the Printer button and select the printer you want to
use.

3. Printing the Document:

Click the Print button on the Standard toolbar. In Windows, Word prints one copy of the active
document using the word default print settings.



. . Sample GUI
Oricated
Applicatiors

Check Your Progress 2

1. To prevent other users from opening o documient which of the followmg should be clicked in the options
command in Tools menu ’

i) Protection Password box
ii)  Write Reservation Password box
iti) Read-only Recommended box

iv)  Either (ii) or (iii)

2. While Saving a document, a filename without the extension can have maximum of

i) 15 characters
1i) 11 characters
iil) 8 characters

iv) 10 characters

.........................................................................................................................

4.6 SUMMARY

Mail Merge has an advanced feature of printing envelopes and labels. This feawure is not present in the Mail
Merge feature of WordStar Macros in Word can be assigned to menu, keyboard-shortcut keys ortoolbar.
This can make the operation of the macro made faster and easier. We have also discussed the steps involved
for protecting and printing documents. :

4.7 MODEL ANSWERS

The questions given in the ‘Check Your Progress’ have been designed only at the conceptual level and the
answers to these questions are directly available in the unit. Therefore, Model Answers have not been
provided. However, as this block is more practical oriented, therefore, students are advised to try the
commands given, on their terminals.
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POWERPOINT

Structure

5.0 Introduction

5.1 Objectives

52 What is Business Graphics?

5.2.1  Types of Business Graphics
5.2.2  How to make an effective preseniation?
5.2.3  Physical aspects of presentation
53 A Presentation Graphics Package: PowerPeint
5.4 Creating a Presentation
‘ 5.4.1  Creating a Title Slide
5.42  Creating a Graph
5.4.3  Creating Tables
5.4.4  Make Organization Chart
5.4.5  Save and Close a Presentation
5.5 Working with Tools '
5.6 Slide Show
5.7 ‘Summary

5.0 INTRODUCTION

In the previous four units, we have focussed our attention on some of the features of a powerful Word
Processing package. In this unit, we will introduce you to the concepts relating to presentation graphics

This unit provides a brief introduction of Business Graphice and it’s types. It also introduces you to
PowerPoint as one of the tools for making Business Presentations. A presenitation graphics package allows
you to produce a professional-looking presentation involving text, outlining, drawing, graphics, ciip art, and
so on. It also offers rich speaker support and aids to help you create truly effective presentations. It normally
incerporates features for design and colour and a set of templates.

We will discuss some of the above mentioned aspects relating to PowerPoint in this unit.

5.1 OBJECTIVES

After going through this unit, you will be able to

e define different types of graphics

« appreciate physical aspects of presentation
e  create a presentation

e create graphs as your slide

« change the layout of a slide

e change the fonts, size and color of text.

» add drawing objects in your slide.

e work with objects |

#  ctoup or unproup objects.
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52 WHAT IS BUSINESS GRAPHICS?

A picture is wortn a thousand words. We 'ive in a visual world, and the human mind can comprehend and
retam coneepts learnt through isual depiction for longer time. In today's world, it is very critical for a person
to put across ideas effectively, whether it s business or not. One way of putting across ideas cftectively, is the
use of visuai images. And the best form of visual images is graphics and pictures. Graphics if used to convey
ideas ins tusiness situations ave known as Business Graphics. '

5.2.1 Types of Business Graphics

There are three types of Business Graphics. They are:

Presentation Graphics, Analytic Graphics, and Design Graphics.

Presentation Graphics: Convincing the audience about an idea and putting your views across is the aim of
any presentation. The main goal of presentation graphics is to get a message across. Examples of

presentation graphics tools include Harvard Graphics, PowerPoint etc.

Analytic Graphics: Analytic Graphics presents the data and information in such a way that it helps in people
analyzing it. Its aim is to show relationships in data and information.

Analytic Graphics need not have a very high quality. They are used to produce graphics from the data stored
in database management systems like MS-Access and electronic spreadsheets like MS-Excel. They help in
analyzing the data and taking a decision thereby. Graphics provided by spreadsheet packages like Lotus 1-2-
3, MS-Excel are examples of analytic graphics.

Design Graphics: Design Graphics are used to create visual images of products, medels, etc. Computer
Aided Design (CAD) is an example of design graphic tool.

In this unit, we will discuss about a tool to create business graphics.

5.2.2 How to make an effective presentation?

Till now you have examined the different types of business graphics. Of ali these, presentation graphics is the
most commonly used one. To convince the audience about an idea, the presentation has to be effective. In
other words, you can say that effective use of presentation graphics is a very important aspect of successiul
presentations. For this, ask yourself some questions while making the presentation like:

e Do I know about the people whom | am giving a presentation?

¢ You must be aware of the audience’s level of knowledge on the topic about which you are makmg a
presentation. -

e s my presentation simple? You can convince the audience only if they understand you. Your presentation
should be simple enough, so that even a person who is totally new or who hardly knows anything about
the topic also gets your point.

s [s the presentation to the point?

Take care of following points while making the presentation



e Start with what is familiar to the aud:ence.
e Make each chart independent.
e Use space effectively.

e Use tet and color judiciously.

523 Physi§a| aspects of presentation

How the information has been disp'ayed, is very important aspect of any presentation. Mostiy slides, graphs,
bar charts and pictures are used for displaying iriormation. To be able to use slides meaningfully, the petson
must be familiar with the basic components of a slide.

A good slide communicates 2 message successfully.

The components of a slide are:
o Title : Title gives an idea of what the slide s all about.
¢ Subtitle : A subtitlc emphasizes the slide’s central idea.
-» Footnote® : A footnote indicates the source of the shide’s data.
¢ Border : It acts like a frame for your slide.

o X-axis, Y-axis, X-axis title, Y-axis titic (for the graph).

Slides are one of the most important components of a presentation. A slide may inciude
« Text highlighting the main ideas.

e Charts like Pie Chart, Bar and Column Chart, Area Cnart, [.ine Chart, and Organization Chart, clarify the
relationships in data and information.-

e Multimedia components to enhance the quality of presentation.

53 A PRESENTATION GRAPHICS PACKAGE:
POWERPOINT

PowerPoint is a powerful presentation graphics package. It allows the presenter to create his own high
quality presentations. Don't worry about consistency in design and colour. PowerPoint can help you. If you
don't consider yourself a designer, just apply one of the PowerPoint templates to your presentation and
choose from among the thousands of color schemes available.

Whether vou need quick overheads for a team briefing, slides for a sales meeting, or dazzling effects for an
on-screen presentation, PowerPoint wizards, templates, and AutoLayouts help you get right to work; and a
complete set of easy-to-use tools assures you have cverything you need to get your point across and share
information with others. -

A PowerPoint prescntation is a collection of your slides, handouts, speaker's notes, and your outline, all in
one file. As you create slides, you're creating a presentation - you're designing how your presentation shoutd
look and giving it-a format that carries through from beginning to end.

PowerPoint gives you the flexibility of switching between different views during the creation of slides for a
presentation.

Presentaviui
Graphics mnd
Powerkoirt
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» Slides are the individual "pages” of vour presentation. Soon, you'll be creating slides with PowerPoint.
Slides can have iitles, text, graphs, drawn objects, shapes, clip ari, drawn art, and visual created with other
anplications and more.

» Handouts support your presentation. You have the option of providing handouts for your audience.
Handouts consist of smalicr, printed versions of your slides. '

. Speai(er's Notes can be created and printed. You'll see a small image of the slide on each notes page,
along with any notes you type on the notes pages. :

¢ Outlines As you're working on a presentation, you have the option of working with your presentation in
outline view. In the outline, your titles and main text appear, but not your art or the text typed with the
Text tool.

5.4 CREATING A PRESENTATION

In PowerPoint, your entire presentation is in one file - everything is "under one roof". That includes all the
slides, the outline, the speaker's notes, and the handouts, as well as the formatting information you build into
your presentation.

Using a slide layout is an easy way to begin building a presentation. You choose a slide layout by selecting
‘New Slide from the insert menu and then selecting the layout you want in the New Slide dialog box. There is
a variety of slide layouts, some with placeholders in which you type text, and some with placeholders set up
to make it easy to add graphs, charts, clip art, or other objects.

With PowerPoint, you can change the look of your presentation - the format, the colors, or the kind of output
you want - anytime. You can always apply a new template or change the colour scheme.

When you create a new presentation, you have choices z5out how to proceed. You can use the AutoContent
wizard to help you organize what you want your presentation to say. You can use the Pick a Look wizard to
help you apply a template and set up the masters. You can also start with a "blank" presentation if you want
to'use the default presentation - either the PowerPoint default or one that you set up.

5.4.1 Creating a Title slide

A Title slide is the first slide that wili be displayed in your presentation. A Title slide is divided into two parts
- the top part for the title and the bottom part for the sub-title or the topic.

To create a Title slide

1 Select New from the File menu, to display the presentation dialog box.

.

2. Click the Blank Presentation, and then OK.



Prescatation
Graphics and
PowdrPoint

| Cancet

] Help

: ‘Tip for ;""g
New

- Users - Y

The AutoContent
» : : ,» , | Wizardis the quickest
é &, (O Current Presentation Format - way to create &
] ' , presentation,

3. Select Titie slide from the AutoLayout diaiog box and click on OK.

Al 114
ooosiioenn ] RN
LRPITIVITIIPH . s 1
R ﬂ!’l Eance! ;
; — Hi0 : St
| A 4
| ; ~ Title Slids
R s s 2] B R
i -.__.1 : N : YU PO O "’ !
23 |WE| BB |
’E

4. It will display the blank title slide to enter information.

5. Type the title and sub-title.
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o PowerPoint presentation file is a collection of slides. Till now, you have created a slide. Now you want to

~expand the presentation to add more slides.

To add u new slide

1. Select New Slide from the Insert menu to display AutoLayout dizlog box.

[39)

Select the layout.

3. Click on OK to display blank slide layout to enter information.

5.4.2 Creating a graph

A graph can be created and viewed in different formats. as a pic, bar, column and so on. Legends, titles and
data labels can be added to improve readability.

To . zate a graph

1. . Chek on new slide button on the status bar to display AutoLayout dialog box.

2. Select the slide as shovn in the following figure.

e " New Slide
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3. Click your mouse cursor on the OK «sign.

4. Tt will display the blank graph layout slide.
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Double click to add graph

3. Double click on the graph box marked as “Double click to add graph” to go in the graph mode. Now
you can create and modify the graph. You will see some data also in the Presentation - Datasheet. Please
do not get disturbed. This is only a default data. You can put the new data i.e. modify the existing data as
per your datasheet by taking the mouse cursor and clicking it once.

6. Whenever you change the values in the d"uasheet it wili change the oraph automatically, displaying
backside of the datasheet.

Change the graph tvpe

You can change the graph type as p2r vour requirement. There are two ways to change the graph type.

One way is

o Click on graph type iist box. It will display you different types of graphs. You can choose any of them.
The second way 1s

o Select Chart Type from the Format menu to display chart type dialog box.

o From the chart type dialog box, you can select 2D or 3D type graphs ana click on OK.

C!z’ange the sub-type of the graph

« Select 3D column group from the Format menu.

« Itwill display a 3-1) corumn group dialog box.

7,

Presenistion
Gisprhics nn
PowerPoint
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e Click on Subtype tut*on and select the subtype graph and then click on OK. It will display you the

preview of the graph.
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Creating Titles

Sometimes you may want to include more than one graph on a single slide. In such cases, each individual
graph will need to be identified. This can be done using titles.

¢ Select Titles from the Insert menu to display titles dialog box.

¢ Click on the check boxes in the dialog box, you can create titles in the graph.

(441) 1'1-VDg



Add data labels in the graph

e Sclect Daia Labels from the Inse.t menu to display a dialog box.
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Hidden gridlines

You can show the value or label with the graph. %€lect anv onc and then click on OK..

100
80
60
40
20

dth
Qtr

3rd

Qtr Gtr Qu

E_AN\SNANARRARRARNGANANE SRAARNARNARERANNANNAR Y. |

S

@ East
m West
w Morth

S "7

Select Gridlines from the Insert menu to display a dialeg box.
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Tables are uscd to display data in a columnar form
To creae a Takwe »

1. Ciick on New slide buttois or the status bar to display AutoLayout dialog oox.

2. Seiect Table layout trom: the AvtoLayout list and then click on OK to dxsplay a blank Table presentation
stide. From where you can add table.

fU)

Double click on Table Lox to display Insert table dialog box.

4. Type number of columns and number of rows in respective boxes of your requirement and click on OK tc
¢o in word table( rows and columns) form.

5. And lastiy type vour information in the cells.

Cp ey
i

T
ife
i

~N

..3...|

5.4.4 Make Organisation Chart |

An organization chart shows the formal structure of a hierarchical group. An organization chart can be used
to effectively depict a complex organization scheme as an casily comprehensibie visual. These charts are
ideal for all types of groups - clubs. companies and governments.

If the hierarchy of an organization is very complex. the Organization Chart that represents this erganization
may also become complex. In such a situation, it is betterto create two organization charts. For example. if
you have more than five boxes at the same level. then civide them between two charts and present the charts
together. If the organization chart looks toe crowded. use abbreviations for the names or titles displaved in
the chart. Or, show only the names of people. rot their titles.

To create an organization chart

1. Click on New slide button on the status bar to display AutoLavout dialog box.
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2. Select Org Chart layout from tt * AutoLayout list and then click on OK te display a blank Crganization Preseniaiion
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3. Double click on Org. Chart box to display Organization chart window.

4. Click on box to type title and name in the box.

[ Microgolt Organization Chart - [Object in Presentation] = | .
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To change group styles

¢ Select on Styles menu to display different Group Styles. Selectany of them
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To change box border styles

» Click on box to select.

Select the box

R o s W T

(Type name her
e

e

1

| Typel fer

H
£

» Select Box Border from the Boxes menu to display different border styles. Select any one of them.

To change box shadow styles

Click un box to select.

e Select Box Shadow from the Boxes menu to display different shadow styles. Select any one of them.

Tc¢ change box colours

@

Click on box to select.

« Select Box Color from the Boxes menu to display different colours. Select any one of them.

To ehange line thickness of the box

Click on box to select.
[

e Select Line Thickness from the Boxes menu to display different line thickness. Select any one of them.

Kchange line styles of the box

e

Click oii box to select.

» Select Line Style from the Boxes menu to display different line styles. Select any one of them.

To change line colour of the box

Click on box to select.



e
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o Select Line Color from the Boxes menu to display different line colours. Select any one of them.
' Graphics and
FowerPoint

To add more boxes in organization chart
e Click on the appropriate button on the toolbar, to add Subordinate, Co-worker, Manager and Asaistant

boxes.

Coworker-l:] h'lanagerqzl Assmiant D{J

e Adding different boxes :

Ty name here]
| Typettle here |

Co-worker
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5.4.5 Save and Close a presentation

After creating a slide, now you can save your presentation.

To save a presentation

13

4.

Select Save from the File menu to display Save As dialog box.

This dialeg, box displays the current directory and the current drive in respective directories and drives

~boxes. Erer the name of the presentation in the File: name box. No need to give extension because

Microsoit PowerPoint automatically adds a .PPT extension to the name.

To stor: the presentation in a different directory'. select the directory from the dircctories list.

Click OK to save prc_Semation file.

To close a presentation

Select Close from the File menu to close the current presentation.
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5.5 WORKING WITH TOOLS | Graphics and

PowerPoint

You can create a text object, edit text and move text objeé.t in a slide using text tools.
To create a text object

1. Select Text tool button from the toolbar.

O Text Tool

2. Leave the tool on blank slide and type text on it.
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3. When finish typing the text, click any where of the blank slide.
To edit the text object ‘

e Click on the text object. While cursor is blinking on it, you can add more characters or using Del key /
Backspace key to remove characters. - ' :
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To move the text object

e Click on text object to select it. Move the mouse cursor to border of the text object and click on it and
hold down the mouse button. Move the text object anywhere of the slide and leave the mouse button.

[ JRRHUSSRNBUIHH _HISBSGSBSHUT S |
ooy o

= PowerPoint

B IRRHENUSR SR BEEESSTEE S

To delete the object
e Click on object to select . Press DEL key to delete.
To resize the object

o Click on object to select. Move the mouse cursor to the corner of the object, when cursor changes its
shape, hold down the mousg button and drag it to increase or decrease the size.
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Change fgé(s, size and colour of text

PowerPi)iht provides so many choices for the appearance of text object on slide. You can change the size of
the text, change the font of the text and can make the text bold or italic. You can also fill color to background
of the text, shadow the text and text color.

To make text bold, italic or colorful

1. Selecf; the text object, to enables additional‘ tools in the toolbar for changing the appearance of the text.
2. Click the bold or italic button to chaﬁges the text. |

To change the font and size of a label

1. Select the text object.

2. Select font from the fonts list box of the toolbar to change the appearance of the text.

3. Select size from the size list box of the toolbar to resize the label text.

4. Using the mousé pointer to resize the control. |

To fill the text b.zckgroum; color

. Seléct the text object.

¢ Click on fill color button to display color lists and select to fill it.

To create or chanéé the bord: - olor

o Select the text object.

e Click on border color button to display color list and select to create border of that color.

W ith border

To create or change the Shadow colour
o Select the text object.

e Click on shadow color button to display color list and select to create shadow of that color.

®
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Working with graphic tools

" e Click on any drawing button from the Drawing or Drawing + toolbar.
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e Draw any drawing object on the slide.
‘Align objects

e Select the first object, press and hold down the Shift key and click on the second object to align with first
object. :

| ] | n
» Microsoft =

a [ | | |
" . "
» PowerPoint =
[ ] | | [ |

e Select Align from the Draw menu to display another sub-menu.

o Sclect centers to align the objects in center.

L
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Microsoft

PowerPomnt

Group or ungroup the objects
You can create a set of object to group them and separété them by Ungroup.
To group the gbjects

o Select the first object, press and hold down the Si\ift key and click on the second object to group with first
objcct. ‘ :

' » Microsoft «
. PoxverPoint .

e Sclect Group from the Draw menu.

~ Group -

Window Help

Lirnroup

* Regroup

¢ [t will group the objects.

NMlicrosoft
PowerPoint

To Ungroup the objects

¢ Click on the grouped object to select. Select Ungroup from the Draw menu to'Ungroup them

5.6 SLIDE SHOW

Till now you have learned about creating slides. Now you can show them by slide show.

* Select Slide show from the view menu to display a dialog box.

-



e Click on show button to display slide show. ~ Presentation
Graphics and
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You can setup timings for individual slide, can create animation in a slide and lot more. Au this is beyond
the scope of this unit. You can learn about other PowerPoint features by using them on the Microsoft
PowerPoint itself. '

5.7 SUMMARY

Business graphics can be categorized into
e Presentation graphics
e  Analytic gl"aphics
e  Design graphics

¢ The various components of a slide are: Title, Subtitle, Footnotes, Border, X-axis and its Titles, Y-axis and
its Titles. '

e You can change the fonts, size and colour of text, yoﬁ can'add drawing objects in your slide by select the
drawing shape from the drawing toolbar. )

¢ You can align 6bjects, group or ungroup object; in PowerPoint.
e Screen display effeqts can be added to enhance a presentation.
e To create a new presentation by select New from the File menu.
o Titles slides are used to display the tii:!e;of a presentation.

 Bulleted lists are used to group related information on a slide.

e Slide show provides a way to-appear slides on the screen one by one.
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